This documentation has been created for software version 16.3.
It is also valid for subsequent software versions as long as no new document version is shipped with
the product or is published at https://knowledge.opentext.com.

Open Text Corporation
275 Frank Tompa Drive, Waterloo, Ontario, Canada, N2L 0A1
Tel: +1-519-888-7111
Toll Free Canada/USA: 1-800-499-6544 International: +800-4996-5440
Fax: +1-519-888-0677
Support: https://support.opentext.com
For more information, visit https://www.opentext.com

Copyright © 2017 Open Text. All Rights Reserved.

Trademarks owned by Open Text.
Adobe and Adobe PDF Library are trademarks or registered trademarks of Adobe Systems Inc. in
the U.S. and other countries.

Disclaimer

No Warranties and Limitation of Liability

Every effort has been made to ensure the accuracy of the features and techniques presented in this
publication. However, Open Text Corporation and its affiliates accept no responsibility and offer no
warranty whether expressed or implied, for the accuracy of this publication.
# Table of Contents

**Preface** ........................................................................................................................................... 27

**Chapter 1 Getting Started** .................................................................................................................. 29

- Introduction to AppXtender Concepts ............................................................................................... 29
- Content Organization in AppXtender .................................................................................................... 30
- Glossary of AppXtender Terms .......................................................................................................... 30
  - Annotations ................................................................................................................................. 31
  - Applications ............................................................................................................................... 32
  - COLD/ERM Data ......................................................................................................................... 32
  - Digital Signatures ....................................................................................................................... 32
  - Documents ................................................................................................................................. 33
  - Full-Text ....................................................................................................................................... 33
  - Indexes ......................................................................................................................................... 34
  - OCR ............................................................................................................................................... 34
  - ODMA .......................................................................................................................................... 35
  - Pages ............................................................................................................................................. 35
  - Redactions ..................................................................................................................................... 35
  - KeyView Viewer ........................................................................................................................... 36
- Document Storage Locations ................................................................................................................. 36
  - DiskXtender.................................................................................................................................. 36

- AppXtender Components .................................................................................................................... 37
  - Administrator Components ............................................................................................................ 37
    - AppXtender Index Server .......................................................................................................... 37
    - Import Wizards .......................................................................................................................... 38
      - AppXtender Index Image Import Wizard .................................................................................... 38
      - AppXtender Key Reference Import Wizard .............................................................................. 38
      - AppXtender Auto Index Import Wizard ..................................................................................... 38
    - Administrator Utilities ................................................................................................................ 39
      - AppXtender Migration Wizard .................................................................................................. 39
  - User Components .............................................................................................................................. 39
    - AppXtender Document Manager ............................................................................................... 39
    - AppXtender Data Source Selector .............................................................................................. 40
- AppXtender Image Capture ................................................................................................................... 40
- AppXtender License Server .................................................................................................................. 40

- AppXtender on Your Network ............................................................................................................... 41

- How Documents are Stored and Displayed in AppXtender ................................................................ 41

- Supported Files .................................................................................................................................... 42
  - Image Files ..................................................................................................................................... 42
  - ERM/Text Files .............................................................................................................................. 43
  - Rich Text Format (RTF) Files ........................................................................................................ 44
  - Hypertext Markup Language (HTML) Files .................................................................................... 44
  - Portable Document Format (PDF) Files ........................................................................................... 44

- Unsupported Files ................................................................................................................................ 45
  - Foreign Files ................................................................................................................................. 45
  - OLE Objects .................................................................................................................................... 46
  - Field Masking .................................................................................................................................. 46

- Ways of Using AppXtender .................................................................................................................. 47
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Modes of Operation</td>
<td>48</td>
</tr>
<tr>
<td>Check In/Check Out Mode</td>
<td>49</td>
</tr>
<tr>
<td>Reason Audit Mode</td>
<td>49</td>
</tr>
<tr>
<td>Normal Mode</td>
<td>49</td>
</tr>
<tr>
<td>ODMA</td>
<td>50</td>
</tr>
<tr>
<td>Selecting Data Sources</td>
<td>50</td>
</tr>
<tr>
<td>Locating Data Sources</td>
<td>51</td>
</tr>
<tr>
<td>Specifying a Default Data Source</td>
<td>54</td>
</tr>
<tr>
<td>Specifying Multiple Data Sources</td>
<td>55</td>
</tr>
<tr>
<td>Starting AppXtender Document Manager</td>
<td>56</td>
</tr>
<tr>
<td>Variations on Login Procedures</td>
<td>58</td>
</tr>
<tr>
<td>New Login</td>
<td>59</td>
</tr>
<tr>
<td>Logging into Multiple Data Sources</td>
<td>60</td>
</tr>
<tr>
<td>Viewing Application Properties</td>
<td>62</td>
</tr>
<tr>
<td>AppXtender Document Manager Views</td>
<td>62</td>
</tr>
<tr>
<td>Application View</td>
<td>63</td>
</tr>
<tr>
<td>Showing and Hiding Application Lists Using a Shortcut Menu</td>
<td>66</td>
</tr>
<tr>
<td>Activating an Application</td>
<td>66</td>
</tr>
<tr>
<td>Query View</td>
<td>66</td>
</tr>
<tr>
<td>Search Tab</td>
<td>67</td>
</tr>
<tr>
<td>Result Set Tab</td>
<td>68</td>
</tr>
<tr>
<td>Running an Existing Query</td>
<td>69</td>
</tr>
<tr>
<td>Showing or Hiding the Query View</td>
<td>69</td>
</tr>
<tr>
<td>Document Display View</td>
<td>69</td>
</tr>
<tr>
<td>Index View</td>
<td>71</td>
</tr>
<tr>
<td>Showing and Hiding the Index View</td>
<td>72</td>
</tr>
<tr>
<td>Adjusting Cell Height</td>
<td>72</td>
</tr>
<tr>
<td>Thumbnail View</td>
<td>73</td>
</tr>
<tr>
<td>AppXtender Document Manager Toolbars</td>
<td>75</td>
</tr>
<tr>
<td>Main Toolbar</td>
<td>75</td>
</tr>
<tr>
<td>Annotation Toolbar</td>
<td>77</td>
</tr>
<tr>
<td>Image Toolbar</td>
<td>79</td>
</tr>
<tr>
<td>Script Toolbar</td>
<td>81</td>
</tr>
<tr>
<td>Batch Index Toolbar</td>
<td>81</td>
</tr>
<tr>
<td>Scan Toolbar</td>
<td>82</td>
</tr>
<tr>
<td>Function Keys</td>
<td>83</td>
</tr>
</tbody>
</table>

**Chapter 2 Customizing Your AppXtender Document Manager Workstation**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>86</td>
</tr>
<tr>
<td>Disabling the Remember Password Option</td>
<td>87</td>
</tr>
<tr>
<td>Configuring Toolbars, Title Bar, and Status Bar</td>
<td>87</td>
</tr>
<tr>
<td>Displaying or Hiding a Toolbar</td>
<td>88</td>
</tr>
<tr>
<td>Changing the Size of Toolbar Buttons</td>
<td>89</td>
</tr>
<tr>
<td>Customizing Toolbars</td>
<td>90</td>
</tr>
<tr>
<td>Configuring the Title Bar</td>
<td>91</td>
</tr>
<tr>
<td>Displaying or Hiding the Status Bar</td>
<td>92</td>
</tr>
<tr>
<td>Print Setup</td>
<td>92</td>
</tr>
<tr>
<td>Using Sticky View</td>
<td>93</td>
</tr>
<tr>
<td>Saving Sticky View Settings</td>
<td>94</td>
</tr>
<tr>
<td>Customizing AppXtender Document Manager Views</td>
<td>95</td>
</tr>
<tr>
<td>Docking a View</td>
<td>95</td>
</tr>
<tr>
<td>Displaying a View as a Dialog Box</td>
<td>96</td>
</tr>
<tr>
<td>Displaying a View as a Subwindow</td>
<td>97</td>
</tr>
<tr>
<td>Hiding a View on Use</td>
<td>98</td>
</tr>
<tr>
<td>Activating AppXtender Document Manager Full Screen Mode</td>
<td>99</td>
</tr>
</tbody>
</table>
Managing the Query View Result Set ............................................................. 99
Changing the Way the Result Set Lists Documents ......................................... 99
Hiding or Showing Result Set Columns .......................................................... 101
Sorting the Result Set ..................................................................................... 101
Reordering the Result Set Columns ................................................................... 102
Resizing the Result Set Columns ...................................................................... 102
Saving the Result Set Columns ....................................................................... 102
Resetting Result Set Column Configuration ..................................................... 102
Collapsing the Result Set ................................................................................ 103
Opening the Configuration Dialog Box ............................................................ 103
View Tab ........................................................................................................... 104
Image Size Options .......................................................................................... 105
Zoom Settings are Pixels .................................................................................. 106
Scale-to-Gray .................................................................................................... 107
Use KeyView to Display Foreign Files ............................................................ 107
Use Acrobat Reader to Display PDF Files ....................................................... 107
Allow Map of Unknown Data Sources to Existing Data Sources .................... 107
Display Text View of Page .............................................................................. 108
Display Text View of Page .............................................................................. 108
Restore Last Layout at Startup ......................................................................... 108
Display Tab ...................................................................................................... 109
Screen DPI ........................................................................................................ 110
PgUp/PgDn in Dual-Page View .......................................................................... 110
Query Results .................................................................................................... 110
Maximum Query Results .................................................................................. 110
Sort Result Set Automatically .......................................................................... 111
Maximum # of Indexes Retrieved ..................................................................... 111
Sort Order of Document ID ............................................................................. 111
Ascending Order .............................................................................................. 111
Descending Order ............................................................................................. 112
Fonts Tab .......................................................................................................... 112
Screen Fonts ...................................................................................................... 113
Printer Fonts ..................................................................................................... 114
Simulate Box Drawing Characters ................................................................... 115
Scan Tab ............................................................................................................ 115
Enabling Image Processing Options ............................................................... 116
Removing Blank Pages .................................................................................... 117
Synchronized Scan ........................................................................................... 118
Scanner Manual Feed Timeout ......................................................................... 118
COLD Tab .......................................................................................................... 118
Cache Forms ..................................................................................................... 119
Allow Paste Text .............................................................................................. 119
Allow Zoom ...................................................................................................... 119
Display As Image Only .................................................................................... 119
Form Overlay Settings ..................................................................................... 119
Screen ............................................................................................................... 120
Printer .............................................................................................................. 120
Default Color Bar Settings ............................................................................... 120
Show ................................................................................................................ 120
Lines ................................................................................................................. 120
Color ................................................................................................................. 120
Print Tab ............................................................................................................ 121
Print Original Size ............................................................................................ 121
Fit to Page ......................................................................................................... 122
Dithering .......................................................................................................... 122
Print Toolbar Button ....................................................................................... 122
<table>
<thead>
<tr>
<th>Table of Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceleration ................................................................. 122</td>
</tr>
<tr>
<td>XipPrint ................................................................. 123</td>
</tr>
<tr>
<td>Talaris ................................................................. 123</td>
</tr>
<tr>
<td>Quick PCL ................................................................. 123</td>
</tr>
<tr>
<td>Endorse Printed Pages .................................................. 123</td>
</tr>
<tr>
<td>E-Mail Tab ................................................................. 124</td>
</tr>
<tr>
<td>E-Mail Formats ............................................................. 125</td>
</tr>
<tr>
<td>PDF Images for E-Mail ......................................................... 125</td>
</tr>
<tr>
<td>XPS Images for E-Mail ....................................................... 125</td>
</tr>
<tr>
<td>Black &amp; White Images for E-Mail ......................................... 125</td>
</tr>
<tr>
<td>4/8-bit Color Images for E-Mail ........................................... 126</td>
</tr>
<tr>
<td>True Color Images for E-Mail ............................................. 126</td>
</tr>
<tr>
<td>JPEG Quality Factor (1-100) ............................................... 126</td>
</tr>
<tr>
<td>Text for E-Mail ............................................................. 127</td>
</tr>
<tr>
<td>Use Multi-Page Files for E-Mail ........................................... 127</td>
</tr>
<tr>
<td>E-mail in Archived Format ................................................ 128</td>
</tr>
<tr>
<td>E-Mail Vendor ............................................................... 129</td>
</tr>
<tr>
<td>Export Tab ................................................................. 129</td>
</tr>
<tr>
<td>PDF images for Export ...................................................... 129</td>
</tr>
<tr>
<td>Black &amp; White Images for Export ........................................ 130</td>
</tr>
<tr>
<td>4/8-bit Color Images for Export ........................................... 130</td>
</tr>
<tr>
<td>True Color Images for Export ............................................. 130</td>
</tr>
<tr>
<td>JPEG Quality Factor (1-100) ............................................... 130</td>
</tr>
<tr>
<td>Text for Export ............................................................. 131</td>
</tr>
<tr>
<td>Use Multi-Page Files for Export ........................................... 131</td>
</tr>
<tr>
<td>Export in Archived Format ................................................ 131</td>
</tr>
<tr>
<td>File Types Tab ............................................................. 132</td>
</tr>
<tr>
<td>Adding File Types ........................................................... 133</td>
</tr>
<tr>
<td>Deleting File Types .......................................................... 133</td>
</tr>
<tr>
<td>Data Tab ................................................................. 134</td>
</tr>
<tr>
<td>Enable Dual Data Entry ...................................................... 134</td>
</tr>
<tr>
<td>Disable Query Window ....................................................... 135</td>
</tr>
<tr>
<td>Database Connect &amp; Drop .................................................. 135</td>
</tr>
<tr>
<td>Check for Matching Index .................................................. 136</td>
</tr>
<tr>
<td>ODMA Support ............................................................... 136</td>
</tr>
<tr>
<td>Allow Remember Password ................................................ 136</td>
</tr>
<tr>
<td>Prompt for Check Out when Open ........................................ 137</td>
</tr>
<tr>
<td>Enable ODMA Attribute Search ........................................... 138</td>
</tr>
<tr>
<td>Auto Logout ................................................................. 138</td>
</tr>
<tr>
<td>Data Field 2 Digit Year Max Future Years Setting ................... 138</td>
</tr>
<tr>
<td>Image Storage Format ....................................................... 139</td>
</tr>
<tr>
<td>Storage Format for Black &amp; White Images .............................. 139</td>
</tr>
<tr>
<td>Storage Format for 4/8-bit Color Images ................................ 140</td>
</tr>
<tr>
<td>Storage Format for True Color Images .................................. 140</td>
</tr>
<tr>
<td>JPEG Quality Factor (1-100) ............................................... 140</td>
</tr>
<tr>
<td>Separate Multi-Page TIFFs ................................................... 141</td>
</tr>
<tr>
<td>Paths Tab ................................................................. 141</td>
</tr>
<tr>
<td>Local Write Path ............................................................ 142</td>
</tr>
<tr>
<td>Personal Search Path ........................................................ 142</td>
</tr>
<tr>
<td>Volume Label Search Drives ................................................ 143</td>
</tr>
<tr>
<td>Business Intelligence Gateway Path ....................................... 143</td>
</tr>
<tr>
<td>Full Text Tab ............................................................. 143</td>
</tr>
<tr>
<td>Processing Queue ........................................................... 143</td>
</tr>
<tr>
<td>Allow Full-Text .............................................................. 144</td>
</tr>
<tr>
<td>Convert to Text (if necessary) ............................................... 144</td>
</tr>
<tr>
<td>Prompt User with Queue Selection ....................................... 145</td>
</tr>
<tr>
<td>Submit New Documents for Full Text Index ............................. 145</td>
</tr>
</tbody>
</table>
Chapter 3 Creating Documents ................................................................. 163

Introduction to Document Creation .......................................................... 163

Creating New Documents ........................................................................ 164
  New AppXtender Document Object Dialog Box ........................................ 165
  Input Methods ......................................................................................... 165
    Deciding What Input Method to Use ........................................................ 166
    Support for Viewing of Imported Files in AppXtender .......................... 167
      Native AppXtender File Support .............................................................. 167
      KeyView File Support ............................................................................. 168
      ODMA File Support ................................................................................ 168
  Adding a Document by Scanning ............................................................... 172
  Adding a Document from the Windows Clipboard ....................................... 173
    Adding a Document by Pasting ............................................................... 173
    Adding a Document by Pasting in a Selected Format ............................. 175
  Adding a Document by Inserting an Object ................................................ 177
    Inserting a New File as an Object ............................................................ 177
    Inserting an Existing File as an Object ..................................................... 180
  Adding a Document by Importing a File .................................................... 182
    Adding a Document by Using the Import File Option ............................. 182
    Adding a Document by Dragging from Windows Explorer ....................... 185
    Adding a Document by Dragging from Microsoft Outlook ....................... 187
  Adding a Document from the Fax-in Queue .............................................. 189
  Creating _RSTAMP and _FORMS Documents ........................................ 192
  Reason Code Required Dialog Box .......................................................... 194

Creating Documents in Batches .............................................................. 194
  Batch Import ......................................................................................... 194
    Creating a Batch Import File ................................................................. 195
      General Batch Import File Format ........................................................ 195
      Format for Import Referencing a Volume Label ..................................... 197
      Format for Importing Multiple Files with a Single Command ................ 198
    Performing the Batch Import ............................................................... 198
  Batch Creation ....................................................................................... 200
  File Selection Batch Create ..................................................................... 200
  Fax-in Batch Create ................................................................................ 202
  AppXtender Image Capture ..................................................................... 204
## Table of Contents

**Chapter 4** *Scanning* ................................................................. 223  
Introduction to Scanning ............................................................ 223  
Selecting a Scanner ................................................................. 224  
Optional Scanning Configurations .............................................. 225  
  Scan Feeder Options ............................................................. 226  
  Manual Feed .............................................................. 226  
  Single Feed .......................................................... 227  
Automatic Enhancement ......................................................... 227  
  Enhancement Settings ...................................................... 227  
Auto OCR .............................................................. 227  
Resolution Settings ............................................................... 228  
Mode Settings .................................................................... 228  
Page Size Settings ............................................................... 229  
Source Setting .................................................................. 229  
Auto Rotation .................................................................... 230  
  Front Page Rotation ....................................................... 230  
  Back Page Rotation ....................................................... 230  
Scanner Driver Configuration ............................................... 231  
Scanning Documents .............................................................. 231  
Scanning Pages ...................................................................... 234  
  Inserting a Scanned Page before the Current Page .............. 235  
  Inserting a Scanned Page after the Current Page ............. 235  
  Appending a Scanned Page to a Document ...................... 235  
Integrating QuickScan Pro with AppXtender ......................... 236  
  Creating QuickScan Pro Export Profiles in Document Manager 236  
Exporting QuickScan Pro Documents to AppXtender ............ 237  
Creating Profiles in QuickScan Pro .................................... 238  
  Creating a Profile for Single-Document Processing .......... 238  
  Creating a Profile for Batch Processing ......................... 239  

**Chapter 5** *Retrieving Documents* ........................................... 241
Table of Contents

Introduction to Document Retrieval .......................................................... 241
What is a Query? .................................................................................. 242
Searching a Single Application ............................................................... 243
   Entering Index Values as Search Criteria ........................................... 245
      Query by Index ........................................................................... 246
      Pasting Index Values from the Document Index View .................. 246
     Wildcard Query ........................................................................... 246
      Expression Range Query ............................................................ 247
      List of Values Query .................................................................. 249
      Searching by ODMA Attributes ..................................................... 251
      Compound Queries ..................................................................... 253
      Compound Query Examples ......................................................... 254
      Entering Full-Text Values as Search Criteria ................................ 255
      Building Full-Text Search Expressions ........................................ 257
      Combination (Index and Full-Text) Queries .................................... 258
Searching Multiple Applications .............................................................. 259
   Creating a New Cross Application Query ........................................... 259
   Performing a Cross Application Query ............................................. 263
   Modifying a Cross Application Query ............................................... 266
Displaying Documents from the Result Set .............................................. 266
   Displaying AppXtender Documents ................................................. 267
Selecting a Document Display Mode ....................................................... 271
   What is Check In/Check Out Mode? ................................................ 272
   What is the Normal AppXtender Mode? .......................................... 272
   What is the Normal Document Display Mode? ................................ 273
   What is the Read-only Document Display Mode? ............................. 273
   What is the Check Out Document Display Mode? ............................. 273
   Opening a Document in Normal Document Display Mode ................. 274
   Opening a Document in Read-Only Mode ......................................... 274
   Opening a Document in Check Out Mode ......................................... 276
Displaying AppXtender Reports Mgmnt Reports ..................................... 278
   Requirements for Displaying AppXtender Reports Mgmnt Reports .... 278
   Searching for an AppXtender Reports Mgmnt Report ....................... 279
   AppXtender Reports Mgmnt Report Function Commands ................. 280
   Displaying the Document for Current AppXtender Reports Mgmnt Report Page .......................................................... 281
   Displaying the AppXtender Reports Mgmnt Report for the Current Document .......................................................... 282
Viewing Full-Text Search Results ........................................................... 282
Viewing Documents from Unknown Data Sources ................................. 284
Viewing Documents from a Volume ....................................................... 285
Document Text Searches ....................................................................... 286
   Text Search from the Document Display View .................................. 287
   Text Search from the Result Set ...................................................... 288
   Special Search Characters ................................................................ 289
Managing Queries ................................................................................ 290
   Saving a Query ............................................................................ 291
   Running a Query .......................................................................... 291
   Editing a Query ............................................................................ 292
   Making a Query Public or Private ................................................... 292
   Renaming a Saved Query ............................................................... 293
   Embedding an AppXtender Query in Another Application ................ 293
   Deleting a Query ......................................................................... 294

Chapter 6 Viewing Documents ................................................................. 295
Introduction to Viewing Documents ......................................................... 295
Selecting Pages to View within a Document .................................................. 295
Next, Previous, and Go To Page ........................................................................ 296
    Next Page .................................................................................................. 296
    Previous Page ......................................................................................... 297
    Go To Page ............................................................................................. 297
Viewing Thumbnails ......................................................................................... 297
Displaying the Thumbnail View ....................................................................... 298
Displaying Thumbnails ................................................................................... 298
    Displaying Thumbnails for a Displayed Document .................................... 298
    Displaying only Thumbnails ..................................................................... 299
Displaying a Page from the Thumbnail View .................................................... 299
Creating an AppXtender Document Shortcut .................................................. 299
Viewing Versions of a Page ............................................................................. 300
    Previous Version ................................................................................... 300
    Next Version ......................................................................................... 301
    Newest Version .................................................................................... 301
    Oldest Version ....................................................................................... 301
Viewing Subpages .......................................................................................... 301
Viewing Multiple Documents and Pages ......................................................... 302
    Cascade .................................................................................................. 302
    Tile .......................................................................................................... 303
Split View ..................................................................................................... 303
Displaying Documents in a Duplicate Window .................................................. 303
Page View Functions Available for Multiple Page Types .................................. 304
Using Sticky View ......................................................................................... 304
    Switching Sticky View Settings .............................................................. 305
Using Zoom ................................................................................................... 306
    Zoom In ................................................................................................. 307
    Zoom Out ............................................................................................... 308
    Zoom To Percent .................................................................................. 308
    Zoom Percent ....................................................................................... 308
Fit to Window ................................................................................................ 309
    Fit to Window Width ............................................................................ 309
    Fit to Window Height ........................................................................... 309
    Actual Size ............................................................................................ 310
Using Rotate .................................................................................................. 310
    Rotate Left .............................................................................................. 310
    Rotate Right ........................................................................................... 311
Using the Magnifier ....................................................................................... 311
Using Scale-to-Gray ...................................................................................... 312
Using Regions ............................................................................................... 313
    Enabling Select Mode ........................................................................... 313
    Drawing a Region .................................................................................. 314
    Magnifying a Region ............................................................................ 314
    Copying a Region to the Windows Clipboard ......................................... 316
    Clearing Regions .................................................................................. 317
Viewing Specific Page Types ......................................................................... 317
Viewing Image Pages ..................................................................................... 318
Viewing Text Pages ....................................................................................... 318
    Viewing Documents with Form Overlay ............................................... 318
      COLD/ERM Display as Image Only ................................................... 319
      Modifying the Form Overlay ................................................................ 319
    Title Locking on Text Pages ................................................................... 320
    Customizing Color Bar Settings for an Application ................................... 321
Viewing PDF Files ......................................................................................... 324
Viewing Foreign Files ..................................................................................... 324
    Configuring a Viewer for Foreign Files .................................................. 324
    Viewing Foreign Files with the AppXtender Web KeyView Viewer ............ 325
Chapter 7  Managing Documents .......................................................... 339

Adding Pages to Documents .................................................................. 340
Adding a Page by Scanning ...................................................................... 340
Adding a Page from the Windows Clipboard ........................................ 341
Adding a Page by Pasting ........................................................................ 341
Adding a Page in a Selected Format .......................................................... 342
Adding a Page by Inserting an Object ...................................................... 343
Create New Object .................................................................................. 345
Insert Object from File ........................................................................... 346
Adding a Page by Importing a File .......................................................... 346
Adding a Page by Dragging a File ............................................................ 347
Adding a Page from the Fax-in Queue ...................................................... 347
Replacing Pages ...................................................................................... 349
Reordering Pages ..................................................................................... 350
Page Versions .......................................................................................... 350

Modifying Document Indexes .................................................................. 350

Applying Digital Signatures ..................................................................... 351
Viewing Signature History ........................................................................ 351

Applying IRM Protection to ApplicationXtender Content ....................... 353
Specifying IRM Options ........................................................................... 354

Printing or Faxing Documents and Pages .............................................. 354
Printing or Faxing Documents .................................................................. 355
Printing or Faxing from the Result Set .................................................... 355
Printing or Faxing a Displayed Document ................................................. 357
Endorsing Printed or Faxed Pages ............................................................ 359
Printing or Faxing Pages .......................................................................... 359
Printing or Faxing a Region .................................................................... 361
Changing AppXtender Printer Fonts ........................................................ 361

E-Mailing Documents and Pages ............................................................... 362
E-Mailing from the Result Set .................................................................. 362
E-Mailing Displayed Documents ................................................................. 365
E-Mailing Document References ............................................................... 367
E-Mailing Pages ...................................................................................... 369

Exporting Documents and Pages ............................................................. 370
Exporting Displayed Documents .............................................................. 371
Exporting a Displayed Document to a File .............................................. 371
Exporting a Displayed Document to an XPS File ..................................... 374
Exporting OCR Output from a Displayed Document ............................... 374
Exporting Documents from the Result Set ................................................. 375
### Table of Contents

- Exporting a Document from the Result Set to an XPS File ........................................... 377
- Exporting Pages .................................................................................................................. 378
- Exporting a Page to a File .................................................................................................... 378
- Exporting a Page to an XPS File ........................................................................................ 380
- Exporting Page OCR Output ................................................................................................ 380
- Exporting to an Existing File Name .................................................................................. 381

- Moving or Copying Document Pages ............................................................................... 381
- Document and Page OCR .....................................................................................................
  - Processing a Document Using OCR .................................................................................. 382
  - Processing a Page Using OCR ........................................................................................ 384
  - Processing a Region Using OCR ...................................................................................... 386
  - Submitting Documents to an OCR Queue ........................................................................ 386

- OCR Indexing Documents .................................................................................................. 387

- Submitting Documents to a Full-text Queue ...................................................................... 387
  - Submitting from the Result Set ....................................................................................... 388
  - Submitting a Displayed Document .................................................................................. 389

- Submitting Documents/Reports to BI Gateway ................................................................. 390

- Submitting Documents to ApplicationXtender Workflow Manager .................................... 393

- Converting Subpages to Pages ........................................................................................... 393

- AppXtender Document Properties .................................................................................... 394

- Saving the Result Set as a Text File ..................................................................................... 396

- Checking in and Canceling Changes .................................................................................. 397

- Checking in a Document in AppXtender ............................................................................ 398

- Canceling the Check Out of a Document .......................................................................... 399

- Deleting Documents, Pages, Versions, and Batches ............................................................ 399
  - Deleting Versions .............................................................................................................. 400
  - Purging Versions .............................................................................................................. 400
  - Deleting Pages ................................................................................................................ 400
    - Deleting a Page from the Document Display View ......................................................... 401
    - Deleting Pages from Thumbnail View ............................................................................ 401
  - Cutting Pages .................................................................................................................. 402
  - Deleting Documents ........................................................................................................ 402
    - Deleting Documents from a Result Set ......................................................................... 403
    - Deleting Displayed Documents ..................................................................................... 403
    - Deleting Batches .......................................................................................................... 403

### Chapter 8 Using ODMA With AppXtender Documents ...................................................... 405

- Introduction to ODMA ......................................................................................................... 405

- AppXtender ODMA Support ............................................................................................... 406

- Configuring ODMA Support in AppXtender ..................................................................... 407

- Creating New AppXtender Documents through ODMA .................................................... 409
  - Opening Non-AppXtender Documents with ODMA ....................................................... 410
  - Saving New ODMA Documents to AppXtender ............................................................. 411
  - Reason Code Required Dialog Box .................................................................................. 413
  - Logging into AppXtender in an ODMA-compliant Application ...................................... 414

- Entering AppXtender Document Properties ..................................................................... 414
  - Viewing General Information about an AppXtender Document ..................................... 414
  - AppXtender Document Properties: the General Tab ...................................................... 415
  - Viewing Summary Information about an AppXtender Document .................................... 416
  - AppXtender Document Properties: the Summary Tab ................................................... 416
  - AX Document Properties: the Index Tab ......................................................................... 417
  - Viewing Revision History Information for an AppXtender Document ............................. 418
### Table of Contents

<table>
<thead>
<tr>
<th>Chapter 9 Annotations</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Annotations</td>
<td>443</td>
</tr>
<tr>
<td>Annotation Types</td>
<td>445</td>
</tr>
<tr>
<td>Saving Annotations</td>
<td>445</td>
</tr>
<tr>
<td>Creating Line and Shape Annotations</td>
<td>445</td>
</tr>
<tr>
<td>Configuring Annotation Settings</td>
<td>446</td>
</tr>
<tr>
<td>Default Line Width</td>
<td>446</td>
</tr>
<tr>
<td>Default Color for Line and Shape Annotations</td>
<td>447</td>
</tr>
<tr>
<td>Default Color for Highlight Annotations</td>
<td>447</td>
</tr>
<tr>
<td>Default Filled or Hollow Setting</td>
<td>448</td>
</tr>
<tr>
<td>Default Redaction Setting</td>
<td>448</td>
</tr>
<tr>
<td>Interaction between Redactions and OCR/Full-text</td>
<td>449</td>
</tr>
<tr>
<td>Creating a Line or Shape Annotation</td>
<td>449</td>
</tr>
<tr>
<td>Creating a Line Annotation</td>
<td>450</td>
</tr>
<tr>
<td>Creating a Basic Line Annotation</td>
<td>450</td>
</tr>
<tr>
<td>Creating a Polyline Annotation</td>
<td>451</td>
</tr>
<tr>
<td>Creating a Shape Annotation</td>
<td>452</td>
</tr>
<tr>
<td>Creating a Basic Shape Annotation</td>
<td>452</td>
</tr>
<tr>
<td>Creating a Polygon Annotation</td>
<td>453</td>
</tr>
<tr>
<td>Creating a Highlight Annotation</td>
<td>453</td>
</tr>
<tr>
<td>Creating Text Annotations</td>
<td>454</td>
</tr>
<tr>
<td>Using the Annotation Text Editor</td>
<td>454</td>
</tr>
<tr>
<td>Using the In-place Text Editor</td>
<td>456</td>
</tr>
</tbody>
</table>
Working with Rubber Stamp Annotations .......................................................... 457
Creating a New Text Rubber Stamp Annotation ........................................... 458
  Changing the Font of a Rubber Stamp ........................................................... 460
Creating a Text Rubber Stamp Annotation from an Existing File .............. 462
Creating an Image Rubber Stamp Annotation from an Existing File ......... 464
Adding Rubber Stamp Annotations to Pages .............................................. 464
  Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps .................................................. 465
  Adding a Rubber Stamp from the Select Rubber Stamp Dialog Box ........ 466
  Applying a Rubber Stamp with the Rubber Stamp Shortcut Key ............... 467
Overlapping Annotations ............................................................................ 467
Assigning an Annotation to an Annotation Group ....................................... 468
Assigning a Default Annotation Group .......................................................... 468
Showing or Hiding Annotations .................................................................. 469
  Hiding Annotations When Viewing Documents ........................................ 470
  Hiding Annotations by Annotation Group ................................................... 470
  Hiding Annotations When Printing ............................................................ 471
  Hiding Annotations When E-mailing ............................................................ 472
    Hiding Annotations When E-mailing Documents .................................... 473
    Hiding Annotations When E-mailing Pages ............................................. 474
  Hiding Annotations When Exporting .......................................................... 474
    Hiding Annotations When Exporting Documents .................................... 474
    Hiding Annotations When Exporting Pages ........................................... 475
Modifying Annotation Settings ................................................................... 476
  Selecting Annotations ................................................................................ 476
  Moving Annotations .................................................................................. 477
  Resizing an Annotation ............................................................................... 478
  Modifying Shape Annotations ................................................................... 478
  Modifying Text Annotations ....................................................................... 480
    Changing the Properties of a Text Annotation ....................................... 480
      Modifying Annotation Text ................................................................ 482
    Editing Text Rubber Stamp Annotations ............................................... 482
Printing Text Annotations ........................................................................... 484
Removing Annotations ............................................................................... 485
Erasing Annotations .................................................................................... 485
Deleting Annotations .................................................................................... 486

Chapter 10  Image Enhancement ................................................................. 487
  Introduction to Image Enhancement ............................................................ 487
  Enhancing an Image .................................................................................. 487
Configuring Image Enhancement ................................................................. 488
Performing Advanced Image Enhancement ................................................ 490
  Using Advanced Deskew ........................................................................... 490
    Minimum Detect Length ....................................................................... 493
    Maximum Acceptable Skew ................................................................ 493
  Character Protection .................................................................................. 494
  Using Advanced Registration .................................................................... 494
    Horizontal/Vertical Registration .............................................................. 496
      Central Focus ...................................................................................... 497
      Add Only .............................................................................................. 497
      Ignore Holes ....................................................................................... 497
      Resultant Left/Top Margin .................................................................. 497
      Find Line for Register ........................................................................ 497
  Advanced Registration Settings ................................................................. 497
Line Gap ....................................................................................................... 498
Appendix

Working Overview

Retention

Extending Hold
Documents

Retention for Manager

AppXtender to Dot Shading

Speck Removal

Using Advanced Line Smoothing

Characters

Advanced Correction

Inverse Text Crop

Manual Using Image an

Resizing

Using Advanced Sub Image

Using Multiple Filing

Retention Documents

Result Query

Retention for View

from Set Applications

Retention Display

Retention Documents the for Extending Retention

Retention a for Document Display from View....................

Retention Query Result Period

from View Extending Document from Period Retention

Removing Holds

Retention Changing Labels

Retention Area Width

Area Minimum Height

Horizontal Adjust Size

Size Vertical Maximum Size

Horizontal De-Speck

De-Speck Vertical Line Minimum Line Thickness

Maximum Line Gap

Line Cleaning

Edge Repair Characters...

Top Bottom Edge Right

Set...................... Retention Query Applying from the Hold Retention View Applying Display a Retention Set of Documents Retention Result View from a Retention Display Extending a Retention Period

Extending the Retention Period from Document Display View

Extending the Retention Period from the Query View Result Set

Extending the Retention Period for Multiple Documents

Processing Documents for Retention Hold

Applying Retention Holds

Applying a Retention Hold from Document Display View

Applying a Retention Hold from the Query View Result Set

Removing Retention Holds

Removing a Retention Hold from Document Display View

Removing a Retention Hold from the Query View Result Set

Removing a Retention Hold from a Set of Documents

Changing Retention Hold Labels

Appendix A Working with Document Retention ........................................................ 529

Overview .......................................................... 529

Retention Concepts .............................................. 529

Identifying Retention Applications .............................. 530

Filing Documents for Retention ...................................... 531

Filing a Document for Retention from Document Display View .......................... 531

Filing a Document for Retention from the Query View Result Set ......................... 532

Filing Multiple Documents for Retention .................................................. 533

Extending a Retention Period ........................................ 535

Extending the Retention Period from Document Display View .......................... 535

Extending the Retention Period from the Query View Result Set ......................... 536

Extending the Retention Period for Multiple Documents .................................. 538

Processing Documents for Retention Hold ................................................. 539

Applying Retention Holds ........................................... 539

Applying a Retention Hold from Document Display View .......................... 539

Applying a Retention Hold from the Query View Result Set ......................... 540

Removing Retention Holds ........................................... 541

Removing a Retention Hold from Document Display View .......................... 541

Removing a Retention Hold from the Query View Result Set ......................... 542

Removing a Retention Hold from a Set of Documents .................................. 542

Changing Retention Hold Labels ........................................... 544

Appendix B Working with Records Manager for AppXtender .................................. 547

Introduction to Records Manager for AppXtender ........................................... 547
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>RM for AppXtender Concepts</td>
<td>548</td>
</tr>
<tr>
<td>Filing Systems and File Plans</td>
<td>549</td>
</tr>
<tr>
<td>Records Management</td>
<td>549</td>
</tr>
<tr>
<td>Retention Administration</td>
<td>550</td>
</tr>
<tr>
<td>Identifying RM for AppXtender Applications in AppXtender</td>
<td>550</td>
</tr>
<tr>
<td>Transferring AppXtender Documents for Records Management</td>
<td>552</td>
</tr>
<tr>
<td>Filing AppXtender Documents for Retention Administration</td>
<td>554</td>
</tr>
<tr>
<td>Working With AppXtender Documents That Are Filed for Retention</td>
<td>557</td>
</tr>
<tr>
<td>Glossary</td>
<td>559</td>
</tr>
</tbody>
</table>
List of Figures

Figure 1. Content Organization in AppXtender ................................................................. 30
Figure 2. Example of a Document Index ........................................................................... 34
Figure 3. Masked Index Field .......................................................................................... 47
Figure 4. AppXtender Data Source Selector Dialog Box ............................................... 51
Figure 5. Data Link Properties Dialog Box - Provider Tab .............................................. 52
Figure 6. Data Link Properties Dialog Box - Connection Tab ......................................... 53
Figure 7. AppXtender Data Source Selector Dialog Box ............................................... 54
Figure 8. Icon Indicating Default Data Source .............................................................. 55
Figure 9. AppXtender Document Manager Login Dialog Box ....................................... 57
Figure 10. Application View with AppXtender Data Source Expanded ......................... 61
Figure 11. Multiple Views Open on AppXtender Desktop ............................................. 63
Figure 12. Application View ......................................................................................... 64
Figure 13. AppXtender Data Source Icons Showing Login State .................................. 64
Figure 14. Data Source Node Expanded ......................................................................... 65
Figure 15. Application Node Expanded ........................................................................... 65
Figure 16. Application Node Closed ............................................................................... 65
Figure 17. Data Source Node Closed ............................................................................. 65
Figure 18. Query View: Search Tab ................................................................................ 67
Figure 19. Query View: Result Set Tab .......................................................................... 68
Figure 20. New Query Listed Under Application in Application View ......................... 69
Figure 21. Document Display View ................................................................................ 70
Figure 22. Pan Mode Button ......................................................................................... 71
Figure 23. Index View and Document Display View ....................................................... 71
Figure 24. Index View Button ....................................................................................... 72
Figure 25. Thumbnail View ............................................................................................ 73
Figure 26. AppXtender Document Manager Main Toolbar .......................................... 75
Figure 27. AppXtender Annotation Toolbar ................................................................... 77
Figure 28. AppXtender Document Manager Image Toolbar ......................................... 79
Figure 29. AppXtender Document Manager Script Toolbar .......................................... 81
Figure 30. AppXtender Document Manager Batch Index Toolbar ................................ 81
Figure 31. AppXtender Scan Toolbar ............................................................................ 82
Figure 32. Change Password Dialog Box ...................................................................... 86
Figure 33. Displaying Toolbars ..................................................................................... 89
Figure 34. Customize Toolbar Dialog Box ..................................................................... 90
Figure 35. Properties Dialog Box: Title Tab ................................................................... 91
Figure 36. Print Setup Dialog Box ................................................................................ 93
Figure 37. Saved Settings Menu .................................................................................... 94
Figure 38. Saved Settings Menu with Selected Saved Settings View ........................................ 95
Figure 39. AppXtender Document Manager Docked View Grab Bar ...................................... 95
Figure 40. AppXtender Document Manager Desktop with Docked Views .............................. 96
Figure 41. AppXtender Document Manager Dialog Box Title Bar ........................................ 97
Figure 42. AppXtender Document Manager Desktop with Query View as Dialog Box .......... 97
Figure 43. AppXtender Document Manager Subwindow Title Bar ....................................... 97
Figure 44. AppXtender Document Manager Desktop with Query View as Subwindow ......... 98
Figure 45. Displaying Names in the Result Set ..................................................................... 100
Figure 46. Displaying Details in the Result Set ..................................................................... 100
Figure 47. Displaying Folders in the Result Set ..................................................................... 100
Figure 48. List Column Editor Dialog Box .......................................................................... 101
Figure 49. Configuration Dialog Box: View Tab ................................................................... 104
Figure 50. Configuration Dialog Box: Display Tab ................................................................. 109
Figure 51. Configuration Dialog Box: Fonts Tab .................................................................. 112
Figure 52. Configuration Dialog Box: Scan Tab .................................................................... 116
Figure 53. Configuration Dialog Box: Scan Tab: Removing Blank Pages ......................... 117
Figure 54. Save AppXtender Document Manager Settings Dialog Box ............................... 151
Figure 55. Load AppXtender Document Manager Settings Dialog Box ............................... 160
Figure 56. Reason Code Required Dialog Box ..................................................................... 174
Figure 57. Signature Properties Dialog Box .......................................................................... 174
Figure 58. Paste Special Dialog Box ..................................................................................... 175
Figure 59. Reason Code Required Dialog Box ..................................................................... 176
Figure 60. Signature Properties Dialog Box .......................................................................... 176
Figure 61. Insert Object Dialog Box ...................................................................................... 177
Figure 62. Reason Code Required Dialog Box ..................................................................... 178
Figure 63. Signature Properties Dialog Box .......................................................................... 179
Figure 64. Object Edited in AppXtender .............................................................................. 179
Figure 65. Insert Object Dialog Box ...................................................................................... 180
Figure 66. Reason Code Required Dialog Box ..................................................................... 181
Figure 67. Signature Properties Dialog Box .......................................................................... 181
Figure 68. Import File Dialog Box ......................................................................................... 183
Figure 69. Reason Code Required Dialog Box ..................................................................... 183
Figure 70. Signature Properties Dialog Box .......................................................................... 184
Figure 71. Unsupported Foreign File Type Import ................................................................. 185
Figure 72. Reason Code Required Dialog Box ..................................................................... 186
Figure 73. Signature Properties Dialog Box .......................................................................... 186
Figure 74. Reason Code Required Dialog Box ..................................................................... 188
Figure 75. Signature Properties Dialog Box .......................................................................... 188
Figure 76. Login to Fax Server Dialog boxes ......................................................................... 189
Figure 77. FAX Server Import Dialog Box ............................................................................ 190
Figure 78. Reason Code Required Dialog Box ..................................................................... 191
Figure 79. Signature Properties Dialog Box .......................................................................... 191
Figure 80. Select Batch Import File Dialog boxes ................................................................. 199
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>81</td>
<td>Batch Import Status Dialog Box</td>
<td>199</td>
</tr>
<tr>
<td>82</td>
<td>Select Files for Batch Import Dialog Box</td>
<td>201</td>
</tr>
<tr>
<td>83</td>
<td>Login to Fax Server Dialog Box</td>
<td>202</td>
</tr>
<tr>
<td>84</td>
<td>Select Faxes for Batch Import Dialog Box</td>
<td>203</td>
</tr>
<tr>
<td>85</td>
<td>Batch Import Status Dialog Box</td>
<td>204</td>
</tr>
<tr>
<td>86</td>
<td>Batch Index (Single) Dialog Box</td>
<td>213</td>
</tr>
<tr>
<td>87</td>
<td>Reason Code Required Dialog Box</td>
<td>214</td>
</tr>
<tr>
<td>88</td>
<td>Signature Properties Dialog Box</td>
<td>215</td>
</tr>
<tr>
<td>89</td>
<td>Batch Index (List) Dialog Box</td>
<td>216</td>
</tr>
<tr>
<td>90</td>
<td>Reason Code Required Dialog Box</td>
<td>217</td>
</tr>
<tr>
<td>91</td>
<td>Signature Properties Dialog Box</td>
<td>217</td>
</tr>
<tr>
<td>92</td>
<td>Memo Dialog Box</td>
<td>218</td>
</tr>
<tr>
<td>93</td>
<td>Submit Full-text Index Job Dialog Box</td>
<td>220</td>
</tr>
<tr>
<td>94</td>
<td>Select Scanner Dialog Box</td>
<td>225</td>
</tr>
<tr>
<td>95</td>
<td>Front Rotation Button and Back Rotation Button</td>
<td>230</td>
</tr>
<tr>
<td>96</td>
<td>Sample Scanner Settings Dialog Box</td>
<td>231</td>
</tr>
<tr>
<td>97</td>
<td>Reason Code Required Dialog Box</td>
<td>232</td>
</tr>
<tr>
<td>98</td>
<td>Signature Properties Dialog Box</td>
<td>233</td>
</tr>
<tr>
<td>99</td>
<td>Index View: Indexing a New Scanned Document</td>
<td>234</td>
</tr>
<tr>
<td>100</td>
<td>Select Applications Dialog Box</td>
<td>237</td>
</tr>
<tr>
<td>101</td>
<td>New Query Search Tab</td>
<td>242</td>
</tr>
<tr>
<td>102</td>
<td>New Query Search Tab</td>
<td>243</td>
</tr>
<tr>
<td>103</td>
<td>Result Set Tab</td>
<td>245</td>
</tr>
<tr>
<td>104</td>
<td>Search Expression Dialog Box</td>
<td>248</td>
</tr>
<tr>
<td>105</td>
<td>Search with Expression</td>
<td>248</td>
</tr>
<tr>
<td>106</td>
<td>List of Values Dialog Box</td>
<td>250</td>
</tr>
<tr>
<td>107</td>
<td>Search with List</td>
<td>251</td>
</tr>
<tr>
<td>108</td>
<td>Searching by ODMA Attributes</td>
<td>252</td>
</tr>
<tr>
<td>109</td>
<td>Add Column Shortcut Menu</td>
<td>253</td>
</tr>
<tr>
<td>110</td>
<td>Query View Search Tab with Compound Query</td>
<td>254</td>
</tr>
<tr>
<td>111</td>
<td>Query View Search Tab with Full-Text Search Portion Indicated</td>
<td>256</td>
</tr>
<tr>
<td>112</td>
<td>New Cross Application Query Configuration Tab</td>
<td>260</td>
</tr>
<tr>
<td>113</td>
<td>New Cross Application Query with Applications Added</td>
<td>261</td>
</tr>
<tr>
<td>114</td>
<td>New Cross Application Query Configuration: Designating Query Fields</td>
<td>262</td>
</tr>
<tr>
<td>115</td>
<td>Cross App Query: Application Display View</td>
<td>263</td>
</tr>
<tr>
<td>116</td>
<td>Icons for Regular Query and Cross App Query</td>
<td>264</td>
</tr>
<tr>
<td>117</td>
<td>Cross Application Query Search Tab</td>
<td>264</td>
</tr>
<tr>
<td>118</td>
<td>Cross Application Query Result Set Tab</td>
<td>265</td>
</tr>
<tr>
<td>119</td>
<td>Result Set Tab</td>
<td>267</td>
</tr>
<tr>
<td>120</td>
<td>Query View Result Set Tab</td>
<td>269</td>
</tr>
<tr>
<td>121</td>
<td>Reason Code Required Dialog Box</td>
<td>270</td>
</tr>
<tr>
<td>122</td>
<td>Check Out Dialog Box (Check in/Check out Mode)</td>
<td>275</td>
</tr>
<tr>
<td>123</td>
<td>Check Out Dialog Box (Normal Document Display Mode)</td>
<td>277</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>124</td>
<td>Check Out Dialog Box (Check in/Check out Mode)</td>
<td>277</td>
</tr>
<tr>
<td>125</td>
<td>AppXtender Application Shortcut Menu</td>
<td>279</td>
</tr>
<tr>
<td>126</td>
<td>Query View: Query Reports Search Tab</td>
<td>279</td>
</tr>
<tr>
<td>127</td>
<td>Query View Result Set with Full-Text Hits</td>
<td>282</td>
</tr>
<tr>
<td>128</td>
<td>Full-Text Search Results Dialog Box</td>
<td>283</td>
</tr>
<tr>
<td>129</td>
<td>Pick a Data Source Dialog Box</td>
<td>285</td>
</tr>
<tr>
<td>130</td>
<td>Volume Label Search Drives Dialog Box</td>
<td>286</td>
</tr>
<tr>
<td>131</td>
<td>Find Text Search Dialog Box</td>
<td>287</td>
</tr>
<tr>
<td>132</td>
<td>Result Set Text Search Dialog Box</td>
<td>288</td>
</tr>
<tr>
<td>133</td>
<td>Text Search Result Tab</td>
<td>289</td>
</tr>
<tr>
<td>134</td>
<td>Save Query Dialog Box</td>
<td>291</td>
</tr>
<tr>
<td>135</td>
<td>Public and Private Queries</td>
<td>292</td>
</tr>
<tr>
<td>136</td>
<td>Expanded Application Node</td>
<td>293</td>
</tr>
<tr>
<td>137</td>
<td>Go To Dialog Box</td>
<td>297</td>
</tr>
<tr>
<td>138</td>
<td>Page Version in Status Bar</td>
<td>300</td>
</tr>
<tr>
<td>139</td>
<td>Switch View Menu</td>
<td>305</td>
</tr>
<tr>
<td>140</td>
<td>Switch View Menu with the Selected View</td>
<td>306</td>
</tr>
<tr>
<td>141</td>
<td>Next Sticky View Button</td>
<td>306</td>
</tr>
<tr>
<td>142</td>
<td>Sticky View Menu</td>
<td>306</td>
</tr>
<tr>
<td>143</td>
<td>Zoom Percent Dialog Box</td>
<td>309</td>
</tr>
<tr>
<td>144</td>
<td>Magnifier Dialog Box</td>
<td>311</td>
</tr>
<tr>
<td>145</td>
<td>Document Display View with Magnified Area</td>
<td>312</td>
</tr>
<tr>
<td>146</td>
<td>Pan Mode Button</td>
<td>314</td>
</tr>
<tr>
<td>147</td>
<td>Page Region with Shortcut Menu</td>
<td>315</td>
</tr>
<tr>
<td>148</td>
<td>Magnify Window</td>
<td>315</td>
</tr>
<tr>
<td>149</td>
<td>Application Properties Dialog Box: COLD Tab</td>
<td>322</td>
</tr>
<tr>
<td>150</td>
<td>Application Properties Dialog Box: COLD Tab</td>
<td>323</td>
</tr>
<tr>
<td>151</td>
<td>Foreign File in Source Application</td>
<td>326</td>
</tr>
<tr>
<td>152</td>
<td>Update Foreign File Dialog Box</td>
<td>327</td>
</tr>
<tr>
<td>153</td>
<td>AppXtender View Control Properties: General Tab</td>
<td>330</td>
</tr>
<tr>
<td>154</td>
<td>AppXtender View Control Properties: Image Tab</td>
<td>332</td>
</tr>
<tr>
<td>155</td>
<td>AppXtender View Control Properties: Text Tab</td>
<td>334</td>
</tr>
<tr>
<td>156</td>
<td>Information Tab</td>
<td>336</td>
</tr>
<tr>
<td>157</td>
<td>Image Information Dialog Box: Files Tab</td>
<td>337</td>
</tr>
<tr>
<td>158</td>
<td>Paste Special Dialog Box</td>
<td>342</td>
</tr>
<tr>
<td>159</td>
<td>Insert Object Dialog Box</td>
<td>344</td>
</tr>
<tr>
<td>160</td>
<td>Insert Object Dialog Box</td>
<td>345</td>
</tr>
<tr>
<td>161</td>
<td>Import File Dialog Box</td>
<td>346</td>
</tr>
<tr>
<td>162</td>
<td>Login to Fax Server Dialog Box</td>
<td>348</td>
</tr>
<tr>
<td>163</td>
<td>FAX Server Import Dialog Box</td>
<td>348</td>
</tr>
<tr>
<td>164</td>
<td>Replace Page Confirmation Message</td>
<td>349</td>
</tr>
<tr>
<td>165</td>
<td>Index View</td>
<td>351</td>
</tr>
<tr>
<td>166</td>
<td>Page Security Invalid Icon</td>
<td>351</td>
</tr>
<tr>
<td>Figure 167.</td>
<td>Signature Properties Dialog Box</td>
<td>352</td>
</tr>
<tr>
<td>Figure 168.</td>
<td>Signing Data with Key Dialog Box</td>
<td>352</td>
</tr>
<tr>
<td>Figure 169.</td>
<td>Signature History Dialog Box</td>
<td>353</td>
</tr>
<tr>
<td>Figure 170.</td>
<td>Reason Code Required Dialog Box</td>
<td>356</td>
</tr>
<tr>
<td>Figure 171.</td>
<td>Print Dialog Box</td>
<td>356</td>
</tr>
<tr>
<td>Figure 172.</td>
<td>Print Dialog Box</td>
<td>358</td>
</tr>
<tr>
<td>Figure 173.</td>
<td>Print Dialog Box</td>
<td>360</td>
</tr>
<tr>
<td>Figure 174.</td>
<td>E-mail Document Pages Dialog Box</td>
<td>363</td>
</tr>
<tr>
<td>Figure 175.</td>
<td>Mail Message with AppXtender Document Attachments</td>
<td>364</td>
</tr>
<tr>
<td>Figure 176.</td>
<td>E-mail Document Pages Dialog Box</td>
<td>366</td>
</tr>
<tr>
<td>Figure 177.</td>
<td>Mail Message with AppXtender Document Attachments</td>
<td>367</td>
</tr>
<tr>
<td>Figure 178.</td>
<td>Mail Message with AppXtender Document Reference Attachment</td>
<td>368</td>
</tr>
<tr>
<td>Figure 179.</td>
<td>E-mail Page dialog box</td>
<td>369</td>
</tr>
<tr>
<td>Figure 180.</td>
<td>Mail Message with AppXtender Page Attachment</td>
<td>370</td>
</tr>
<tr>
<td>Figure 181.</td>
<td>Export Document Pages Dialog Box</td>
<td>372</td>
</tr>
<tr>
<td>Figure 182.</td>
<td>Windows Explorer with Sample Exported Document</td>
<td>373</td>
</tr>
<tr>
<td>Figure 183.</td>
<td>OCR Export Document Pages Dialog Box</td>
<td>375</td>
</tr>
<tr>
<td>Figure 184.</td>
<td>Export COLD Document Page(s) Dialog Box</td>
<td>376</td>
</tr>
<tr>
<td>Figure 185.</td>
<td>Reason Code Required Dialog Box</td>
<td>377</td>
</tr>
<tr>
<td>Figure 186.</td>
<td>Windows Explorer with Sample Exported Document</td>
<td>377</td>
</tr>
<tr>
<td>Figure 187.</td>
<td>Export Page Dialog Box</td>
<td>379</td>
</tr>
<tr>
<td>Figure 188.</td>
<td>OCR Export Page Dialog Box</td>
<td>380</td>
</tr>
<tr>
<td>Figure 189.</td>
<td>OCR Processing Window</td>
<td>383</td>
</tr>
<tr>
<td>Figure 190.</td>
<td>Text View of AppXtender Document After OCR</td>
<td>384</td>
</tr>
<tr>
<td>Figure 191.</td>
<td>OCR Processing Window</td>
<td>385</td>
</tr>
<tr>
<td>Figure 192.</td>
<td>Text View of Document Page After OCR</td>
<td>385</td>
</tr>
<tr>
<td>Figure 193.</td>
<td>Submit OCR Job Dialog Box</td>
<td>387</td>
</tr>
<tr>
<td>Figure 194.</td>
<td>Submit Full-text Index Job Dialog Box</td>
<td>388</td>
</tr>
<tr>
<td>Figure 195.</td>
<td>Submit Full-text Index Job Dialog Box</td>
<td>389</td>
</tr>
<tr>
<td>Figure 196.</td>
<td>Sample ERMX.INI File</td>
<td>391</td>
</tr>
<tr>
<td>Figure 197.</td>
<td>AppXtender Configuration Dialog Box - Paths Tab</td>
<td>392</td>
</tr>
<tr>
<td>Figure 198.</td>
<td>History Detail Dialog Box</td>
<td>396</td>
</tr>
<tr>
<td>Figure 199.</td>
<td>Save As Dialog Box for Saving the Result Set</td>
<td>397</td>
</tr>
<tr>
<td>Figure 200.</td>
<td>Configuration Dialog Box: Data Tab</td>
<td>408</td>
</tr>
<tr>
<td>Figure 201.</td>
<td>Open AppXtender Document Dialog Box: Application Tab</td>
<td>410</td>
</tr>
<tr>
<td>Figure 202.</td>
<td>Open Dialog Box</td>
<td>411</td>
</tr>
<tr>
<td>Figure 203.</td>
<td>Reason Code Required Dialog Box</td>
<td>412</td>
</tr>
<tr>
<td>Figure 204.</td>
<td>Signature Properties Dialog Box</td>
<td>413</td>
</tr>
<tr>
<td>Figure 205.</td>
<td>Open AppXtender Document Dialog Box: Application Tab</td>
<td>420</td>
</tr>
<tr>
<td>Figure 206.</td>
<td>Open AppXtender Document Dialog Box: Search Tab</td>
<td>421</td>
</tr>
<tr>
<td>Figure 207.</td>
<td>Open AX Document Dialog Box: Result Set Tab</td>
<td>423</td>
</tr>
<tr>
<td>Figure 208.</td>
<td>Reason Code Required Dialog Box</td>
<td>424</td>
</tr>
<tr>
<td>Figure 209.</td>
<td>AppXtender Message Box</td>
<td>430</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>210.</td>
<td>Open Dialog Box</td>
<td>442</td>
</tr>
<tr>
<td>211.</td>
<td>AppXtender Page With Annotations</td>
<td>444</td>
</tr>
<tr>
<td>212.</td>
<td>Color Drop-Down Box</td>
<td>447</td>
</tr>
<tr>
<td>213.</td>
<td>Annotation Text Editor Dialog Box</td>
<td>455</td>
</tr>
<tr>
<td>214.</td>
<td>Annotation Text Editor Dialog Box: Advanced Options</td>
<td>456</td>
</tr>
<tr>
<td>215.</td>
<td>In-place Text Editor</td>
<td>457</td>
</tr>
<tr>
<td>216.</td>
<td>New Text Rubber Stamp Dialog Box</td>
<td>458</td>
</tr>
<tr>
<td>217.</td>
<td>Font Dialog Box for Rubber Stamps</td>
<td>461</td>
</tr>
<tr>
<td>218.</td>
<td>Sample Text Rubber Stamp XML Text File</td>
<td>462</td>
</tr>
<tr>
<td>219.</td>
<td>Import File Dialog Box</td>
<td>462</td>
</tr>
<tr>
<td>220.</td>
<td>Imported Rubber Stamp with Index View</td>
<td>463</td>
</tr>
<tr>
<td>221.</td>
<td>Rubber Stamp Annotation Button</td>
<td>465</td>
</tr>
<tr>
<td>222.</td>
<td>Rubber Stamp Annotation Drop-Down Menu</td>
<td>465</td>
</tr>
<tr>
<td>223.</td>
<td>Cursor in Rubber Stamp Mode</td>
<td>465</td>
</tr>
<tr>
<td>224.</td>
<td>Select Rubber Stamp Dialog Box</td>
<td>466</td>
</tr>
<tr>
<td>225.</td>
<td>Cursor in Rubber Stamp Mode</td>
<td>466</td>
</tr>
<tr>
<td>226.</td>
<td>Select the Default Annotation Group Dialog Box</td>
<td>469</td>
</tr>
<tr>
<td>227.</td>
<td>Show/hide Annotation Groups Dialog Box</td>
<td>471</td>
</tr>
<tr>
<td>228.</td>
<td>Print Dialog Box</td>
<td>472</td>
</tr>
<tr>
<td>229.</td>
<td>Email Document Pages Dialog Box</td>
<td>473</td>
</tr>
<tr>
<td>230.</td>
<td>Export Document Pages Dialog Box</td>
<td>475</td>
</tr>
<tr>
<td>231.</td>
<td>Selected and Unselected Annotations</td>
<td>477</td>
</tr>
<tr>
<td>232.</td>
<td>Annotation Properties Dialog Box</td>
<td>479</td>
</tr>
<tr>
<td>233.</td>
<td>Annotation Text Editor Dialog Box</td>
<td>480</td>
</tr>
<tr>
<td>234.</td>
<td>Annotation Text Editor Dialog Box: Advanced Options</td>
<td>481</td>
</tr>
<tr>
<td>235.</td>
<td>Query View Search Tab</td>
<td>483</td>
</tr>
<tr>
<td>236.</td>
<td>Query View Result Set Tab</td>
<td>483</td>
</tr>
<tr>
<td>237.</td>
<td>Edit Text Rubber Stamp Dialog Box with Rubber Stamp Contents</td>
<td>484</td>
</tr>
<tr>
<td>238.</td>
<td>Annotation Toolbar Eraser Button</td>
<td>485</td>
</tr>
<tr>
<td>239.</td>
<td>Image Enhancement Dialog Box</td>
<td>488</td>
</tr>
<tr>
<td>240.</td>
<td>ScanFix Configuration Dialog Box</td>
<td>489</td>
</tr>
<tr>
<td>241.</td>
<td>Before Using Deskew</td>
<td>491</td>
</tr>
<tr>
<td>242.</td>
<td>Deskew Tab</td>
<td>492</td>
</tr>
<tr>
<td>243.</td>
<td>After Using Deskew</td>
<td>493</td>
</tr>
<tr>
<td>244.</td>
<td>Before Using Registration</td>
<td>494</td>
</tr>
<tr>
<td>245.</td>
<td>Registration Tab</td>
<td>495</td>
</tr>
<tr>
<td>246.</td>
<td>After Using Registration</td>
<td>496</td>
</tr>
<tr>
<td>247.</td>
<td>Before Using Dot Shading Removal</td>
<td>499</td>
</tr>
<tr>
<td>248.</td>
<td>Noise Removal Tab</td>
<td>500</td>
</tr>
<tr>
<td>249.</td>
<td>After Using Dot Shading Removal</td>
<td>501</td>
</tr>
<tr>
<td>250.</td>
<td>Before Using De-Speck</td>
<td>503</td>
</tr>
<tr>
<td>251.</td>
<td>Noise Removal Tab</td>
<td>504</td>
</tr>
<tr>
<td>252.</td>
<td>After Using De-Speck</td>
<td>505</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Figure 253</td>
<td>Before Using Vertical Line Removal</td>
<td>507</td>
</tr>
<tr>
<td>Figure 254</td>
<td>Line Removal Tab</td>
<td>508</td>
</tr>
<tr>
<td>Figure 255</td>
<td>After Using Vertical Line Removal</td>
<td>509</td>
</tr>
<tr>
<td>Figure 256</td>
<td>Before Using Inverse Text Correction</td>
<td>511</td>
</tr>
<tr>
<td>Figure 257</td>
<td>Inverse Text Tab</td>
<td>511</td>
</tr>
<tr>
<td>Figure 258</td>
<td>After Using Inverse Text Correction</td>
<td>513</td>
</tr>
<tr>
<td>Figure 259</td>
<td>Before Smoothing Characters</td>
<td>514</td>
</tr>
<tr>
<td>Figure 260</td>
<td>Smooth Tab</td>
<td>514</td>
</tr>
<tr>
<td>Figure 261</td>
<td>After Smoothing Characters</td>
<td>516</td>
</tr>
<tr>
<td>Figure 262</td>
<td>Before Using Manual Crop</td>
<td>517</td>
</tr>
<tr>
<td>Figure 263</td>
<td>Crop Tab</td>
<td>517</td>
</tr>
<tr>
<td>Figure 264</td>
<td>After Using Manual Crop</td>
<td>519</td>
</tr>
<tr>
<td>Figure 265</td>
<td>Before Resizing an Image</td>
<td>520</td>
</tr>
<tr>
<td>Figure 266</td>
<td>Crop Tab</td>
<td>521</td>
</tr>
<tr>
<td>Figure 267</td>
<td>After Resizing an Image</td>
<td>522</td>
</tr>
<tr>
<td>Figure 268</td>
<td>Before Using Sub Image</td>
<td>523</td>
</tr>
<tr>
<td>Figure 269</td>
<td>Crop Tab</td>
<td>524</td>
</tr>
<tr>
<td>Figure 270</td>
<td>After Using Sub Image</td>
<td>525</td>
</tr>
<tr>
<td>Figure 271</td>
<td>Before Using IntelligentCrop</td>
<td>526</td>
</tr>
<tr>
<td>Figure 272</td>
<td>Crop Tab</td>
<td>527</td>
</tr>
<tr>
<td>Figure 273</td>
<td>After Using IntelligentCrop</td>
<td>528</td>
</tr>
<tr>
<td>Figure 274</td>
<td>Document Manager Applications View: Application Folder Icons</td>
<td>530</td>
</tr>
<tr>
<td>Figure 275</td>
<td>Set Retention Options Dialog Box: Single Document, Document Display View</td>
<td>531</td>
</tr>
<tr>
<td>Figure 276</td>
<td>Set Retention Options Dialog Box: Single Document, Query View Result Set</td>
<td>533</td>
</tr>
<tr>
<td>Figure 277</td>
<td>Set Retention Options Dialog Box: Multiple Documents</td>
<td>534</td>
</tr>
<tr>
<td>Figure 278</td>
<td>Extend Retention Period dialog box</td>
<td>536</td>
</tr>
<tr>
<td>Figure 279</td>
<td>Set Retention Options Dialog Box: Single Document, Query View Result</td>
<td></td>
</tr>
<tr>
<td>Figure 280</td>
<td>Set Retention Options Dialog Box: Multiple Documents</td>
<td>538</td>
</tr>
<tr>
<td>Figure 281</td>
<td>Retention Hold Options Dialog Box</td>
<td>540</td>
</tr>
<tr>
<td>Figure 282</td>
<td>Manage Retention Holds Dialog Box</td>
<td>540</td>
</tr>
<tr>
<td>Figure 283</td>
<td>Retention Hold Options Dialog Box</td>
<td>542</td>
</tr>
<tr>
<td>Figure 284</td>
<td>Retention Hold Options Dialog Box</td>
<td>542</td>
</tr>
<tr>
<td>Figure 285</td>
<td>Manage Retention Holds Dialog Box</td>
<td>543</td>
</tr>
<tr>
<td>Figure 286</td>
<td>Remove Retention Holds Dialog Box</td>
<td>544</td>
</tr>
<tr>
<td>Figure 287</td>
<td>Manage Retention Holds Dialog Box</td>
<td>545</td>
</tr>
<tr>
<td>Figure 288</td>
<td>Example of File System Configuration in RM for AppXtender Server</td>
<td>549</td>
</tr>
<tr>
<td>Figure 289</td>
<td>Application Folder Icons on RM for AppXtender Desktop</td>
<td>551</td>
</tr>
<tr>
<td>Figure 290</td>
<td>Records Management Servers Icon</td>
<td>551</td>
</tr>
<tr>
<td>Figure 291</td>
<td>Select File Plan Dialog Box</td>
<td>553</td>
</tr>
<tr>
<td>Figure 292</td>
<td>Destination Filing System File Plan Selected</td>
<td>554</td>
</tr>
<tr>
<td>Figure 293</td>
<td>Select File Plan Dialog Box</td>
<td>555</td>
</tr>
<tr>
<td>Figure 294.</td>
<td>Select File Plan with File Plan Selected</td>
<td>556</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Figure 295.</td>
<td>Retention Administration Clock Icon in AppXtender Status Bar</td>
<td>556</td>
</tr>
</tbody>
</table>
# List of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Document Storage Format for Text Files</td>
<td>43</td>
</tr>
<tr>
<td>2</td>
<td>AppXtender Desktop License Types</td>
<td>57</td>
</tr>
<tr>
<td>3</td>
<td>Variations in Login Procedures</td>
<td>58</td>
</tr>
<tr>
<td>4</td>
<td>Page and Thumbnail Types</td>
<td>74</td>
</tr>
<tr>
<td>5</td>
<td>AppXtender Document Manager Main Toolbar Buttons</td>
<td>76</td>
</tr>
<tr>
<td>6</td>
<td>Annotation Toolbar Buttons</td>
<td>78</td>
</tr>
<tr>
<td>7</td>
<td>AppXtender Document Manager Image Toolbar Buttons</td>
<td>79</td>
</tr>
<tr>
<td>8</td>
<td>AppXtender Document Manager Batch Index Buttons</td>
<td>81</td>
</tr>
<tr>
<td>9</td>
<td>AppXtender Document Manager Scan Toolbar Buttons</td>
<td>82</td>
</tr>
<tr>
<td>10</td>
<td>AppXtender Document Manager Function Keys</td>
<td>83</td>
</tr>
<tr>
<td>11</td>
<td>AppXtender Document Manager Toolbars</td>
<td>88</td>
</tr>
<tr>
<td>12</td>
<td>Image Size Options</td>
<td>106</td>
</tr>
<tr>
<td>13</td>
<td>Configuring Screen Fonts with Form Overlay</td>
<td>113</td>
</tr>
<tr>
<td>14</td>
<td>Configuring Printer Fonts with Form Overlay</td>
<td>114</td>
</tr>
<tr>
<td>15</td>
<td>Endorsement Macros</td>
<td>124</td>
</tr>
<tr>
<td>16</td>
<td>File Types and Combined Output</td>
<td>127</td>
</tr>
<tr>
<td>17</td>
<td>Allow Remember Password Option</td>
<td>136</td>
</tr>
<tr>
<td>18</td>
<td>OCR Result Format Option</td>
<td>146</td>
</tr>
<tr>
<td>19</td>
<td>Thumbnail Tab Options</td>
<td>147</td>
</tr>
<tr>
<td>20</td>
<td>Saved Workstation Settings</td>
<td>153</td>
</tr>
<tr>
<td>21</td>
<td>AppXtender Desktop License Types</td>
<td>162</td>
</tr>
<tr>
<td>22</td>
<td>Deciding What Input Method to Use</td>
<td>166</td>
</tr>
<tr>
<td>23</td>
<td>AppXtender-Supported Foreign File Types</td>
<td>169</td>
</tr>
<tr>
<td>24</td>
<td>Rubber Stamp Index Fields</td>
<td>192</td>
</tr>
<tr>
<td>25</td>
<td>Forms Index Fields</td>
<td>193</td>
</tr>
<tr>
<td>26</td>
<td>Using @ vs. Using @@</td>
<td>195</td>
</tr>
<tr>
<td>27</td>
<td>Trade-Off Between Using @ vs. Using @@</td>
<td>196</td>
</tr>
<tr>
<td>28</td>
<td>Automated Indexing Features</td>
<td>206</td>
</tr>
<tr>
<td>29</td>
<td>Example File Sizes When Using Different Modes for Same Image</td>
<td>228</td>
</tr>
<tr>
<td>30</td>
<td>Typical Source Settings</td>
<td>229</td>
</tr>
<tr>
<td>31</td>
<td>Single-Document Processing Options</td>
<td>239</td>
</tr>
<tr>
<td>32</td>
<td>Search Specification Examples</td>
<td>247</td>
</tr>
<tr>
<td>33</td>
<td>Examples of Search Expressions</td>
<td>249</td>
</tr>
<tr>
<td>34</td>
<td>List of Values Dialog Box Buttons</td>
<td>250</td>
</tr>
<tr>
<td>35</td>
<td>More Information on ODMA Attributes</td>
<td>252</td>
</tr>
<tr>
<td>36</td>
<td>Compound Search Expression Examples</td>
<td>254</td>
</tr>
<tr>
<td>37</td>
<td>Full-Text Search Options</td>
<td>255</td>
</tr>
</tbody>
</table>
Table 38. Expression Operators ................................................................................. 257
Table 39. Examples of Expression Operators .......................................................... 258
Table 40. Cross Application Query Icon Legend .................................................... 261
Table 41. Result Set Document Status Legend ....................................................... 268
Table 42. Behavior of the Displayed Document ...................................................... 270
Table 43. AppXtender Reports Mgmt Report Function Commands ...................... 280
Table 44. Results of Full-Text Searching ................................................................. 283
Table 45. Wildcard Character Results ..................................................................... 290
Table 46. Magnify Window Menu Commands ......................................................... 315
Table 47. Text Positioning Methods ....................................................................... 320
Table 48. Description of Each OLE Object Display Method .................................... 328
Table 49. AppXtender View Control Properties - General Tab Options ................ 330
Table 50. AppXtender View Control Properties - General Tab Options ................ 331
Table 51. AppXtender View Control Properties - Text Tab Options ..................... 334
Table 52. AppXtender View Control Properties - OCR Tab Options ..................... 335
Table 53. AppXtender View Control Properties - OCR Result Format Options .... 336
Table 54. Image Information - Information Tab Options .......................................... 337
Table 55. Image Information - Files Tab Description ................................................ 337
Table 56. General Tab Fields .................................................................................. 394
Table 57. Summary Tab Fields ................................................................................ 395
Table 58. AppXtender-Supported Applications for ODMA .................................... 407
Table 59. General Tab Fields .................................................................................. 415
Table 60. Summary Tab Fields ................................................................................ 416
Table 61. Folder Icons in the Result Set .................................................................. 423
Table 62. Closing a Checked Out AppXtender Document ...................................... 433
Table 63. Checking In a Document Through ODMA ............................................. 436
Table 64. Creating Basic Lines ................................................................................ 451
Table 65. Creating Basic Shapes ............................................................................. 452
Table 66. Rubber Stamp Format Strings .................................................................. 459
Table 67. Changing Properties of a New Text Rubber Stamp Annotation ............. 461
Table 68. Rubber Stamp Index Fields ...................................................................... 463
Table 69. Selecting Annotations ............................................................................. 476
Table 70. Modifying the Properties of a Shape Annotation ..................................... 479
Table 71. Changing the Properties of a Text Annotation .......................................... 481
Table 72. Enhancement Options ............................................................................. 489
Table 73. Character Protection Options .................................................................. 503
Table 74. Isolated De-Speck Options ..................................................................... 506
Table 75. Inverse Text Settings .............................................................................. 512
Table 76. Smooth Settings ..................................................................................... 515
Table 77. Manual Crop Settings ............................................................................. 518
Table 78. Resize Settings ....................................................................................... 521
Table 79. IntelligentCrop Settings .......................................................................... 527
Table 80. RM for AppXtender Application Folder Icon Descriptions ...................... 551
This document provides instructions on using ApplicationXtender Document Manager to create and manage ApplicationXtender documents.

**Intended audience**

This document is part of the ApplicationXtender Document Manager documentation set and is intended for use by administrators and end users who are responsible for managing ApplicationXtender documents, including creating documents, retrieving documents, viewing documents, and performing tasks such as adding, searching for, editing, and deleting documents.

**Revision history**

The following revisions have been made to this document:

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 2017</td>
<td>Initial publication</td>
</tr>
</tbody>
</table>
Chapter 1

Getting Started

ApplicationXtender (AppXtender) is a content management system that uses image processing to bring large amounts of data online in a cost-effective manner. ApplicationXtender Document Manager (AppXtender Document Manager), AppXtender’s end user desktop module, can be used to create, enhance, store, retrieve, and output any type of document.

You can use AppXtender Document Manager to add documents and pages AppXtender through scanning, importing, faxing, using the Windows Clipboard, or inserting objects from other applications. Once a document has been added to the AppXtender database, it can be retrieved and accessed so that you can work with the document. For example, you may need to fax a copy to someone, add an electronic signature, or annotate the document.

This section presents essential concepts related to AppXtender, as well as information and instructions for getting started with AppXtender Document Manager. The section includes the following topics:

- Introduction to AppXtender Concepts, page 29
- AppXtender Components, page 37
- AppXtender on Your Network, page 41
- How Documents are Stored and Displayed in AppXtender, page 41
- Ways of Using AppXtender, page 47
- Selecting Data Sources, page 50
- Starting AppXtender Document Manager, page 56
- AppXtender Document Manager Views, page 62
- AppXtender Document Manager Toolbars, page 75
- Function Keys, page 83

Introduction to AppXtender Concepts

The functionality of the AppXtender system centers on a few key concepts. An understanding of these concepts helps you use AppXtender effectively.
For more information, refer to:

- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30
- Document Storage Locations, page 36

## Content Organization in AppXtender

The highest level of organization in AppXtender is the application. Applications, which are designed by the AppXtender system administrator, contain documents consisting of one or more pages. Pages, in turn, consist of one or more page versions.

During application creation, one or more index fields are specified for each application. Information entered in the index fields when a document is added to an application acts as a label identifying the document in the AppXtender system.

![Diagram of Content Organization in AppXtender](image)

**Figure 1. Content Organization in AppXtender**

For more information, refer to:

- Introduction to AppXtender Concepts, page 29
- Glossary of AppXtender Terms, page 30

## Glossary of AppXtender Terms

The following terms pertain to the AppXtender system, its main functional components (applications, documents, pages, and indexes), and concepts related to system operation.
For more information, refer to:
- Introduction to AppXtender Concepts, page 29
- Content Organization in AppXtender, page 30
- Annotations, page 31
- Applications, page 32
- COLD/ERM Data, page 32
- Digital Signatures, page 32
- Documents, page 33
- Full-Text, page 33
- Indexes, page 34
- OCR, page 34
- ODMA, page 35
- KeyView Viewer, page 36
- Pages, page 35
- Redactions, page 35

Annotations

An annotation is a text note or a shape added to a page, typically to focus attention on a particular part of the page. You can use annotations to comment on the contents of a page, highlight important information, or block areas of the page from view. The types of annotations available in AppXtender Document Manager include text, highlighting, lines, arrows, and shapes.

Note: An annotation that blocks part of a page from view is called a redaction.

AppXtender allows you to add annotations to the following page types:
- Images
- Text
- Portable Document Format (PDF) files

When you create an annotation, it is related to the AppXtender page to which it was added. When you view the page, the annotation appears as part of the image or text on the page. However, annotations are stored separately from documents and pages in the AppXtender system.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30
Applications

An application is the highest level of organization in AppXtender. You store documents in applications and retrieve documents from applications.

AppXtender system administrators create applications through the ApplicationXtender Application Generator (AppXtender AppGen) module. During this process, the system administrator names the application and defines one or more indexes for the application.

Every time you store a document in an application, you must enter index information for that particular document. AppXtender stores the index information in a database, allowing you to search for and retrieve the document as needed.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

COLD/ERM Data

COLD (Computer Output to Laser Disk) data and ERM (Enterprise Report Management) data is report data generated for existing applications, indexed using an extraction process, and downloaded into AppXtender applications.

COLD/ERM data is added to AppXtender as documents via ApplicationXtender Reports Management® (AppXtender Reports Mgmt). AppXtender Reports Mgmt produces ASCII or PDF documents known as AppXtender Reports Mgmt documents. To allow users to view the report data in the context of a standard form, form overlays can be added to AppXtender Reports Mgmt ASCII document.

Note: Form overlays cannot be added to PDF documents.

AppXtender Document Manager can perform text searches on individual AppXtender Reports Mgmt documents, allowing you to locate important data within the report.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

Digital Signatures

Digital signatures allow users to electronically sign any page version in AppXtender and ApplicationXtender Web Access (AppXtender Web Access). Like a written signature, the purpose of a digital signature is to guarantee that the individual signing the page really is who he or she claims to be and that the document has not changed since the date of the signature.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30
Documents

A document is a file or group of files stored in an AppXtender application and identified by index information. Each page of a document is a single object, such as a scanned image file or a word processing document. Documents can contain any combination of objects, each stored as a page within the document. For instance, a document for a hospital patient might include scanned admission forms, a doctor’s report in Microsoft Word format, and an x-ray image file. A single document can contain one page or thousands of pages.

**Note:** For more information on the types of files that can be stored in AppXtender, refer to How Documents are Stored and Displayed in AppXtender, page 41.

You create documents in AppXtender by adding objects to applications. Part of this process is to enter information from the document into each of the application’s index fields. This information acts as a "label" for the document. Once a document is added to the database, you can then add additional objects as additional pages. If you have the proper security privileges, you can modify documents and their indexes at any time.

Because document index information is stored in a database, you can search for the document's "label" to retrieve the document. When you make a search request in AppXtender, all records of index information containing a match with the information you requested will appear in the search results. You can then retrieve and view any document by selecting its record from the result set. You can process (print, fax, mail, or export) documents pages individually or together as a single unit. You can also print or fax several documents simultaneously by selecting them from the result set and choosing the appropriate command.

For more information, refer to:

- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

Full-Text

Some applications are configured so that you can have documents indexed for full-text searching. With full-text search, you can find documents without knowing any of the document's index values. You can also use full-text searching to narrow down results from an index value search.

To be available for full-text search, documents must be submitted to the AppXtender Index Server for full-text indexing. The following types of documents can be full-text indexed in AppXtender:

- Bi-level (black and white) and color images
- Rich Text Format (RTF) files
- Hypertext Markup Language (HTML) files
- Portable Document Format (PDF) files
- Foreign files added by importing the files into AppXtender

For more information, refer to:

- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30
Indexes

An AppXtender index is a group of fields where information relating to a document is stored. The index values you enter identify the document when it is stored in an AppXtender application.

As the part of the AppXtender system that allows you to organize stored documents efficiently, the index is the central component in an AppXtender application. Documents can be stored in AppXtender in random order and yet still be easily retrieved. Because an index record is attached to every document, you can search all stored index values for an application to retrieve relevant documents.

The AppXtender administrator specifies the index information required for each AppXtender application. During application creation, the administrator decides what index information will be requested from the user and what the format for that information will be. The administrator plans how many descriptive entries to request for each stored document, what type of information to use to identify the documents, how much space to provide for each entry, and how the information for a particular entry will be entered.

Figure 2. Example of a Document Index

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td></td>
</tr>
<tr>
<td>SSN</td>
<td></td>
</tr>
<tr>
<td>DEPARTMENT</td>
<td></td>
</tr>
<tr>
<td>DATE OF HIRE</td>
<td></td>
</tr>
</tbody>
</table>

AppXtender uses the fields specified during application creation to build an Index view. Whenever you add a document to an application from AppXtender Document Manager, the Index view for the application specifies the exact information you need to enter and provides input fields for you to enter each value.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

OCR

With AppXtender, you can use optical character recognition (OCR) to process bi-tonal (black and white) and color images and convert an image of text into actual text. After an image is processed using OCR, you can submit the resulting text to the AppXtender Index Server for full-text searching.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30
ODMA

Open Document Management API (ODMA) support allows you to work with AppXtender documents within ODMA-compliant applications such as Microsoft Word and Microsoft Project. Through the ODMA check-in process, you can save a non-AppXtender document as a new AppXtender document, adding AppXtender index values and document summary information. You can also check out and modify an existing AppXtender document and then check it back into AppXtender as a major revision, a minor revision, a new page version, or a replacement page version (depending on your user privileges). Through the ODMA checkout process, you can retrieve previous document revisions and the most recent page version of the first page in a document from AppXtender.

When you search for AppXtender documents through ODMA, you can utilize all of AppXtender’s normal search functionality. The search dialog box that appears in the ODMA-compliant application is similar to the Query view used in AppXtender.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

Pages

The word "page" typically implies a single entity. Because AppXtender supports multiple object types, a page in AppXtender is defined as a single object. A page can come from one of many different sources. For example, a very long word processing file is a page to AppXtender. A page could also be a single scanned image, for example, a 30-minute video clip, or an audio recording.

When you create a document in AppXtender, the object added as the new document is the first page of that document. Up to 250,000 pages can be attached to a document. The same index record is attached to all of the pages in a single document.

Authorized users can select commands from the AppXtender Document Manager Document menu to process all of the pages in a document simultaneously or select commands from the Page menu to process pages individually. Authorized users can also insert or delete pages at any time.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

Redactions

Redactions are annotation shapes that are filled and opaque. They can be used to secure (hide) portions of image and text pages.

You can apply redaction to all available annotation shapes: freehand lines, straight lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page behind the redaction is hidden from view.
For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

**KeyView Viewer**

The KeyView Viewer allows you to view the content of some foreign files in AppXtender Document Manager. The major benefit of having the KeyView Viewer is that a third-party viewer, such as Microsoft Word, is no longer needed to display the content of the files.

The appearance of a foreign file in the KeyView viewer is similar to but not exactly the same as its appearance in its native viewer. As soon as the content of the file appears, you can launch its native software program from the Page menu and then edit the file.

For more information, refer to:
- Content Organization in AppXtender, page 30
- Glossary of AppXtender Terms, page 30

**Document Storage Locations**

Unlike document indexes for AppXtender applications, which are stored in a database, the actual document files (scanned images and text files, for example) are stored in a directory designated by the administrator as the application’s document write path.

AppXtender applications can be configured to store documents to any storage devicethat can be mapped by the AppXtender workstation. This includes devices such as a network file server, local hard disk, or erasable and WORM optical media.

For more information, refer to:
- Introduction to AppXtender Concepts, page 29
- DiskXtender, page 36

**DiskXtender**

The LEGATO DiskXtender® (DX) software revolutionizes data storage management for Windows. DiskXtender can be used as a Document Server for your AppXtender document storage. By intelligently controlling hardware devices and access to files on media, DiskXtender allows you to save and retrieve files to and from its extended NTFS volumes (DX "extended drives").

DX moves files out to media, keeping track of each file's location. When files are needed, DX seamlessly retrieves and delivers them to the user. DX lets the administrator automate file migration through a user-friendly interface that displays hardware, media, and extended drives in a single, unified "tree" structure.
To write AppXtender documents to DiskXtender, the document write path for the application simply points to a DiskXtender extended drive. The administrator can also configure a dedicated connection between AppXtender and the DX server using Microsoft’s Distributed Object Component Model (DCOM) or Remote Procedure Call (RPC) technologies.

For information on configuring DX server connectivity, refer to the "Using a Document Storage Server" chapter of the ApplicationXtender Core Components Administrator’s Guide.

For more information, refer to:
• Document Storage Locations, page 36

AppXtender Components

An AppXtender system can contain several AppXtender products and modules, each of which performs a specific function within the system. For more information, refer to the following topics:
• Administrator Components, page 37
• User Components, page 39
• AppXtender License Server, page 40

Administrator Components

The AppXtender system administrator uses the following components to create and maintain the AppXtender content management system.
• AppXtender Index Server, page 37
• Import Wizards, page 38
• Administrator Utilities, page 39

For more information on any of the administrator components, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

AppXtender Index Server

The ApplicationXtender Index Server (AppXtender Index Server) module provides full-text search functionality and OCR processing for AppXtender systems. You can submit an image to the AppXtender Index Server for OCR processing or add text information for full-text indexing. You can process scanned images using OCR and then add the resultant text version of the document to the AppXtender Index Server, allowing users to search on "key" words that might be located anywhere in the document.
For more information, refer to:

- Administrator Components, page 37

### Import Wizards

AppXtender has three import wizards. For more information, refer to the following topics:

- AppXtender Index Image Import Wizard, page 38
- AppXtender Key Reference Import Wizard, page 38
- AppXtender Auto Index Import Wizard, page 38

#### AppXtender Index Image Import Wizard

If images, text, or foreign file format files and associated index data exist in another system, you can import them into AppXtender using the AppXtender Index Image Import Wizard.

For information on importing index information and images together, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide.

#### AppXtender Key Reference Import Wizard

This wizard is used to import key reference information into the AppXtender system by importing data into a table to be used for automatic index population. This table is a central holding area for index information and operates on a "static data" basis, which means that records remain in the table even after they are used. If changes occur (such as an address or name), then those changes are immediately reflected across the entire application, because any documents in the application indexed using Key Reference data obtain their index information from the Key Reference table.

For information on importing Key Reference information, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide. For information on using the Key Reference Import table, refer to Automated Indexing Features, page 205.

#### AppXtender Auto Index Import Wizard

This wizard is used to import Auto Index information into the AppXtender system. When you perform an Auto Index Import, AppXtender imports the data into an Auto Index table; that information is then used for the automatic population of AppXtender indexes.

The Auto Index table operates on a "use once and discard" basis, which means that when an item is extracted from the table, it is automatically deleted. This feature is used when initially creating documents, so that all unindexed records can be tracked.

For information on importing Auto Index information, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide.
Administrator’s Guide. For information on using the Auto Index Import table, refer to Automated Indexing Features, page 205.

**Administrator Utilities**

AppXtender has utilities for the AppXtender system administrator. For more information, refer to the following topic:

- AppXtender Migration Wizard, page 39

**AppXtender Migration Wizard**

The AppXtender Migration Wizard moves or copies AppXtender application definitions, application import specifications, application data, user lists and group lists from one AppXtender data source to another AppXtender data source.

The AppXtender Migration Wizard can be used to distribute information to other sites or to scale AppXtender solutions to larger or smaller databases. The administrator can choose to migrate all AppXtender application data or just a subset of the information. Several applications can be migrated without exiting the wizard to change the source database. The administrator can automate application migration using the save and load settings features or using extensive command line options. Only users who have been given AppXtender Administrator privileges in AppXtender Desktop can perform migrations.

**User Components**

Three components—AppXtender Document Manager, AppXtender Image Capture, and AppXtender Data Source Selector—are used by all system users, including the administrator. For more information, refer to the following topics:

- AppXtender Document Manager, page 39
- AppXtender Image Capture, page 40
- AppXtender Data Source Selector, page 40

**AppXtender Document Manager**

AppXtender Document Manager, the central program in the AppXtender system, provides the interface through which users store, retrieve, view, and process documents. Documents and pages can be added one at a time or imported together in groups, called batches. The documents can then be indexed so that they can be located and retrieved later as needed.

You can perform index searches in AppXtender Document Manager to locate documents. As soon as a document has been retrieved in AppXtender Document Manager, you can adjust the display of the document. You can add comments to documents or batches in the form of text annotations.
You can also use a variety of annotation shapes to highlight areas of pages and apply redactions to documents. You can print, fax, mail, or export documents and pages from AppXtender.

**Note:** The Configuration dialog box in AppXtender Document Manager provides a way for you to configure several features that effect the way AppXtender Document Manager looks or performs.

For more information, refer to:
- User Components, page 39

### AppXtender Data Source Selector

The AppXtender Data Source Selector allows you to locate and select data sources that have been created in the AppXtender Administrator module. When multiple data sources are available, you may be able to select two or more data sources to be accessed within AppXtender Document Manager. This allows you to work with applications from different data sources during a single AppXtender Document Manager session. For information on using the AppXtender Data Source Selector, refer to Selecting Data Sources, page 50.

For more information, refer to:
- User Components, page 39

### AppXtender Image Capture

ApplicationXtender Image Capture® (AppXtender Image Capture), a separate installation package provides batch scanning functionality, allowing you to scan documents and then index them at a later time in AppXtender Document Manager. For more information on AppXtender Image Capture, consult your system administrator or refer to the ApplicationXtender Image Capture User's Guide.

For more information, refer to:
- User Components, page 39

### AppXtender License Server

AppXtender uses the AppXtender License Server to monitor licensing for AppXtender Document Manager workstations. The License Server is a central license server that manages licensing for all AppXtender products. For information on using the License Server, refer to the ApplicationXtender Core Components Administrator's Guide.
For more information, refer to:
• Administrator Components, page 37

AppXtender on Your Network

The modules that make up AppXtender, the files that you store and manage through AppXtender, and the database used by AppXtender can all be located on separate computers across a network to increase performance. When you store a document to AppXtender, you are probably storing it to a location on the network rather than onto your local computer. The database that you are using to store index information is also probably on a server somewhere on your network.

However, from your perspective as a user of AppXtender, database location and document storage location are relatively unimportant. The benefit of AppXtender to you as a user is that you do not have to decide where to store documents or remember where to go to locate them. You simply open an AppXtender application and use the search function to find the documents you want, and AppXtender knows where to go to retrieve them.

In order to understand how your particular AppXtender system works, you may want to consult your AppXtender system administrator to find out if you have access to an AppXtender Index Server, which full-text engine has been selected for the applications you use, what functionality is configured for your workstation, what AppXtender data sources are configured for you, and what functions you have rights to in AppXtender. Having an understanding of what functions are available to you will help you to better understand how you can use AppXtender.

For more information, refer to:
• Chapter 1, Getting Started

How Documents are Stored and Displayed in AppXtender

You can store any type of file in AppXtender. Depending on the file type, AppXtender stores the file as a supported file type such as image or text, or as an unsupported file type such as foreign or OLE. When files are created in AppXtender, AppXtender verifies the file type and then stores the file as the identified type (such as image, text, foreign file format).

Many of the functions available in AppXtender are file-type dependent. Because AppXtender is geared toward providing access to as many useful functions as possible, features are provided that can be used to work with particular file types. However, these functions are frequently not available when you are working with other file types.

A good example of this is the Enhance Image function. If you are viewing a scanned image of an invoice, for example, it might be very helpful to use image enhancement to clean up the image and make it easier to read. However, when you are working with a Microsoft Word document stored as a foreign file, image enhancement is not available (because it would not be of any use with the Microsoft Word document).

AppXtender has the capability to display file types in a variety of ways. The content of supported file types can be displayed in the Document Display view. Depending on your AppXtender
configuration, an unsupported file type can be displayed as an icon representing a foreign file, through KeyView Viewer support, or in its native application in the Document Display view.  

**Note:** Access to AppXtender functions depends on the rights granted in your AppXtender user profile. For more information on your user privileges in AppXtender, consult your AppXtender system administrator or refer to the "Implementing Security" section of the *ApplicationXtender Core Components Administrator’s Guide.*

**Note:** Access to AppXtender functions also depends on the "mode" in which you are using AppXtender: check in/check out mode or normal AppXtender mode. For more information on the different operational modes for AppXtender, refer to *Ways of Using AppXtender, page 47.*

The following topics discuss how AppXtender stores different types of files and give a brief overview of the functions available for files stored in each format:

- Supported Files, page 42
- Unsupported Files, page 45

**Supported Files**

Supported files are files that AppXtender natively supports. Supported file types include: image files (for example, TIFF, GIF, Bitmap, PCX, DCX, JPEG, and TGA files), Rich Text Format (RTF) files, Hypertext Markup Language (HTML) files, and Adobe Portable Document Format (PDF) files. The following topics describe the AppXtender-supported files:

- Image Files, page 42
- ERM/Text Files, page 43
- Rich Text Format (RTF) Files, page 44
- Hypertext Markup Language (HTML) Files, page 44
- Portable Document Format (PDF) Files, page 44

**Image Files**

AppXtender has the ability to store image files in their native format or in a different format supported by AppXtender. Image files contain graphic data. AppXtender displays image files in their stored format. Depending on the image storage format, black and white files and 4/8-bit color files can be displayed in their native format as well as TIFF or Windows bitmap files. True color files can be displayed in their native format as well as TIFF, Windows bitmap, or JPEG files. If you store images using the JPEG format, you can configure the level of compression of the images through AppXtender.

By default, AppXtender stores images in their native format (for example, a TIFF file is stored as TIFF). When you choose to store an image file in a specific image format, AppXtender ignores the original format and stores all images in that format.

Images are added to AppXtender by importing them or by scanning in paper documents. You have access to a large range of AppXtender functionality when you are working with supported images in AppXtender. You can add annotations, enhance the image quality, process the image using Optical Character Recognition (OCR), and adjust the display of the image in many ways to allow optimal
viewing of the image. You can also perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an AppXtender Index Server for full-text indexing, you can submit images that contain text to the AppXtender Index Server, using OCR to extract the text for indexing. Document Display properties are also available for image files, allowing you to change display settings from the Document Display view.

For more information, refer to:

- Supported Files, page 42

**ERM/Text Files**

Text files can be added to AppXtender by importing them or by performing an AppXtender Reports Management extract and upload. Once the files are in AppXtender, they are stored as AppXtender-proprietary compressed text file format.

**Note:** In most cases, text files display as text files; otherwise, they display as foreign files. If you map text extensions on the File Types tab rather than having AppXtender do the mapping automatically, the files may not display properly. For information on configuring the File Types tab, consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

You have access to a large range of AppXtender functionality when you are working with text files in AppXtender. You can add annotations and adjust the display of the image in many ways to allow optimal viewing of the image. You can also perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an AppXtender Index Server for full-text indexing, you can submit text files to the AppXtender Index Server. Document Display properties are also available for text files, allowing you to change display settings from the Document Display view.

Form overlays can be added to ASCII documents from AppXtender Reports Mgmt to allow users to view the report data in the context of a standard form. (Form overlays cannot be added to PDF documents from AppXtender Reports Mgmt.) Depending on your AppXtender configuration, ERM documents with form overlay can be displayed with either text form overlay or image form overlay, or image form overlay only. ERM documents without form overlay are displayed in an ASCII format.

The following table provides an explanation of each supported text format.

**Table 1. Document Storage Format for Text Files**

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>ASCII stands for the American Standard Code for Information Interchange. This character set is used on most PCs, Macintosh's, and other desktop computers. A report generated on a desktop computer is likely to be in an ASCII format.</td>
</tr>
<tr>
<td>EBCDIC</td>
<td>EBCDIC stands for Extended Binary Coded Decimal Interchange Code. This character set is used on IBM mainframes. A report generated on an IBM mainframe will be in EBCDIC format.</td>
</tr>
<tr>
<td>EBCDIK</td>
<td>EBCDIK is the Japanese variation on EBCDIC. This character set is used on IBM mainframes manufactured in Japan. A report generated on a Japanese IBM mainframe will probably be in EBCDIK format.</td>
</tr>
</tbody>
</table>
For more information, refer to:
• Supported Files, page 42

Rich Text Format (RTF) Files

AppXtender stores RTF files in their native format. You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an AppXtender Index Server for full-text indexing and RTF file conversion is configured on the AppXtender Index Server, you can submit RTF files for full-text indexing. (RTF file conversion is not necessary if your application is configured to use the K2 full-text engine.) Document Display properties are not available for RTF files.

RTF files are displayed in their native format. The contents of the RTF file appears in the Document Display window, even if you do not have the KeyView Viewer enabled for foreign files. Because RTF is natively supported in AppXtender, the KeyView Viewer is not required to view file contents.

For more information, refer to:
• Supported Files, page 42

Hypertext Markup Language (HTML) Files

HTML files are files written in the language used for display on the World Wide Web. A web page is typically in HTML format.

AppXtender stores HTML files in their native format. You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing). If you have access to an AppXtender Index Server for full-text indexing and HTML file conversion is configured on the AppXtender Index Server, you can submit HTML files for full-text indexing. (HTML file conversion is not necessary if your application is configured to use the K2 full-text engine.) Document Display properties are available for HTML files.

For more information, refer to:
• Supported Files, page 42

Portable Document Format (PDF) Files

PDF files are files in a proprietary Adobe format. AppXtender stores and displays PDF files in their native format. Because PDF is natively supported in AppXtender, the KeyView Viewer is not required to view file contents. The contents of the PDF file appear in the Document Display view document viewer, even if you do not have the KeyView Viewer enabled for foreign files.

You can add annotations and adjust the display of the PDF file in many ways to allow optimal viewing. Document Display properties are available for PDF files. You can also perform all of the AppXtender export functions (such as printing, faxing, exporting, and e-mailing). Depending on the privileges assigned to your user account, while using these export functions, you may be able to hide annotations on a PDF file.
If the software cannot extract text from a PDF file, the pages are then processed for text content using OCR.

If you have access to an AppXtender Index Server for full-text indexing, you can submit PDF files for full-text indexing. PDF files that have been submitted for full-text indexing can be full-text searched in releases previous to 4.6. However, the display of hits differs from that of PDF files submitted in release 4.6 or later releases.

For more information, refer to:
• Supported Files, page 42

Unsupported Files

Unsupported files are stored in AppXtender in their native format. Unsupported files include foreign files and OLE files. For most unsupported file types, you can choose whether to add the file as an OLE object or a foreign file when you add the file to AppXtender. For more information, refer to the following topics:
• Foreign Files, page 45
• OLE Objects, page 46

Foreign Files

When you import a file that is not natively supported in AppXtender, AppXtender stores that file as a foreign file. All files other than TIFF, Windows bitmaps, JPEG, TGA, GIF, PCX, DCX, RTF, and HTML are stored in AppXtender as foreign files. AppXtender stores foreign file types in their native file format.

You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing) for foreign files. If you have access to an AppXtender Index Server for full-text indexing and foreign file conversion is configured on the AppXtender Index Server, you can submit foreign files to the AppXtender Index Server. (Foreign file conversion is not necessary if your application is configured to use the K2 full-text engine.) You can view page information for foreign files in AppXtender. Document Display properties are also available for foreign files. If you would like to edit a foreign file, you can launch the foreign file in its associated source application to do so.

Certain foreign files can be created, accessed and modified using ODMA. If you want to create AppXtender documents with files from an ODMA-compliant application that is supported by AppXtender, you can do so. When you create a document through ODMA, that file is stored in AppXtender as a foreign file.

For a list of the AppXtender-supported applications that are ODMA-compliant, refer to AppXtender Document Properties: the General Tab, page 415.

⚠️ Caution: Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.
You can choose how to display foreign files in your AppXtender Document Display view. If you enable the KeyView Viewer in AppXtender Configuration, the content of foreign files that are supported under KeyView will appear in the view. If you do not enable the KeyView Viewer, foreign files appear as icons in the Document Display view.

For a list of the foreign files that can be viewed using the KeyView Viewer feature, refer to KeyView File Support, page 168.

For more information, refer to:
- Unsupported Files, page 45

**OLE Objects**

When you insert a file that is not supported in AppXtender as an object, AppXtender uses Object Linking and Embedding (OLE) to embed the file in AppXtender. AppXtender stores OLE objects in their native file format.

You can perform all of the export functions (such as printing, faxing, exporting, and e-mailing) for OLE objects. You can view page information for OLE objects in AppXtender. Document Display properties are also available for OLE objects.

You can choose how to display OLE objects in your AppXtender Document Display view. If you choose to display the object normally, the content of the object appears in the view. If you choose to Display as Icon, the OLE object will appear as an icon in the Document Display view.

You can double-click an OLE object to activate it and start the source application (if you chose to display the object as an icon) or to perform in-place editing (if you did not choose to display as icon). In-place editing means that the AppXtender Document Manager menus change to the menus of the source application for the OLE object, and you can access source application commands without leaving the AppXtender Document Display view.

**Note:** OLE objects cannot be submitted for full-text indexing.

For more information, refer to:
- Unsupported Files, page 45

**Field Masking**

Currently, ApplicationXtender administrators can use a validation mask to specify the exact format (character pattern) required for each text index field associated with an application. When the Validation Mask option is enabled for a text field, ApplicationXtender performs a character-by-character validation of user input for the field during the document indexing process. This action ensures that data is stored in the database in the desired format.

ApplicationXtender extends the concept of field masking to allow administrators to mask field display values. This feature prevents you from viewing confidential data in index fields.

With the exception of the ApplicationXtender Document Index view, masked field values are not visible in the Document Manager or Web Access user interface (Result Set, Export, Email, and cross-application query dialogs) regardless of user permissions. An asterisk (*) appears in place of
each masked character in the index field, as shown in Figure 3, page 47. However, ApplicationXtender users with Modify Index privilege can view and modify index values for masked fields in the Document Index view. Refer to Implementing Security in the ApplicationXtender Core Components Administrator’s Guide for more information on user and group privileges.

Figure 3, page 47 illustrates a masked index field in ApplicationXtender Document Manager. In the sample dialog, the currently logged in user does not have the Modify Index privilege. As a result, the masked portion of the index field value is hidden in the Document Index view in addition to the Result Set view.

Figure 3. Masked Index Field

Ways of Using AppXtender

You can use AppXtender applications to store documents through the AppXtender interface, or you can use them to add document storage and processing capabilities to other third-party software programs.

For more information, refer to:

• Chapter 1, Getting Started
• AppXtender Modes of Operation, page 48
• ODMA, page 35
AppXtender Modes of Operation

You can use AppXtender applications to store and retrieve documents through the AppXtender interface. AppXtender has two modes of operation that you may be able to choose from: normal AppXtender mode and check in/check out mode. Your administrator may have configured check in/check out mode at the application level, which means that you do not have control over the mode on your workstation. Your administrator may also have enabled required comments on check in and/or check out of documents and reason audit mode for some or all of the applications you work with.

The normal AppXtender and check in/check out modes of operation relate to the use of revision control in AppXtender. Revision control keeps track of who is working on a document and can be used to track previous revisions of a document. When revision control is in use, you must check a document out before you can modify it. When you finish modifying the document, you must then decide how (or whether) to resave the document to the AppXtender document repository.

When you check out a document, a copy of the document as it exists in the AppXtender repository is created by AppXtender. This copy becomes your working copy. Even when you close a document, you can keep the document checked out in order to continue working on it.

When you finish your modifications, you can choose to check the document back into the repository. You can replace the most recent revision in the repository with the current revision, or you can check it in as a new revision and mark it as a minor revision or a major revision.

If the application you are working with has Prompt for checkout on open enabled, when you check in a document that is in final form, you can mark the document as a final revision. Once this is done, users can open the document only in read-only mode and cannot modify the document. For information on enabling final revision functionality when you set up AppXtender applications, refer to "Creating an Application" in the ApplicationXtender Core Components Administrator's Guide.

Note: Users with deletion privileges can delete final document revisions from the AppXtender repository.

Note: The final revision option on check-in is not available when checking in documents through ODMA.

You can also choose to cancel checkout of the document. When you cancel checkout of the document, the working copy created when you checked the document out is deleted, and AppXtender considers the revision of the document that you checked out as the current revision. Any changes that you made to the working copy are discarded.

Reason audit mode, which is configured by your administrator at the application level, requires you to enter comments whenever you create, display, export, print, or email documents. When you display documents in reason audit mode, you must select options to print, email, or export if you want access to those functions once the documents are displayed.

For more information, refer to:
- Ways of Using AppXtender, page 47
- Check In/Check Out Mode, page 49
- Normal Mode, page 49
Check In/Check Out Mode

An AppXtender Document Manager workstation is in check in/check out mode when the Prompt for check out when open option of the workstation configuration is enabled. An AppXtender application is in check in/check out mode when the Prompt for checkout when open documents option of the application configuration is enabled. Check in/check out mode is enabled for you if it is enabled for either your workstation or the current application.

When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. If you attempt to open a document, AppXtender will prompt you to either check out the document or open it in read-only mode. You must check out the document in order to modify it.

The application may also be configured so that comments are required when you check in or check out documents. The final revision option on check-in is only available when the AppXtender application is in check in/check out mode.

For more information, refer to:
• AppXtender Modes of Operation, page 48

Reason Audit Mode

The Health Insurance Portability and Accountability Act of 1996 (HIPAA) was put in place to protect health care patients by regulating how patient records are stored and accessed. AppXtender contains options that can be used to help create a content management solution that facilitates compliance with the HIPAA regulations. When the Reason Code option is enabled for an AppXtender application and the Audit Trail option is enabled, all document creation, printing, email, and export actions are audited. You are required to enter comments explaining the reason for document creation, printing, email, and export, and to enable printing, email, and export options indicating the functionality you intend to use. Those comments, along with your user identity, are logged used the Audit Trail feature.

For more information, refer to:
• AppXtender Modes of Operation, page 48

Normal Mode

An AppXtender Document Manager workstation is in normal mode when the Prompt for check out when open option of the workstation configuration is not enabled. An AppXtender application is in normal mode when the Prompt for checkout when open documents option of the application configuration is not enabled. Normal mode is enabled for you if it is enabled for both your workstation and for the current application.

When AppXtender is in normal mode, use of revision control with AppXtender documents is not mandatory. You can open and modify documents, and when you close them, the modifications are automatically saved to the AppXtender document repository.

You can check out documents while AppXtender is in normal mode, in order to prevent other users from making modifications while you are working on a document. This is useful if making modifications to a document will extend past the current AppXtender Document Manager session. However, you are not required to check out a document in order to make modifications to it.
If your workstation is in normal mode and you attempt to open a document that is checked out by another user, you will automatically receive a read-only copy of the document and you will not be able to make changes. Read-only status is indicated by an ‘(RO)’ notation in the title bar.

If your workstation is in normal mode and you attempt to open a document that you already have checked out, you will receive a dialog box that gives you the option of opening your checked out copy of the document or opening a read-only copy of the document (the AppXtender repository copy which is the document as it was when you checked it out).

For more information, refer to:
• AppXtender Modes of Operation, page 48

ODMA

The ODMA feature is an alternate way to create, index, and retrieve AppXtender documents. Before you can access this feature, ODMA support must be enabled on your AppXtender Document Manager workstation. ODMA uses the Open AppXtender Document dialog box to interface with ODMA-compliant applications and the AppXtender system to create and access AppXtender documents. For example, on the Open AppXtender Document dialog box, you can open and save non-AppXtender documents to AppXtender using the File Selection button, enter search criteria to perform queries to find existing AppXtender documents from the Search tab, and check out an existing AppXtender document for modifications, or open it as read-only from a Result Set tab like the one in AppXtender.

As soon as all modifications are completed, you can check in the modified document to AppXtender as a major revision, as a minor revision, as a new page version, or as a replacement page version (depending on your user rights). For more information on foreign files types that can be accessed using ODMA, refer to Foreign Files, page 45. For more information on using ODMA with AppXtender documents, refer to Chapter 8, Using ODMA With AppXtender Documents.

For more information, refer to:
• Ways of Using AppXtender, page 47

Selecting Data Sources

A data source is the means by which AppXtender accesses data from a database. Information that is stored in the AppXtender database includes application definitions, security information, document index information, and pointers to document locations.

Multiple data sources can be viewed simultaneously within AppXtender Document Manager. In this way, you can access applications located on different data sources during a single AppXtender Document Manager session, provided you have security rights to access those data sources.

For more information, refer to:
• Locating Data Sources, page 51
• Specifying a Default Data Source, page 54
• Specifying Multiple Data Sources, page 55
For information on data source creation and configuration, consult your AppXtender system administrator or refer to the "ApplicationXtender Data Sources" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: You can save data source settings (which data sources are default and which are selected) to a file, along with other AppXtender Document Manager workstation settings. Also, if you have such a saved settings file, you can load the data source settings from that file. For instructions, refer to Saving and Loading Settings, page 150.

Caution: All of the settings that you enter in the AppXtender Data Source Selector are stored in C:\Documents and Settings\All Users\Application Data\XSCM.CONFIG. Do not edit the contents of the XSCM.CONFIG file.

Locating Data Sources

The AppXtender Data Source Selector allows you to locate data sources from your workstation.

To locate data sources:
1. From the Windows Start menu, select Programs and then ApplicationXtender Desktop.
2. From the ApplicationXtender Desktop menu, select AppXtender Data Source Selector. The AppXtender Data Source Selector dialog box appears.

Figure 4. AppXtender Data Source Selector Dialog Box

3. Click Locate. The Data Link Properties dialog box appears.
4. Click the Provider tab label to reveal the tab.
5. On the Provider tab, select the appropriate data provider for one of the data sources in the data source group that you want to locate.

6. Click the Connection tab label to reveal the tab.
Figure 6. Data Link Properties Dialog Box - Connection Tab

7. On the Connection tab, enter appropriate server and database information.
   
   **Note:** For more information, consult your AppXtender system administrator or refer to the "ApplicationXtender Data Sources" section of the ApplicationXtender Core Components Administrator's Guide.

8. To verify that you correctly entered the server and database information, on the lower right, click Test Connection.

9. If the test is successful, save the settings by clicking OK. The Data Link Properties dialog box closes and you are returned to the AppXtender Data Source Selector dialog box.

10. To locate another data source, repeat steps 3 through 9.

11. Specify a default data source. For more information, refer to Specifying a Default Data Source, page 54.

   **Note:** You *must* specify a data source as default before you can close the AppXtender Data Source Selector dialog box.

12. To save the settings and close the dialog box, click OK.
Specifying a Default Data Source

The AppXtender Data Source Selector allows you to set a data source as default. This setting determines which data sources are in use for AppXtender Desktop, the import wizards, and AppXtender Move Online.

To set a data source as default:

1. From the Windows Start menu, select Programs and then AppXtender. From the AppXtender menu, select AppXtender Data Source Selector. The AppXtender Data Source Configuration dialog box appears.

   **Figure 7. AppXtender Data Source Selector Dialog Box**

2. In the list box, double-click the data source you want to set as default. A white check mark on a black background should appear next to it.
3. To save your setting, click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes without closing the dialog box.)

**Note:** Even when multiple data sources are designated for viewing within AppXtender Document Manager, only the data source designated as the default data source can be accessed using AppXtender Move Online.

The next time you log into AppXtender Document Manager, the default data source will automatically “open” so that you can access its applications.

For more information, refer to:
- Chapter 1, Getting Started
- Specifying Multiple Data Sources, page 55

### Specifying Multiple Data Sources

If multiple data sources are available from the AppXtender Data Source Selector dialog box, multiple data sources may be designated to be viewed from within AppXtender Document Manager. This allows authorized users to access and work with applications from two or more data sources during a single AppXtender Document Manager session.

**Note:** You can log into only those data sources for which you have a user account. For more information on creating a user account in a data source, consult your system administrator or refer to the “Implementing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

**To configure multiple data sources to be viewed in AppXtender Document Manager:**

1. Access the AppXtender Data Source Selector dialog box. For specific steps, refer to Locating Data Sources, page 51.

2. From the list of available data sources, select a data source that you want to appear within AppXtender Document Manager (other than the default data source).

3. Click Show/Hide. A black check mark should appear next to the selected data source.
4. Repeat steps 2 and 3 for each data source you want to be accessible within AppXtender Document Manager.

5. To save your settings, click OK or Apply. (OK saves your changes and closes the dialog box. Apply saves your changes without closing the dialog box.) The next time you launch AppXtender Document Manager, all data sources that you placed check marks next to are accessible.

   **Note:** Even when multiple data sources are designated for viewing within AppXtender Document Manager, only the data source designated as the default data source can be accessed using AppXtender Move Online.

---

### Starting AppXtender Document Manager

The AppXtender Document Manager program is the AppXtender module most frequently accessed by users. Documents are stored, retrieved, and processed within this module.

AppXtender is password protected, which means that it monitors each user’s activity and allows or denies access to certain information and functions based on that user’s assigned privileges. Privileges—such as the ability to display, print, fax, modify, or delete—are assigned to a user’s account by the administrator. AppXtender has varying levels of security, from initial login to document level.

The administrator can assign full system rights for all applications or different rights from one application to another. For example, a user may have full privileges for the "Purchase Orders" application but only display and print privileges for the "Human Resources" application.

Each user account is driven by the user name and password, making this information required when logging on to the system. If you have not been assigned an AppXtender user name and password, consult your AppXtender system administrator to obtain a user account.

If you cannot perform a particular AppXtender function, consult the system administrator to verify your security privileges. For more information on security in AppXtender, refer to the "Implementing Security" section of the *ApplicationXtender Core Components Administrator’s Guide*.

**Note:** Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to *Variations on Login Procedures, page 58*.

**To start AppXtender Document Manager:**

1. From the Windows Start menu, select Programs> ApplicationXtender Desktop> AppXtender Document Manager. The AppXtender Document Manager copyright screen appears for a short period of time and then closes automatically. If you are required to log in to access AppXtender Document Manager, the Login dialog box will appear next.
Figure 9. AppXtender Document Manager Login Dialog Box

2. If the Login dialog box appears, from the Logon Type drop-down list, select the logon type. The following table describes the licenses required for each logon type:

Table 2. AppXtender Desktop License Types

<table>
<thead>
<tr>
<th>Logon Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender</td>
<td>Logs into AppXtender using an AppXtender Desktop license only.</td>
</tr>
<tr>
<td>AppXtender Reports Mgmt</td>
<td>Logs into AppXtender using a AppXtender Reports Management license so that you can view AppXtender Reports Mgmt data.</td>
</tr>
<tr>
<td>AppXtender &amp; AppXtender Reports Mgmt</td>
<td>Logs into AppXtender using both an AppXtender Desktop license and an AppXtender Reports Mgmt license so that you can view both AppXtender and AppXtender Reports Mgmt data.</td>
</tr>
</tbody>
</table>

3. In the User Name text box, enter a user name that is appropriate for the selected data source.
4. In the Password text box, enter your password.
5. If you are the only person that uses AppXtender Document Manager on this workstation, to have AppXtender Document Manager remember your user name and password and bypass the Login dialog box for all subsequent logins, select the Remember password option.

**Note:** The Remember password option is only available if it has been enabled for the AppXtender Document Manager workstation. For information on disabling this feature, refer to Disabling the Remember Password Option, page 87.

6. Click Login. If the information you entered is correct, AppXtender Document Manager will start. If the information is incorrect, an error message will appear.
7. For information about AppXtender’s built-in security, consult your AppXtender system administrator or refer to the “Implementing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

**Note:** When you click Login, if a message appears indicating that AppXtender Document Manager cannot find the data source or licensing information it needs to connect to the AppXtender database, you can load settings to provide AppXtender Document Manager with connection information. For more information, refer to Disabling the Remember Password Option, page 87.
For more information, refer to:

- Chapter 1, Getting Started
- Variations on Login Procedures, page 58
- New Login, page 59
- Logging into Multiple Data Sources, page 60
- Viewing Application Properties, page 62

**Variations on Login Procedures**

The variations in login procedures depend primarily on the security provider in use for the data source. The following table describes each variation:

<table>
<thead>
<tr>
<th>Variation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the current data source is using the CM security provider</td>
<td>Passwords are <em>not</em> case-sensitive.</td>
</tr>
<tr>
<td>If the current data source is using the Windows security provider</td>
<td>When you select AppXtender Document Manager from the AppXtender Desktop menu to start the software, your current Windows user account is checked for authentication and authorization. Depending on your profile, you might be automatically logged into the software rather getting a Login dialog box. If you want the Login dialog box to appear, press [Shift] when you select AppXtender Document Manager to start the software and hold the key down until the Login dialog box appears. You must precede the user name with a domain and a backslash. For example, typing CM\axadmin indicates the &quot;axadmin&quot; user on the &quot;CM&quot; domain. Passwords <em>are</em> case-sensitive.</td>
</tr>
</tbody>
</table>

58
<table>
<thead>
<tr>
<th>Variation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the current data source is using a directory service security provider</td>
<td>Depending on configuration, you may need to specify user account information in multiple parts separated by backslashes (). The administrator who configures directory services in AppXtender Admin should distribute appropriate login instructions. For more information, consult your AppXtender system administrator or refer to the &quot;Implementing Security&quot; chapter of the ApplicationXtender Core Components Administrator’s Guide. Passwords are case-sensitive.</td>
</tr>
<tr>
<td>If the Remember Password option has been enabled in AppXtender Document Manager or AppXtender Image Capture</td>
<td>If you have logged in previously, when starting a new session, you are automatically logged in using the same logon type and your current user name.</td>
</tr>
</tbody>
</table>

For more information, refer to:
- Starting AppXtender Document Manager, page 56

### New Login

AppXtender allows you to log into AppXtender Document Manager during another user’s AppXtender Document Manager session on the same workstation. For example, when a system administrator wants to make a change to a setting on the AppXtender Configuration dialog box and comes to the workstation that Bob is logged into, he can select New Login from the File menu and log in using his user name. After making the change, he can again select New Login from the File menu and log back in as Bob.

**Note:** Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to Variations on Login Procedures, page 58.

**Note:** If the AppXtender system is using the Windows security provider and you are logging into AppXtender Document Manager on a workstation on which someone else has logged in using his or her Windows user name and password, you must have the Act as part of operating system privilege configured for your Windows user account, either on the local domain for the computer where you are logging in or on the License Server. For more information, consult your AppXtender system administrator or refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

**To log in as a new user:**

   The AppXtender Document Manager program is executed.
2. From the File menu, select New Login.
   The AppXtender Document Manager Login dialog box appears.
3. From the Logon Type drop-down list, select the logon type. For a description of each logon type, refer to Starting AppXtender Document Manager, page 56.

4. In the User Name text box, enter a user name that is appropriate for the selected data source.

5. In the Password text box, enter your password.

6. Click Login.
   If the information you entered is correct, AppXtender Document Manager restarts using the new user name and password. For more information about AppXtender’s built-in security, consult your AppXtender system administrator or refer to the “Implementing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

For more information, refer to:
- Starting AppXtender Document Manager, page 56

### Logging into Multiple Data Sources

If multiple data sources have been configured using the AppXtender AppXtender Data Source Selector, you can access them all from the AppXtender Document Manager interface. In this way, you can access applications located on many different data sources during a single AppXtender Document Manager session. For more information on data sources, refer to Selecting Data Sources, page 50.

**Note:** You can log into only those data sources for which you have a user account.

**Note:** You cannot configure Cross Application Queries to be run across data sources. Applications must reside within the same data source to be included together in a Cross Application Query.

**Note:** Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to Variations on Login Procedures, page 58.

When logging in, by default, you are logged into only one of the available data sources. To log into other data sources available in the Application view, use the following procedures.

**To log into another data source:**

1. Log into AppXtender Document Manager.
   The AppXtender Document Manager interface appears with a list of available data sources appearing within the Application view pane. The active data source (data source you logged into) appears in the data source list in bold type, and the list of applications is expanded under the data source name.
2. To log into an additional data source, right-click the data source you want to log into and select Login. The Login dialog box appears.

3. From the Logon Type drop-down list, select the logon type.

   **Note:** For a description of each logon type, refer to *Starting AppXtender Document Manager*, page 56.

4. In the User Name text box, enter a user name that is appropriate for the selected data source.

5. In the Password text box, enter your password.

6. If you are the only person that uses AppXtender Document Manager on this workstation, to have AppXtender Document Manager remember your user name and password and bypass the Login dialog box for all subsequent logins, select the Remember password option.

   **Note:** The Remember password option is only available if it has been enabled for your AppXtender Document Manager workstation. For information on disabling this feature, refer to *Saving and Loading Settings*, page 150.

7. Click Login to log into the data source.
For more information, refer to:
• Starting AppXtender Document Manager, page 56

Viewing Application Properties

The General tab of the Application Properties dialog box contains basic information about the selected application, including a description of the application, the date and time the application was created, and the write paths for documents, annotations, OCR output text, and full-text versions of documents.

To view general application properties:
1. In Application view, right-click the application name and select Properties. The Application Properties dialog box appears.
2. To display the general application properties, click the General tab.
3. When you finish viewing, click OK to close the Application Properties dialog box.

For more information, see:
• Starting AppXtender Document Manager, page 56
• Configuring the Title Bar, page 91
• Customizing Color Bar Settings for an Application, page 321

AppXtender Document Manager Views

The AppXtender Document Manager desktop consists of many views, or panes, that you can customize to fit your preferences. You can show or hide each view. If you want a certain view to always appear in a certain location on the desktop, you can dock that view on the desktop.
When two or more views are showing, only one of the views is active.

Note: If you installed the AppXtender demo database during AppXtender installation, you can use the applications and documents in that database to practice using AppXtender Document Manager views to display information.

For more information, see:
- Chapter 1, Getting Started
- Application View, page 63
- Query View, page 66
- Document Display View, page 69
- Index View, page 71
- Thumbnail View, page 73

**Application View**

The Application view contains a tree structure listing available data sources, applications, and queries.
The data source icons show which data sources you are currently logged into on your workstation. When you are logged into a data source, the icon shows a key. When you are not logged in, the icon shows a locked padlock.

**Figure 12. Application View**

```plaintext
[AXDEM0DB]
- AP - ACCOUNTS PAYABLE
- AR - ACCOUNTS RECEIVABLE
- BUSINESS-OFFICE - HEALTHCARE BUSINESS OFFICE DOCUMENTS
  - LADSON, MICHAEL
  - DONES, JAMIE M
- CHECKS - DEMO SCRIPTING APPLICATION
- COLDAPP - DEMO COLD APPLICATION
- CONADMIN - CONTRACTS (ANNOTATIONS)
- COUNTY - LAND RECORDS (FULL TEXT)
[HR - HUMAN RESOURCES]
- IMAGEAPP - MISC IMAGE APP (COLOR, PDF, ZIPS)
- LOAN_DOCUMENTS - LOAN FILES
- MEDICAL-RECORDS - CLINICAL DOCUMENTS
- REPORT-MGMT-STM - REPORT MANAGEMENT DEMO STATEMENT
- SCRIPTS - DEMONSTRATION GUIDES
- STUDENT_RECORDS - STUDENT RECORDS (AUTO & KEY REFINDS)
- TCCU - THE CONTENT CREDIT UNION
```

**Figure 13. AppXtender Data Source Icons Showing Login State**

When you are logged into more than one data source simultaneously, the name of the currently active data source appears in bold-faced type.

**Note:** For information on logging into a data source from Application view, refer to Logging into Multiple Data Sources, page 60.

To show or hide the Application view:
- From the View menu, select Applications.

For each active data source in the Application view, you can show or hide a list of its applications. You can also show or hide a list of available queries for each application.

**To show or hide applications and available queries lists:**

1. If you have not done so already, log into the data source. When you log into the data source, the data source node expands to show a list of available applications.
Figure 14. Data Source Node Expanded

![Documentation]

- FORMS - FORMS OVERLAY APPLICATION
- RSTAMP - RUBBER STAMP APPLICATION
- AP - ACCOUNTS PAYABLE
- AR - ACCOUNTS RECEIVABLE
- BUSINESS-OFFICE - HEALTHCARE BUSINESS OFFICE DOCUMENTS
  - CHECKS - DEMO SCRIPTING APPLICATION
  - COLDAPP - DEMO COLD APPLICATION
  - CONADMIN - CONTRACTS (ANNOTATIONS)
  - COUNTY - LAND RECORDS (FULL TEXT)
- HR - HUMAN RESOURCES
- IMAGEAPP - MISC IMAGE APP (COLOR, PDF, ZIPS)
- LOAN_DOCS - LOAN FILES
- MEDICAL-RECORDS - CLINICAL DOCUMENTS
- REPORT-MGMT-STMT - REPORT MANAGEMENT DEMO STATEMENTS
- SCRIPTS - DEMONSTRATION GUIDES
- STUDENT_RECORDS - STUDENT RECORDS (AUTO & KEY REF INDEX)
- TCCU - THE CONTENT CREDIT UNION

Note: For information on logging into a data source from Application view, refer to Logging into Multiple Data Sources, page 60.

2. To show a list of available queries for an application, click the plus sign to the left of the application name. The plus sign changes to a minus sign, and the application node expands to show a list of available queries.

Figure 15. Application Node Expanded

- IMAGEAPP - MISC IMAGE APP (COLOR, PDF, ZIPS)
  - Invoice with Rubber Stamp Signature
  - Miscellaneous Document Rubber Stamp example
  - Username Rubber Stamp example
  - Color image query
  - X-Ray query
  - New Query [2]

3. To hide the list of queries, click the minus sign to the left of the application name. The application node closes, and the minus sign changes to a plus sign.

Figure 16. Application Node Closed

- IMAGEAPP - MISC IMAGE APP (COLOR, PDF, ZIPS)

4. To hide the list of applications, click the minus sign to the left of the data source name. The list closes, and the minus sign changes to a plus sign.

Figure 17. Data Source Node Closed

- Documentation
Showing and Hiding Application Lists Using a Shortcut Menu

Another way to show or hide the list of available applications and queries for a data source is by selecting from a shortcut menu.

To show or hide lists of applications and queries using shortcut menu commands:

1. If you have not done so already, log into the data source.
   
   **Note:** For information on logging into a data source from Application view, refer to Logging into Multiple Data Sources, page 60.

2. To access the shortcut menu for the data source, right-click the data source name.
   
   When the shortcut menu appears, you have the following choices:
   
   • To show the list of applications, click Expand.
   
   • To show the list of applications and the list of queries for each application, click Expand All.
   
   • To hide the lists, click Collapse.

Activating an Application

To work with an application, you must first activate it.

To activate an application:

• Double-click the application name. The application name appears in bold-faced type, indicating the application is now active.

**Note:** When you are logged into two or more data sources and you activate an application located in a data source other than the currently active data source, you also activate the data source in which the application is located.

For more information, see:

• AppXtender Document Manager Views, page 62

Query View

The Query view is a tabbed dialog box containing the Search tab, the Result Set tab, and the Text Search tab. The Search tab allows you to query for AppXtender documents by entering index data, full-text data, or both index and full-text data as search criteria. The Result Set tab and Text Search tab show the results of the queries you perform from the Search tab (the result set).

To show the Query view for a new query:

• In the Application view, right-click the name of the application you want to query. A shortcut menu appears.

• From the menu, select New Query. The Query view appears with the Search tab revealed.
Search Tab

The application fields available for searching are listed in a table on the Search tab of the Query view.

Figure 18. Query View: Search Tab

You set up queries by entering values in the Value column of the table. (The procedure to query an application is discussed in detail in Chapter 5, Retrieving Documents.)

You can adjust the height of the table cells on the Search tab to suit your preferences, as well as restore resized cells to the default height.

To change cell height for a row:
- In the Fields column, drag the lower boundary line for the row you want to resize up or down to increase or decrease the height of the cells.
Note: Resizing the height of the cells in a row does not change the height of the cells in the other rows on the Search tab.

To restore resized cells to the default height:
- In the Fields column, right-click and then select Restore Cells. AppXtender Document Manager automatically resets all cells to their default height.

Result Set Tab

When you search for documents, if the search is successful, the search results appear on the Result Set tab of the Query view.

Figure 19. Query View: Result Set Tab

From the list on the Result Set tab, you can select documents and then select commands from the Document menu to process those documents. For example, you can display, print, fax, or delete documents from the Result Set, or you can submit them to the AppXtender Index Server.

Note: If only one document matches the search criteria, the document automatically appears in the Document Display view. For more information, refer to Document Display View, page 69.
When you create and run a query, the query is automatically added to the list of queries for the corresponding application in the Application view. This way, you can run the query later in the session without having to enter the search criteria again.

Figure 20. New Query Listed Under Application in Application View

Running an Existing Query

If you want to run a query in later sessions, you can save the search criteria and give the query a name. Otherwise, any queries you create during a session are deleted when you exit AppXtender Document Manager.

To run an existing query:
1. In the Application view, expand the node for the application.
2. Double-click the name of the query you want to run.

Showing or Hiding the Query View

To show or hide the Query view:
• From the View menu, select Query.

For more information, see:
• AppXtender Document Manager Views, page 62

Document Display View

The Document Display view allows you to view a stored document after you have retrieved it or a new document while you are indexing it. For information on adding and indexing new documents, refer to Chapter 3, Creating Documents.

To display a stored document in Document Display view:
1. Access the Query view and search for the document you want to display.
2. On the Result Set tab in the Query view, double-click the entry for the document you want to view. The document appears in the Document Display view.
Figure 21. Document Display View

Note: For more information on retrieving stored documents, refer to Chapter 5, Retrieving Documents.

When you display a document in the Document Display view, an image toolbar appears below the main toolbar on your desktop.

You can use the pointer to manipulate the displayed document in several ways, depending on the current pointer mode. In pan mode, you can drag the image in the view to see more of it. In selection mode, you can select a region of the image and implement one or more commands on that region.

To switch between pan mode and selection mode:
- On the Image toolbar, click the Pan Mode button.
For more information, see:
• AppXtender Document Manager Views, page 62

Index View

In the Index view, you can index new documents and view existing index information for displayed documents. For information on indexing new documents, refer to Indexing New Documents, page 205. For information on modifying indexes, refer to Modifying Document Indexes, page 350.

There are three separate Index views in AppXtender Document Manager: the Index view that appears when you add a new document, the Index view that appears when you display an existing document index, and the Index view that appears when you use the AppXtender Document Manager Batch Index function. By default, each of these Index views appears to the left of the Document Display view.

Each of the three Index views can be repositioned in relation to the Document Display view based on your preferences. When you reposition an Index view, AppXtender Document Manager saves
the new position information. The next time you open that Index view, AppXtender Document Manager displays it in the new position instead of in the default position. For example, if you select Document, New, and then any option from the menu that appears (such as Scan, Clipboard Paste, Clipboard Paste Special, Insert Object, Import File, or Fax-in Queue), the Index view appears to the left of the Document Display view. If you then move the Index view to the right of the Document Display view, the next time you select Document, New, and an option, the associated Index View will appear to the right of the document.

AppXtender Document Manager saves the position of each of the three Index views separately. Changing the position of one Index view does not affect the position of the other two views.

**Showing and Hiding the Index View**

To show the Index view:

- Click the Index View button on the Image toolbar until the Index view appears where you want it. You can display it to the left, right, top, or bottom of the Document Display view.

**Figure 24. Index View Button**

![Index View Button](image)

Note: This button is available only when a document is displayed.

To hide the Index view:

- Click the Index View button on the Image toolbar until the Index view is hidden.

**Adjusting Cell Height**

You can also change the height of Index view cells and then restore them to their original size.

To change cell height for a row in Index view:

- In the Fields column, drag the lower boundary line for the row you want to resize up or down to increase or decrease the height of the cells.
Note: Resizing the cell height for a row does not change the height of the cells in the other rows.

To restore resized cells to the default height:
- In the Fields column, right-click and then select Restore Cells. AppXtender Document Manager automatically resets all cells to their default height.

For more information, see:
- AppXtender Document Manager Views, page 62

**Thumbnail View**

The Thumbnail view contains a series of miniature images or icons representing the pages of the currently displayed document.

**Figure 25. Thumbnail View**

A thumbnail appears either as a miniature rendering of the image in the Document Display view or as an icon. The following table provides information of the types of thumbnails used to represent different page types:
### Table 4. Page and Thumbnail Types

<table>
<thead>
<tr>
<th>Page Type</th>
<th>Thumbnail Type</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image</td>
<td>Miniature image</td>
<td><img src="image1.png" alt="Image Miniature" /></td>
</tr>
<tr>
<td>COLD/ERM text (with or without form overlay)</td>
<td>Icon</td>
<td><img src="image2.png" alt="Icon" /></td>
</tr>
<tr>
<td>Foreign file</td>
<td>Icon or miniature image, depending on configuration</td>
<td><img src="image3.png" alt="Icon" />  <img src="image4.png" alt="Miniature Image" /></td>
</tr>
<tr>
<td>OLE</td>
<td>Miniature image</td>
<td><img src="image5.png" alt="Miniature Image" /></td>
</tr>
<tr>
<td>PDF</td>
<td>Icon (foreign file icon or Adobe Acrobat Document icon, depending on configuration)</td>
<td><img src="image6.png" alt="Adobe Acrobat Document" /></td>
</tr>
<tr>
<td>RTF</td>
<td>Icon or miniature image, depending on configuration</td>
<td><img src="image7.png" alt="Miniature Image" /></td>
</tr>
<tr>
<td>HTML</td>
<td>Icon</td>
<td><img src="image8.png" alt="Icon" /></td>
</tr>
</tbody>
</table>

Page 2, Page 1, Page 4, Page 4, Page 3, Page 4, Page 4, Page 5, Page 5, Page 6
For information on configuring thumbnails, including the options to display foreign file thumbnails and RTF thumbnails as miniature images, see Thumbnail Tab, page 147 the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

To show or hide the Thumbnail view:
- From the View menu, select Thumbnail.

**Note:** Depending on the configuration of your AppXtender Document Manager workstation, thumbnails do not always appear when Thumbnail view appears. For information on displaying thumbnails in Thumbnail view, Displaying Thumbnails, page 298.

For more information, see:
- AppXtender Document Manager Views, page 62

## AppXtender Document Manager Toolbars

ApplicationXtender Document Manager (AppXtender Document Manager) has six toolbars. These toolbars provide shortcut buttons for the most frequently used AppXtender Document Manager commands. When the mouse pointer is held over a toolbar button, a description of the button’s function appears as a tool tip and in the status bar.

Each toolbar can be shown or hidden, depending on your preference. You can also customize the toolbars based on your work requirements. For information on showing, hiding, and customizing a toolbar, refer to Configuring Toolbars, Title Bar, and Status Bar, page 87.

For information on each of the toolbars, refer to the following topics:
- Main Toolbar, page 75
- Annotation Toolbar, page 77
- Image Toolbar, page 79
- Script Toolbar, page 81
- Batch Index Toolbar, page 81
- Scan Toolbar, page 82

## Main Toolbar

The Main toolbar contains buttons that allow you to access the essential functions of AppXtender Document Manager.

**Figure 26. AppXtender Document Manager Main Toolbar**

The following table describes the function of each button on the Main toolbar:
Table 5. AppXtender Document Manager Main Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button]</td>
<td>Shows or hides the Application view.</td>
<td>Application View, page 63</td>
</tr>
<tr>
<td>![Button]</td>
<td>Shows or hides the Query view for the current query.</td>
<td>Query View, page 66</td>
</tr>
<tr>
<td>![Button]</td>
<td>Shows or hides the Thumbnail view.</td>
<td>Thumbnail View, page 73</td>
</tr>
<tr>
<td>![Button]</td>
<td>Runs the selected query.</td>
<td>Running a Query, page 291</td>
</tr>
<tr>
<td>![Button]</td>
<td>Begins a new query on the active application.</td>
<td>Searching a Single Application, page 243</td>
</tr>
<tr>
<td>![Button]</td>
<td>Opens the New Cross Application Query dialog box so you can configure a new query that searches across multiple applications.</td>
<td>Creating a New Cross Application Query, page 259</td>
</tr>
<tr>
<td>![Button]</td>
<td>Depending on how the Print feature is configured, prints either the currently displayed document or the currently displayed page. <strong>Note:</strong> If the Print configuration is set to Prompt, when you use the Print toolbar button to print, regardless of which option you select from the Print dialog box, only the currently displayed page will print.</td>
<td>Printing or Faxing Documents and Pages, page 354</td>
</tr>
<tr>
<td>![Button]</td>
<td>Cuts the displayed page to the Windows Clipboard.</td>
<td>Adding a Document from the Windows Clipboard, page 173 and Adding a Page from the Windows Clipboard, page 341</td>
</tr>
<tr>
<td>![Button]</td>
<td>Copies the displayed page to the Windows Clipboard.</td>
<td>Adding a Document from the Windows Clipboard, page 173 and Adding a Page from the Windows Clipboard, page 341</td>
</tr>
<tr>
<td>![Button]</td>
<td>Creates a new document from the Windows Clipboard or adds a new page to the displayed document from the Windows Clipboard.</td>
<td>Adding a Document from the Windows Clipboard, page 173 and Adding a Page from the Windows Clipboard, page 341</td>
</tr>
</tbody>
</table>
**Button** | **Function** | **For More Information, Refer To:**
--- | --- | ---
🔍 | Performs a text search on the currently displayed document. | Text Search from the Result Set, page 288
🔧 | Opens the AppXtender Configuration dialog box. | Customizing AppXtender Document Manager Views, page 95
🗖️ | Vertically tiles multiple documents in Document Display view. | Tile, page 303
🗖️ | Horizontally tiles multiple documents in Document Display view. | Tile, page 303
🗖️ | Cascades multiple documents in Document Display view. | Cascade, page 302
🗖️ | Maximizes the Document Display view and any open toolbars to fill the entire screen. If the Index view and the Thumbnail view are open, they will appear along with the Document Display view. | Activating AppXtender Document Manager Full Screen Mode, page 99
🔍 | Opens the Select Scanner dialog box. | Selecting a Scanner, page 224
🔍 | Scans a new document into the active application. | Scanning Documents, page 231

For more information, see:
- AppXtender Document Manager Toolbars, page 75

## Annotation Toolbar

The Annotation toolbar allows you to add annotations to documents and batch pages. All of the functions available from the Annotation toolbar can also be accessed from the Annotate menu.

**Figure 27. AppXtender Annotation Toolbar**

![Annotation Toolbar](image)

**Note:** Only users with appropriate privileges can access commands and buttons in the Annotations menu and toolbar. If you have questions about the privileges assigned to your AppXtender user...
profile, consult your AppXtender system administrator or refer to the "Implementing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

This topic briefly explains the function of each Annotation toolbar button. For more information on adding an annotation, refer to Chapter 9, Annotations.

Table 6. Annotation Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Allows selection of annotations (toggle). For information, refer to Modifying Annotation Settings, page 476.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a text annotation. For information, refer to Creating Text Annotations, page 454.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a highlight annotation. For information, refer to Creating a Highlight Annotation, page 453.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a freehand line annotation. For information, refer to Creating a Basic Line Annotation, page 450.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a straight line annotation. For information, refer to Creating a Basic Line Annotation, page 450.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates an arrow annotation. For information, refer to Creating a Basic Line Annotation, page 450.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a rectangular annotation. For information, refer to Creating a Basic Shape Annotation, page 452.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a rounded rectangular annotation. For information, refer to Creating a Basic Shape Annotation, page 452.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates an oval annotation. For information, refer to Creating a Basic Shape Annotation, page 452.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a polyline annotation. For information, refer to Creating a Polygon Annotation, page 453.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a polygon annotation. For information, refer to Creating a Polygon Annotation, page 453.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Erases the annotation. For information, refer to Erasing Annotations, page 485.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates a filled or hollow annotation (toggle). For information, refer to Default Filled or Hollow Setting, page 448.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Creates an annotation with redaction (toggle). For information, refer to Default Redaction Setting, page 448.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Selects the default annotation group. For information, refer to Assigning a Default Annotation Group, page 468.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Selects all annotations. For information, refer to Modifying Annotation Settings, page 476.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Moves the selected annotation in front of another annotation. For information, refer to Overlapping Annotations, page 467.</td>
</tr>
</tbody>
</table>
### Getting Started

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Sends the selected annotation behind another annotation. For information, refer to Overlapping Annotations, page 467.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Shows or hides annotations (toggle); allows you to hide annotations by annotation group. For information, refer to Showing or Hiding Annotations, page 469.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Selects line width. For information, refer to Default Line Width, page 446.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Selects annotation colors. For information, refer to Default Color for Line and Shape Annotations, page 447.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Deletes the selected annotations. For information, refer to Deleting Annotations, page 486.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Saves all annotations.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Cancels annotation changes.</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Adds the selected rubber stamp annotation to a page. For information, refer to Adding Rubber Stamp Annotations to Pages, page 464.</td>
</tr>
</tbody>
</table>

For more information, see:
- AppXtender Document Manager Toolbars, page 75

### Image Toolbar

The Image toolbar contains buttons that allow you to manipulate to document images appearing in the Document Display view.

**Figure 28. AppXtender Document Manager Image Toolbar**

The following table describes the function of each button on the Image toolbar:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Displays the selected view of the current page (rotated, enlarged, reduced, fit top to bottom, fit left to right) in the Document Display view.</td>
<td>Using Sticky View, page 93</td>
</tr>
<tr>
<td><img src="image" alt="Button" /></td>
<td>Fits the displayed page in the Document Display view.</td>
<td>Fit to Window, page 309</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
<td>For More Information, Refer To</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Fits the displayed page in the Document Display view from top to bottom.</td>
<td>Fit to Window Height, page 309</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Fits the displayed page in the Document display view from left to right.</td>
<td>Fit to Window Width, page 309</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Rotates the displayed page 90° to the left in the Document Display view.</td>
<td>Rotate Left, page 310</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Rotates the displayed page 90° to the right in the Document Display view.</td>
<td>Rotate Right, page 311</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Zooms in so the image in the Document Display view appears larger.</td>
<td>Zoom In, page 307</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Zooms out so the image in the Document Display view appears smaller.</td>
<td>Zoom Out, page 308</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Opens the Magnifier window.</td>
<td>Using the Magnifier, page 311</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Displays the previous page of a multipage document.</td>
<td>Previous Page, page 297</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Displays the next page of a multipage document.</td>
<td>Next Page, page 296</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Displays the previous version of the page in the Document Display view.</td>
<td>Previous Version, page 300</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Displays the next version of the page in the Document Display view.</td>
<td>Next Version, page 301</td>
</tr>
<tr>
<td><img src="image12.png" alt="Icon" /></td>
<td>Shows the text or the image for the displayed document.</td>
<td>Viewing Image Pages, page 318</td>
</tr>
<tr>
<td><img src="image13.png" alt="Icon" /></td>
<td>Performs optical character recognition (OCR) on the displayed page.</td>
<td>Processing a Page Using OCR, page 384</td>
</tr>
<tr>
<td><img src="image14.png" alt="Icon" /></td>
<td>Switches the Document Display view between pan mode and selection mode.</td>
<td>Document Display View, page 69</td>
</tr>
<tr>
<td><img src="image15.png" alt="Icon" /></td>
<td>Shows or hides Index view.</td>
<td>Index View, page 71</td>
</tr>
<tr>
<td><img src="image16.png" alt="Icon" /></td>
<td>Shows or hides form overlays on COLD/ERM documents.</td>
<td>Viewing Documents with Form Overlay, page 318</td>
</tr>
<tr>
<td><img src="image17.png" alt="Icon" /></td>
<td>For ICE format pages, displays the previous subpage. This button is available only if it has been added through the Customize Toolbar dialog box.</td>
<td>Viewing Subpages, page 301</td>
</tr>
<tr>
<td><img src="image18.png" alt="Icon" /></td>
<td>For ICE format pages, displays the next subpage. This button is available only if it has been added through the Customize Toolbar dialog box.</td>
<td>Viewing Subpages, page 301</td>
</tr>
</tbody>
</table>
For more information, see:

- AppXtender Document Manager Toolbars, page 75

### Script Toolbar

The Script toolbar allows you to perform up to 20 script-based functions. In order to activate the buttons on this toolbar, your system administrator must create a file named AEX32.TXT containing a script that assigns AppXtender Document Manager functions to the Script toolbar buttons.

**Figure 29. AppXtender Document Manager Script Toolbar**

![Script Toolbar]

The AppXtender Desktop software development kit (SDK) provides documentation on AppXtender Document Manager scripting. For more information, contact your sales representative.

For more information, AppXtender Document Manager Toolbars, page 75 see:

- AppXtender Document Manager Toolbars, page 75

### Batch Index Toolbar

The Batch Index toolbar allows you to perform batch indexing operations.

**Figure 30. AppXtender Document Manager Batch Index Toolbar**

![Batch Index Toolbar]

**Note:** For information on batch indexing, refer to Indexing Batches, page 213

The following table describes the function of each button on the Batch Index toolbar:

**Table 8. AppXtender Document Manager Batch Index Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Creates a new document and attaches the current page in the batch to the new document." /></td>
<td>Creates a new document and attaches the current page in the batch to the new document.</td>
</tr>
<tr>
<td><img src="image" alt="Attaches the current page in the batch to the current document." /></td>
<td>Attaches the current page in the batch to the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Attaches all pages in the batch to the current document." /></td>
<td>Attaches all pages in the batch to the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Deletes the current page from the batch or the current document." /></td>
<td>Deletes the current page from the batch or the current document.</td>
</tr>
</tbody>
</table>
Scan Toolbar

The Scan toolbar allows you to perform and configure scanning operations. All of the functions on the Scan toolbar can also be accessed from the Scan menu.

Figure 31. AppXtender Scan Toolbar

This topic briefly explains the function of each Scan toolbar button and drop-down list. For more information on scanning, refer to Chapter 4, Scanning.

Note: All of the following conditions must be met for a user to access features in the Scan toolbar or menu:

• Scanning hardware is installed on the user’s workstation
• The scanner drivers appropriate for the scanner are installed on the user’s workstation
• AppXtender Document Manager scanner support files are installed on the user’s workstation
• AppXtender scanning privileges are assigned to the user

For information on hardware and drivers, refer to the documentation provided by the scanner manufacturer. For a list of scanners that AppXtender supports, refer to Selecting a Scanner, page 224. For information on support files and privileges, consult your AppXtender system administrator or refer to the ApplicationXtender Installation Guide and the ApplicationXtender Core Components Administrator’s Guide.

Table 9. AppXtender Document Manager Scan Toolbar Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Scan Button]</td>
<td>Begins a scanning session. If a document is displayed in Document Display view, AppXtender Document Manager creates a new page. If no document is displayed, AppXtender Document Manager creates a new document.</td>
</tr>
<tr>
<td>![Repeat Button]</td>
<td>Repeats the previous scan.</td>
</tr>
</tbody>
</table>
## Getting Started

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄️</td>
<td>Enables auto feed mode. In auto feed mode, AppXtender Document Manager scans all of the pages in the feeder and then ends the scan session.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Enables manual feed mode. In manual feed mode, AppXtender Document Manager scans all of the pages in the feeder and then waits for you to add more pages to the feeder. If you do not add more pages before the scan session times out, the session ends.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Enables single feed mode. In single feed mode, AppXtender Document Manager scans only one page at a time. After each page is scanned, you must click the Scan button again to scan the next page.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Configures the automatic rotation of images as they are scanned.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Configures the automatic rotation of images as they are scanned.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Displays a shortcut menu so that you can configure scanning.</td>
</tr>
<tr>
<td>🔄️</td>
<td>Enables or disables automatic enhancement of images as they are being scanned.</td>
</tr>
</tbody>
</table>

In addition to these buttons, the Scan toolbar also has four drop-down lists. These lists allow you to change the following settings for the images that you scan:

- DPI resolution setting
- Color
- Page size
- Scanner source

For more information, see:
- AppXtender Document Manager Toolbars, page 75

## Function Keys

AppXtender Document Manager provides function keys that help you perform indexing and searches. The available function keys are identified and their functions are described in the following table.

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F1]</td>
<td>Opens online help.</td>
</tr>
<tr>
<td>[F3]</td>
<td>Opens the Search dialog box. This key functions for text documents only. For more information, refer to Text Search from the Document Display View, page 287.</td>
</tr>
</tbody>
</table>

Table 10. AppXtender Document Manager Function Keys
<table>
<thead>
<tr>
<th>Function Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F4]</td>
<td>Searches for existing document indexes during the indexing process, allowing you to append pages to existing documents. For more information, refer to Appending Pages to Documents, page 209.</td>
</tr>
<tr>
<td>[SHIFT]+[F4]</td>
<td>Searches for unused Key Reference records that meet specified criteria and documents previously indexed with the same values. For more information, refer to Using AppXtender Key Reference Import to Index Documents, page 208.</td>
</tr>
<tr>
<td>[F5]</td>
<td>Displays the List of Values dialog box for the selected index field. This key functions during search only. For more information, refer to List of Values Query, page 249.</td>
</tr>
<tr>
<td>[F7]</td>
<td>Performs auto-indexing. This key functions during document creation for Auto Index fields only. For more information, refer to Using AppXtender Auto Index Import to Index Documents, page 207.</td>
</tr>
<tr>
<td>[F8]</td>
<td>Displays the Search Expression dialog box for the selected index field. This key functions during search only. For more information, refer to Expression Range Query, page 247.</td>
</tr>
<tr>
<td>[F9]</td>
<td>Duplicates index data from the last document index saved. This key functions during document creation only. For more information, refer to Automated Indexing Features, page 205.</td>
</tr>
</tbody>
</table>
Many configuration options are available to accommodate individual workstation preferences. Some configuration options are integral to AppXtender’s functionality, such as a default digital certificate, the file types and formats that AppXtender uses, and interface options with mail and optical character recognition (OCR) packages.

Other configuration options are cosmetic and do not alter the way the system performs, such as options controlling the look and feel of the AppXtender Document Manager interface. You can adjust the layout of the AppXtender Document Manager desktop and the behavior of the desktop views. You can also customize toolbar display and settings.

- Change Password, page 86
- Configuring Toolbars, Title Bar, and Status Bar, page 87
- Print Setup, page 92
- Using Sticky View, page 93
- Customizing AppXtender Document Manager Views, page 95
- Opening the Configuration Dialog Box, page 103
- View Tab, page 104
- Display Tab, page 109
- Fonts Tab, page 112
- Scan Tab, page 115
- Saving and Loading Settings, page 150

**Note:** The AppXtender Add-in for Microsoft Outlook allows you to map Outlook fields with AppXtender index fields so that you can create AppXtender documents by copying or moving items (mail, appointments, meeting requests, and contacts) from Outlook to AppXtender. You can also configure the add-in to monitor folders for incoming items and automatically export these items to AppXtender. For more information, refer to the *Microsoft Outlook Integration for ApplicationXtender Guide.*
Change Password

AppXtender is password protected. If the AppXtender system is using the CM security provider, you can change your password at any time to ensure system security.

Note: If the AppXtender system is using the CM security provider, AppXtender passwords are not case-sensitive.

Note: If the AppXtender system is using the Windows security provider or a directory service security provider, you cannot change your password in AppXtender. The only user whose password can be changed when AppXtender is using the Windows security provider is the SYSOP user. To change your Windows password, refer to your Windows documentation. To change your directory service password, refer to your directory service documentation.

To change your password:

1. From the File menu, select Change Password. The Change Password dialog box appears, with the current user name in the User Name text box.

Figure 32. Change Password Dialog Box

2. In the Current Password text box, type the original password for the current user name.

Note: If you have forgotten your password, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

3. In the New Password text box, type the new password that you want to use for the current user name.

4. In the Confirm New Password text box, type the new password again. The purpose of this step is to ensure data entry accuracy.

5. Click OK. The new password is saved with the current user name.
For more information, see:

- Disabling the Remember Password Option, page 87

## Disabling the Remember Password Option

If you chose to enable Remember password while logging into AppXtender Document Manager, the Login dialog box no longer appears when you open AppXtender Document Manager. (For instructions on enabling the Remember password feature, refer to Starting AppXtender Document Manager, page 56.) The following procedure describes how to disable the Remember password option, so that the Login dialog box appears when you open AppXtender Document Manager.

**To disable the Remember Password feature:**

1. From the File menu, select Change Password. The Change Password dialog box appears.
2. Clear the Remember Password check box and click OK.

The next time you start AppXtender Document Manager, the Login dialog box appears because AppXtender Document Manager no longer remembers your password.

**Note:** If the Allow remember password option is not enabled in the Data tab of the AppXtender Document Manager Configuration dialog box, the Remember Password option will not be available. For more information on the Data tab options, consult your AppXtender system administrator or refer to the "Configuring AppXtender Document Manager Workstations" chapter of the ApplicationXtender Installation Guide.

## Configuring Toolbars, Title Bar, and Status Bar

You can customize the ApplicationXtender Document Manager (AppXtender Document Manager) toolbars, the Document Display view title bar, and the AppXtender Document Manager status bar to meet your needs. For instructions, refer to the following topics:

- Displaying or Hiding a Toolbar, page 88
- Changing the Size of Toolbar Buttons, page 89
- Customizing Toolbars, page 90
- Configuring the Title Bar, page 91
- Displaying or Hiding the Status Bar, page 92

The following table briefly describes the functions available on each toolbar:
Table 11. AppXtender Document Manager Toolbars

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main</td>
<td>The Main toolbar provides shortcuts to common AppXtender commands, such as print, scan, query, and configure. These commands can be executed by clicking the buttons on the toolbar, eliminating the series of steps necessary when using the pull down menus. For a detailed description of each button on the Main toolbar, refer to Main Toolbar, page 75.</td>
</tr>
<tr>
<td>Annotation</td>
<td>The Annotation toolbar contains shortcuts to the annotation features, such as select, save, delete, and create. For a detailed description of each button on the Annotation toolbar, refer to Annotation Toolbar, page 77.</td>
</tr>
<tr>
<td>Image</td>
<td>The Image toolbar provides shortcuts for manipulating images. Some of the buttons available are pan mode, process a page using OCR, show index value, rotating, and zooming. For a detailed description of each button on the Image toolbar, refer to Image Toolbar, page 79.</td>
</tr>
<tr>
<td>Script</td>
<td>The Script toolbar provides shortcuts for up to 20 script-based functions. In order to activate the buttons on this toolbar, your system administrator must create a file named AEX32.TXT containing a script that assigns AppXtender functions to the Script toolbar buttons. The AppXtender software development kit (AppXtender SDK) provides documentation on AppXtender scripting. For more information, contact your sales representative.</td>
</tr>
<tr>
<td>Batch Index</td>
<td>The Batch Index toolbar provides shortcuts to the batch indexing feature. From the Batch Index toolbar, you can create new documents and pages from a batch, delete a page from a batch, and navigate from page to page in a batch or document. For a detailed description of each button on the Batch Index toolbar, refer to Batch Index Toolbar, page 81.</td>
</tr>
<tr>
<td>Scan</td>
<td>The Scan toolbar contains shortcuts for scanning options and configuration settings such as manual feed, auto feed, single feed, rescan, and different automatic-rotation options. For a detailed description of each button on the Scan toolbar, refer to Scan Toolbar, page 82.</td>
</tr>
</tbody>
</table>

Displaying or Hiding a Toolbar

AppXtender Document Manager toolbars can be shown or hidden from view. All AppXtender features are always available from menus, even if the toolbar is hidden. Toolbars can be removed to create more space for displaying documents.
Figure 33. Displaying Toolbars

To display or hide a toolbar:

1. From the View menu, select Toolbars. In the Toolbars submenu, the name of each displayed toolbar has a check mark next to it.

2. In the Toolbars submenu, click the name of the toolbar you want to display or hide. If the toolbar you selected was previously displayed, it is now hidden. If the toolbar you selected was previously hidden, it is now displayed.

Changing the Size of Toolbar Buttons

The default size of AppXtender Document Manager toolbar buttons may be too small for some users. You can change the size of AppXtender Document Manager toolbar buttons, if necessary.

To make small toolbar buttons larger:

1. From the View menu, select Toolbars. In the Toolbars submenu, a check mark indicates the current button size setting.

2. If Small Icons are enabled, in the Toolbars submenu, click Large Icons. The buttons increase in size.
To make large toolbar buttons smaller:
1. From the View menu, select Toolbars. In the Toolbars submenu, a check mark indicates the current button size setting.
2. If Large Icons are enabled, in the Toolbars submenu, click Small Icons. The buttons decrease in size.

Customizing Toolbars

Any AppXtender Document Manager toolbar can be customized to meet your needs. Buttons can be deleted from the toolbar, added to the toolbar, or reordered.

To customize a toolbar:
1. Right-click the toolbar to be customized. From the shortcut menu that appears, select Customize. The Customize Toolbar dialog box appears.

![Customize Toolbar Dialog Box](image)

2. You have several choices:
   - Remove buttons from the toolbar by double-clicking on the button name in the Current toolbar buttons list or by selecting the button name and clicking Remove.
   - Add buttons to the toolbar by double-clicking on the button name in the Available buttons list or by selecting the button name and clicking Add.
   - Re-order buttons by selecting a button name in the Current toolbar buttons list and clicking Move Up or Move Down or by dragging the button name to the new location.
   - Reset to a pre-defined list of toolbar buttons by clicking Reset.
3. After you have completed customizing the toolbar, click Close.
Configuring the Title Bar

When documents are displayed in the Document Display view, information about each document appears in the Document Display view title bar, including a value for each document from one of its index fields. If a document window is maximized in the Document Display view, this information appears in the title bar for the main AppXtender Document Manager window.

For each application, you can specify which index field is used to populate the title bar. You can also configure the title bar to display the name of the AppXtender data source that contains the document, the name of the application that contains the document, or both for each application.

To configure the Document Display view title bar:

1. In the Applications view, right-click the application for which you want to configure the Document Display view title bar. From the shortcut menu that appears, select Properties. The Properties dialog box for that application appears.

2. Select the Title tab.

Figure 35. Properties Dialog Box: Title Tab

3. Specify whether you want the name of the AppXtender data source to appear in the Document Display view title bar. You have the following choices:
   - To include the name of the AppXtender data source, enable the Data Source Name check box.
   - To leave out the name of the AppXtender data source, clear the Data Source Name check box.
4. Specify whether you want the name of the application to appear in the Document Display view title bar. You have the following choices:
   • To include the name of the application, enable the Application Name check box.
   • To leave out the name of the application, clear the Application Name check box.

5. In the Field Value of drop-down list, select the name of the index field that you want to include in the Document Display view title bar.

6. Save your changes. You have the following choices:
   • To save changes and keep the Properties dialog box open, click Apply.
   • To save changes and close the Properties dialog box, click OK.

The next time you display a document, the Document Display view title bar reflects your changes.

For more information, see:
   • Viewing Application Properties, page 62
   • Customizing Color Bar Settings for an Application, page 321

### Displaying or Hiding the Status Bar

The status bar appears at the bottom of the AppXtender Document Manager desktop and contains each of the following from left to right:
   • Help messages for AppXtender Document Manager functions, describing toolbar button functions and menu item functions
   • The name of the active application
   • The page number of the currently displayed page
   • The total number of pages in the currently displayed document
   • The version number of the currently displayed version
   • The total number of versions in the currently displayed page

The AppXtender Document Manager status bar can be removed from the desktop to save space for the Document Display view.

**To display or hide the status bar:**

1. Click the View menu. In the View menu, the Status Bar command has a check mark next to it if the status bar is currently displayed.
2. From the View menu, select Status Bar. If the status bar was previously displayed, it is now hidden. If the status bar was previously hidden, it is now displayed.

### Print Setup

The Print Setup dialog box allows you to set up the default print settings. From this dialog box, you can select the printer, the orientation, the paper size, the paper source, and other properties of future print jobs.
To configure printing:

1. From the File menu, select Print Setup. The standard Windows Print Setup dialog box appears.

Figure 36. Print Setup Dialog Box

2. If you want to connect to a printer on the network, click Network. For further instructions, refer to your Windows documentation.

3. In the Print Setup dialog box, select a default printer from the Name list, and select the default paper size, source, and orientation.

4. If you want to configure advanced properties of the selected printer, click Properties. For further instructions, refer to your Windows documentation.

5. Click OK. The dialog box closes and the changes you have made are saved.

Using Sticky View

Sticky View means that AppXtender Document Manager can “remember” display settings (zoom, rotation, and scale-to-gray) for similar page types. For example, bi-tonal (black and white) pages can be “stuck” to open with certain zoom and rotation settings. A different Sticky View could be set for bitmaps. Sticky View can be helpful when scanning similar paper documents, by displaying the page at its actual size to facilitate monitoring the quality of the scan. AppXtender Document Manager automatically discerns which page type is displayed and responds with the appropriate settings.

You can use Sticky View with the following page types. (The Information dialog box displays a page's type. For more information, refer to Page Information, page 336.)

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
• COLD/ERM/Text with no overlay
• Text (as defined in the File Types tab of the Configuration dialog box)
• OLE Objects

Note: For more information on the File Types tab of the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” chapter of the ApplicationXtender Installation Guide.

Sticky View is different from the default display configuration in that the pages are not stored with the sticky settings; the pages appear in Sticky View simply for document creation and retrieval. The sticky settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:
• Zoom, as described in Using Zoom, page 306
• Rotation, as described in Using Rotate, page 310
• Scale-to-gray, as described in Using Scale-to-Gray, page 312
• Form overlay, as described in Viewing Documents with Form Overlay, page 318

You can also save multiple sticky view settings for a displayed document and switch between each of the saved sticky view settings. For more information, refer to Saving Sticky View Settings, page 94 and Switching Sticky View Settings, page 305.

Saving Sticky View Settings

The Save Settings feature allows you to store multiple sticky view settings for each document type. You can save up to five different sticky view settings for each document type.

To save a sticky view setting:
1. Display a document with the desired settings.
2. Select a Save Settings view. From the View menu, select Sticky View and then Save Settings. The Save Settings menu appears. Highlight the appropriate view (for example, View 1).

Figure 37. Saved Settings Menu

<table>
<thead>
<tr>
<th>View</th>
<th>Ctrl+Shift+1</th>
</tr>
</thead>
<tbody>
<tr>
<td>View 1</td>
<td>Alt+Shift+1</td>
</tr>
<tr>
<td>View 2</td>
<td>Alt+Shift+2</td>
</tr>
<tr>
<td>View 3</td>
<td>Alt+Shift+3</td>
</tr>
<tr>
<td>View 4</td>
<td>Alt+Shift+4</td>
</tr>
<tr>
<td>View 5</td>
<td>Alt+Shift+5</td>
</tr>
</tbody>
</table>

A check mark appears next to the saved view setting.
Customizing Your AppXtender Document Manager Workstation

Figure 38. Saved Settings Menu with Selected Saved Settings View

<table>
<thead>
<tr>
<th>View</th>
<th>Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Alt+Shift+1</td>
</tr>
<tr>
<td>2</td>
<td>Alt+Shift+2</td>
</tr>
<tr>
<td>3</td>
<td>Alt+Shift+3</td>
</tr>
<tr>
<td>4</td>
<td>Alt+Shift+4</td>
</tr>
<tr>
<td>5</td>
<td>Alt+Shift+5</td>
</tr>
</tbody>
</table>

3. Repeat steps 1 and 2 to save more views.

For more information, see:
- Switching Sticky View Settings, page 305

**Customizing AppXtender Document Manager Views**

The Applications, Query, and Thumbnail views can be modified to meet your preferences. By changing the way AppXtender Document Manager views display, you can customize the AppXtender Document Manager desktop.

The Applications, Query, and Thumbnail views can each be configured to appear as a docked view, as a dialog box, or as a subwindow. The Applications view and the Query view can also be configured to "hide on use."

For more information, refer to the following topics:
- Docking a View, page 95
- Displaying a View as a Dialog Box, page 96
- Displaying a View as Subwindow, page 97
- Hiding a View on Use, page 98
- Activating AppXtender Document Manager Full Screen Mode, page 99
- Managing the Query View Result Set, page 99

**Docking a View**

An AppXtender Document Manager docked view has a grab bar. A grab bar is similar to a title bar except that it does not contain a title.

Figure 39. AppXtender Document Manager Docked View Grab Bar

You can drag the view to the left, right, top, or bottom of the AppXtender Document Manager window by dragging this bar. A docked view automatically aligns with the AppXtender Document Manager window borders and cannot be moved beyond the borders. By default, the Applications, Query, and Thumbnail views appear as docked views.
Customizing Your AppXtender Document Manager Workstation

**Note:** The following procedure applies to only the Applications, Query, and Thumbnail views. It does not apply to the Document Display view or the Index view.

**To dock a view that is now a dialog box:**

1. Right-click inside the dialog box. From the shortcut menu that appears, select Allow Docking. Allow Docking can be toggled on or off.

2. Click the grab bar, and drag the view to the desired position on the AppXtender Document Manager desktop. For the view to dock, you must drag it to the left, right, top or bottom edge of the AppXtender Document Manager desktop. When you release the mouse button, the view moves to that location.

**Figure 40. AppXtender Document Manager Desktop with Docked Views**

**Displaying a View as a Dialog Box**

An AppXtender Document Manager dialog box has a title bar with a Close button. You can drag the view to a different location on your desktop by dragging the title bar. A dialog box is independent of the AppXtender Document Manager window borders. That is, it can be moved away from the AppXtender Document Manager window borders, in any direction. This behavior is often described as "floating."
Customizing Your AppXtender Document Manager Workstation

Figure 41. AppXtender Document Manager Dialog Box Title Bar

Note: The following procedure applies to only the Applications, Query, and Thumbnail views. It does not apply to the Document Display view or the Index view.

To display a view as a dialog box:
1. Double-click the grab bar. The docked view becomes a dialog box.
2. Click the Title bar and drag the dialog box to the desired location on the AppXtender Document Manager desktop.

Figure 42. AppXtender Document Manager Desktop with Query View as Dialog Box

Displaying a View as Subwindow

An AppXtender Document Manager subwindow has a title bar with Minimize, Maximize, and Close buttons. You can drag the view to a different location in the AppXtender Document Manager window by dragging the title bar. A subwindow is independent of the AppXtender Document Manager window borders but cannot be moved beyond them. This behavior is often described as "floating as an MDI window."

Figure 43. AppXtender Document Manager Subwindow Title Bar

Note: The following procedure applies to only the Applications, Query, and Thumbnail views. It does not apply to the Document Display view or the Index view.

To display a view as a subwindow:
1. Right-click in the docked view or view dialog box. From the shortcut menu that appears, select Float as MDI Window.
2. Click the Title bar and drag the subwindow to the desired location on the AppXtender Document Manager desktop.
Hiding a View on Use

By default, the views remain in the AppXtender Document Manager window until you close, or hide, them. That is, when you display the Query View, the Applications View remains. Also, when you display a document, the Query View remains. You can configure the Applications view to hide when you display the Query View, and you can configure the Query View to hide when you display a document.

This is described as "hiding on use" because you use the Applications view to display the Query View and you use the Query View to display a document. When a view is configured to hide on use, this configuration is often described as "hide on use mode." In this mode, AppXtender Document Manager automatically hides the view after items have been selected.

You can always display the hidden view using the Applications View button or the Query View button on the Main toolbar. The hide on use mode can be used on a view whether it displays as a docked view, as a dialog box, or as a subwindow.

Note: The following procedures apply to only the Applications view and the Query view. They do not apply to the Document Display, Index, or Thumbnail view.
To configure a docked view to hide on use:
• Right-click the view’s grab bar. From the shortcut menu that appears, select Hide on Use.

To configure a dialog box or subwindow to hide on use:
• Right-click inside the dialog box or subwindow. From the shortcut menu that appears, select Hide on Use.

**Activating AppXtender Document Manager Full Screen Mode**

The Full Screen feature allows you to expand AppXtender Document Manager to fill the entire monitor screen. This feature allows you to maximize AppXtender Document Manager viewing.

To enable or disable full screen:
• From the View menu, select Full Screen.

**Managing the Query View Result Set**

After you search for a document, the Query view Result Set tab displays the document index records that met the search criteria you entered. There is a column for each field in the result set. You can control the display of columns from the Result Set. For example, you can show or hide, reorder, or save columns from the Result Set. For more information, refer to the following topics:
• Changing the Way the Result Set Lists Documents, page 99
• Hiding or Showing Result Set Columns, page 101
• Sorting the Result Set, page 101
• Reordering the Result Set Columns, page 102
• Resizing the Result Set Columns, page 102
• Saving the Result Set Columns, page 102
• Resetting Result Set Column Configuration, page 102
• Collapsing the Result Set, page 103

**Changing the Way the Result Set Lists Documents**

You can change the way the Result Set lists your documents.

**To change the way the Result Set lists your documents:**

1. Right-click the Result Set. From the shortcut menu that appears, select View As. Another shortcut menu appears.
2. You have the following choices:
   - To display only the first index field of each record and a small folder icon next to each record, select Names.

   **Figure 45. Displaying Names in the Result Set**

   ![Names](image)

   - To display all index fields and a small folder icon next to each record, select Details.

   **Figure 46. Displaying Details in the Result Set**

   ![Details](image)

   - To display only the first index field of each record and a large folder icon above each record, select Folders.

   **Figure 47. Displaying Folders in the Result Set**

   ![Folders](image)
Hiding or Showing Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays a column for each of the index fields in the application, plus a column for the number of pages in each document. You can hide any of these columns. There is also a column for the document ID, which is hidden by default. You can configure this column to appear in the Result Set.

To hide or show a column:

1. Right-click a column heading in the Result Set. From the shortcut menu that appears, select Settings. The List Column Editor dialog box appears.

   Figure 48. List Column Editor Dialog Box

   ![List Column Editor Dialog Box](image)

2. Click the check box next to the name of the column that you want to hide or show.

3. When each column that you want to hide has no check mark and each column that you want to show has a check mark, click OK.

Sorting the Result Set

Ascending or descending sorts can be performed on any index column listed in the Result Set tab. To sort a field in ascending order, click the column heading of the desired field. To sort a field in descending order, click the column heading of the field again.

In addition, your workstation may be configured to sort the result set automatically based on the last column selected or based on the document ID. The Display tab of the Configuration dialog box allows this configuration. For information, refer to Use KeyView to Display Foreign Files, page 107.
Reordering the Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays columns in a default order. You can change the order of these columns.

To move a column:

- Drag the column to the position you want to use.

Resizing the Result Set Columns

The first time you log into an AppXtender application, the Result Set tab displays default column widths for each index field. These column widths are resizable. Because the data is truncated in narrow columns, resizing is a useful display tool.

To resize a column width:

1. Drag the boundary between column headings to the position you want.
2. Right-click the column headings. From the shortcut menu that appears, select Save Columns. The column configuration is saved for the current user name and application.

Saving the Result Set Columns

You can save Result Set column configuration changes for the current user name and application.

To save column settings:

- Right-click any column heading in the Result Set. From the shortcut menu that appears, select Save Columns. The column configuration is saved for the current user name and application.

Resetting Result Set Column Configuration

If you have made changes to the way columns appear in the Result Set (such as hiding columns, showing the Document ID column, changing the column order, or changing the column width) you can set them back to their default configuration.

To reset Result Set columns:

1. If you have your View As option set to Folders or Names, you must first change that option to Detail. For instructions, refer to Changing the Way the Result Set Lists Documents, page 99.
2. Right-click any of the Result Set column headings. From the shortcut menu that appears, select Settings. The List Column Editor dialog box appears.
3. Click Reset All.
Collapsing the Result Set

You can collapse the Result Set to display only those documents that you select.

To collapse the Result Set:
1. In the Result Set tab, select the documents you want to view in the Result Set. You have the following choices:
   - If you want to select only one document, click the document.
   - If you want to select multiple documents in consecutive order, hold down [SHIFT] and click the first and last document.
   - If you want to select multiple documents that are not in consecutive order, hold down [CTRL] and select each document individually.
2. Right-click within the Result Set. From the shortcut menu that appears, select Collapse. Only the documents you selected are listed in the Result Set tab.

Opening the Configuration Dialog Box

You can customize the behavior of many aspects of AppXtender functionality through the AppXtender Document Manager Configuration dialog box. You can use the AppXtender Document Manager Configuration dialog box to change workstation defaults for most features, such as zoom and tile.

If you have the Configure WS privilege, you can refer to all of the configuration tabs, and you are able to make a wide variety of configuration changes. If you do not have the Configure WS privilege, four tabs appear: the View tab, the Display tab, the Fonts tab, and the Scan tab. This topic discusses these four tabs. For information on the other tabs available to users with the Configure WS privilege, refer to the “Configuring ApplicationXtender Workstations” chapter of the ApplicationXtender Installation Guide.

To open the Configuration dialog box:
1. From the File menu, select Configuration. The Configuration dialog box appears.
2. Set the desired options according to the instructions in the following topics:
   - View Tab, page 104
   - Display Tab, page 109
   - Fonts Tab, page 112
   - Scan Tab, page 115
   - COLD Tab, page 118
   - Print Tab, page 121
   - E-Mail Tab, page 124
   - Export Tab, page 129
   - File Types Tab, page 132
   - Data Tab, page 134
Customizing Your AppXtender Document Manager Workstation

- Paths Tab, page 141
- Full Text Tab, page 143
- OCR Tab, page 145
- Fax-in Tab, page 147
- Thumbnail Tab, page 147
- Document Signing Tab, page 148

3. Click OK. The Configuration dialog box closes and any changes you have made are saved.

View Tab

The View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box allows you to configure several aspects of viewing documents and batches. Some of the options on the AppXtender Document Manager Configuration dialog box View tab are not available on the AppXtender Image Capture Configuration dialog box View tab, because they configure features that are not necessary in AppXtender Image Capture.

Figure 49. Configuration Dialog Box: View Tab
Image Size Options

Image Size options on the View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box control the default display size of images displayed in
AppXtender Document Manager or AppXtender Image Capture. You can use these options with all supported image types. (In AppXtender Document Manager, these options also apply to text when the Allow zoom option is enabled on the COLD tab of the Configuration dialog box.) For more information on which image types are supported in AppXtender Document Manager, refer to Image Files, page 42.

To change the default image size setting:

1. In the Configuration dialog box, select the View tab.
2. Under Image Size, select one of the five zoom settings.
   These settings are explained in the following table:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit to window</td>
<td>If this option is chosen as the default, AppXtender Document Manager or AppXtender Image Capture displays images to fit the display window either top to bottom or left to right, while maintaining the original aspect ratio of the image and displaying the entire image.</td>
</tr>
<tr>
<td>Fit to window height</td>
<td>If this option is chosen as the default, AppXtender Document Manager or AppXtender Image Capture displays images to fit the window from top to bottom. You might need to scroll left or right to refer to the sides of the image.</td>
</tr>
<tr>
<td>Fit to window width</td>
<td>If this option is chosen as the default, AppXtender Document Manager or AppXtender Image Capture displays images to fit the window from left to right. You might need to scroll up or down to refer to the top or bottom of the image.</td>
</tr>
<tr>
<td>Actual size</td>
<td>If this option is chosen as the default, AppXtender Document Manager or AppXtender Image Capture displays images as actual size (one pixel stored is equal to one pixel on the monitor).</td>
</tr>
<tr>
<td>Use zoom setting</td>
<td>If this option is chosen as the default, AppXtender Document Manager or AppXtender Image Capture displays images using the default zoom percent. The Use Zoom Setting drop-down list allows you to set the default ratio.</td>
</tr>
</tbody>
</table>

3. If you have enabled the Use zoom setting radio button, select the desired ratio. You can click the User zoom setting drop-down list and select the desired ratio (standard options range from 25% to 400%) or type the preferred percentage in the text box.

4. Click OK to save the settings.

Zoom Settings are Pixels

By default, AppXtender Document Manager or AppXtender Image Capture takes into consideration both the image resolution and monitor resolution when rendering images for display. By enabling the Zoom settings are pixels option on the View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box, AppXtender Document Manager or
AppXtender Image Capture displays images in raw pixel size, disregarding image and monitor resolution.

**Scale-to-Gray**

When the Scale-to-gray option on the View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box is enabled, AppXtender Document Manager or AppXtender Image Capture displays bi-tonal (black and white) images as grayscale, which is frequently a more legible format. Various shades are used to convert black and white images for the highest readability. This option applies to bi-tonal images only.

For more information, see:
- Using Scale-to-Gray, page 312

**Use KeyView to Display Foreign Files**

When this Use KeyView to display foreign files option is enabled on the View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box, AppXtender Document Manager or AppXtender Image Capture uses the KeyView Viewer to display the contents of various foreign files. The appearance of a foreign file in KeyView is similar to its appearance in its native viewer, but not exactly the same. For a list of KeyView Viewer-supported file types, refer to KeyView File Support, page 168. When this option is disabled, Document Manager and Image Capture display a foreign file page as an icon.

**Use Acrobat Reader to Display PDF Files**

When this Use Acrobat Reader to display PDF files option is enabled on the View tab of the AppXtender Document Manager and AppXtender Image Capture Configuration dialog box, AppXtender Document Manager or AppXtender Image Capture uses the Acrobat Reader technology to display the contents of PDF files. When this option is disabled, AppXtender Document Manager or AppXtender Image Capture uses PDF Library to display each PDF page. If you enable the option for AppXtender Document Manager or AppXtender Image Capture, it is enabled for both.

**Note:** If you choose to display a PDF document in Acrobat Reader, you cannot annotate the pages and full-text search hits on the PDF pages will not be highlighted. However, the PDF Library performs document printing of a PDF page regardless of the view setting.

**Allow Map of Unknown Data Sources to Existing Data Sources**

When this option is enabled on the View tab of the AppXtender Document Manager Configuration dialog box, AppXtender Document Manager will allow you to specify a data source for a document for which the data source is unknown. The original data source may be unknown if you are opening
a document that has been somehow saved to your machine or if a reference to an AppXtender document has been e-mailed to you. If the name of the data source listed in the reference is named different from the data sources that are configured on your computer and you attempt to open the file, the Pick a Data Source dialog box will appear, allowing you to specify the correct data source to use. For more information about selecting a data source from the Pick a Data Source dialog box, refer to Viewing Documents from Unknown Data Sources, page 284. (This option is not available in AppXtender Image Capture.)

**Display Text View of Page**

AppXtender Document Manager allows users to process images using OCR, creating an alternate "text view" of the image. Users can switch between the original image and the text view of the image at will. The Display text view of page option on the View tab of the AppXtender Document Manager Configuration dialog box sets the default document display to text format or image format. When the check box is enabled on the View tab of the Configuration dialog box, AppXtender Document Manager displays documents as text when applicable. If no OCR view is available, the page will be automatically processed using OCR to create an OCR view when it is viewed. When the check box is disabled, AppXtender Document Manager always displays documents in image format. (This option is not available in AppXtender Image Capture.)

**Display Text View of Page**

AppXtender Document Manager allows users to process images using OCR, creating an alternate "text view" of the image. Users can switch between the original image and the text view of the image at will. The Display text view of page option on the View tab of the AppXtender Document Manager Configuration dialog box sets the default document display to text format or image format. When the check box is enabled on the View tab of the Configuration dialog box, AppXtender Document Manager displays documents as text when applicable. If no OCR view is available, the page will be automatically processed using OCR to create an OCR view when it is viewed. When the check box is disabled, AppXtender Document Manager always displays documents in image format. (This option is not available in AppXtender Image Capture.)

**Restore Last Layout at Startup**

If the Restore last layout at startup option is enabled on the View tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box, the AppXtender Document Manager or AppXtender Image Capture desktop layout is automatically saved when you exit AppXtender Document Manager or AppXtender Image Capture. This includes the following settings:
- AppXtender Document Manager or AppXtender Image Capture window size and location
- Toolbar locations and toolbar button size
- View type (docked view, dialog box, or subwindow) for the Applications, Query, and Thumbnail views
- Location and size of the Applications, Query, and Thumbnail views

If this option is disabled, the desktop layout is not saved on exit. When you open AppXtender Document Manager or AppXtender Image Capture, the desktop layout reverts to the previously saved settings.

**Display Tab**

The Display tab of the Configuration dialog box contains options for various AppXtender Document Manager or AppXtender Image Capture display features. Some of the options on the AppXtender Document Manager Configuration dialog box Display tab are not available on the AppXtender Image Capture Configuration dialog box Display tab because they configure features that are not available in AppXtender Image Capture.

*Figure 50. Configuration Dialog Box: Display Tab*
For more information, see:

- Opening the Configuration Dialog Box, page 103
- Screen DPI, page 110
- PgUp/PgDn in Dual-Page View, page 110
- Query Results, page 110

**Screen DPI**

The Screen DPI settings refer to the dots per inch of the system monitor. AppXtender Document Manager or AppXtender Image Capture takes this information from the video interface card installed with the system. You can overwrite the defaults by entering new Horizontal or Vertical settings. If you want to change the Horizontal or Vertical settings back to the defaults from the video interface card, click Reset.

**PgUp/PgDn in Dual-Page View**

This option dictates how the [PAGE UP] and [PAGE DOWN] keys operate in AppXtender Document Manager or AppXtender Image Capture when a document or batch is in dual-page display mode. This mode is also known as Split View. The Split View feature splits the Document Display view or the Batch Display view so that multiple pages of the same document or batch are displayed.

In Split View, the actions performed by your [PAGE UP] and [PAGE DOWN] keys depend on the PgUp/PgDn in Dual-Page View setting in the Display tab:

- When you select Next/previous 2 pages, the keys page through two pages at a time. For example, if you display a document or batch with four pages in Split View, pages 1 and 2 appear first, then pages 3 and 4.
- When you select Next/previous page, the keys page through one page at a time. For example, if you display a document or batch with four pages in Split View, pages 1 and 2 appear first, then pages 2 and 3.

**Query Results**

The Query Results options allow you to configure the maximum number of documents that will be included in a result and how the result set will be sorted. (These options are not available in AppXtender Image Capture.)

**Maximum Query Results**

Using the Maximum Query Results option, you can set the maximum number of documents that will be included in a result set. The default is 2048 documents. The higher this value is set, the larger the
result set can be. If a query returns more documents than the maximum number, the result set will be truncated. (This option is not available in AppXtender Image Capture.)

**Sort Result Set Automatically**

This option sets the default to automatically sort index records displayed in the query result set based on the column field selected. When this option is enabled on the Display tab of the Configuration dialog box, the new query displayed in the result set is sorted by the last column field selected. When this option is disabled, AppXtender Desktop displays the index records in the query result set based on one of the two Sort Order of Document ID options specified in the Sort Order of Document ID topic. For more information, refer to [Sort Order of Document ID, page 111](#).

*Note:* Automatic sort overrides sort order of document ID.

**Maximum # of Indexes Retrieved**

If the application in which you are searching has the Multiple indexes referencing single document setting enabled, the result set may contain more than one record for each document. For example, if the Maximum Query Results value on the Display tab in the Configuration dialog box is set to 2048 documents, your result set may contain more than 2048 index records. To improve performance, you can use the Maximum Index Retrieved setting to limit the number of index records that are listed in the result set.

The default setting is 1000 index records. The higher this value is set, the larger the result set can be. If a query returns more index records than the maximum number, the result set is truncated.

**Sort Order of Document ID**

This feature lets you control the display of items in the query result set. When Ascending order is enabled, AppXtender Document Manager displays index records listed in the query result set by ascending chronological order. Enabling the Descending order sorts the documents in reverse chronological order.

**Ascending Order**

This option sets the sort order of the query result set in ascending chronological order, based on the document ID number. If this option is chosen as the default, AppXtender Document Manager displays index records sequentially, from low to high, in the query view.
Descending Order

This option sets the sort order of the query result set to descending chronological order, based on the document ID number. If this option is chosen as the default, AppXtender Document Manager displays index records sequentially, from high to low, in the query view.

Fonts Tab

Using the Fonts tab of the Configuration dialog box, you can choose the fonts for displaying and printing text documents.

Figure 51. Configuration Dialog Box: Fonts Tab

For more information, refer to:

- Opening the Configuration Dialog Box, page 103
- Screen Fonts, page 113
Screen Fonts

The font used for text display depends on whether the page has a text overlay, an image overlay, or no overlay at all. It also depends on whether the user is allowed to zoom in on the page.

Note: Zoom is configured using the Allow zoom setting on the COLD tab. For more information on configuring Allow zoom, see Allow Zoom, page 119 refer to the "Configuring ApplicationXtender Workstations" chapter of the ApplicationXtender Installation Guide.

Using the Screen Fonts setting, you can configure the fonts used for text display.

To set the screen fonts:

1. Select the font to configure from the Screen Fonts list. You have the following choices:
   - Page (fixed size)
   - Page (variable size)
   - Image Form Overlay

   The font that you select depends on whether the text page has a text or image overlay and whether zoom is enabled. The following table describes which font is used for text display in each scenario:

<table>
<thead>
<tr>
<th>Page Type</th>
<th>When Zoom is Enabled</th>
<th>When Zoom is Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with no overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with a text overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with an image overlay</td>
<td>Image Form Overlay</td>
<td>Image Form Overlay</td>
</tr>
</tbody>
</table>

2. Click Change. The Font dialog box appears.

   Note: AppXtender only supports fixed pitch fonts. The fonts that are displayed are the only fixed pitch fonts currently on your machine.

3. Choose the font, style, and size you want to use for text display.

   Note: If you are configuring the Image Form Overlay font, you do not need to select a font size. Text on pages with an image overlay automatically appears at a calculated size that is not configurable.

4. Click OK to save the settings.
Printer Fonts

The font used for printing text documents depends on whether the page has a text overlay, an image overlay, or no overlay at all. It also depends on whether the user is allowed to zoom in on the page.

Note: Zoom is configured using the Allow zoom setting on the COLD tab. For more information on configuring Allow zoom, see Allow Zoom, page 119 refer to the "Configuring ApplicationXtender Workstations" chapter of the ApplicationXtender Installation Guide.

Using the Printer Fonts setting, you can configure the fonts used for printing text.

You can configure the print fonts to be the same as the display fonts. For more information on configuring screen fonts, refer to Screen Fonts, page 113.

However, you may need to configure the print fonts differently from the display fonts if the fonts installed on the workstation are different from those installed on the printer.

To set the print fonts:

1. Select the font to configure from the Printer Fonts list. You have the following choices:
   - Page (fixed size)
   - Page (variable size)
   - Image Form Overlay

   The font that you select depends on whether the text page has a text or image overlay and whether zoom is enabled. The following table describes which font is used for printing text in each scenario:

   **Table 14. Configuring Printer Fonts with Form Overlay**

<table>
<thead>
<tr>
<th>Page Type</th>
<th>When Zoom is Enabled</th>
<th>When Zoom is Disabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text with no overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with a text overlay</td>
<td>Page (variable size)</td>
<td>Page (fixed size)</td>
</tr>
<tr>
<td>Text with an image overlay</td>
<td>Image Form Overlay</td>
<td>Image Form Overlay</td>
</tr>
</tbody>
</table>

2. Click Change. The Font dialog box appears.

   Note: AppXtender only supports fixed pitch fonts. The fonts that appear in the list are the only fixed pitch fonts currently on your printer.

3. Choose the font, style, and size you want to use for text display.

   Note: If you are configuring the Image Form Overlay font, you do not need to select a font size. Text on pages with an image overlay automatically prints at a calculated size that is not configurable.

4. Click OK to save the settings.
Simulate Box Drawing Characters

AppXtender uses "box drawing characters" to support the use of fonts that require box drawing characters to correctly represent AppXtender text documents. Because of this, several characters in the AppXtender font set are replaced with box drawing characters. For documents that are written in foreign languages, this substitution may interfere with the font set requirements for the foreign language. Characters display as boxes rather than as the characters that they should be.

For example, when viewing documents written in the Danish language, the box drawing character substitution interferes with the font set requirements for Danish.

You need to disable the Simulate Box Drawing Characters options to view documents and text form overlays written in any foreign language that uses characters that are assigned using the ASCII values from 176 to 223.

To allow viewing of documents written in foreign languages using the ASCII values from 176 to 223:

1. Disable the Enable Support for Form Text option to allow display of form overlays written in foreign languages using the ASCII values from 176 to 223.
2. Disable the Enable Support for Data Text option to allow display of text documents written in foreign languages using the ASCII values from 176 to 223.

Scan Tab

The Scan tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box allows you to customize your batch scanning process.
Customizing Your AppXtender Document Manager Workstation

Figure 52. Configuration Dialog Box: Scan Tab

For more information, see:
- Opening the Configuration Dialog Box, page 103
- Enabling Image Processing Options, page 116
- Removing Blank Pages, page 117
- Synchronized Scan, page 118
- Scanner Manual Feed Timeout, page 118

Enabling Image Processing Options

Image processing is a licensed feature that allows you to enhance scanned images.

To configure AppXtender Document Manager or AppXtender Image Capture for image processing:
1. On the Scan tab of the Configuration dialog box, enable Allow Image Processing.
2. Click OK.
**Note:** To access image enhancement options, you must log out of AppXtender and then log back in to AppXtender after you enable Allow Image Processing for the first time.

## Removing Blank Pages

You can configure AppXtender Document Manager or AppXtender Image Capture to automatically remove blank pages from the batch while you are scanning.

**To configure the automatic removal of blank pages:**

1. On the Scan tab of the Configuration dialog box, select the Remove blank pages check box to enable the option. The Threshold slider becomes available.

   ![Configuration Dialog Box: Scan Tab: Removing Blank Pages](image)

2. Use the Threshold slider to adjust the setting for what the scanner recognizes as a blank page. Keep in mind the following points:
   - If you want to allow a noisier image to be recognized as a blank page (and therefore removed), adjust the slider towards Noisier.
   - If you want to allow a cleaner image to be recognized as a blank page (and therefore removed), adjust the slider towards Cleaner.
3. Click OK to save the settings.

Caution: As you begin to use this feature, examine the pages that are scanned and take note of which pages are automatically removed from the document or batch as you scan them. If you find that pages are being removed that should not be removed, adjust the slider towards Cleaner. You must make sure that the Threshold slider setting is appropriate for the pages that you are scanning.

Synchronized Scan

With some types of scanning, the images are scanned faster than AppXtender Document Manager or AppXtender Image Capture can display them. The Synchronized scan option slows down your scanner so that AppXtender Document Manager or AppXtender Image Capture can display each scanned image. You have the following choices:

- If you want to review each page as it is scanned, enable the Synchronized scan option.
- If you want to allow your scanner to scan images at its highest speed, disable the Synchronized scan option.

Scanner Manual Feed Timeout

This option sets the scanner timeout for scanning that is performed while in the manual feed mode. The default is 20 seconds. The timeout option specifies how much time you will need to put more pages in the scanner without having to manually continue the scan process. This option can be set higher or lower to meet your needs.

COLD Tab

The COLD tab of the Configuration dialog box allows you to configure the display of the following file types:

- ColdXtender documents
- AppXtender Reports Management documents
- Text, as defined on the File Types tab of the Configuration dialog box (For instructions, see File Types Tab, page 132.)

The COLD tab is not available on the AppXtender Image Capture Configuration dialog box.

For more information, see:

- Opening the Configuration Dialog Box, page 103
- Cache Forms, page 119
- Allow Paste Text, page 119
- Allow Zoom, page 119
Customizing Your AppXtender Document Manager Workstation

- Display As Image Only, page 119
- Form Overlay Settings, page 119
- Default Color Bar Settings, page 120

**Cache Forms**

When this option is selected, forms will be cached locally in memory to facilitate quicker retrieval. This setting holds for the current session only. Once you exit AppXtender Document Manager, the form is no longer held in cache. Click to place a check mark in the Cache Forms check box to enable the option.

**Allow Paste Text**

Users are not required to use the Paste Special command to insert text pages from the clipboard. AppXtender supports standard pasting of text pages from the clipboard with the Paste command. The Allow paste text option must be enabled to activate this function.

**Allow Zoom**

When this option has a check mark in it, the Zoom feature becomes active for AppXtender Reports Mgmt and COLD and ASCII documents. Consequently, you can zoom in and out on AppXtender Reports Mgmt or COLD and ASCII documents if a variable font is selected.

**Display As Image Only**

When enabled, this option restricts the user's ability to change an AppXtender Reports Mgmt document with an Image Form Overlay to either a COLD or ASCII Form Overlay or without the Image Form Overlay.

**Form Overlay Settings**

The Form Overlay Settings configure display and print options for AppXtender Reports Mgmt documents. Separate settings apply to display and print. COLD and AppXtender Reports Mgmt documents can be configured to display or print with a form overlay.
Screen

This option determines how AppXtender Reports Mgmt documents are displayed. Select Off to display documents without a form overlay. Select Text to display documents with a text form overlay, or select Image to display documents with an image form overlay.

Printer

This option determines how AppXtender Reports Mgmt documents are printed. Select Off to print documents without a form overlay. Select Text to print documents with a text form overlay, or select Image to print documents with an image form overlay.

Default Color Bar Settings

This feature lets you view text documents with a "color" bar background. When a document is displayed with the color bar enabled, the background will be composed of alternating bars of a selected color and white. You can change the color and the width of the bands.

Show

Use this option to turn the color view on or off. A check mark indicates that color view is on. No check mark indicates that color view is off.

Lines

This option determines the width of the bands. The default setting is three lines.
To set the line width:
• In the Lines box, type or select the number of lines desired by using the up or down arrow.

Color

This option sets the color to be used in color view.
To set the line color:
• In the Color drop-down list, click the color of your choice. (If the color that you want to use is not listed, select Custom. The standard Windows Color dialog box appears, allowing you to create a color for the color bar.)

Print Tab

The Print tab of the AppXtender Document Manager Configuration dialog box allows you to configure how AppXtender documents or pages are printed. The Print tab of the AppXtender Image Capture Configuration dialog box allows you to configure how AppXtender Image Capture pages are printed. Some of the options on the AppXtender Document Manager Configuration dialog box Print tab are not available on the AppXtender Image Capture Configuration dialog box Print tab, because they configure features that are not available in AppXtender Image Capture.

For more information, see:
• Opening the Configuration Dialog Box, page 103
• Print Original Size, page 121
• Fit to Page, page 122
• Dithering, page 122
• Print Toolbar Button, page 122
• Acceleration, page 122
• Endorse Printed Pages, page 123

Print Original Size

When an AppXtender Document Manager or AppXtender Image Capture page is printed, the printer automatically fits the contents of the page to a standard printable area. If some characters in the page are outside the printable area of the page, the printer slightly reduces the overall size of the page so that all characters can fit. However, there are occasions when a perfect one-to-one (original to printed) match is required. AppXtender Document Manager or AppXtender Image Capture meets this requirement through the Print original size feature. This function allows AppXtender Document Manager or AppXtender Image Capture to override the printer’s fixed printable area. All characters in a page are scaled to print exact original size.

When the Print Original Size option is enabled, AppXtender Document Manager or AppXtender Image Capture overrides the printer’s printable area and prints the selected page in exact original size. When disabled, the printer shrinks or enlarges the selected page to fit the printable area.

This option applies to the following page types:
• Images
• Text, as defined on the File Types tab of the Configuration dialog box (For instructions, see File Types Tab, page 132.)
Fit to Page

Enabling this option allows AppXtender Document Manager or AppXtender Image Capture to fit an image to the entire printable area of a single page. The print endorsement settings determine whether the Fit to page option is available. For more information, refer to Endorse Printed Pages, page 123

Dithering

Dithering is a technique used in computer graphics to create the illusion of varying shades of gray on a monochrome display or printer. Dithering relies on treating areas of an image as groups of dots that are colored in different patterns. Dithering takes advantage of the eye’s tendency to blur spots of different colors by averaging their effects and merging them into a single perceived shade or color. Depending on the ratio of black dots to white dots within a given area, the overall effect is of a particular shade of gray. Dithering is used to add realism to computer graphics and to soften jagged edges in curves and diagonal lines at low resolutions.

If you are printing a color image to a monochrome (black and white) printer, you can improve the quality of the printout by enabling the Dithering option. When this option is enabled and you send a color image to a monochrome printer, AppXtender Document Manager or AppXtender Image Capture dithers the image. For example, if you print a color, 400 K, 200 DPI image to a monochrome printer, the result is a black and white, 3600 K, 600 DPI image of the same size. Each pixel in the color image becomes nine pixels in the black and white image.

Note: When the Dithering option is enabled and you send an image to a color printer, AppXtender does not dither the image.

Print Toolbar Button

The Print Toolbar Button options allow you to configure the Print button on the Main toolbar. You have the following choices:

• If you want the Print button to print the entire displayed document, select Document print.
• If you want the Print button to print only the displayed page, select Page print.
• If you want the Print button to display a Print dialog box for the currently displayed page, so that the user can specify the scope of each print job individually, select Prompt.

Acceleration

The Acceleration options expedite the printing of AppXtender Document Manager documents or AppXtender Image Capture batches. AppXtender Document Manager and AppXtender Image Capture support XipPrint accelerator cards, Talaris printers, and Quick PCL printing.

Note: Pages with annotations, Cold and AppXtender Reports Mgmt pages with a form overlay, and pages with print endorsements (from AppXtender Document Manager) are not printed in
accelerated mode. Whenever a page of one of these types is printed, AppXtender Document Manager or AppXtender Image Capture ignores the acceleration setting while that page prints.

**XipPrint**

If you have a XipPrint II card, you can use the XipPrint printer acceleration feature. The XipPrint II is a card that can be installed in the SIMM socket of a printer. It takes over file decompression, allowing AppXtender Document Manager or AppXtender Image Capture to process print jobs more quickly.

**Talaris**

If you have a Talaris 1794FT or 3290FT printer, you can use the Talaris printer acceleration feature. The Talaris 1794FT and 3290FT printers take over file decompression, allowing AppXtender Document Manager or AppXtender Image Capture to process print jobs more quickly.

**Quick PCL**

If you have a PCL5 compatible printer, such as HP III, HP IV or Compaq, you can use the Quick PCL printer acceleration feature. This feature significantly improves printing performance for black and white images to any PCL5 compatible printers. Quick Print bypasses the Windows GDI layer so that AppXtender Document Manager or AppXtender Image Capture talks directly to the Windows printer driver. This substantially reduces cycle time.

*Note:* Quick Print is valid for bi-tonal images only. Grayscale and color images are processed at the standard rate.

**Endorse Printed Pages**

You can use this option to print pages with an identifying text message in one corner of each page. Endorsements print on all pages as long as the option is enabled.

*Note:* Endorsements are valid for all file types except HTML.

**To configure print endorsement:**

1. Click the Endorse Printed Pages check box. (To disable the endorsement, clear the check box.)
2. From the Position drop-down list, select an option. Available options include Lower right, Lower left, Upper right, and Upper left.
3. Type the endorsement message in the Text text box.
   
   The endorsement feature supports predefined macros. The following table describes the macros.
Table 15. Endorsement Macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>%DS</td>
<td>Displays the short form of the date, such as 3/2/2007, on which the page is printed.</td>
</tr>
<tr>
<td>%DL</td>
<td>Displays the long form of the date, such as Friday, March 02, 2007, on which the page is printed.</td>
</tr>
<tr>
<td>%T</td>
<td>Displays the time at which the page is printed.</td>
</tr>
<tr>
<td>%U</td>
<td>Displays the user who printed the page.</td>
</tr>
<tr>
<td>%P</td>
<td>Displays the current page number.</td>
</tr>
</tbody>
</table>

4. Enable or disable the Overlap on image option. (This option is not available when using XipPrint or Talaris acceleration.)
   - If this option is enabled, the endorsement overlaps any images. This option allows the image to be printed on a larger area of the page. You must select either Print original size or Fit to page.
   - If this option is disabled, the images and the endorsement take up separate areas of the printed page. Also, if this option is disabled, the Print original size and Fit to page options become unavailable.

   Consider disabling this option if the endorsement overlaps with an important part of the image, or if the endorsement is difficult to read with the image printed behind it.

AppXtender prints the endorsement on every page in the location selected from the Position drop-down list. The location of the macro output in the endorsement depends on the location of the macro in the text string.

**E-Mail Tab**

The E-Mail tab of the AppXtender Document Manager Configuration dialog box provides options for e-mailing AppXtender documents. AppXtender interfaces with Microsoft Outlook® or cc:Mail™ so that you can attach AppXtender documents or pages to electronic mail messages. (The E-Mail tab is not available on the AppXtender Image Capture Configuration dialog box.)

The attachment is displayed as an icon in the body of the e-mail message, and the recipient double-clicks on the icon to view documents or pages. AppXtender Document Manager has both a Mail Document Reference feature and a Mail Document Page feature. Use this page to configure the Mail Document Pages feature in the Document menu and the Mail feature in the Page menu.

Through e-mail configuration, any user can receive and view an e-mail message with an AppXtender attachment, even if AppXtender Document Manager is not installed on the user’s workstation. This is accomplished by converting the AppXtender document into a format that can be opened by an application that exists on the user’s workstation. If the recipient has only the Paint program, for example, AppXtender Document Manager can convert the attachment to a bitmap format. The recipient can then view the attachment via Paint, because it reads bitmap files.

For instructions on sending documents by e-mail, see E-Mailing Documents and Pages, page 362.
For more information, see:
• Opening the Configuration Dialog Box, page 103
• E-Mail Formats, page 125
• E-Mail Vendor, page 129

E-Mail Formats

On the E-Mail tab of the Configuration dialog box, all available formats for each image type (that is, Black & white images, 4/8-bit color images, and True color images), are listed. The following is an explanation of the E-Mail tab options that are available for your use.

For more information, see:
• PDF Images for E-Mail, page 125
• XPS Images for E-Mail, page 125
• Black & White Images for E-Mail, page 125
  4/8-bit Color Images for E-Mail, page 126
• True Color Images for E-Mail, page 126
• Text for E-Mail, page 127
• Use Multi-Page Files for E-Mail, page 127
• E-mail in Archived Format, page 128

PDF Images for E-Mail

Enable this option to e-mail attachments in PDF format.

XPS Images for E-Mail

Enable this option to e-mail attachments in XPS format.

Black & White Images for E-Mail

This option determines the file format that AppXtender Desktop will use for images. Select a file format from the Black & white images drop-down list. Your choices are Windows BMP, TIFF, and TIFF Compressed.
**4/8-bit Color Images for E-Mail**

This option determines the file format that AppXtender Desktop will use for 4/8-bit color images. Select an appropriate file format from the 4/8-bit color images drop-down list. Your choices are Windows BMP, Windows BMP Compressed, GIF, TIFF, and TIFF Compressed.

**True Color Images for E-Mail**

This option determines the file format that AppXtender Desktop will use when e-mailing true color images. Select an appropriate file format from the True color images drop-down list. Your choices are Windows BMP, GIF, JPEG, TIFF, and TIFF Compressed.

**Note:** You can compress true color images using Joint Photographic Experts Group (JPEG) image compression. If you select JPEG, the JPEG quality factor (1-100) is enabled. For more information on compressing JPEG images, see JPEG Quality Factor (1-100), page 126.

**Note:** AppXtender does not support progressive JPEGs. Importing a progressive JPEG into AppXtender will result in the file being imported as a foreign file.

For more information, see:
- JPEG Quality Factor (1-100), page 126

**JPEG Quality Factor (1-100)**

JPEG provides compression of true color images, such as photographs, artwork, and similar still images. There is always some loss of information when you use JPEG compression to compress an image. For example, when compressing a scanned photograph, the output image is not exactly identical to the input image.

JPEG compression allows you to trade off between file size and output image quality. In most cases, you want to obtain a minimum file size by choosing the maximum amount of compression without affecting the output image quality. However, if image quality is not important, you can use a higher compression level to make an extremely small file. Conversely, if the image quality is important, you can use a lesser compression level to increase the quality until there is no visible change to the output image.

The JPEG quality factor (1-100) slider allows you to choose the compression setting for true color images. AppXtender uses the JPEG quality factor scale, which ranges from 1 to 100, where 1 indicates the smallest file size with the lowest quality and 100 indicates the largest file size with the best quality.

**To set the level of JPEG compression for e-mailed images:**

1. On the E-Mail tab of the AppXtender Document Manager Configuration dialog box, select JPEG from the True color images drop-down list. The JPEG Quality Factor (1-100) slide ruler becomes available.

2. Use the slide ruler on the scale to adjust (reduce or increase) the level of compression and the quality factor that AppXtender applies to True color images when they are sent by e-mail.

3. Click OK to save the settings.
Text for E-Mail

This option determines the file format that AppXtender Desktop will use when e-mailing text pages. By selecting As text, AppXtender Desktop will e-mail pages as text and exclude all annotations except redactions. Redactions cause the area where the redaction is located to be blank. By selecting As image, AppXtender Desktop will e-mail text pages as TIFFs regardless of the image e-mail settings and include all annotations.

Use Multi-Page Files for E-Mail

You can combine sequential pages that are similar or of the same file type and send them by e-mail as a combined file attachment or as a sequence of combined file attachments with the Use multi-page files option. For example, a document composed of a GIF, a TIFF, two PDFs, and three JPEGs (in that order) would be combined into three files: a TIFF, a PDF, and another TIFF. The first TIFF would contain the GIF and TIFF, the PDF would contain the two PDFs, and the second TIFF would contain the three JPEGs.

Note: AppXtender can combine up to 1024 TIFF pages into a single attachment. For example, if you send a document that contains 1025 consecutive TIFF pages, one attachment contains the first 1024 consecutive TIFF pages and another attachment contains the remaining TIFF page.

The following table details which file types can be combined and how they are combined:

Table 16. File Types and Combined Output

<table>
<thead>
<tr>
<th>File Types</th>
<th>Output When Combined</th>
</tr>
</thead>
<tbody>
<tr>
<td>All supported image files, including:</td>
<td>1 TIFF file for each sequence of image pages in the document</td>
</tr>
<tr>
<td>• TIFF</td>
<td>Note: The number of pages that can be combined into 1 TIFF file is limited to 1024. If there are more than 1024 pages in the document, the combined files are broken up so that each file has no more than 1024 pages in it.</td>
</tr>
<tr>
<td>• GIF</td>
<td></td>
</tr>
<tr>
<td>• Bitmap</td>
<td></td>
</tr>
<tr>
<td>• PCX</td>
<td></td>
</tr>
<tr>
<td>• DCX</td>
<td></td>
</tr>
<tr>
<td>• JPEG</td>
<td></td>
</tr>
<tr>
<td>• TGA</td>
<td></td>
</tr>
<tr>
<td>Adobe Portable Document Format (PDF) files</td>
<td>1 PDF file for each sequence of PDF pages in the document</td>
</tr>
<tr>
<td>File Types</td>
<td>Output When Combined</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text files, including:</td>
<td>1 TXT file for each sequence of text pages in the document (if the TXT file type was configured on the Configuration File Types tab in AppXtender Desktop when the document was created); otherwise 1 TXT file for each TXT page in the document</td>
</tr>
<tr>
<td>• TXT files</td>
<td></td>
</tr>
<tr>
<td>• ColdXtender reports</td>
<td></td>
</tr>
<tr>
<td>• AppXtender Reports Management reports</td>
<td></td>
</tr>
<tr>
<td>Rich Text Format (RTF) files</td>
<td>1 RTF file for each RTF page in the document</td>
</tr>
<tr>
<td>HTML files</td>
<td>1 HTML file for each HTML page in the document</td>
</tr>
<tr>
<td>AppXtender-supported foreign file types, including:</td>
<td>1 file for each file in the document</td>
</tr>
<tr>
<td>• Word processing files</td>
<td></td>
</tr>
<tr>
<td>• Spreadsheets</td>
<td></td>
</tr>
<tr>
<td>• Presentations</td>
<td></td>
</tr>
</tbody>
</table>

When the Use multi-page files option is disabled, pages of the same type are not combined. If you send a document by e-mail when this option is disabled, each page of the document is a separate attachment to the e-mail message.

**E-mail in Archived Format**

The Email in Archived format option allows you to send the archived format of each page by e-mail. That is, instead of specifying that images be sent as Windows BMP, Windows BMP Compressed, GIF, JPEG, TIFF, or TIFF Compressed, you can specify that pages be sent in the same format in which they were stored in the AppXtender system. A page can be sent in its archived format only when both of the following conditions are true:

- The current user has sufficient privileges to hide all of the redactions on the page (if there are any).
- The page to be sent is not a certain kind of subpage. (If a subpage number appears after the BIN file name in the Information dialog box for the page to be sent, it cannot be sent in its archived format. For instructions on displaying the Information dialog box, see the “Viewing Documents” chapter of the AppXtender User’s Guide.)

If these conditions are true, the archived format of the page is always sent. If these conditions are not true, the page is sent as specified with other format options on the E-mail tab.

For example, if you have the image storage format for black and white images set to TIFF on the Data tab of the AppXtender Document Manager Configuration dialog box, and you import a black and white image into AppXtender, it is stored in TIFF format. If you enable the Use archived format option on the E-mail tab, and you send the same image from AppXtender (and the conditions above are met), it is sent as TIFF.

**Note:** When the archived format of a page is sent by e-mail, no annotations are included on that page.

You can use this option to allow images to be sent in their original format. That is, if an image is imported into AppXtender and sent from AppXtender, the format of the sent image is exactly the
same as the original image before import. A page can be sent in its original format only when all of the following conditions are true (in addition to the conditions above):

- The image storage format for the image type on the Data tab of the AppXtender Document Manager Configuration dialog box was set to Default when the image was imported.
- The Separate multi-page TIFFs option on the Data tab of the AppXtender Document Manager Configuration dialog box was disabled when the image was imported.
- The page to be sent is not text. (Text is always compressed before storage.)

If these conditions are true, the original format of the page is always sent.

E-Mail Vendor

This option configures the e-mail package that will be used by AppXtender Desktop. You can choose from either Microsoft (MAPI32) or CC: Mail (SMI32).

Export Tab

The Export tab provides options for exporting AppXtender documents and pages. AppXtender Document Manager can export documents and pages in the system to various file formats. (The Export tab is not available on the AppXtender Image Capture Configuration dialog box.)

For instructions on exporting documents, see Exporting Documents and Pages, page 370.

For more information, see:
- Opening the Configuration Dialog Box, page 103
- PDF images for Export, page 129
- Black & White Images for Export, page 130
- 4/8-bit Color Images for Export, page 130
- True Color Images for Export, page 130
- Text for Export, page 131
- Use Multi-Page Files for Export, page 131
- Export in Archived Format, page 131

PDF images for Export

Enable the Use PDF format if possible option to export document text and images in PDF format.
Black & White Images for Export

This option determines the file format that AppXtender will use for images. Select a file format from the Black & white images drop-down list. Your choices are Windows BMP, TIFF, and TIFF Compressed.

4/8-bit Color Images for Export

This option determines the file format that AppXtender will use for 4/8-bit color images. Select an appropriate file format from the 4/8-bit color images drop-down list. Your choices are Windows BMP, Windows BMP Compressed, GIF, TIFF, and TIFF Compressed.

True Color Images for Export

This option determines the file format that AppXtender will use when exporting true color images. Select an appropriate file format from the True color images drop-down list. Your choices are Windows BMP, GIF, JPEG, TIFF, and TIFF Compressed.

Note: You can compress true color images using Joint Photographic Experts Group (JPEG) image compression. If you select JPEG, the JPEG quality factor (1-100) is enabled. For more information, see JPEG Quality Factor (1-100), page 126.

For more information, see:
• JPEG Quality Factor (1-100), page 126

JPEG Quality Factor (1-100)

JPEG provides compression of true color images, such as photographs, artwork, and similar still images. There is always some loss of information when you use JPEG compression to compress an image. For example, when compressing a scanned photograph, the output image is not exactly identical to the input image.

JPEG compression allows you to trade off between file size and output image quality. In most cases, you want to obtain a minimum file size by choosing the maximum amount of compression without affecting the output image quality. However, if image quality is not important, you can use a higher compression level to make an extremely small file. Conversely, if the image quality is important, you can use a lesser compression level to increase the quality until there is no visible change to the output image.

The JPEG quality factor (1-100) slider allows you to choose the compression setting for true color images. AppXtender uses the JPEG quality factor scale, which ranges from 1 to 100, where 1 indicates the smallest file size with the lowest quality and 100 indicates the largest file size with the best quality.
To set the level of JPEG compression for exported images:

1. On the Export tab of the AppXtender Document Manager Configuration dialog box, select JPEG from the True color images drop-down list. The JPEG Quality Factor (1-100) slide ruler becomes available.

2. Use the slide ruler on the scale to adjust (reduce or increase) the level of compression and the quality factor that AppXtender applies to True color images when they are exported.

3. Click OK to save the settings.

Text for Export

This option determines the file format that AppXtender will use when exporting text pages. By selecting As text, AppXtender will export pages as text and exclude all annotations except redactions. Redactions cause the area where the redaction is to be blank in the exported page. If you select As image, AppXtender will export text pages as TIFFs (regardless of the image export settings) and include all annotations.

Use Multi-Page Files for Export

You can combine sequential pages that are similar or of the same file type and export them as a combined file or as a sequence of combined files with the Use multi-page files option. For example, a document composed of a GIF, a TIFF, two PDFs, and three JPEGs (in that order) would be combined into three files: a TIFF, a PDF, and another TIFF. The first TIFF would contain the GIF and TIFF, the PDF would contain the two PDFs, and the second TIFF would contain the three JPEGs.

Note: AppXtender can combine up to 1024 TIFF pages into a single file. For example, if you export a document that contains 1025 consecutive TIFF pages, one file contains the first 1024 consecutive TIFF pages and another file contains the remaining TIFF page.

Files can be combined for export in the same way that they can be combined for e-mail. For detailed information on how files are combined, see Use Multi-Page Files for Export, page 131.

When the Use multi-page files option is disabled, pages of the same type are not combined. If you export a document when this option is disabled, each page of the document is exported as a separate file.

Export in Archived Format

The Export in Archived format option allows you to export the archived format of each page. That is, instead of specifying that images be exported as Windows BMP, Windows BMP Compressed, GIF, JPEG, TIFF, or TIFF Compressed, you can specify that pages be exported in the same format in which
they were stored in the AppXtender system. A page can be exported in its archived format only when both of the following conditions are true:

- The current user has sufficient privileges to hide all of the redactions on the page (if there are any).
- The page to be exported is not a certain kind of subpage. (If a subpage number appears after the BIN file name in the Information dialog box for the page to be exported, it can not be exported in its archived format. For instructions on displaying the Information dialog box, see the “Viewing Documents” chapter of the ApplicationXtender User’s Guide.)

If these conditions are true, the archived format of the page is always exported. If these conditions are not true, the page is exported as specified with other format options on the Export tab.

For example, if you have the image storage format for black and white images set to TIFF on the Data tab of the AppXtender Document Manager Configuration dialog box, and you import a black and white image into AppXtender, it is stored in TIFF format. If you enable the Use archived format option on the Export tab, and you export the same image from AppXtender (and the conditions above are met), it is exported as TIFF.

Note: When the archived format of a page is exported, no annotations are included on that page.

You can use this option to allow images to be exported in their original format. That is, if an image is imported into AppXtender and exported from AppXtender, the format of the exported image is exactly the same as the original image before import. A page can be exported in its original format only when all of the following conditions are true (in addition to the conditions above):

- The image storage format for the image type on the Data tab of the AppXtender Document Manager Configuration dialog box was set to Default when the image was imported.
- The Separate multi-page TIFFs option on the Data tab of the AppXtender Document Manager Configuration dialog box was disabled when the image was imported.
- The page to be exported is not text. (Text is always compressed before storage.)

If these conditions are true, the original format of the page is always exported.

File Types Tab

The File Types tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box provides options for importing files into AppXtender Document Manager or AppXtender Image Capture. By default, files not natively supported by AppXtender Document Manager or AppXtender Image Capture (for example, files other than TIFF, Windows bitmaps, TGA, RTF, JPEG, GIF, PCX, and DCX) are imported as foreign files. (For details on what file types are natively supported, refer to the "Getting Started" chapter of the ApplicationXtender Document Manager User’s Guide.) Pages imported as foreign files are represented in AppXtender Document Manager or AppXtender Image Capture in one of the following two ways:

- Represented by an icon and require a third-party viewer to display the contents of the page
- Displayed in the KeyView Viewer (For more information, see Use KeyView to Display Foreign Files, page 107.)

For example, if a Microsoft Word document is imported (using the Import File function) as a new page, a Word icon displays as the AppXtender Document Manager or AppXtender Image Capture
Customizing Your AppXtender Document Manager Workstation

Page 1

You then double-click the icon to start Word and view the document. The File Type tab provides options for importing file types or extensions.

AppXtender Document Manager and AppXtender Image Capture supports different file types in a variety of ways.

- Microsoft Word documents can be brought into AppXtender as OLE Objects, in which case the File Types settings do not matter. File Types settings only apply when a document or page is brought into AppXtender using the Import File command. (AppXtender Image Capture does not support OLE Objects.)
- AppXtender Document Manager and AppXtender Image Capture do not support progressive JPEGs. Importing a progressive JPEG into AppXtender or AppXtender Image Capture results in the file being imported as a foreign file.
- By default, most text pages are imported into AppXtender and AppXtender Image Capture as plain text, but some may be imported as foreign files. If you want to import all files with a TXT extension as plain text, add this file type in the File Types tab.

For more information, see:

- Opening the Configuration Dialog Box, page 103
- Adding File Types, page 133
- Deleting File Types, page 133

### Adding File Types

The File Types tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box allows you to configure AppXtender Document Manager or AppXtender Image Capture to recognize files by their extensions as certain file types. For example, you can configure AppXtender Document Manager or AppXtender Image Capture to recognize files with the TXT extension as the Text file type.

To add a file type:

1. In the File Extension text box, type the extension that you want AppXtender Document Manager or AppXtender Image Capture to recognize.
2. Select a file type from the File Type drop-down list. The File Type options available are Image Format, Text, Rich Text Format, Embedded Object, Foreign File, Web Component, and Adobe PDF.
3. Click Add. The extension and file type are added to the Formats list.
4. Click OK to save the settings.

### Deleting File Types

The File Types tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box allows you to remove extensions from the list of recognized file types.
To delete a file type:
1. In the Formats list, select the file type you want to delete.
2. Click Delete. The file type is removed from the Formats list.
3. Click OK to save the settings.

Data Tab

Some of the options on the AppXtender Document Manager Configuration dialog box Data tab are not available on the AppXtender Image Capture Configuration dialog box Data tab, because they configure features that are not available in AppXtender Image Capture.

- The Data tab of the AppXtender Image Capture Configuration dialog box allows you to set default image formats and other data-related settings.
- The Data tab of the AppXtender Document Manager Configuration dialog box allows you to set AppXtender Document Manager index options, set default image formats, and other data-related settings.

For more information, see:
- Opening the Configuration Dialog Box, page 103
- Enable Dual Data Entry, page 134
- Disable Query Window, page 135
- Database Connect & Drop, page 135
- Check for Matching Index, page 136
- ODMA Support, page 136
- Allow Remember Password, page 136
- Prompt for Check Out when Open, page 137
- Enable ODMA Attribute Search, page 138
- Auto Logout, page 138
- Data Field 2 Digit Year Max Future Years Setting, page 138
- Image Storage Format, page 139

Enable Dual Data Entry

The Enable dual data entry option on the Data tab works in conjunction with the Dual Data Entry flag configured in the Application Generator (AppXtender AppGen). This option is enabled by default. (Dual Data Entry options are not available in AppXtender Image Capture.)

Note: In order for dual data entry to be available for an index field, your system administrator must first enable the Dual Data Entry flag for that field in AppXtender AppGen. For more information, consult your AppXtender system administrator or refer to the "Designing an Application" chapter of the ApplicationXtender Concepts and Planning Guide.
The Dual Data Entry flag and the Enable dual data entry option together form a validation measure that ensures documents are indexed correctly. When this feature is enabled, you must enter an index field’s data twice. AppXtender Desktop accepts the information upon verification of the second entry.

If the information entered the second time is exactly the same as the first time, the document is indexed and added to the application. If the information is not entered correctly, a Dual Data Entry Error dialog box appears.

Note: If an Auto Index table is used to enter a value into an index field, even if that field is flagged for dual data entry, the user is not prompted to enter data a second time. For more information on importing data into an Auto Index table, consult your AppXtender system administrator or refer to the "Import Wizards" chapter of the ApplicationXtender Core Components Administrator’s Guide. For more information on using an Auto Index table to enter a value into an index field, refer to consult your AppXtender system administrator or refer to the "Using Auto Index to Index Documents" section of the ApplicationXtender Document Manager User’s Guide.

To activate dual data entry:

1. During application generation in the Application Generator, apply the Dual Data Entry flag to each index field that requires the validation feature.

2. In AppXtender Desktop, in the AppXtender Document Manager Configuration dialog box, click the Data tab.

3. Make sure that the Enable dual data entry option is enabled. (This option is enabled by default.)

4. Click OK to save the settings.

Disable Query Window

This option allows AppXtender system administrators to control what queries are run in AppXtender. This option limits access to the Query view on the AppXtender Document Manager workstation. (Query options are not available in AppXtender Image Capture.)

This option is intended for systems where the AppXtender SDK has been used to set up access to AppXtender from another interface. You can use this option to force users to run queries from another interface instead of AppXtender.

Database Connect & Drop

This option controls the duration of the database connection held by AppXtender Document Manager or AppXtender Image Capture. By default, the Database connect & drop option is disabled.

- If this option is disabled, the AppXtender Document Manager or AppXtender Image Capture data layer holds the connection to the underlying database for the entire AppXtender Document Manager or AppXtender Image Capture session.

- If this option is enabled, the AppXtender Document Manager or AppXtender Image Capture data layer connects to the database when needed and then drops the connection when it is not needed.

Because the user is connecting to the database and then dropping the connection when it is not needed, if the database goes down and back up or if the database fails over in a clustered server
Customizing Your AppXtender Document Manager Workstation

[Text]

environment, AppXtender Document Manager or AppXtender Image Capture connects to the restarted database or the new database. However, because users are connecting and dropping, there is performance degradation when this option is enabled (because database connect and drop depends on the data source’s ability to perform connection pooling).

If you are planning to run AppXtender Desktop in a clustered environment, you must enable the Database connect & drop option. For more information on clustering, refer to the "Planning Your ApplicationXtender Desktop Installation" chapter of the ApplicationXtender Installation Guide.

Check for Matching Index

If this option is enabled, AppXtender Document Manager will automatically check against existing documents for a duplicate index. This option allows the same index value or combination of index values to be entered for more than one document in an application. (Index options are not available in AppXtender Image Capture.)

ODMA Support

Use this option to activate the Open Document Management API (ODMA) integration between AppXtender-supported ODMA client applications and AppXtender. By enabling this option, users of AppXtender-supported ODMA client applications can easily store and retrieve documents within AppXtender without leaving an active client application. (ODMA options are not available in AppXtender Image Capture.)

Allow Remember Password

This option controls the display of the Remember password option on the Login dialog box for AppXtender Document Manager or AppXtender Image Capture. By default, the Allow remember password option is enabled. The following table indicates the result of enabling or disabling the Allow remember password option on the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box:

Table 17. Allow Remember Password Option

<table>
<thead>
<tr>
<th>Option Status</th>
<th>Configuration Dialog Box</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>AppXtender Document Manager</td>
<td>The next time you start AppXtender Document Manager, the Login dialog box appears with the Remember password option.</td>
</tr>
<tr>
<td>Enabled</td>
<td>AppXtender Image Capture</td>
<td>The next time you start AppXtender Image Capture, the Login dialog box appears with the Remember password option.</td>
</tr>
<tr>
<td>Option Status</td>
<td>Configuration Dialog Box</td>
<td>Result</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Disabled</td>
<td>AppXtender Document Manager</td>
<td>The next time you start AppXtender Document Manager, the Login dialog box appears without the Remember password option.</td>
</tr>
<tr>
<td>Disabled</td>
<td>AppXtender Image Capture</td>
<td>The next time you start AppXtender Image Capture, the Login dialog box appears without the Remember password option.</td>
</tr>
</tbody>
</table>

**Prompt for Check Out when Open**

This option controls the operational mode of AppXtender for the AppXtender Document Manager workstation. If this option is enabled, the AppXtender Document Manager workstation operates in check in/check out mode. If the option is disabled, the AppXtender Document Manager workstation operates in normal mode. In check in/check out mode, users are prompted to either check out a document or open it in read-only mode when they display the document. In AppXtender Desktop normal mode, users can check out documents if needed, but they are not required to do so in order to make changes to a document (as long as the document is not checked out to someone else). (Options for document check-out are not available in AppXtender Image Capture.)

When a user checks a document out, AppXtender makes a separate working copy of the document. Any changes made to the document while the user has it checked out are made to the copy. If the user decides to check the document back in, the working copy is saved as either a new document revision or a replacement document revision of the original document. If the user decides to cancel changes, the working copy is discarded by AppXtender.

When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. A user must check out a document in order to modify it. If the user does not check the document out, it is opened in read-only mode and it cannot be modified.

When AppXtender is in normal mode, users can open and modify documents without checking them out. When a user closes a document, the modifications are automatically saved to the AppXtender document repository. Users can check out documents while AppXtender is in normal mode, in order to prevent other users from making modifications while they are working on a document. This is useful if making the document modifications will extend past the current user session.

If a user checks out a document and another user accesses that document while in normal mode, the second user automatically receives the AppXtender repository copy of the checked out document in read-only mode and is not able to make changes to the document until it is checked back in.

A similar option in AppXtender AppGen enables check in/check out mode on an application basis, rather than a workstation basis. If you need configure your AppXtender system to comply with the Health Insurance Portability and Accountability Act of 1996 (HIPAA), it is recommended that you enable check in/check out mode on an application basis. For more information on configuring AppXtender to comply with HIPAA, refer to the ApplicationXtender Document Manager Administrator’s Guide.
Enable ODMA Attribute Search

When a user creates an AppXtender document using an ODMA-compliant application, the user can enter optional information about the document: title, subject, author, keywords, and comment. These pieces of information, including the name of the user that created the document, are considered to be the document’s “ODMA attributes.” These attributes can be changed once a document has been created. ODMA attributes (document properties) can be changed either within AppXtender or within the ODMA-compliant application that was used to create it. You can configure an AppXtender Document Manager workstation to allow users to use these ODMA attributes to retrieve documents. (ODMA options are not available in AppXtender Image Capture.)

To allow users to search by ODMA attributes:
• Enable the Enable ODMA attribute search option.
To prevent users from searching by ODMA attributes:
• Disable the Enable ODMA attribute search option.

Auto Logout

You can configure the AppXtender Document Manager workstation to automatically log out of AppXtender Document Manager after a specified period of idle time. An idle workstation is one on which the pointer and cursor have not been moved over any AppXtender interface at all, no dialog boxes or messages have appeared, and the current user is not logged onto any active data source as SYSOP. (The Auto Logout option is not available in AppXtender Image Capture.)

To configure Auto Logout:
• In the Auto Logout text box, specify the number of minutes that you want to allow an AppXtender Document Manager workstation to remain idle. (The maximum number of minutes that you can enter is 480.) When that time is up, the user is automatically logged out of AppXtender Document Manager.

To disable Auto Logout:
• In the Auto Logout text box, type 0 (zero).

Data Field 2 Digit Year Max Future Years Setting

When a date has been stored in a two-digit date format, AppXtender Document Manager interprets the date in the context of a range of one hundred years. For example, in the context of the range 1910 to 2009, AppXtender Document Manager interprets the year 08 as 2008 instead of 1908.

AppXtender Document Manager calculates the end of this range by adding the number that you specify in the Max Future Years Setting text box to the current year. For example, if the current year is 2005 and you specify the value 25, AppXtender Document Manager would interpret each two-digit date in the context of the range 1931-2030. This option only applies to two-digit date formats.

It is not necessary to update this option each year, because AppXtender Document Manager calculates the range of years based on the current year. To continue the previous example (in which you have
specified 25 in the Max Future Years Setting text box), in the year 2006, AppXtender Document Manager would interpret each two-digit date in the context of the range 1932-2031.

The default value for the Max Future Years Setting is 10. If you use the default value of 10, in the year 1999, AppXtender Document Manager would interpret any two-digit year between 00 and 09 as 2000-2009 respectively. AppXtender Document Manager would interpret any date between 10 and 99 as 1910-1999.

**Image Storage Format**

You can configure the default storage format for AppXtender Document Manager or AppXtender Image Capture image files. These settings determine the storage format for documents, batches, and pages created from scanning.

These settings also determine to what storage format imported documents, batches, and pages are converted. This applies to all document imports, such as creating a new document, batch, or page using the Import File command; using the Index Image Import wizard and an import file that precedes each image file name with two "@" symbols (@@); creating a new document or page from a fax-in queue; and so on.

For more information, see:

- Storage Format for Black & White Images, page 139
- Storage Format for 4/8-bit Color Images, page 140
- Storage Format for True Color Images, page 140
- Separate Multi-Page TIFFs, page 141

**Storage Format for Black & White Images**

This option determines the file format that AppXtender Document Manager or AppXtender Image Capture uses to store bi-tonal images. Select an appropriate file format from the Black & White drop-down list. Your choices are Default, TIFF, and Windows BMP:

- If you select Default on the Configuration dialog box, imported bi-tonal images are stored in their native format (for example, a GIF file would be stored as GIF) and scanned bi-tonal images are stored as TIFF.
- If you select one of the specific image formats on the Configuration dialog box, all bi-tonal images are stored in that format, regardless of their original format.
Storage Format for 4/8-bit Color Images

This option determines the file format that AppXtender Document Manager or AppXtender Image Capture uses for 4/8-bit color images. Select an appropriate file format from the 4/8-Bit Color drop-down list. Your choices are Default, TIFF, and Windows BMP:

- If you select Default, imported 4/8-bit color images are stored in their native format (for example, a GIF file would be stored as GIF) and scanned 4/8-bit color images are stored as TIFF.
- If you select one of the specific image formats, all 4/8-bit color images are stored in that format, regardless of their original format.

Storage Format for True Color Images

This option determines the file format that AppXtender Document Manager or AppXtender Image Capture uses to store true color images. Select an appropriate file format from the True Color drop-down list. Your choices are Default, TIFF, Windows BMP, and JPEG.

- If you select Default, imported true color images are stored in their native format (for example, a GIF file would be stored as GIF) and scanned true color images are stored as TIFF.
- If you select one of the specific image formats, all true color images are stored in that format, regardless of their original format.

Note: You can compress true color images using Joint Photographic Experts Group (JPEG) image compression. If you select JPEG, JPEG compression is enabled. You can set the JPEG Quality Factor (1-100) slider to control the level of compression and the quality of the compressed images. For more information on compressing images using this slider, see JPEG Quality Factor (1-100), page 126.

For more information, see:
- JPEG Quality Factor (1-100), page 126

JPEG Quality Factor (1-100)

JPEG provides compression of true color images, such as photographs, artwork, and similar still images. There is always some loss of information when you use JPEG compression to compress an image. For example, when compressing a scanned photograph, the output image is not exactly identical to the input image.

JPEG compression allows you to trade off between file size and output image quality. In most cases, you want to obtain a minimum file size by choosing the maximum amount of compression without affecting the output image quality. However, if image quality is not important, you can use a higher compression level to make an extremely small file. Conversely, if the image quality is important, you can use a lesser compression level to increase the quality until there is no visible change to the output image.

The JPEG quality factor (1-100) slider allows you to choose the compression setting for true color images. AppXtender Document Manager and AppXtender Image Capture use the JPEG quality factor scale, which ranges from 1 to 100, where 1 indicates the smallest file size with the lowest quality and 100 indicates the largest file size with the best quality.
To set the level of JPEG compression for stored images:

1. On the Data tab of the AppXtender Document Manager Configuration dialog box, select JPEG from the True color images drop-down list. The JPEG Quality Factor (1-100) slide ruler becomes available.

2. From the True Color drop-down list, select JPEG.

3. Use the slide ruler on the scale to adjust (reduce or increase) the level of compression and the quality factor that AppXtender Document Manager or AppXtender Image Capture applies to True Color images when they are stored.

4. Click OK to save the settings.

Separate Multi-Page TIFFs

This option controls how AppXtender Document Manager or AppXtender Image Capture imports a multi-page TIFF or multi-page DCX file.

- If this option is enabled, AppXtender Document Manager or AppXtender Image Capture imports a multi-page TIFF or multi-page DCX file by separating each page of the imported file into a page within the new AppXtender document or AppXtender Image Capture batch. Each page is stored as a separate BIN file.

If you enable this option, file storage format for multi-page image files depends on the image storage format settings discussed above (for black and white, 4/8-bit color, or true color settings). If this option is enabled, AppXtender Document Manager or AppXtender Image Capture applies the selected image storage format (for example, BMP) to each stored page separated from the multi-page file. If this option is enabled and the image storage format is set to Default, all multi-page image files are saved in the file’s native format.

- If this option is disabled, AppXtender Document Manager or AppXtender Image Capture imports a multi-page TIFF or multi-page DCX file in its native format, regardless of the image storage format settings discussed above. All of the pages in the multi-page file are stored together as one BIN file. Disabling this option greatly increases the speed at which system conversion is completed.

Paths Tab

The Paths tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box allows you to configure local and personal write paths for the AppXtender Document Manager workstation. These are separate from the write paths established in AppXtender AppGen for the application. You may also enter volume label search drive(s) for the AppXtender Document Manager workstation. This setting tells AppXtender Document Manager or AppXtender Image Capture to look at the specified drives for the images. The Business Intelligence Gateway path is configured on this tab as well. However, it is not available on the AppXtender Image Capture Configuration tab because it configures a feature that is not necessary in AppXtender Image Capture.

Path settings are saved in the Windows registry for each AppXtender Document Manager or AppXtender Image Capture workstation. Whether you configure path settings on the Paths tab in the AppXtender Image Capture Configuration dialog box, or in the AppXtender Document Manager
Configuration dialog box, the settings are saved to the same place in the registry and apply only to the workstation where the configuration takes place.

For more information, see:
- Opening the Configuration Dialog Box, page 103
- Local Write Path, page 142
- Personal Search Path, page 142
- Volume Label Search Drives, page 143
- Business Intelligence Gateway Path, page 143

## Local Write Path

Using this option, you can activate a temporary storage area for scanning in AppXtender Document Manager or AppXtender Image Capture, such as a local hard drive. You can even configure a different local write path for each data source. If you index documents when scanning locally in AppXtender Document Manager, the index information is stored in the AppXtender application just as if you had scanned to the primary document write path, except the images are stored locally. The Local Write Path option enables you to use the local write path when needed and the document write path at other times. When this option is enabled, documents are stored in the path entered in the Local Write Path text box.

⚠️ **Caution:** Do not enable a local write path on the AppXtender Document Manager workstation where the Index Server is installed. If a local write path has been configured and enabled when you attempt to start the Index Server, an error message appears and the Index Server automatically shuts down.

**Note:** The Local Write Path option should be enabled when scanning locally. The option remains enabled until you clear the check box in the Paths tab of the Configuration dialog box.

**Note:** You cannot use volume labels for the local write path.

You can use the Move Online component of AppXtender Desktop to move locally scanned documents to the document write path. For instructions on using Move Online, see .

## Personal Search Path

Using this option, you can configure additional paths to search for AppXtender documents or AppXtender Image Capture batches. If documents or batches for an application are stored in a location that is not referenced in any of the other path settings, a personal search path should be set to allow for retrieval of those documents or batches.

When retrieving documents or batches, AppXtender Document Manager or AppXtender Image Capture searches first in the primary search path, then the application’s write path, and then the paths listed in the Personal Search Path text box. AppXtender Document Manager or AppXtender Image Capture then searches all the remaining configured write paths.
Volume Label Search Drives

The Paths tab of the AppXtender Document Manager or AppXtender Image Capture Configuration dialog box allows you to specify the drives that AppXtender Document Manager or AppXtender Image Capture searches to find documents batches that were stored on removable media using volume labels.

If removable media with volume labels are used as document write paths to store documents or batches, this option is used to configure retrieval of those documents or batches. The drive letter (or letters) where the media will be mounted must be specified as Volume Label Search Drives. AppXtender Document Manager or AppXtender Image Capture checks each of the drives specified to determine if the media labeled with the volume label is mounted in one of those drives. If not, AppXtender Document Manager or AppXtender Image Capture prompts the user to insert the appropriate media.

To specify a drive:
1. You have the following choices:
   • In the Volume Label Search Drive(s) text box, type the drive letter. (To specify multiple drives, type each drive letter separated by a semicolon.)
   • Click Select. Select a drive. (To specify multiple drives, hold down the [CTRL] key or [SHIFT] key while selecting the drives.)
2. Click OK to save the settings.

Business Intelligence Gateway Path

The Paths tab of the AppXtender Document Manager Configuration dialog box allows you to configure the path for submitting documents/reports to BI Gateway. This path is not available in the AppXtender Image Capture Configuration dialog box because it configures a feature that is not necessary in AppXtender Image Capture. This path must be configured before submission to BI Gateway is allowed. For more information, see Submitting Documents/Reports to BI Gateway, page 390.

To specify a BI Gateway path:
1. In the Business Intelligence Gateway path text box, type the path to the location where the AppXtender Reports Mgmt.INI file was stored by AppXtender Reports Management.
2. Click OK to save the settings.

Full Text Tab

The Full Text tab of the AppXtender Document Manager Configuration dialog box provides options for full-text indexing. The following is an explanation of the Full Text tab options that are available for your use. (The Full Text tab is not available on the AppXtender Image Capture Configuration dialog box, because it configures features that are not necessary in AppXtender Image Capture.)
For more information, see:
- Opening the Configuration Dialog Box, page 103
- Processing Queue, page 144
- Allow Full-Text, page 144
- Convert to Text (if necessary), page 144
- Prompt User with Queue Selection, page 145
- Submit New Documents for Full Text Index, page 145

**Processing Queue**

Use this option to choose the queue that will be used to process full-text indexing jobs. Full-text queues are created in the AppXtender Document Manager Index Server Configuration dialog box or in Queue Manager and can be selected at any AppXtender Document Manager workstation. Select the queue you want to use from the Processing Queue drop-down list.

*Note:* When considering which queues to assign to each workstation, keep in mind that you cannot use more than one Index Server for the same AppXtender application.

**Allow Full-Text**

Using this option, you can make all full-text commands unavailable to an AppXtender Document Manager workstation. This option may be useful when, for example, you are configuring a workstation for a user who does not need to use full text and you have a limited number of full-text licenses. If this option is enabled for an AppXtender Document Manager workstation when a user logs in to that workstation, a full-text license is used.

**To make all Full-Text commands unavailable on an AppXtender Document Manager workstation:**

1. Disable the Allow full-text option.
2. Restart AppXtender Document Manager. The full-text commands are now unavailable on this workstation.

**Convert to Text (if necessary)**

When this option is enabled, all image pages that you submit to the Index Server for full-text indexing are automatically processed using optical character recognition (OCR). When this option is not selected, you must use OCR to process an image page before you can submit it. In addition, when the OCR option is not selected, only text pages can be submitted to the Index Server.

*Note:* When you submit an image to the Index Server for full-text indexing, if the OCR (if necessary) option is enabled and if the image does require OCR processing, the result of the OCR processing is automatically plain text, regardless of the OCR Result Format configuration on the OCR tab.
Prompt User with Queue Selection

When this option is selected, AppXtender Document Manager will prompt you to pick a full-text queue every time a job is submitted to the Index Server. Disabling this option will result in every full-text index job being submitted to the queue selected in the Processing Queue drop-down list.

Submit New Documents for Full Text Index

When this option is enabled, all new documents (that are imported or scanned into AppXtender) are automatically submitted to the Index Server for full-text indexing. When the document is saved and closed, a message appears indicating that the full text index job has been submitted to the Index Server. For instructions on configuring the Index Server, consult your AppXtender system administrator or refer to the 'Managing the Index Server' chapter of the ApplicationXtender Administrator’s Guide. For instructions on creating a document, see Chapter 3, Creating Documents.

OCR Tab

The OCR tab contains options for using optical character recognition (OCR) with AppXtender. (The OCR tab is not available on the AppXtender Image Capture Configuration dialog box, because it configures features that are not available in AppXtender Image Capture.)

For more information, see:

- Opening the Configuration Dialog Box, page 103
- OCR Engine, page 145
- Allow OCR, page 145
- OCR Result Format, page 146
- OCR Job, page 146

OCR Engine

Using this option, you can choose the OCR engine to be used by AppXtender. The "RecoStar OCR Engine" option is always available as an OCR engine. (RecoStar OCR Engine is always installed with AppXtender Desktop.)

Allow OCR

Using this option, you can make all OCR commands unavailable to an AppXtender Document Manager workstation. This option may be useful when, for example, you are configuring a workstation for a user who does not need to use OCR.
To make all OCR commands unavailable on an AppXtender Document Manager workstation:

1. Click the Allow OCR check box to disable the option.
2. Restart AppXtender Document Manager. The OCR commands are now unavailable on this workstation.

OCR Result Format

Only text (TXT) format is supported.

Table 18. OCR Result Format Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain text (TXT)</td>
<td>The plain text format is an ASCII text format, readable on MS-DOS/Windows operating systems. Plain text format retains formatting options that are available in MS-DOS text format, such as bold and italics.</td>
</tr>
</tbody>
</table>

Note: OCR proofing is not supported.

OCR Job

The following topics describe the two ways that you can configure OCR jobs.

Processing Queue

Use this option to choose the queue that will be used to process OCR jobs. OCR queues can be created in the AppXtender Document Manager Index Server Configuration dialog box and can be selected at any AppXtender Document Manager workstation. Select the queue you want to use from the Processing Queue drop-down list. (For more information on creating an OCR queue, consult your AppXtender system administrator or refer to the "Managing Queues" chapter of the ApplicationXtender Core Components Administrator's Guide.)

Prompt User with Queue Selection

When this option is selected, AppXtender Desktop prompts the user to select an OCR queue each time a job is submitted to the Index Server. Disabling this option results in every OCR job being submitted to the queue selected in the Processing Queue drop-down list.
Fax-in Tab

The Fax-in tab of the AppXtender Document Manager Configuration dialog box allows you to choose a Fax-in server. (The Fax-in tab is not available on the AppXtender Image Capture Configuration dialog box, because it configures features that are not necessary in AppXtender Image Capture.)

To configure the Fax-in tab:

- From the Select Fax-in Server drop-down list, select the server that you want to use. AppXtender supports each of the following Fax-in servers:
  - Castelle FAX Press Server (Software Version 7.0.0/8.0.0)
  - RightFax (Software Version 8.5)

Note: If you select RightFax, everything that you need to connect to the FAX server is included in AppXtender Desktop. If you select a version of the Castelle FAX Press Server, the Castelle FAX Press client must be installed on the workstation. The Castelle FAX Press client is not included with AppXtender Desktop.

Note: If you select RightFax, you can customize the way columns appear in fax server queue dialog boxes, which list each incoming or outgoing fax from a selected queue. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. To modify these options, open the RFFIELDLIST.INI file, which is located in the C:\Program Files\ApplicationXtender\Content Management\ directory (or wherever AppXtender Desktop was installed), in Notepad and follow the instructions in the file to edit it.

For more information, see:
- Opening the Configuration Dialog Box, page 103

Thumbnail Tab

The Thumbnail tab allows you to configure the Thumbnail view. (The Thumbnail tab is not available on the AppXtender Image Capture Configuration dialog box.)

The following table describes each option on the Thumbnail Tab:

<table>
<thead>
<tr>
<th>Table 19. Thumbnail Tab Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
</tr>
<tr>
<td>thumbnail Width (pixels)</td>
</tr>
<tr>
<td>thumbnail Height (pixels)</td>
</tr>
<tr>
<td>Color Depth</td>
</tr>
<tr>
<td>Option</td>
</tr>
<tr>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Render foreign file</td>
</tr>
<tr>
<td>Render RTF File</td>
</tr>
<tr>
<td>Hide annotation if allowed to do so</td>
</tr>
<tr>
<td>3D Icon</td>
</tr>
<tr>
<td>Display thumbnail of the document when double-click on a query result.</td>
</tr>
<tr>
<td>Always display the thumbnail of the active document.</td>
</tr>
</tbody>
</table>

For more information, see:
- Opening the Configuration Dialog Box, page 103

**Document Signing Tab**

The Document Signing tab of the AppXtender Document Manager Configuration dialog box allows you to specify a digital certificate and comment to be used by default when documents are signed. This tab is available only for applications in which the Document signing option has been enabled.

For more information, see the following topics:
- Importing Digital Certificates, page 148
- Exporting Digital Certificates, page 149
- Specifying a Default Digital Certificate, page 149
- Clearing Default Digital Certificate, page 149
- Deleting Digital Certificates, page 150

**Importing Digital Certificates**

Import a digital certificate on each AppXtender Document Manager workstation that will be used to sign AppXtender page versions.
To import digital certificates:
2. Specify the certificate file to import. (You can click Browse to locate the file.)
3. Specify the password for the private key.
4. Specify whether you want the certificate file to be available only for the current user or for any user on the machine.
5. Specify whether you want to enable strong private key protection.
6. Specify whether you want the certificate to be exportable.
7. Click OK.
8. On the Document Signing tab, click OK.

Exporting Digital Certificates

To export a certificate:
2. Specify the certificate file to export. (You can click Browse to locate the file.)
3. Specify the password for the private key.
4. Click OK.

Specifying a Default Digital Certificate

To specify a default certificate and comment:
1. On the Document Signing tab, select the certificate that you want to designate as default.
2. Click Set As Default. The default comment text box becomes available.
3. In the default comment text box, type the comment that you want to include each time a document is signed.
4. On the Document Signing tab, click OK.

Clearing Default Digital Certificate

To clear the default certificate designation:
1. On the Document Signing tab, select the default certificate.
2. Click Clear.
3. On the Document Signing tab, click OK.
Deleting Digital Certificates

To delete a certificate from configuration:
1. On the Document Signing tab, select the certificate that you want to delete.
2. Click Delete. A message appears asking you to confirm the deletion.
3. Click Yes.
4. On the Document Signing tab, click OK.

Saving and Loading Settings

To make AppXtender system deployment easier for you, AppXtender has Save Settings and Load Settings features that allow you to copy workstation settings from one AppXtender Document Manager workstation to another. You (or the user) customize the configuration of the AppXtender Document Manager workstation in several ways, and then you save the configuration. To copy the saved configuration to other workstations, you then just load the saved settings file on each workstation and all of the saved configuration settings are applied. The following topics detail the settings that are saved and explain how to save and load settings.

For more information, see:
- Saving Settings, page 150
- Saved Workstation Settings, page 153
- Loading Settings, page 160

Saving Settings

Once the AppXtender Document Manager workstation has been configured, you can save the customized settings to a configuration file. The saved settings file can be loaded on other AppXtender Document Manager workstations to copy the saved configuration settings to those workstations.

Note: If a profile is created in one version of AppXtender, this profile cannot be applied to later versions of AppXtender. You must save a new settings file for specific to each AppXtender release.

When you save settings for a workstation, AppXtender saves information about all of the options in the AppXtender Document Manager Configuration dialog box. When you load the settings on another workstation, the settings you saved are loaded for that workstation. If an option is enabled on the workstation where the settings are saved, the option is enabled on the other workstation once you load the settings.

In addition to AppXtender Document Manager Configuration dialog box options, Save Settings saves information about the views and toolbars on the AppXtender Desktop desktop. If, for example, Allow Docking is enabled for the Query view on the workstation where you save settings, Allow Docking is enabled on the AppXtender Desktop desktop of the second workstation once you load settings.

Additional information saved when you save settings includes default settings for annotations, the data source configurations on the AppXtender Document Manager workstation, and the last
directories used for several AppXtender Desktop functions. For details on setting AppXtender annotation defaults, refer to Creating Line and Shape Annotations, page 445. For more information on setting up AppXtender data sources, refer to the ApplicationXtender Installation Guide.

For a detailed list of the settings that are saved, refer to Saved Workstation Settings, page 153.

**To save a workstation settings file:**

1. Make the appropriate changes to the AppXtender Document Manager Configuration settings, annotation defaults, data source configuration, and desktop arrangement.

2. Select Save Settings from the File menu. The Save AppXtender Document Manager Settings dialog box appears.

**Figure 54. Save AppXtender Document Manager Settings Dialog Box**

3. If you want to specify the type of file you are saving, from the Save as type drop-down list, select the type of files that you want to save. Your available choices are AppXtender Document Manager Settings Files (*.AXS) or All Files (*. *).

4. Select the location to save the file. You can select the location from the Save in drop-down list and double-click a folder or file in the box below to open it, or enter a path and file name.

5. You also have the following options:
   - To save the AppXtender Document Manager workstation configuration settings, leave the AppXtender Document Manager Settings check box enabled. Enabling this option saves all
AppXtender Document Manager configuration settings, toolbar configuration, views, and status bar settings.

- To save data source settings, leave the XSCM.Config check box enabled. For more information, refer to Important Information about XSCM.CONFIG, page 152.
- To save settings from an AppXtender integration with Microsoft Outlook, such as targets and field mappings, enable the Outlook check box. (For information on integrating AppXtender with Microsoft Outlook, refer to the Microsoft Integration for ApplicationXtender Integration Guide.)

6. Click Save. The file is saved in the specified location.

For more information, see:
- Saved Workstation Settings, page 153
- Loading Settings, page 160

### Important Information about XSCM.CONFIG

When you use AppXtender Administrator (AppXtender Admin), Component Setup Wizard, or Data Source Selector, settings are read from and written to C:\Documents and Settings\All Users\Application Data\XSCM.CONFIG. Each component writes different settings to this file.

⚠️ **Caution:** Do not edit or distribute the XSCM.CONFIG file.

The recommended method for providing each user with access to a data source group is to have each user use the Data Source Selector to locate a data source, as described in Locating Data Sources, page 51.

However, the XSCM.Config file check box on the Load AppXtender Document Manager Settings dialog box and the Save AppXtender Document Manager Settings dialog box provides another method for distributing data source connectivity. When you save workstation settings with the XSCM.Config file check box selected, the contents of the XSCM.CONFIG file are included in the AppXtender Document Manager settings file. The contents of the XSCM.CONFIG file are located at the end of the AppXtender Document Manager settings file starting with line [XSCM.CFG].

The AppXtender Document Manager settings file can be distributed to other AppXtender Document Manager workstations. When your users load an AppXtender Document Manager settings file that has an [XSCM.CFG] section in it, with the XSCM.Config file check box selected, a new XSCM.CONFIG file is created. Each user is then prompted to log in to the default data source, as specified in the new XSCM.CONFIG file.
Customizing Your AppXtender Document Manager Workstation

⚠️ **Caution:** If you choose to use this method for distributing data source connectivity, you must take both of the following precautions:

- Ensure that AppXtender Admin, the Component Setup Wizard, AppXtender Web Access Server, and Rendering Server have not been installed on any of the computers on which you intend to save or load the AppXtender Document Manager workstation settings.
- Ensure that no changes are made in AppXtender Admin or in the Component Setup Wizard on any computer in your AppXtender system between saving and loading AppXtender Document Manager workstation settings.

If problems occur after deployment on an AppXtender Document Manager workstation, use the Data Source Selector to locate a data source, as described in Locating Data Sources, page 51. If problems occur after deployment on a workstation with AppXtender Web Access components, run the Component Setup Wizard to register components again as described in the ApplicationXtender Web Access Administrator’s Guide.

## Saved Workstation Settings

The following table lists the settings that are saved when you save settings for an AppXtender Document Manager workstation:

**Table 20. Saved Workstation Settings**

<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
</table>
| AppXtender Document Manager Desktop Configuration | • The tab of the Configuration dialog box that was most recently viewed  
| | • The data source set as the active data source (shown in bold in the Application view)  
| | • The application set as the active application (shown in bold in the Application view)  
| | • Allow Docking option for the Application view  
| | • Allow Docking option for the Query view  
| | • Allow Docking option for the Thumbnail view  
| | • Hide On Use option for the Application view  
| | • Hide On Use option for the Query view  
| | • Float as MDI Window option for the Application view  
<p>| | • Float as MDI Window option for the Query view |</p>
<table>
<thead>
<tr>
<th><strong>AppXtender Document Manager Configuration</strong></th>
<th><strong>Saved Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Float as MDI Window option for the Thumbnail view</td>
</tr>
<tr>
<td></td>
<td>• New Document Index view location</td>
</tr>
<tr>
<td></td>
<td>• Modify Document Index view location</td>
</tr>
<tr>
<td></td>
<td>• Batch Index view location</td>
</tr>
<tr>
<td></td>
<td>• Batch Index view column settings</td>
</tr>
<tr>
<td></td>
<td>• Display of Enhance Image dialog box</td>
</tr>
<tr>
<td><strong>Annotation Settings</strong></td>
<td>• Foreground color</td>
</tr>
<tr>
<td></td>
<td>• Background color</td>
</tr>
<tr>
<td></td>
<td>• Line width</td>
</tr>
<tr>
<td></td>
<td>• List of most recently used rubber stamp annotations for each AppXtender application</td>
</tr>
<tr>
<td></td>
<td>• Default annotation group for each data source</td>
</tr>
<tr>
<td><strong>Toolbars</strong></td>
<td>• For all toolbars:</td>
</tr>
<tr>
<td></td>
<td>— Small icons</td>
</tr>
<tr>
<td></td>
<td>— Large icons.</td>
</tr>
<tr>
<td></td>
<td>• For each toolbar:</td>
</tr>
<tr>
<td></td>
<td>• Display location</td>
</tr>
<tr>
<td></td>
<td>• Whether or not the toolbar is hidden</td>
</tr>
<tr>
<td><strong>Query Result Set column Configuration</strong></td>
<td>• The settings for result set column display in the result set for each application</td>
</tr>
<tr>
<td><strong>View Tab Configuration</strong></td>
<td>• Image Size</td>
</tr>
<tr>
<td></td>
<td>— Fit to window</td>
</tr>
<tr>
<td></td>
<td>— Fit to window height</td>
</tr>
<tr>
<td></td>
<td>— Fit to window width</td>
</tr>
<tr>
<td></td>
<td>• Actual size</td>
</tr>
<tr>
<td></td>
<td>• Use zoom setting</td>
</tr>
<tr>
<td></td>
<td>• Zoom settings are pixels</td>
</tr>
<tr>
<td></td>
<td>• Display text view of page</td>
</tr>
<tr>
<td>AppXtender Document Manager Configuration</td>
<td>Saved Settings</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td>• Scale-to-gray</td>
</tr>
<tr>
<td></td>
<td>• Restore last layout at startup</td>
</tr>
<tr>
<td></td>
<td>• Use KeyView to display foreign files</td>
</tr>
<tr>
<td></td>
<td>• Allow map of unknown data sources to existing data sources</td>
</tr>
<tr>
<td>Display Tab Configuration</td>
<td>• Screen DPI</td>
</tr>
<tr>
<td></td>
<td>— Vertical</td>
</tr>
<tr>
<td></td>
<td>— Horizontal</td>
</tr>
<tr>
<td></td>
<td>• Maximum Query Results</td>
</tr>
<tr>
<td></td>
<td>• Sort result set automatically</td>
</tr>
<tr>
<td></td>
<td>• Sort Order of Document ID</td>
</tr>
<tr>
<td></td>
<td>— Ascending Order</td>
</tr>
<tr>
<td></td>
<td>— Descending Order</td>
</tr>
<tr>
<td></td>
<td>• PgUp/PgDn in dual-page view</td>
</tr>
<tr>
<td></td>
<td>— Next/previous 2 pages</td>
</tr>
<tr>
<td></td>
<td>— Next/previous page</td>
</tr>
<tr>
<td>Fonts Tab Configuration</td>
<td>• Screen Fonts</td>
</tr>
<tr>
<td></td>
<td>• Printer Fonts</td>
</tr>
<tr>
<td></td>
<td>• Simulate Box Drawing Characters</td>
</tr>
<tr>
<td></td>
<td>— Enable Support for Form Text</td>
</tr>
<tr>
<td></td>
<td>— Enable Support for Data Text</td>
</tr>
<tr>
<td>Scan Tab Configuration</td>
<td>• Allow Image Processing</td>
</tr>
<tr>
<td></td>
<td>• Remove blank pages (and Threshold)</td>
</tr>
<tr>
<td></td>
<td>• Synchronized scan</td>
</tr>
<tr>
<td></td>
<td>• Scanner manual feed timeout</td>
</tr>
<tr>
<td>AppXtender Document Manager Configuration</td>
<td>Saved Settings</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>COLD Tab Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Cache forms</td>
</tr>
<tr>
<td></td>
<td>• Allow paste text</td>
</tr>
<tr>
<td></td>
<td>• Allow zoom</td>
</tr>
<tr>
<td></td>
<td>• Display as image only</td>
</tr>
<tr>
<td></td>
<td>• Form Overlay Settings</td>
</tr>
<tr>
<td></td>
<td>— Screen</td>
</tr>
<tr>
<td></td>
<td>— Printer</td>
</tr>
<tr>
<td></td>
<td>• Default Color Bar settings</td>
</tr>
<tr>
<td></td>
<td>— Show</td>
</tr>
<tr>
<td></td>
<td>— Lines</td>
</tr>
<tr>
<td></td>
<td>— Color</td>
</tr>
<tr>
<td>Print Tab Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Print original size</td>
</tr>
<tr>
<td></td>
<td>• Dithering</td>
</tr>
<tr>
<td></td>
<td>• Toolbar Print Button</td>
</tr>
<tr>
<td></td>
<td>• Acceleration</td>
</tr>
<tr>
<td></td>
<td>— None</td>
</tr>
<tr>
<td></td>
<td>— XipPrint</td>
</tr>
<tr>
<td></td>
<td>— Talaris</td>
</tr>
<tr>
<td></td>
<td>— Quick PCL</td>
</tr>
<tr>
<td></td>
<td>• Endorsement</td>
</tr>
<tr>
<td></td>
<td>— Endorse printed pages</td>
</tr>
<tr>
<td></td>
<td>— Position</td>
</tr>
<tr>
<td></td>
<td>— Text</td>
</tr>
<tr>
<td>AppXtender Document Manager Configuration</td>
<td>Saved Settings</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| OCR Tab Configuration | • OCR Engine  
• Allow OCR  
• OCR Result Format  
• Template Settings  
• Language Selection  
• Text View  
  – Enable proofing  
  – Use form templates  
• Export  
  – Enable proofing  
  – Use form templates  
• Indexing  
  – Enable proofing  
• Processing Queue  
• Prompt user with queue selection on submit |
| Fax-in Tab Configuration | • Select Fax-in Server |
| Thumbnail Tab Configuration | • Thumbnail Width (Pixels)  
• Thumbnail Height (Pixels)  
• Color Depth  
• Render foreign file  
• Render RTF file  
• Hide annotation if allowed to do so  
• 3D icon  
• Display thumbnail of document when double-click result set  
• Always display the thumbnail of the active document |
| Document Signing Tab Configuration | • Default certificate  
• Default comment |
<table>
<thead>
<tr>
<th>AppXtender Document Manager Configuration</th>
<th>Saved Settings</th>
</tr>
</thead>
</table>
| E-Mail Tab Configuration               | • Use PDF format if possible  
                                     | • Use XPS format if possible  
                                     | • Black & White Images Format  
                                     | • Pseudo Color Images Format  
                                     | • True Color Images Format  
                                     |   — JPEG Quality Factor  
                                     | • Text Format  
                                     | • Use multi-page files  
                                     | • Vendor  
                                     |   — Microsoft (MAPI32)  
                                     |   — CC: Mail (SMI32)  |
| Export Tab Configuration                | • Use PDF format if possible  
                                     | • Black & White Images Format  
                                     | • Pseudo Color Images Format  
                                     | • True Color Images Format  
                                     |   — JPEG Quality Factor  
                                     | • Text Format  
                                     | • Use multi-page files  |
| File Types Tab Configuration            | • File types that have been added and their associated file extensions  |
| Data Tab Configuration                  | • Enable dual data entry  
                                     | • Disable query window  
                                     | • Database connect & drop  
                                     | • Check for matching index  
                                     | • ODMA support  
                                     | • Allow remember password  
                                     | • Prompt for checkout when open  
<pre><code>                                 | • Enable ODMA Attribute Search  |
</code></pre>
<table>
<thead>
<tr>
<th><strong>AppXtender Document Manager Configuration</strong></th>
<th><strong>Saved Settings</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Auto Logout</td>
</tr>
<tr>
<td></td>
<td>• Date Field with 2-digit Year Max Future Years Setting</td>
</tr>
<tr>
<td></td>
<td>• Image Storage Format</td>
</tr>
<tr>
<td></td>
<td>• Black &amp; White</td>
</tr>
<tr>
<td></td>
<td>• 4/8-Bit Color</td>
</tr>
<tr>
<td></td>
<td>• True Color</td>
</tr>
<tr>
<td></td>
<td>• Separate multi-page TIFFs</td>
</tr>
<tr>
<td></td>
<td>• JPEG Quality Factor</td>
</tr>
<tr>
<td>Paths Tab Configuration</td>
<td>• Local write path use</td>
</tr>
<tr>
<td></td>
<td>• Local write path</td>
</tr>
<tr>
<td></td>
<td>• Personal search path</td>
</tr>
<tr>
<td></td>
<td>• Volume label search drives</td>
</tr>
<tr>
<td>Full-Text Tab Configuration</td>
<td>• Processing Queue</td>
</tr>
<tr>
<td></td>
<td>• Allow Full text</td>
</tr>
<tr>
<td></td>
<td>• Convert to text (if necessary)</td>
</tr>
<tr>
<td></td>
<td>• Prompt user with queue selection on submit</td>
</tr>
<tr>
<td></td>
<td>• Submit new documents for full text index</td>
</tr>
<tr>
<td>Directories</td>
<td>• Last import directory</td>
</tr>
<tr>
<td></td>
<td>• Last export directory</td>
</tr>
<tr>
<td></td>
<td>• Last Batch Create directory</td>
</tr>
<tr>
<td></td>
<td>• Last Batch Import directory</td>
</tr>
<tr>
<td></td>
<td>• Last OCR export directory</td>
</tr>
<tr>
<td>Data Source Configuration</td>
<td>• Default data source setting</td>
</tr>
<tr>
<td></td>
<td>• Selected data sources</td>
</tr>
<tr>
<td></td>
<td>• For each data source:</td>
</tr>
<tr>
<td></td>
<td>-- Description</td>
</tr>
<tr>
<td></td>
<td>-- Encoded data source connection string</td>
</tr>
</tbody>
</table>
Loading Settings

When you choose Load Settings from the File menu, AppXtender Desktop displays the Load AppXtender Document Manager Settings dialog box. This dialog box allows you to load previously saved configuration settings on an AppXtender Document Manager workstation. The settings consist of the AppXtender Document Manager settings that are found in the AppXtender Document Manager Configuration dialog box, toolbar configuration, AppXtender Desktop views, and status bar settings, user data source settings, and system data source settings.

**Note:** When you attempt to open AppXtender Desktop, if a message appears indicating that AppXtender cannot find the data source or licensing information it needs to connect to the AppXtender database, you can load settings to provide AppXtender with connection information.

**To load a workstation settings file:**

1. From the File menu, select Load Settings. The Load AppXtender Document Manager Settings dialog box appears.

   ![Figure 55. Load AppXtender Document Manager Settings Dialog Box](image)
2. Select the file name. You can select the appropriate folder from the Look In drop-down list and double-click a folder or file in the box below to open it, or enter a path and file name and click Open.

If you do not find an AXS file saved to your desktop, contact your system administrator to determine if a workstation profile has been saved for you. The system administrator can save AppXtender data source settings to a file for you from another AppXtender Document Manager workstation that is accessing the same database, and you can load that file.

3. Specify which settings are loaded from the file. You have the following choices:
   - To load the AppXtender Document Manager workstation configuration settings, leave the AppXtender Document Manager Settings check box enabled. Enabling this option loads all AppXtender Document Manager Configuration settings, toolbar configuration, AppXtender Desktop views, and status bar settings.
   - To load the data source settings, leave the XSCM.Config check box enabled. For more information, refer to Important Information about XSCM.CONFIG, page 152.
   - To load settings from an AppXtender integration with Microsoft Outlook, such as targets and field mappings, enable the Outlook check box. (For information on integrating AppXtender with Microsoft Outlook, refer to the Microsoft Outlook Integration for ApplicationXtender)

Note: If AppXtender is having trouble connecting to the AppXtender database on your computer, you can copy the data source settings for a workstation that can successfully connect to the database and load the data source settings on your computer. If you choose not to load AppXtender Document Manager Settings when you load settings, you can load the data source configuration without affecting the rest of your AppXtender configuration.

4. Click Open. The Login dialog box appears.
Note: Your login procedure may vary depending on the security provider in use for the current data source. For information, refer to the ApplicationXtender Core Components Administrator's Guide.

You must re-login to AppXtender Document Manager to load the saved profile.

5. From the Logon Type drop-down list, select the type of license that you want the logon to use. The following table describes each logon type:

Table 21. AppXtender Desktop License Types

<table>
<thead>
<tr>
<th>Login Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Document Manager</td>
<td>Logs into AppXtender Document Manager using an AppXtender Desktop license only.</td>
</tr>
<tr>
<td>CX/AppXtender Reports Mgmt</td>
<td>Logs into AppXtender Document Manager using a CX and AppXtender Reports Mgmt license only, so that you can view CX/AppXtender Reports Mgmt data.</td>
</tr>
<tr>
<td>AppXtender Document Manager &amp; CX/AppXtender Reports Mgmt</td>
<td>Logs into AppXtender Document Manager using both an AppXtender Document Manager and CX/AppXtender Reports Mgmt license, so that you can view both AppXtender and CX/AppXtender Reports Mgmt data.</td>
</tr>
</tbody>
</table>

6. In the User Name text box, type a user name that is valid for the default data source.

7. In the Password text box, type your password.

8. Click Login. AppXtender resets your AppXtender Document Manager workstation to the new workstation profile settings.

Note: If AppXtender is unable to connect to the database, check the database to make sure that it is running and accessible.

For more information, see:

- Saving Settings, page 150
- Saved Workstation Settings, page 153
Chapter 3

Creating Documents

This section topic describes the procedures for creating, indexing, and submitting documents to a full-text queue.

- Introduction to Document Creation, page 163
- Creating New Documents, page 164
- Creating Documents in Batches, page 194
- Indexing New Documents, page 205
- Indexing Batches, page 213
- Submitting Documents to a Full-text Queue, page 219

Introduction to Document Creation

ApplicationXtender (AppXtender) allows you to store and organize many types of information as documents. AppXtender documents are organized in applications for easy retrieval. A variety of input methods are available for you to add documents and pages to applications. Each document is saved in AppXtender with an index that is used to search for the document. AppXtender allows you to add pages and page versions to documents after they have been created.

Note: If you would prefer to create your AppXtender documents directly from an ODMA-compliant application, such as Microsoft Word, you can do so. When you create a document through ODMA, you create the document in the ODMA-compliant application and then index the document and check it into AppXtender. For more information on creating AppXtender documents through ODMA, refer to Chapter 8, Using ODMA With AppXtender Documents.

The following procedures provide an overview of the two document creation methods discussed in this section set of topics: creating documents one at a time and creating documents in batches.

To create documents one at a time:

1. Bring the information that you want to store into AppXtender. You can use several different methods to bring information into AppXtender. For more information, refer to Creating New Documents, page 164. After you have brought the information into AppXtender, it appears in Document Display view and an empty Index View appears.

2. Index the new document. To enter information into the fields, you can type, use AppXtender’s automated indexing features, or both. For more information, refer to Indexing New Documents, page 205.
Creating Documents

3. Click Save. The new document is stored in AppXtender with its index information.

4. If necessary, add pages to the new document. For more information, refer to Adding Pages to Documents, page 340.

5. If necessary, submit the new document to the ApplicationXtender Index Server (AppXtender Index Server) for full-text searching. For more information, refer to Submitting Documents to a Full-text Queue, page 219.

   Note: Your workstation may be configured so that when you save and close a new document, it is automatically submitted to the AppXtender Index Server for full-text searching. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143 consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

To create documents in batches:

1. Create or import a batch of documents. For more information, refer to Creating Documents in Batches, page 194.

   Note: As soon as the batch has been created, it is available for indexing.

2. Use the Batch Index utility to index the documents in the batch. To enter information into the fields, you can type, use AppXtender’s automated indexing features, or both. For more information, refer to Indexing Batches, page 213.

3. If necessary, add pages to the new documents. For more information, refer to Adding Pages to Documents, page 340.

4. If necessary, submit the new documents to the AppXtender Index Server for full-text searching. For more information, refer to Submitting Documents to a Full-text Queue, page 219.

   Note: Your workstation may be configured so that when you save and close a new document, it is automatically submitted to the AppXtender Index Server for full-text searching. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143 consult your AppXtender system administrator or refer to the "Configuring AppXtender Document Manager Workstations" section of the ApplicationXtender Installation Guide.

Creating New Documents

When you create a document in AppXtender, you bring the document into AppXtender and enter index information that identifies the document. Index fields must be populated for every document in an application, and the combination of data entered into the fields for a particular document should be unique. Unique sets of index data keep documents organized and allow for easier retrieval and display. The index information for each document is stored in the AppXtender database along with page information and the storage location.

All the commands necessary for creating a new document are available from the Document menu. Document creation begins with the input of the first page. Each document in an application must contain at least one page. The commands to add additional pages to a document, which are similar to the Document menu commands, are found in the Page menu.

Note: In the _RSTAMP and _FORMS applications, each document can consist of only one page. For more information on the _RSTAMP and _FORMS applications, consult your AppXtender system
administrator or refer to the "Configuring AppXtender Document Manager Workstations" section of the ApplicationXtender Installation Guide.

To begin the document creation process:

1. In Application view on the AppXtender user desktop, right-click the name of the application to which you want to add the document. The application shortcut menu appears.

2. From the shortcut menu, select New Document.

3. Select the input method that you want to use.

For more information, see:

- Creating New Documents, page 164
- New AppXtender Document Object Dialog Box, page 165
- Input Methods, page 165
- Adding a Document by Scanning, page 172
- Adding a Document from the Windows Clipboard, page 173
- Adding a Document by Inserting an Object, page 177
- Adding a Document by Importing a File, page 182
- Adding a Document from the Fax-in Queue, page 189
- Creating _RSTAMP and _FORMS Documents, page 192

New AppXtender Document Object Dialog Box

The New AppXtender Document Object dialog box appears when you click the New Document button on the Main toolbar. Select the input method that you want to use and click OK.

For more information, see:

- Creating New Documents, page 164
- Input Methods, page 165
- Adding a Document by Scanning, page 172
- Adding a Document from the Windows Clipboard, page 173
- Adding a Document by Inserting an Object, page 177
- Adding a Document by Importing a File, page 182
- Adding a Document from the Fax-in Queue, page 189

Input Methods

AppXtender allows for various methods of creating documents or pages, such as:

- Scanning
- Clipboard Paste
Creating Documents

- Clipboard Paste Special (paste as a different file type)
- Insert Object
- Import File
- Fax-in Queue

These various input sources can be used for the first page and for any successive page. Because document creation begins with adding the first page, each input source is detailed in this topic.

Note: The Insert Object input method is not available for creating documents in either the _RSTAMP or _FORMS applications.

For more information, see:
- Creating New Documents, page 164
- Deciding What Input Method to Use, page 166
- Support for Viewing of Imported Files in AppXtender, page 167

**Deciding What Input Method to Use**

AppXtender allows you to create documents in many ways. The following table will help you decide the best way to bring a document into AppXtender:

<table>
<thead>
<tr>
<th>If the Document You Want to Create is</th>
<th>Use the Method</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>A paper document that is not yet in electronic format</td>
<td>Scanning</td>
<td>Chapter 4, Scanning or the ApplicationXtender Image Capture User’s Guide</td>
</tr>
<tr>
<td>An electronic document that is in an image format supported in AppXtender</td>
<td>Import File</td>
<td>Support for Viewing of Imported Files in AppXtender, page 167 or Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is a text file (*.TXT)</td>
<td>Import File</td>
<td>Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is a Rich Text Format file (*.RTF)</td>
<td>Import File</td>
<td>Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is a Hypertext Markup Language file (*.HTM or *.HTML)</td>
<td>Import File</td>
<td>Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is an Adobe Portable Document Format (PDF) file (*.PDF)</td>
<td>Import File</td>
<td>Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>If the Document You Want to Create is</td>
<td>Use the Method</td>
<td>For More Information, Refer To</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>An electronic document that is an e-mail attachment in Microsoft Outlook</td>
<td>Import File (drag and drop e-mail attachment)</td>
<td>Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is in a format not natively supported by AppXtender and that you would like to index using full-text indexing</td>
<td>Import File</td>
<td>Support for Viewing of Imported Files in AppXtender, page 167 or Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using ODMA</td>
<td>Import File</td>
<td>Support for Viewing of Imported Files in AppXtender, page 167 or Adding a Document by Importing a File, page 182</td>
</tr>
<tr>
<td>An electronic document that is in a format that is not natively supported by AppXtender and that you would like to work with within the application in which it was created using in-place editing in AppXtender (Note that documents brought into AppXtender as objects cannot be submitted for full-text indexing.)</td>
<td>Clipboard Paste or Clipboard Paste Special or Insert Object</td>
<td>Support for Viewing of Imported Files in AppXtender, page 167 or Adding a Document from the Windows Clipboard, page 173 or Adding a Document by Inserting an Object, page 177</td>
</tr>
<tr>
<td>A fax in a fax server queue</td>
<td>Fax-in Queue</td>
<td>Adding a Document from the Fax-in Queue, page 189</td>
</tr>
</tbody>
</table>

For more information, see:
- Input Methods, page 165

**Support for Viewing of Imported Files in AppXtender**

Files imported into AppXtender are supported for viewing in three ways: using the native AppXtender viewer, using the KeyView Viewer, and using ODMA-compliant applications.
Creating Documents

For more information, see:
- Input Methods, page 165
- Native AppXtender File Support, page 168
- KeyView File Support, page 168
- ODMA File Support, page 172

**Native AppXtender File Support**

AppXtender supports several file formats natively. File formats that are supported natively display in the Document Display view without need for an additional third-party viewer or any additional AppXtender configuration. AppXtender-supported file types include:
- Bitmap (BMP)
- TrueVision Targa (TGA)
- DCX
- Graphics Interchange Format (GIF)
- JPEG
- PCX
- Tagged Image File Format (TIFF)
- Rich Text Format (RTF)
- Hypertext Markup Language (HTML)

All files that are not natively supported in AppXtender are referred to as "foreign files," both in this document and in the AppXtender interface.

Keep in mind the following points:
- Multi-page TIFF and DCX files can be imported into AppXtender. Each page of the imported file becomes a page within the new AppXtender document. Your workstation may be configured to store each multi-page TIFF file as one BIN file or many BIN files. For information, see Data Tab, page 134 consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.
- AppXtender does not support progressive JPEGs or GIF animation files. Importing a progressive JPEG or a GIF animation file into AppXtender results in the file being imported as a foreign file.

For more information, see:
- Support for Viewing of Imported Files in AppXtender, page 167

**KeyView File Support**

Several file formats that are not supported natively by AppXtender are supported by the KeyView Viewer, which has been integrated with AppXtender. When the KeyView Viewer is enabled in the View tab of the AppXtender Configuration dialog box, the contents of KeyView-supported files are displayed in Document Display view without need of a third-party viewer. The appearance of
a foreign file in the KeyView Viewer is similar to but not exactly the same as its appearance in its
native viewer.

**Embedded Office Viewer**

ApplicationXtender allows you to view, edit, and print Microsoft Office 2003 and 2007 documents in
a native Office embedded window inside the ApplicationXtender Document Display view. This
capability, which is available for Word, Excel, PowerPoint, and Visio Office document formats, uses
Microsoft Object Linking and Embedding (OLE) technology.

You can enable the Office Viewer feature in ApplicationXtender Document Manager by selecting
the **Use KeyView to display foreign files** option on the View tab of the Configuration dialog. If
KeyView is enabled, ApplicationXtender displays supported Office documents using the Office
Viewer automatically, in either read-only mode (without Office toolbars) or edit mode (with Office
toolbars), depending on the current document read/write permission.

After editing a supported Office document within the embedded Office Viewer, users can do the
following:

- Save the file as a new page version using the **Save** button on the Office toolbar
- Replace the existing page version with the modified file using the **Save** button
- Discard the changes made to the file by closing the Document Display view without saving
  the changes

You can also print Office document pages using native Office document printing. Selecting the
ApplicationXtender Page > Print command or Print toolbar button (if it is configured to print pages)
invokes the Office print functionality. Alternatively, you can print the document using the standard
ApplicationXtender Document Print functionality.

The following issues pertain to the Office Viewer feature:

- Each MS Office application behaves differently when used in embedded mode. Different versions
  of Office also behave quite differently in terms of the user interface.
- You are not prevented from editing Office documents that are in read-only mode. However,
  because Office toolbars are not available in read-only mode, you cannot save changes.
- In edit mode, each Office application provides an Office toolbar. The buttons on the toolbar may
  not be enabled or disabled correctly depending on the Office application. For example, the Save
  button works correctly for Word documents. However, it is always enabled, but not functional, for
  Excel and PowerPoint documents. This behavior is controlled by the Office application; therefore,
  ApplicationXtender cannot change it.

The following table lists the foreign file types that can be viewed using the KeyView Viewer:

<table>
<thead>
<tr>
<th>Format</th>
<th>Foreign File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Processing</td>
<td>Adobe Maker Interchange Format</td>
</tr>
<tr>
<td></td>
<td>Applix Words</td>
</tr>
<tr>
<td></td>
<td>ASCII Text</td>
</tr>
<tr>
<td></td>
<td>ANSI Text</td>
</tr>
<tr>
<td></td>
<td>Autocad DXF &amp; Export formats</td>
</tr>
<tr>
<td>Format</td>
<td>Foreign File Type</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>DisplayWrite</td>
<td></td>
</tr>
<tr>
<td>Folio Flat File</td>
<td></td>
</tr>
<tr>
<td>Fujitsu Oasys</td>
<td></td>
</tr>
<tr>
<td>HTML</td>
<td></td>
</tr>
<tr>
<td>IBM DCA/RFT</td>
<td></td>
</tr>
<tr>
<td>JustSystems Ichitaro</td>
<td></td>
</tr>
<tr>
<td>Lotus Ami Pro</td>
<td></td>
</tr>
<tr>
<td>LotusSmartMaster</td>
<td></td>
</tr>
<tr>
<td>Lotus Word Pro</td>
<td></td>
</tr>
<tr>
<td>Maker Interchange Format (MIF)</td>
<td></td>
</tr>
<tr>
<td>Microsoft RTF</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word for Windows</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word Mac</td>
<td></td>
</tr>
<tr>
<td>Microsoft Word PC</td>
<td></td>
</tr>
<tr>
<td>Microsoft Works</td>
<td></td>
</tr>
<tr>
<td>Microsoft Write</td>
<td></td>
</tr>
<tr>
<td>RichText Format</td>
<td></td>
</tr>
<tr>
<td>Unicode</td>
<td></td>
</tr>
<tr>
<td>WordPro</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for DOS</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Linus</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Mac</td>
<td></td>
</tr>
<tr>
<td>WordPerfect for Windows</td>
<td></td>
</tr>
<tr>
<td>XHTML</td>
<td></td>
</tr>
<tr>
<td>XML</td>
<td></td>
</tr>
<tr>
<td>XyWrite for Windows</td>
<td></td>
</tr>
<tr>
<td>Spreadsheets</td>
<td></td>
</tr>
<tr>
<td>Applix Spreadsheets (AS)</td>
<td></td>
</tr>
<tr>
<td>Comma Separated Values (CSV)</td>
<td></td>
</tr>
<tr>
<td>Corel Quattro Pro (QPW, WB3)</td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 (123)</td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 (WK4)</td>
<td></td>
</tr>
<tr>
<td>Lotus 1-2-3 Charts (123)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel Charts (XLS)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel for Windows (XLS)</td>
<td></td>
</tr>
<tr>
<td>Microsoft Excel for Windows XML Format</td>
<td></td>
</tr>
<tr>
<td>Format</td>
<td>Foreign File Type</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel for Macintosh (XLS)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Works Spreadsheet (S30, S40)</td>
</tr>
<tr>
<td></td>
<td>Open Office (SXC)</td>
</tr>
<tr>
<td></td>
<td>StarOffice (SXC)</td>
</tr>
<tr>
<td>Presentations</td>
<td>Applix Presents</td>
</tr>
<tr>
<td></td>
<td>Corel Presentations</td>
</tr>
<tr>
<td></td>
<td>Lotus Freelance</td>
</tr>
<tr>
<td></td>
<td>Microsoft Powerpoint for Windows</td>
</tr>
<tr>
<td></td>
<td>Microsoft Powerpoint for Macintosh</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint for PC</td>
</tr>
<tr>
<td></td>
<td>Microsoft Project</td>
</tr>
<tr>
<td></td>
<td>Microsoft Visio</td>
</tr>
<tr>
<td></td>
<td>Microsoft Visio XML Format</td>
</tr>
<tr>
<td>Graphics</td>
<td>AutoCAD Drawing format (DWG)</td>
</tr>
<tr>
<td></td>
<td>AutoCAD Drawing format (DXF)</td>
</tr>
<tr>
<td></td>
<td>Computer Graphics Metafile (CGM)</td>
</tr>
<tr>
<td></td>
<td>Corel Draw CDR (TIFF header)</td>
</tr>
<tr>
<td></td>
<td>Encapsulated PostScript (TIFF header)</td>
</tr>
<tr>
<td></td>
<td>Enhanced Metafile (EMF)</td>
</tr>
<tr>
<td></td>
<td>Fax Systems (TIFF CCITT)</td>
</tr>
<tr>
<td></td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td></td>
<td>JPEG File Interchange Format</td>
</tr>
<tr>
<td></td>
<td>Lotus AMIDraw Graphics (SDW)</td>
</tr>
<tr>
<td></td>
<td>Lotus Pic (PIC)</td>
</tr>
<tr>
<td></td>
<td>Macintosh Raster (PICT/PCT)</td>
</tr>
<tr>
<td></td>
<td>MacPaint (PNTG)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Excel Charts (PNTG)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Animated Cursor</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Bitmap (BMP)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Cursor/Icon Graphics</td>
</tr>
<tr>
<td></td>
<td>Microsoft Windows Metafile (WMF)</td>
</tr>
<tr>
<td></td>
<td>PC PaintBrush (PCX)</td>
</tr>
<tr>
<td></td>
<td>Portable Network Graphics (PNG)</td>
</tr>
<tr>
<td></td>
<td>SGI RGBImage (RGB)</td>
</tr>
<tr>
<td></td>
<td>Sun Raster Image (RS)</td>
</tr>
<tr>
<td>Format</td>
<td>Foreign File Type</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Tagged Image File Format (TIFF)</td>
<td></td>
</tr>
<tr>
<td>Truevision Targa (TGA)</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphics (WPG)</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphics 1</td>
<td></td>
</tr>
<tr>
<td>WordPerfect Graphics 2</td>
<td></td>
</tr>
</tbody>
</table>

For more information, see:
- Support for Viewing of Imported Files in AppXtender, page 167

**ODMA File Support**

If you import a file and it is ODMA-compliant and is supported for use of ODMA with AppXtender, you can create and access documents through the interface of the supported applications rather than through the AppXtender interface. For more information, refer to Chapter 8, Using ODMA With AppXtender Documents.

**Note:** If the document you want to work with is not supported for use with ODMA, you can still edit it in AppXtender using in-place editing by inserting it as an object, as long as the source application is installed on your AppXtender workstation and the application supports Object Linking and Embedding (OLE). Most Windows applications support OLE. To determine if your application supports OLE, refer to the documentation for the product. Note that documents inserted as objects in AppXtender cannot be submitted for full-text indexing.

For a list of the AppXtender-supported applications that are ODMA-compliant, refer to Chapter 8, Using ODMA With AppXtender Documents.

**Caution:** Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.

For more information, see:
- Support for Viewing of Imported Files in AppXtender, page 167

**Adding a Document by Scanning**

New documents can be created from any scanner that is supported or certified for use with AppXtender. For detailed scanning procedures and a list of certified and supported scanners, refer to Chapter 4, Scanning.

If you have many paper documents you need to scan into AppXtender, you can use AppXtender Image Capture to scan batches of documents and then index the documents in AppXtender. For more information on using AppXtender Image Capture for batch scanning, consult your system administrator or refer to the ApplicationXtender Image Capture User’s Guide.
Adding a Document from the Windows Clipboard

AppXtender allows for the sharing of data between programs using the Windows Clipboard. The contents of the Clipboard can be pasted into AppXtender to create a new document. Because the Clipboard holds any type of data, the new page can be an image, data from another application (such as WordPerfect or PowerPoint), or even a page from a different AppXtender application. Objects pasted from the clipboard are inserted as OLE objects.

You can paste a document from the Windows Clipboard using the Paste command or the Paste Special command. The Paste command pastes the document in the default format. The Paste Special command allows you to select the format for the pasted document. For more information, refer to the following topics:

- Adding a Document by Pasting, page 173
- Adding a Document by Pasting in a Selected Format, page 175
- Creating New Documents, page 164

**Note:** To create documents in the _RSTAMP or _FORMS applications, you must use the right-click or shortcut menu to access the New Document command.

Adding a Document by Pasting

You can paste a document in the default format.

**To paste a document from the Windows Clipboard:**

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Clipboard Paste.

   If there is not a valid page in the Windows Clipboard, the Clipboard Paste option is dimmed. One or more of the following may have occurred:
   - No document is available to be added.
   - Text is on the Clipboard and the Allow paste text option on the COLD tab of the Configuration dialog box has not been enabled. For more information on configuring the Allow paste text option, refer to Saving and Loading Settings, page 150 consult your system administrator or refer to the “Configuring Workstations” section of the ApplicationXtender Installation Guide.
   - The data source in which an application is located is not active.

**Note:** If the menu option is unavailable, verify that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with Windows) can be used to view the contents of the Clipboard at any time.
3. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you plan to use when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

**Figure 56. Reason Code Required Dialog Box**

4. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

**Figure 57. Signature Properties Dialog Box**

AppXtender displays the contents of the Clipboard in the Document Display view.

5. Enter the index information for the new document and click Save.
For more information, see:
• Adding a Document from the Windows Clipboard, page 173

Adding a Document by Pasting in a Selected Format

You can paste a document from the Windows Clipboard and select the format for the pasted document.

To paste a document in a selected format (Paste Special):

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Clipboard Paste Special. The Paste Special dialog box appears.

Figure 58. Paste Special Dialog Box

3. Under As, select a format.

4. If the Display As Icon check box is available, indicate how you want the new document to be displayed and edited. You have the following choices:
   • To display the object as an icon, select the Display As Icon check box.
   • To display the object as its content, disable the Display As Icon check box.

5. Click OK.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 60. Signature Properties Dialog Box

The document appears in the Document Display view.

8. Enter the index information for the new document and click Save.
Creating Documents

For more information, see:
• Adding a Document from the Windows Clipboard, page 173

Adding a Document by Inserting an Object

You can create new documents by inserting data from applications that support ActiveX embeddable objects into AppXtender. For information, refer to the following topics:
• Inserting a New File as an Object, page 177.
• Inserting an Existing File as an Object, page 180

Note: The Insert Object input method for creating documents is not available for either the _RSTAMP or _FORMS applications.

Inserting a New File as an Object

To add a document as a new object:

1. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Insert Object. The Insert Object dialog box appears, listing all ActiveX server applications installed on your workstation.

Figure 61. Insert Object Dialog Box

2. Select Create New.

3. Under Object Type, select the name of the application that you want to use to create the new document.
4. Indicate how you want the new document to be displayed and edited. You have the following choices:
   • To display the object as an icon, select the Display As Icon check box.
   • To display the object as its content, disable the Display As Icon check box.

5. Click OK.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

   **Figure 62. Reason Code Required Dialog Box**

   ![Reason Code Required Dialog Box]

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
A window appears in AppXtender that allows you to create and edit the new object.

8. Complete the object.

9. To return to the AppXtender Document Display view, from the File menu, select Close.
   - If you enabled the Display As Icon check box, the object appears as an icon in AppXtender.
   - If you disabled the Display As Icon check box, the object appears as its content in AppXtender.

10. In Index view, enter the index information for the new document. Then click Save.
For more information, see:
• Adding a Document by Inserting an Object, page 177

Inserting an Existing File as an Object

To add a new document as an object from an existing file:
1. In Application view, right-click the application name to display the shortcut menu.
2. From the shortcut menu, select New Document and then Insert Object. The Insert Object dialog box appears.
3. Select Create from File.
4. Type the path and file name for the file you want to insert, or click Browse and find the file.

Figure 65. Insert Object Dialog Box

5. Indicate how you want the new document to be displayed and edited. You have the following choices:
   • To display the object as an icon, select the Display As Icon check box.
   • To display the object as its content, disable the Display As Icon check box.
6. Click OK.
7. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
8. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 67. Signature Properties Dialog Box

AppXtender starts the source application.

9. Edit the ActiveX object (if necessary).
   - If you enabled the Display As Icon check box, the object appears as an icon in AppXtender.
   - If you disabled the Display As Icon check box, the object appears as its content in AppXtender.

11. Enter the index information for the new document in the Index view and click Save.
For more information, see:
   - Adding a Document by Inserting an Object, page 177

Adding a Document by Importing a File

You can create a new document by importing an existing file. You can import any file type. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Supported foreign files can be viewed in the Document Display view using the AppXtender Web Verity KeyView. The AppXtender Web Verity KeyView, when enabled on the View tab of the AppXtender Configuration dialog box, allows AppXtender to display the contents of a supported foreign file without having to open a third party viewer. If the AppXtender Web Verity KeyView is not enabled for foreign files, the files display as icons in the Document Display view.

File types that are not supported by AppXtender and are not supported using the AppXtender Web Verity KeyView require a third-party viewer to display the contents of the file.

For more information on viewing support for file formats in AppXtender, refer to Support for Viewing of Imported Files in AppXtender, page 167.

You can import files by using the Import File option in the Document menu, by dragging the files from the Windows Explorer, or by dragging file attachments from e-mail messages in Microsoft Outlook. For instructions, refer to the following topics:
   - Adding a Document by Using the Import File Option, page 182
   - Adding a Document by Dragging from Windows Explorer, page 185
   - Adding a Document by Dragging from Microsoft Outlook, page 187

Note: The _RSTAMP and _FORMS applications do not support drag-and-drop import file functionality.

Adding a Document by Using the Import File Option

To add a new document by importing a file:

1. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Import File. The Import File dialog box appears, allowing selection of any file.
2. Navigate to and select the files that you want to import and click Open.

3. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

4. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
Figure 70. Signature Properties Dialog Box

The document appears in the Document Display view. A message appears indicating how many of the selected files have been imported. You can cancel the import by clicking Cancel.

When the import is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

- If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.
5. Enter the index information for the new document and click Save.

**Adding a Document by Dragging from Windows Explorer**

You can import files by dragging the files from the Windows Explorer.

**To add a new document by dragging a file from Windows Explorer:**

1. Make sure that the appropriate AppXtender application is active.
2. Make sure that no document is currently displayed.
3. Drag the file from Windows Explorer and drop it in the AppXtender Document Display view.
4. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
Figure 72. Reason Code Required Dialog Box

This application is Reason Code Required.

Access To:

- [ ] Print
- [ ] Export
- [ ] E-mail

Please enter a comment for this operation:

OK  Cancel

5. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 73. Signature Properties Dialog Box

A message appears indicating how many of the selected files have been added. You can cancel the import by clicking Cancel.

When the addition is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

- If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender
Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.

6. Enter the index information for the new document and click Save.

**Adding a Document by Dragging from Microsoft Outlook**

You can import files by dragging file attachments from e-mail messages in Microsoft Outlook.

**Note:** The AppXtender Add-in for Microsoft Outlook allows you to map Outlook fields with AppXtender index fields so that you can create AppXtender documents by copying or moving items (mail, appointments, meeting requests, and contacts) from Outlook to Microsoft Outlook Integration for AppXtender. You can also configure the add-in to monitor folders for incoming items and automatically export these items to AppXtender. For more information, refer to the *Microsoft Outlook Integration for ApplicationXtender Guide*.

**To add a new document by dragging a file attachment from Microsoft Outlook:**

1. Make sure that the appropriate AppXtender application is active.
2. Make sure that no document is currently displayed.
3. Drag the file attachment from Microsoft Outlook and drop it in the AppXtender Document Display view.
4. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
5. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

A message appears indicating how many of the selected files have been added. You can cancel the process by clicking Cancel.

When the addition is complete, the message automatically closes and AppXtender displays the new document in the Document Display view.

• If the file is a foreign file type supported by the AppXtender Web Verity KeyView and you have the AppXtender Web Verity KeyView feature enabled in the View tab of the AppXtender
Configuration dialog box, the contents of the foreign file appear in the Document Display view. You can launch the file in its native application using the Launch command on the Document Display shortcut menu.

- If the file is a foreign file type that is not supported by the AppXtender Web Verity KeyView or if you do not have the AppXtender Web Verity KeyView enabled, an icon represents the new document. AppXtender stores unsupported foreign file types in their native file format. You can open the file (and the software program in which it was created) by double-clicking on the icon.

6. Enter the index information for the new document and click Save.

For more information, see:
- Creating New Documents, page 164

### Adding a Document from the Fax-in Queue

This topic describes the addition of a single document by fax-in queue. You can also copy index information from the fax-in queue and paste it into the document index.

**To add a document by fax-in queue:**

1. Configure your workstation for document creation by fax-in queue. For information on configuring the Fax-in tab, see Fax-in Tab, page 147 consult your AppXtender system administrator or refer to the “Configuring Workstations” section of the ApplicationXtender Installation Guide.

2. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Fax-in Queue.

3. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.

**Figure 76. Login to Fax Server Dialog boxes**
4. If you are using Castelle FAX Press for your fax-in server, you have the following choices:
   - If you want to import faxes from your personal queue, select the Import from personal queue option.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue option.

   **Note:** The Import from personal queue check box does not appear on the FAX Server Import dialog box if you are using RightFax for your fax-in server.

5. Click Login. The FAX Server Import dialog box appears, listing each of the incoming faxes from the selected queue (personal or unassigned).

**Figure 77. FAX Server Import Dialog Box**

<table>
<thead>
<tr>
<th>Date</th>
<th>Pages</th>
<th>In/Out</th>
<th>Fax Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>2</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>3</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Note:** If you are using RightFax for your fax-in server, you can customize the way columns display in the FAX Server Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, see Fax-in Tab, page 147 consult your AppXtender system administrator or refer to the "Configuring Workstations" section of the ApplicationXtender Installation Guide.

6. If you want to Preview faxes in the queue, click the Preview check box to select the option. The selected fax appears in AppXtender. Use the Prev and Next buttons to navigate through the fax-in queue, page by page.

7. If you want to delete a fax, select the fax that you want to delete and click Delete.

8. If you do not want the fax that you are importing to be deleted, click the Delete after import check box to disable the option.

9. If you want to copy the index information listed for the fax to save data entry time when you index the document later, right-click on the fax. From the shortcut menu that appears, select Copy.

   **Note:** In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.

10. Click Import to import the fax.
11. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

Figure 78. Reason Code Required Dialog Box

12. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 79. Signature Properties Dialog Box

13. Enter the appropriate index data for this document in the Index view.
If you copied the index information from the FAX Server Import dialog box, right-click in the Index view. From the shortcut menu that appears, select Paste Form. The copied index information appears in the Index view.

14. Click Save.

For more information, see:

• Creating New Documents, page 164

Creating _RSTAMP and _FORMS Documents

Rubber stamps and forms must be created before users can access them. You can configure stamps and forms to be restricted to a specific application or user, if necessary. Rubber stamps and forms can be created only by users with the following privileges assigned to their AppXtender user profile: AppXtender Administrator, Configure WS, Add Page, and Display.

The document creation procedures for the _RSTAMP and _FORMS applications are similar to the document creation procedures for any other AppXtender application. The input methods available for creating _RSTAMP and _FORMS documents include:

• Scan
• Clipboard Paste
• Clipboard Paste Special
• Import File
• Fax-In-Queue

The primary difference between creating documents in these two pre-defined AppXtender applications than in other AppXtender applications is the method for accessing the appropriate commands. Typically, an AppXtender application is made active by double-clicking on the application in AppXtender. Then, selecting toolbar buttons or menu commands performs the selected action on the active application. However, double-clicking on the _RSTAMP and the _FORMS applications does not make them active in AppXtender.

Since neither of these applications can be made active, the commands to create new documents for the _RSTAMP and _FORMS applications must be accessed via the shortcut menu (opened by right-clicking on the application).

Once a new document is input into either the _RSTAMP or _FORMS application, you are required to enter the appropriate index information, so that those documents can be accessed and used with other AppXtender documents as appropriate.

The _RSTAMP index fields are as follows:

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Name of the rubber stamp.</td>
</tr>
<tr>
<td>DESC</td>
<td>Description of the rubber stamp.</td>
</tr>
</tbody>
</table>
The _FORMS index fields are as follows:

**Table 25. Forms Index Fields**

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FORM NAME</td>
<td>Name of the form.</td>
</tr>
<tr>
<td>FORM TYPE</td>
<td>The type of form being created. Select either Image or ASCII from the drop-down list.</td>
</tr>
<tr>
<td>FORM UNITS</td>
<td>Determines the units of measurement used to size the form. Select IN (inches), MM (millimeters) or LI (allows use of line measurement for top-offset setting and character measurement for left offset setting) from the drop-down list.</td>
</tr>
<tr>
<td>TOP OFFSET</td>
<td>The distance between the top of the document and the top of the form.</td>
</tr>
<tr>
<td>LEFT OFFSET</td>
<td>The distance between the left edge of the document and the left edge of the form.</td>
</tr>
<tr>
<td>CPI</td>
<td>Characters per inch setting for the form.</td>
</tr>
<tr>
<td>LPI</td>
<td>Lines per inch setting for the form.</td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>Directional orientation of the form. Select Portrait or Landscape from the drop-down list.</td>
</tr>
<tr>
<td>RESIZE RATIO X</td>
<td>This index field is provided for legacy data purposes.</td>
</tr>
<tr>
<td>RESIZE RATIO Y</td>
<td>This index field is provided for legacy data purposes.</td>
</tr>
</tbody>
</table>

In addition to creating rubber stamps by adding documents to the application via the available input methods, you can also use the New Text Rubber Stamp option, available from the shortcut menu. Text rubber stamp annotations can also be created from existing files.

For more information, refer to the following topics in the Chapter 9, Annotations section:

- Creating a Text Rubber Stamp Annotation from an Existing File, page 462
- Creating an Image Rubber Stamp Annotation from an Existing File, page 464
Reason Code Required Dialog Box

The Reason Code Required dialog box allows you to select the check boxes for the functionality that you will need when the document has been created or opened (Print, Export, and/or Email) and enter a comment explaining the reason for opening the document. This dialog box appears if the AppXtender system administrator has enabled the Reason Code option for the application, for compliance with current standards. When you have enabled the appropriate check boxes and entered a comment, click OK.

For more information on the Reason Code option, refer to the "Configuring AppXtender Document Manager Workstations" chapter of the ApplicationXtender Installation Administrator’s Guide or see your AppXtender system administrator. For more information on the Reason Code Required dialog box, see:

- Creating New Documents, page 164
- Displaying Documents from the Result Set, page 266

Creating Documents in Batches

In addition to adding documents individually, AppXtender allows you to create and index documents in groups or batches. There are three ways to create AppXtender documents in batches:

- Importing a batch using Batch Import. For information, refer to Batch Import, page 194.
- Creating a batch using Batch Create. For information, refer to Batch Creation, page 200.
- Creating a batch using AppXtender Image Capture. For information, refer to Chapter 4, Scanning.

Batch Import

The Batch Import utility allows users to import a batch of files into AppXtender. AppXtender stores the batch temporarily until you are ready to attach index information to the pages in this batch. Those pages can then be used to create new documents or can be added to existing documents using the Batch Index utility. For information on indexing a batch of files in AppXtender, refer to Indexing Batches, page 213.

In order to perform a Batch Import, you must first create a text file referencing the files to be imported. You can import several batches at a time by grouping the imported files for a particular batch together in a file.

Note: When performing a Batch Import, text files that are flagged as hidden or system will not be imported.

For more information, see:

- Creating Documents in Batches, page 194
- Creating a Batch Import File, page 195
- Performing the Batch Import, page 198
Creating a Batch Import File

A batch import file is a text file referencing the location of files for import. This file can be created in the Windows Notepad or in DOS. You can import multiple batches by including a description for each batch in the file. Each batch description should have two components: a unique name for the batch and a reference to each of the files to be imported.

- The batch name can be up to 32 alphanumeric characters long and should always precede the file references to be included in that batch. You should use a name that is unique for the application into which you intend to import the batch. If a batch is imported into an application that already has a batch by that name, then the new batch is appended to the existing batch.

- Each reference to a file location should include either one (in the case of single-page image, PDF, RTF, and HTML files) or two (in the case of all other files) "at" (@) symbols, followed by the path where the file can be found. When importing multi-page images, use one "at" symbol (@) to import only the first page of the image, or two "at" symbols (@@) to import every page in the image. Volume labels can be referenced in place of directory paths in order to import files and images stored on removable media such as optical disks. Additionally, the asterisk (*) wildcard character can be used to import multiple files from a single location with one command line.

For details on formatting a batch file, refer to the following topics:

- General Batch Import File Format, page 195
- Format for Import Referencing a Volume Label, page 197
- Format for Importing Multiple Files with a Single Command, page 198

General Batch Import File Format

To successfully accomplish the import, the batch import file must be formatted correctly. One or two "at" (@) symbols should immediately precede a file name and path. The following table lists the file types that can be preceded by one "at" symbol (@) and the file types that must be preceded by two "at" symbols (@@):

<table>
<thead>
<tr>
<th>May Use One &quot;at&quot; Symbol (@)</th>
<th>Must Use Two &quot;at&quot; Symbols (@@)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single-page image types</td>
<td>Foreign files, including text files (even if they have been configured on the File Types tab of the Configuration dialog box)</td>
</tr>
<tr>
<td>PDF</td>
<td>Multi-page image files (if you want to import every page)</td>
</tr>
<tr>
<td>Basic Windows RTF</td>
<td></td>
</tr>
<tr>
<td>HTM</td>
<td></td>
</tr>
<tr>
<td>Multi-page image files (if you want to import only the first page)</td>
<td></td>
</tr>
</tbody>
</table>

Note: If you import a multi-page PDF file, the result in AppXtender is a single page with multiple subpages. If necessary, after the batch has been indexed, you can convert these subpages to pages. For instructions, refer to Converting Subpages to Pages, page 393.
Note: To separate multi-page TIFF and DCX pages, the Separate multi-page TIFFs option in the Data tab of the Configuration dialog box must be enabled. Each page of the imported file becomes a page within the new AppXtender batch. For information on configuring the separation of multi-page TIFF and DCX files, see Data Tab, page 134 consult your AppXtender system administrator or refer to the “Configuring Workstations” section of the ApplicationXtender Installation Guide.

Note: To import all pages of a multi-page TIFF or DCX file, you must use two “at” symbols (@@) before the file location, even if you have enabled the Separate Multi-page TIFFs option. If you use only one “at” symbol (@) before the file location, the first page of the file becomes a page of the new AppXtender batch, but the remaining pages of the file are discarded.

Note: Multiple pages of GIF animation files cannot be imported into AppXtender. The first page of the file becomes a page of the new AppXtender batch, but the remaining pages of the file are discarded. AppXtender does not support progressive JPEGs. Importing a progressive JPEG into AppXtender results in the file being imported as a foreign file.

When AppXtender processes a batch import file with file names preceded by two “at” symbols (@@), AppXtender honors the file type mappings and image storage format settings for those file names. The following table explains the trade-off between using one “at” symbol or two:

<table>
<thead>
<tr>
<th>For This Scenario</th>
<th>Do This</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of the files listed in the batch import file are of a format that is natively supported by AppXtender.</td>
<td>Precede each file name and path with only one “at” symbol (@).</td>
<td>AppXtender imports the file without checking the file type. Each file must be a natively supported file format.</td>
</tr>
<tr>
<td>Some of the files listed in the batch import file are of a format that is natively supported by AppXtender and some are not, and you do not have time to edit the batch import file.</td>
<td>Precede each file name and path with two “at” symbols (@@).</td>
<td>AppXtender checks the file type and treats the file as the detected type (such as image, text, or foreign file format). The import time is increased by the number of files that AppXtender must check.</td>
</tr>
</tbody>
</table>
| Some of the files listed in the batch import file are of a format that is natively supported by AppXtender and some are not, and you do have time to edit the batch import file. | For each supported file, precede the file name and path with only one “at” symbol (@).  
For each unsupported file, precede the file name and path with two “at” symbols (@@). | If one @ precedes the file name and path, AppXtender imports the file without checking the file type.  
If two @@ signs precede the file name and path, AppXtender checks the file type and treats the file as the detected type. |
| None of the files listed in the batch import file are of a format that is natively supported by AppXtender. | Precede each file name and path with two “at” symbols (@@).             | AppXtender checks the file type and treats the file as the detected type (in this case, foreign file format). |
If the following example batch import file is imported, two batches are created (Images and Fiscal Year 1996):

Images
@c:\bitmaps\sailboat.bmp
@c:\tifs\desert.tif
Fiscal Year 1996
@@c:\1996\report.txt
@@c:\1996\report.doc
@c:\1996\chart.bmp

Note: A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.

For more information, see:
• Creating a Batch Import File, page 195

Format for Import Referencing a Volume Label

A volume label can be used as the root of the file path in place of a drive letter to allow for batch import from multiple pieces of media. If, for example, the images to be stored in AppXtender are located on several different optical disks, each of those disks can be referenced in the import text file by the volume label on the disk. As references to different volume labels are found during the import, you are instructed to insert the correct media. Volume labels can be referenced by placing the name of the volume with a dollar sign in front (as in $VOLUME_NAME) where the drive letter would normally be.

The following example of a batch description includes the volume label VOLUME_01:

Images
@$VOLUME_01\images\castle.bmp
@c:\images\sky.bmp
@c:\images\leaves.bmp

Note: A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.

During import of this example batch import file, you would be prompted to mount the optical disk that has the volume label VOLUME_01, unless it was already mounted.

Note: The removable media drive where the volume would be mounted must be added as a Volume Label Search Drive on the Paths tab of the Configuration dialog box for the AppXtender workstation performing the import so that AppXtender can find the mounted volume. For more information on adding a Volume Label Search Drive, see Paths Tab, page 141 consult your system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.
For more information, see:
- Creating a Batch Import File, page 195

**Format for Importing Multiple Files with a Single Command**

The asterisk (*) wildcard character can be used to import several files from a single location. Rather than entering a line in the import file for each file in the directory, files with similar names can be referenced with one command. When you use the asterisk to replace some or all of the letters, AppXtender imports all of the files in the referenced directory whose names contain the remaining pattern of letters. If, for example, the filenames for all of the financial reports in the directory C:\FINANCE\ begin with the word REPORT, placing the line "c:\finance\report*.*" in the import file would retrieve all of those files. All files in a particular directory can be imported with one command by entering *. in place of the filename.

**Note:** The rules for using one or two "at" (@) symbols still apply when using a wildcard character to import a batch. For more information, refer to General Batch Import File Format, page 195.

The following example batch import file uses the wildcard character:

```
Images
@$VOLUME_01\images\castle*.bmp
@c:\images\*.bmp
@c:\images\new\*.*
```

**Note:** A character return must be inserted between the batch name and the file location in order to distinguish between the two during import.

The first line after the batch name imports all bitmap files with the prefix CASTLE in the IMAGES directory on the disk labeled VOLUME_01. The second line imports all bitmap files in the C:\IMAGES directory. The third line imports all files in the C:\IMAGES\NEW directory.

For more information, see:
- Creating a Batch Import File, page 195

**Performing the Batch Import**

As soon as a batch import file has been created, you can perform the import. AppXtender reads the text file, creating a new batch whenever it encounters a line in the file that does not begin with an @ symbol, and storing each of the successive files referenced in that batch.

**Note:** You cannot add documents to a batch that is being indexed. If you attempt to add documents to a batch that is being indexed, the batch creation fails.

**To create a new batch of imported pages:**

1. Make sure that the appropriate application is active. The active application is in bold in the Application view.
2. From the Utilities menu, select Batch Import. The Select Batch Import File dialog box appears.
3. Navigate to the location of the batch import file and select the batch import file name. Click Open. If any of the files listed in the batch import file are referenced by a volume label, the AppXtender Utility dialog box appears.

4. If the AppXtender Utility dialog box appears, mount the specified volume and then click OK. When the import is complete, a Batch Import Status dialog box appears.

5. If you want to see a log of the import, select View Log. The batch import log appears in Notepad.

   **Note:** When the batch import file that you are importing is on a read-only media or drive, AppXtender places the resultant log and rejection file on the local drive (for example, C:\Temp).

6. If you want to see a list of rejected records and the reasons for the rejections, click View Reject Log. The batch import rejection log appears in Notepad.
For more information, see:
- Batch Import, page 194

**Batch Creation**

The Batch Create and Fax-in Batch Create utilities allow you to select a group of files from either a file system or a fax server queue in order to import the files into AppXtender. AppXtender stores the batch temporarily until you are ready to attach index information to the pages in this batch. Those pages can then be used to create new documents or can be added to existing documents using the Batch Index utility. For information on indexing a batch of files in AppXtender, refer to Indexing Batches, page 213.

**Note:** You cannot add documents to a batch that is being indexed. If you attempt to add documents to a batch that is being indexed, a message appears indicating that the batch creation failed.

For more information on creating a batch, refer to the following topics:
- File Selection Batch Create, page 200
- Fax-in Batch Create, page 202

**File Selection Batch Create**

The Batch Create utility allows you to create a batch by browsing for and selecting files that are located on your computer or on a network. You can select one file or a group of files from the same location.

**Note:** When performing a batch import, text files that are flagged as hidden or system will not be imported.

**To import a batch of files using the Batch Create utility:**

1. Make sure that the appropriate application is active. The active application appears in bold in the Application view.
2. From the Utilities menu, select Batch Create. AppXtender displays the Select Files For Batch Import dialog box.
3. You have the following choices:
   - Type the file name of each file that you want to import. Each file name must be enclosed in double quotes.
   - Select the files that you want to import. The selected file names are displayed in the File name text box.
   - Select the arrow to the right of the Look in drop-down list to browse for a file on your computer. If browsing for a file, choose the file containing the import data within the search dialog box and select Open.

4. You have the following choices:
   - To create a new batch, type a name for the batch in the Batch Name text box. A batch name can contain up to 32 characters.
   - To add the selected files to an existing batch, type the name of the batch in the Batch Name text box.

Note: You cannot add pages to a batch that is being indexed in AppXtender. If you attempt to add pages to a batch that is being indexed, the batch creation fails.

5. Click Open to import all selected files. A message appears, indicating the progress of the batch import. This message is displayed until all files of the batch have been imported. Click Cancel at any time to cancel the batch import.

6. When the import is complete, a Batch Import Status dialog box appears.

7. If you want to see a log of the import, select View Log. The batch create log appears in Notepad.
   
   Note: When importing a file from a read-only media or drive, AppXtender places the resultant log and rejection file on the local drive (C:\Temp).

8. If you want to see a list of records that were rejected and the reasons for the rejections, select View Reject Log. The batch import reject log appears in Notepad.
For more information, see:
- Batch Creation, page 200

**Fax-in Batch Create**

The Batch Create utility allows you to create a batch by selecting files from a fax server queue. You can select one file or a group of files from the queue.

**Note:** You must select a fax-in server from the drop-down list box on the Fax-in tab of the Configuration dialog box in order to access a fax server queue. For more information, see Fax-in Tab, page 147 consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.

**To import a batch of files using the Fax-in Batch Create utility:**

1. Make sure that the appropriate application is active. The active application appears in bold in the Application view.

2. Select Fax-in Batch Create from the Utilities menu. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.

3. If you are using Castelle FAX Press for your Fax In Server, you have the following choices:
   - If you want to import faxes from your personal queue, select the Import from personal queue check box.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue check box.

   **Note:** The Import from personal queue check box does not appear on the FAX Server Import dialog box if you are using RightFax for your fax-in server.

4. Click Login. The Select Faxes for Batch Import dialog box appears.
Figure 84. Select Faxes for Batch Import Dialog Box

<table>
<thead>
<tr>
<th>Date</th>
<th>Pages</th>
<th>In/Out</th>
<th>Fax Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>2</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>3</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Note:** If you are using RightFax for your fax-in server, you can customize the way columns display in the Select Faxes for Batch Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, see Fax-in Tab, page 147 consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.

5. You have the following choices:
   - To import a single file, select the file from the list.
   - To import more than one file when the files are listed sequentially, press and hold down [SHIFT], and select the first and last file in the list so that the desired files are highlighted.
   - To import more than one file when the files are not listed sequentially, press and hold down [CTRL], and select each file.
   - To delete a file from the fax server queue, select the file and click Delete.

6. If you want the selected files to be deleted from the queue after you import them, click the Delete after import check box to select the option.

7. If you are importing a single file, you can copy the index information listed for the file to save data entry when you index the document later. To copy index information, right-click on the file. From the shortcut menu that appears, select Copy.

   **Note:** In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.
8. You have the following choices:
   • To create a new batch, type a name for the batch in the Batch name text box. A batch name can contain up to 32 characters.
   • To add the selected files to an existing batch, type the name of the batch in the Batch name text box.

   *Note:* You cannot add pages to a batch that is being indexed in AppXtender. If you attempt to add pages to a batch that is being indexed, the batch creation fails.

9. Click Import. A message appears, containing the status of the batch import. This message is displayed until all files of the batch have been imported. Click Cancel at any time to cancel the batch import.

   When the import is complete, a Batch Import Status dialog box appears.

   *Figure 85. Batch Import Status Dialog Box*

   ![Batch Import Status Dialog Box](image)

10. If you want to see a log of the import, select View Log. The fax-in batch create log appears in Notepad.

11. If you want to see a list of records that were rejected and the reasons for the rejections, select View Reject Log. The batch import reject log appears in Notepad.

For more information, see:
   • Batch Creation, page 200

**AppXtender Image Capture**

AppXtender Image Capture, a separate module installed with AppXtender, provides batch scanning functionality, allowing you to scan documents and then index them at a later time. For more information on AppXtender Image Capture, consult your system administrator or refer to the ApplicationXtender Image Capture User's Guide.
Indexing New Documents

By default, indexing a document in AppXtender involves pure data entry. If you want to increase indexing speed and accuracy, you can use OCR proofing or one of the automated indexing features. For more information, refer to the following topics:

- Automated Indexing Features, page 205

If, while you are indexing a document, a message appears indicating that another document already exists with the same unique key value, refer to Unique Index Validation, page 211. If a Dual Data Entry dialog box appears, refer to Dual Data Entry, page 212.

If you have imported a batch of documents in AppXtender Image Capture, you can index this batch in AppXtender. For more information, refer to Indexing Batches, page 213.

If your AppXtender system is configured to use Document Level Security and the %U keyword, keep in mind the following points:

- If the AppXtender system is using the Windows security provider, you must precede the user name in the document index record with a domain and a slash. For example, typing CM\axadmin indicates the "axadmin" user on the "CM" domain.

- If the AppXtender system is using a directory service security provider, you must enter the name in the document index record exactly as it appears in ApplicationXtender Application Generator (AppXtender AppGen).

Automated Indexing Features

AppXtender offers several features that allow you to reduce the amount of time spent performing data entry of index information. Index information from a text file can be used to build a table of index records with either the ApplicationXtender Auto Index Import Wizard (AppXtender Auto Index Import) or the ApplicationXtender Key Reference Import Wizard (AppXtender Key Reference Import) feature. Those records can then be used during document indexing to automatically fill in all or part of a document's index.

Some of the features require preparation before you can use them. The following table indicates which features require preparation. For information on preparing to use these features, consult your AppXtender system administrator or refer to the "Import Wizards" section of the ApplicationXtender Core Components Administrator's Guide. The table also indicates which keyboard key implements each feature.
Table 28. Automated Indexing Features

<table>
<thead>
<tr>
<th>Automated Indexing Feature</th>
<th>Previous Preparation Required?</th>
<th>Associated Keyboard Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppXtender Auto Index Import</td>
<td>Yes</td>
<td>[F7]</td>
</tr>
<tr>
<td>AppXtender Key Reference Import</td>
<td>Yes</td>
<td>[TAB] and [SHIFT]+[F4]</td>
</tr>
<tr>
<td>Wizard</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append Page</td>
<td>No</td>
<td>[F4]</td>
</tr>
<tr>
<td>Copy Index Info</td>
<td>No</td>
<td>[F4]</td>
</tr>
<tr>
<td>Copy Previous Index Info</td>
<td>No</td>
<td>[F9]</td>
</tr>
<tr>
<td>Cut and Paste</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

For more information, refer to the following topics:

- AppXtender Auto Index Import vs. AppXtender Key Reference Import, page 206
- Using AppXtender Auto Index Import to Index Documents, page 207
- Using AppXtender Key Reference Import to Index Documents, page 208
- Appending Pages to Documents, page 209
- Copying Existing Index Information, page 209
- Copying the Previous Index Information, page 210
- Pasting Index Values from an Existing Document, page 210

You can also configure AppXtender to automatically parse MICRE codes (from checks or other documents) into index records. For information, refer to the online help provided with the AppXtender Software Development Kit.

**AppXtender Auto Index Import vs. AppXtender Key Reference Import**

With the AppXtender Auto Index Import function, you enter data into an index field and press the [F7] key. The entered data is matched against a record in the AppXtender Auto Index Import table. AppXtender populates all other AppXtender Auto Index Import enabled index fields with data from the record, and deletes that record of data from the AppXtender Auto Index Import table.

The AppXtender Key Reference Import feature operates in a very similar manner. You enter data into one primary – or key – index field and press [TAB]; AppXtender populates all other AppXtender Key Reference Import enabled index fields with the data from the record in the AppXtender Key Reference Import table with that key field value. For example, if the key field is "social security number," then AppXtender could fill in the associated "name" and "birth date" data fields; data entry is required for the key field only. Index records populated from a AppXtender Key Reference Import table are kept in the table even after they are used to index documents. For this reason, AppXtender
Key Reference Import can be a useful feature for automatically populating index information that will be used to describe several documents and that may need to be changed frequently.

For more information, see:
- Automated Indexing Features, page 205

Using AppXtender Auto Index Import to Index Documents

The AppXtender Auto Index Import feature allows you to access imported index information in order to automatically populate a document’s index. Index information can be imported into a AppXtender Auto Index Import table and then used to index documents whenever a new document is created. When a record of imported index information is used to populate a document’s index, that record is deleted from the AppXtender Auto Index Import table.

**Note:** Before you can use the AppXtender Auto Index Import feature, the AppXtender system administrator must apply the AppXtender Auto Index Import flag to the appropriate index fields and must perform an AppXtender Auto Index Import Import. For information, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

**Note:** If an AppXtender Auto Index Import table is used to enter a value into an index field, even if that field is flagged for dual data entry, you are not prompted to enter data a second time. For information on importing data into an AppXtender Auto Index Import table, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

As soon as an AppXtender Auto Index Import has been performed, you can access the imported index information whenever a new document is created. At the time you add a new document, rather than typing in an index value for each index field, you can press the [F7] key to access the index information in the AppXtender Auto Index Import table. Pressing [F7] without filling in any fields in the Index view allows you to choose from all of the imported records of index information. By filling in one or more fields before pressing [F7], you can reduce the number of AppXtender Auto Index Import records retrieved to only those that contain the information entered. If only one record matches the information already entered, AppXtender automatically populates the index with the values from that record.

**To use AppXtender Auto Index Import:**

1. From the Document menu, select New and then select an input option from the submenu to create a new document. The Document Display view and Index view appear, displaying the document.
2. If desired, enter data in one or more of the index fields.
3. Press [F7]. AppXtender begins a search for AppXtender Auto Index Import records that meet the specified criteria.
   - If only one record matches the criteria, the Index view is automatically populated.
   - If more than one record is retrieved, the AppXtender Result Set dialog box appears, listing the matching index records.
4. If the AppXtender Result Set dialog box appears, you have the following choices.
   • To choose an index record, select the record and click Select.
   • To delete a record from the AppXtender Auto Index Import table, select the record and click Delete.
   • To delete all of the listed records from the AppXtender Auto Index Import table, click Delete All.
   • To exit the AppXtender Result Set without choosing an index record, click Cancel.

Note: The availability of the Delete, Delete All, and Select buttons depends on your workstation configuration. For more information, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

If you select an index record and click Select, the index information that you select appears in the new document’s Index view.

5. If necessary, make changes to the index information.

6. Click Save.

For more information, see:
• Automated Indexing Features, page 205

Using AppXtender Key Reference Import to Index Documents

The AppXtender Key Reference Import feature also allows you to access imported index information in order to automatically populate a document’s index. Index information can be imported into a AppXtender Key Reference Import table and then used to index documents whenever a new document is created. Records of index information imported into a AppXtender Key Reference Import table are kept in the table after they have been used to index documents.

Note: Before you can use the AppXtender Key Reference Import feature, the AppXtender system administrator must apply the AppXtender Key Reference Import and Data Reference flags to the appropriate index fields and must perform a AppXtender Key Reference Import. For information, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

As soon as a AppXtender Key Reference Import Wizard has been performed, you can access the imported index information whenever a new document is created. At the time you add a new document, rather than typing in a value for each index field, you can type a value into the “key” field in the index, then press [TAB]. AppXtender locates the record that contains that key field value and fills in the data field values for that record.

A "key" field is the field that contains a unique, identifying value in the AppXtender Key Reference Import table. Each record of index information also contains index field values for each field marked as a "data" field. When a AppXtender Key Reference Import is performed, a set of data field values is associated with each key field value. Therefore, when you enter a key value, the associated data values are automatically selected to populate the Index view.

Note: When you enter a key field value that is not contained in the Key Reference table, the data fields for the document will not be automatically populated. However, AppXtender still allows you to index the document and adds the data to the Key Reference table.
To use Key Reference:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.

2. You have the following choices:
   - Enter a value into the key field of the index. Press [TAB] to populate the data fields in the index with the values corresponding to the key field value. (To find out which field is the key field and which fields are data fields, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.)
   - Enter data in one or more of the index fields, and then press [SHIFT]+[F4] to initiate a search for unused Key Reference records that meet the specified criteria. The AppXtender Result Set appears, listing unused Key Reference records and documents previously indexed with the same values. Select a Key Reference record and click Copy Index. The index information from the Key Reference record that you selected appears in the new document’s Index View.

3. If necessary, edit the values in each data field.
   
   **Note:** To move from field to field when indexing with a Key Reference table, consider using arrow keys rather than the [TAB] key. Each time that you press [TAB] from the key field, the data fields are repopulated from the Key Reference table.

For more information, see:
- Automated Indexing Features, page 205

### Appending Pages to Documents

AppXtender allows you to search for index information from existing documents and append pages to previously indexed documents. The Attach feature allows you to choose an existing document from a result set and add a new page to the existing document.

#### To append a new page to an existing document:

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.

2. Enter data in one or more of the index fields, and then press [F4] to initiate a search for documents that meet the specified criteria. The AppXtender Result Set appears, listing the results.

3. Select the index record and click Attach. The new page is added to the existing document that you selected.

For more information, see:
- Automated Indexing Features, page 205

### Copying Existing Index Information

AppXtender allows you to search for index information from existing documents and copy the existing index information to populate the new document’s index. The Copy Index Info feature allows you to choose an existing document from a result set and copy the existing index information to the new document.
**To copy index information to a new document:**

1. From the Document menu, select New and then select an input option from the submenu to create a new document. AppXtender displays the Index view.

2. Enter data in one or more of the index fields, and then press the [F4] function key to initiate a search for documents that meet the specified criteria. The AppXtender Result Set appears, listing the results.

3. Select an index record and click Copy Index. The index information from the existing document that you selected appears in the new document's Index View.

4. If necessary, make changes to the index information.

5. Click Save.

For more information, see:
- Automated Indexing Features, page 205

**Copying the Previous Index Information**

If you are adding a series of documents to AppXtender and entering similar index information for the whole series, the Copy Previous Index Info feature may help you to save time and avoid mistakes.

**To copy the previous index information:**

1. Add the first document in the series. Enter index information and click Save.

2. Add the next document in the series. Select one of the index fields and press [F9]. The index fields are populated with the same information as the previously indexed document.

3. If necessary, make changes to the index information.

4. Click Save.

5. Repeat steps 2-4 for each additional document in the series.

For more information, see:
- Automated Indexing Features, page 205

**Pasting Index Values from an Existing Document**

You can copy index values from the Index view for an existing document or from a document listed in a fax server queue and then paste the values into the Document Index view for a new document.

**To paste index values from an existing document:**

1. Copy the index information using one of the following methods:
   - Open the existing document from which you want to copy index values and then right-click in the Index view for that document. From the shortcut menu that appears, select Copy Form.
   - Copy index information from a fax in a fax server queue. For more information, refer to Adding a Document from the Fax-in Queue, page 189.
**Note:** In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.

2. Right-click in a Document Index view for the document into which you want to paste the index information. From the shortcut menu that appears, select Paste Form. The index values are pasted in the Values column.
3. If necessary, edit the pasted values.
4. Click Save.

For more information, see:
- Automated Indexing Features, page 205

## Index Validation

Your AppXtender workstation or your AppXtender application may be configured to prevent some errors in data entry while you are indexing a document. Keep in mind the following points:
- Some index fields may be configured to automatically reformat entered values. For example, if you enter 123456789 into a social security field, the value might be automatically reformatted as 123-45-6789.
- Some index fields may be configured to reject values that do not conform to a predetermined character pattern. For example, if you enter abcdefgh into a social security field, a message appears indicating that the value does not fit the pattern.
- Some index fields may be configured to automatically provide values. For example, the Date Stamp and Time Stamp data types cause the current date or time to be automatically filled in. These are read-only values that you cannot change.
- If you add the pm extension to a time index field, AppXtender helps you to convert the data in the index field to military time without having to know the conversion. For example, when you are indexing a document and enter 1: 00: 30 pm in a time index field and click another index field or click Save, the time data is changed to 13: 00: 30.
- A set of index fields for an application may be configured to ensure that the combination of values entered into the fields is unique to the application. For more information, refer to Unique Index Validation, page 211.
- Some index fields may be configured to prompt you to enter index values twice to ensure data entry accuracy. For more information, refer to Dual Data Entry, page 212.

For more information, see:
- Indexing New Documents, page 205
- Dual Data Entry Discrepancy Dialog Box, page 212

## Unique Index Validation

AppXtender provides a feature to ensure that the same index value or combination of index values is not entered for more than one document in an application. One or multiple index fields can be flagged
as part of a unique key. This allows for a set of indexes to be unique within an application. If, during document creation, a duplicate index is entered for a particular document, a message box informs you that that index has already been used on a document. You cannot add the duplicate index.

If this message appears while you are indexing a new document, consider appending the new document as a page to the existing document. For instructions, refer to Appending Pages to Documents, page 209.

Note: This feature does not validate indexes brought into AppXtender using the AppXtender Index Image Import feature.

For more information, see:
  • Index Validation, page 211

Dual Data Entry

When the Dual Data Entry feature is enabled, you must enter an index field’s data twice to confirm the accuracy of the data. If the information entered the second time is exactly the same as the first time, the document is indexed and added to the application. If the information is not entered correctly, a Dual Data Entry Error dialog box appears.

Note: If an AppXtender Auto Index Import table is used to enter a value into an index field, even if that field is flagged for dual data entry, you are not prompted to enter data a second time. For information on using an AppXtender Auto Index Import table to enter a value into an index field, refer to Using AppXtender Auto Index Import to Index Documents, page 207.

The Dual Data Entry flag and the Enable Dual Data Entry option together form the Dual Data Entry validation feature. Your system administrator can enable the Dual Data Entry flag for an index field using AppXtender AppGen and configure the Enable Dual Data Entry option on the Data tab of the Configuration dialog box. For more information, see Data Tab, page 134consult your system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.

For more information, see:
  • Index Validation, page 211
  • Dual Data Entry Discrepancy Dialog Box, page 212

Dual Data Entry Discrepancy Dialog Box

The Dual Data Entry Discrepancy dialog box ensures documents are indexed correctly. It appears only when there is a discrepancy between values that have been entered in a field that requires dual data entry.

The First Entry text box contains the first value you entered. The Second Entry text box contains the second value you entered.
To continue indexing:

- You have the following choices:
  - Click Accept 1st Entry to accept the value in the First Entry text box.
  - Click Accept 2nd Entry to accept the value in the Second Entry text box.
  - Click Re-Enter to re-enter the value in the Second Entry text box.

If the information entered the second time is exactly the same as the first time, the document is indexed and added to the application. If the information is not entered correctly, a Dual Data Entry Error dialog box appears.

For more information, see:
- Index Validation, page 211
- Dual Data Entry, page 212

Indexing Batches

If you have imported a batch of documents from AppXtender Image Capture or from an AppXtender batch utility, you can index this batch in AppXtender. You can perform batch indexing in two ways:

- If you know the name of the batch you want to index, refer to Batch Indexing a Single Batch, page 213.
- If you want to select the batch you want to index from a list of batches, refer to Batch Indexing from a List, page 215.

Batch Indexing a Single Batch

The following procedure describes how to perform batch indexing if you know the name of the batch you want to index.

**Note:** This procedure allows you to perform batch indexing on only the batches that have been created for the active application.

**To perform batch indexing:**

1. Make sure that the appropriate application is active.
2. From the Utilities menu, select Batch Index (Single). The Batch Index (Single) dialog box appears.
3. In the Batch Name text box, type the name of the batch that you want to index. Click OK. The Batch Index toolbar appears and the first page of the batch appears in Document Display view. The AppXtender title bar indicates the number of pages in the batch and indicates the number of the currently displayed page.

4. For each document that you want to create from the current batch, use the Previous Page and Next Page buttons on the Batch Index toolbar to navigate to the page that you want to use to create the new document.

5. Click the New Document button on the Batch Index toolbar.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

**Figure 87. Reason Code Required Dialog Box**

![Reason Code Required Dialog Box]

7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
8. Index the new document and click Save. All AppXtender indexing features, such as AppXtender Auto Index Import ([F7]), Key Reference ([TAB]), and appending pages ([F4]), are available when you are indexing documents in batches. For details on AppXtender indexing options, refer to Indexing New Documents, page 205.

9. Use the Attach Page and Attach All buttons on the Batch Index toolbar to add pages to the most recently indexed document.

When all pages in the batch have been added to AppXtender documents, a message appears asking whether you want to index another batch.

10. You have the following choices:
   - If you want to index another batch, click Yes. The Batch Index (Single) dialog box appears.
   - If you do not want to index another batch, click No. The current batch closes.

   For more information, see:
   - Indexing Batches, page 213

**Batch Indexing from a List**

The following procedure allows you to select a batch from a list.

**To open the batch list and index a batch:**

1. From the Utilities menu, select Batch Index (List). The Batch Index dialog box appears.
2. From the Batches for application drop-down list, select an application. A list of batches appears.

3. From the list of batches, select the batch that you want to index.

4. Click Index. The Batch Index toolbar appears and the first page of the batch appears in Document Display view. The AppXtender title bar indicates the number of pages in the batch and indicates the number of the currently displayed page.

5. For each document that you want to create from the current batch, use the Previous Page and Next Page buttons on the Batch Index toolbar to navigate to the page that you want to use to create the new document.

6. Click the New Document button on the Batch Index toolbar.

7. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.
8. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

Figure 91. Signature Properties Dialog Box

9. Index the new document and click Save. All AppXtender indexing features, such as AppXtender Auto Index Import ([F7]), Key Reference ([TAB]), and appending pages ([F4]), are available when you are indexing documents in batches. For details on AppXtender indexing options, refer to Indexing New Documents, page 205.

10. Use the Attach Page and Attach All buttons to add pages to the most recently indexed document.
When all pages in the batch have been added to AppXtender documents, a message appears asking whether you want to index another batch.

11. You have the following choices:
   - If you want to index another batch, click Yes. The Batch Index (List) dialog box appears.
   - If you do not want to index another batch, click No. The current batch closes.

Note: If a batch is stuck in an error state, you can reset the batch status. To reset the batch status, you must have the AppXtender Administrator privilege associated with your user profile. For more information on resetting a batch, consult your system administrator or refer to the "Managing Existing Application" section of the ApplicationXtender Core Components Administrator’s Guide.

For instructions on adding a memo to a batch, refer to Adding a Memo to a Batch, page 218. For instructions on deleting a batch, refer to Deleting Batches, page 403.

For more information, see:
- Indexing Batches, page 213

## Adding a Memo to a Batch

**To add a memo to a batch:**

1. From the Utilities menu, select Batch Index (List). The Batch Index dialog box appears.
2. From the Batches for application drop-down list, select an application. A list of batches appears.
3. From the list of batches, select the batch to which you want to add a memo.
4. Click Memo. The Memo dialog box appears.

**Figure 92. Memo Dialog Box**

5. Type your memo, click Save, and then click Close.

For more information, see:
- Indexing Batches, page 213
- Batch Indexing from a List, page 215
Submitting Documents to a Full-text Queue

AppXtender allows you to submit documents to the AppXtender Index Server, an AppXtender add-on module, for full-text indexing. By adding documents to the AppXtender Index Server, you can expand your queries for AppXtender documents to include keywords contained within the document. For instructions, refer to the following topics:

- **About Submitting Different File Types, page 219**, provides valuable information about submitting bi-tonal images, foreign files, RTF files, and HTML files to the AppXtender Index Server for full-text indexing.
- **Submitting a Displayed Document, page 220** describes how you can submit a displayed document from the Document menu.
- **Troubleshooting, page 221** provides a list of items to check if the Submit Full-text Index Job command is not available.

Your workstation may be configured so that new documents are automatically submitted to the AppXtender Index Server for indexing. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, see **Submit New Documents for Full Text Index, page 145** consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the *ApplicationXtender Installation Guide*.

**Note:** The ProIndex full-text engine cannot process documents of more than 2000 pages. However, the K2 full-text engine can process documents of up to 250,000 pages.

About Submitting Different File Types

Text documents can be submitted directly to the AppXtender Index Server for indexing. Your AppXtender administrator may have configured the AppXtender system so that other file types can also be submitted directly to the AppXtender Index Server for indexing:

- Color and bi-tonal (gray-scale) images must first be processed using OCR. The resultant text can then be submitted for indexing. For information on OCR, refer to **Document and Page OCR, page 382**.

  **Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to **Using Rotate, page 310**.

Your workstation may be configured so that the AppXtender Index Server automatically uses optical character recognition (OCR) to process any image documents submitted for indexing. The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, see **Full Text Tab, page 143** consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the *ApplicationXtender Installation Guide*.

- Your applications may be configured so that foreign files, RTF files, and HTML files can also be submitted for full-text indexing. If the applications are configured to use the ProIndex full-text engine, the AppXtender Index Server must be configured to convert those file types for full-text indexing. If the applications are configured to use the K2 full-text engine, no conversion is necessary for these file types.
Submitting a Displayed Document

Displayed documents can be submitted to the AppXtender Index Server for full-text indexing from the Document menu. Only the document displayed is processed.

To submit a displayed document to the AppXtender Index Server:

1. Display the document that you want to submit for full-text indexing.
2. From the Document menu, select Submit Full Text Index Job.

   **Note:** If the Submit Full Text Index Job command is not available, refer to Troubleshooting, page 221.

If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the AppXtender Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143 consult your AppXtender system administrator or refer to the “Configuring AppXtender Workstations” section of the ApplicationXtender Installation Guide.)

**Figure 93. Submit Full-text Index Job Dialog Box**

![Submit Full-Text Index Job Dialog Box](image)

3. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, select Convert to text (if necessary) to use OCR to process any color or bi-tonal (gray-scale) pages that are submitted, select a language, and click OK.

   AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in the displayed document. When the AppXtender Index Server has finished processing the document, a message appears.

4. Click OK to clear the message. You now have the ability to find this document by performing a full-text query that searches for text in this document.

   **Note:** When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document. The next time you retrieve the document, the text view of the document is available. For foreign files, RTF files, and HTML files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. (Similarly, for PDF files, only one line is included in the text view.) The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.
For more information, see:

- Submitting Documents to a Full-text Queue, page 219

**Troubleshooting**

If the Submit Full Text Index Job command on the Document menu is not available, use the following procedure. You may need to contact your system administrator for assistance if you do not have administrator privileges in AppXtender.

**To troubleshoot full-text indexing problems:**

1. Make sure that a full-text database path has been specified in the AppXtender AppGen for the active application.

   **Note:** An application cannot be modified in AppXtender AppGen while it is in use in AppXtender.

   For information on specifying a full-text database path, consult your AppXtender system administrator or refer to the "Creating an Application" section of the *ApplicationXtender Core Components Administrator’s Guide*.

   Make sure the user name that you are logged in as has privileges to perform full-text indexing. For information, consult your AppXtender system administrator or refer to the "Managing Security" section of the *ApplicationXtender Core Components Administrator’s Guide*.

2. Make sure the AppXtender Index Server is running. For information, consult your AppXtender system administrator or refer to the "Managing the AppXtender Index Server" section of the *ApplicationXtender Core Components Administrator’s Guide*.

3. Make sure a full-text queue has been created and configured properly in the AppXtender Index Server Configuration dialog box and that you have enabled text conversion of the file types you want to submit. For information, consult your AppXtender system administrator or refer to the "AppXtender Index Server" section of the *ApplicationXtender Core Components Administrator’s Guide*.

4. Make sure the Full Text tab on the AppXtender Configuration dialog box has been configured properly. For information, see *Full Text Tab, page 143* consult your AppXtender system administrator or refer to the "Configuring AppXtender Workstations" section of the *ApplicationXtender Installation Guide*.

   **Note:** If you change settings on the Full Text tab, you must restart to allow the change to take effect. For more information, see *Submitting Documents to a Full-text Queue, page 219*. 
This section explains how to use the two options for scanning paper documents into the AppXtender system: the AppXtender’s integrated scan-and-index online module and AppXtender Image Capture.

- Introduction to Scanning, page 223
- Selecting a Scanner, page 224
- Optional Scanning Configurations, page 225
- Scanning Documents, page 231
- Scanning Pages, page 234
- Integrating QuickScan Pro with AppXtender, page 236

Introduction to Scanning

ApplicationXtender (AppXtender) provides two options for scanning paper documents into the AppXtender system:

- ApplicationXtender’s integrated scan-and-index online module allows you to scan and index documents in an interactive mode. Documents are scanned and indexed at the same time. For information on this module, continue reading this topic.

- ApplicationXtender Image Capture (AppXtender Image Capture), a separate module, provides batch scanning functionality, allowing you to scan documents and then index them at a later time. For more information on AppXtender Image Capture, refer to the ApplicationXtender Image Capture User’s Guide.

Note: AppXtender can display multiple unindexed documents simultaneously, allowing you to add pages from the scanner to each unindexed document as necessary. However, a displayed document is not saved to AppXtender until you index it and click Save.

AppXtender supports several different scanners and scanner interfaces. During AppXtender setup, you can choose a Scanning workstation type to install the appropriate scanner support files. After installation, you install the necessary scanner driver and then select the scanner from the AppXtender Select Scanner dialog box. For a complete list of scanners that AppXtender supports, refer to Selecting a Scanner, page 224.

You can customize several scanner properties to produce the desired scanning results. DPI settings, scanner feeder settings, auto rotation, auto image enhancement, brightness, dither, and other settings
can be configured. Advanced settings available for each scanner are driver-specific and change from scanner to scanner. The Scanner Settings dialog box for scanners provides different, configurable parameters.

This section provides details on scanner setup, settings and procedures using the AppXtender scan-and-index online module.

- Selecting a Scanner, page 224
- Optional Scanning Configurations, page 225
- Scanning Documents, page 231
- Scanning Pages, page 234

## Selecting a Scanner

Refer to the *ApplicationXtender Release Notes* for information on supported scanner drivers.

AppXtender installs scanner support files during the ApplicationXtender Desktop installation. For more information on installing scanner support files, consult your system administrator or refer to the "Installing ApplicationXtender" section of the *ApplicationXtender Installation Guide*.

The manufacturer’s recommended scanner driver must also be installed on your workstation in order to scan. For more information, consult your system administrator or refer to the "Planning Your ApplicationXtender Installation" section of the *ApplicationXtender Installation Guide*.

Before you can begin scanning, however, the scan workstation must have the correct scanner type selected.

**To select a scanner for your workstation:**

1. Install and load the appropriate scanner driver on the scan workstation. For information, consult your AppXtender system administrator or refer to the "Planning Your ApplicationXtender Installation" section of the *ApplicationXtender Installation Guide*.

2. From the Scan menu, select Configuration and then Select Scanner. The Select Scanner dialog box appears.
Figure 94. Select Scanner Dialog Box

Note: If your scanner does not appear in the Select Scanner list, make sure that the scan workstation type was selected when AppXtender was installed, and that the appropriate scanner driver has been installed. For information, consult your AppXtender system administrator or refer to the "Planning Your ApplicationXtender Installation” section of the ApplicationXtender Installation Guide.

Note: If both AppXtender and AppXtender Image Capture are running at the same time on the same workstation, only one can use a scanner driver at a time. If you are using a particular scanner driver for AppXtender Image Capture, you cannot use that scanner driver for AppXtender until you close AppXtender Image Capture or select a different scanner driver in AppXtender Image Capture.

3. Select your scanner from the list, and click OK. Depending on the scanner, another dialog box might appear, allowing you to further configure the scanner driver. For instructions, refer to the documentation for your scanner.

For more information, see:
• Chapter 4, Scanning

Optional Scanning Configurations

You can configure several scanner properties to produce the scanning results that you want. The following topics describe how to configure each aspect of scanning.
• Scan Feeder Options, page 226
• Automatic Enhancement, page 227
• Auto OCR, page 227
• Resolution Settings, page 228
• Mode Settings, page 228
• Page Size Settings, page 229
You can use either the Scan menu or the Scan toolbar to perform each of these configurations. For information on the Scan toolbar buttons, refer to AppXtender Document Manager Toolbars, page 75. For information on hiding or customizing the Scan toolbar, refer to Configuring Toolbars, Title Bar, and Status Bar, page 87.

Scan Feeder Options

AppXtender provides three different options for operating the scanner feeder: single feed, manual feed, and automatic feed. These options are mutually exclusive; only one of the options can be activated.

For more information, see:
• Optional Scanning Configurations, page 225

Automatic Feed

In automatic feed mode, AppXtender scans all of the pages in the feeder. When the feeder is empty, the scan session ends. After all of the pages in the feeder have been scanned, if you put more pages in the feeder, you must click the Scan button again to scan the new pages.

Note: The Synchronized Scan option in the Configuration dialog box allows you to slow down automatic feed and view each page as it is scanned. For information on configuring synchronized scan, refer to Synchronized Scan, page 118.

To enable auto feed:
• From the Scan menu, select Feed and then Auto.

Manual Feed

In manual feed mode, AppXtender scans all of the pages in the feeder, then waits for you to add more pages before the scan session times out. After the time runs out, if you put more pages in the feeder, you must click the Scan button again to scan the new pages.

The time-out is configurable, and is set in the AppXtender Configuration dialog box. The default is 20 seconds. For information on configuring the Scanner Manual Feed Timeout, refer to Scanner Manual Feed Timeout, page 118.

Note: The Synchronized Scan option in the Configuration dialog box allows you to slow down manual feed and view each page as it is scanned. For information on configuring synchronized scan, refer to Synchronized Scan, page 118.
To enable manual feed:
- From the Scan menu, select Feed and then Manual.

**Single Feed**

In single feed mode, AppXtender scans only one page at a time. After each page is scanned, you must click the Scan button again to scan the next page.

To enable single feed mode:
- From the Scan menu, select Feed and then Single.

**Automatic Enhancement**

Auto Enhancement is a licensed feature that allows you to automatically enhance pages as they are scanned. If the pages will be processed using optical character recognition (OCR), this feature makes the OCR more accurate. Automatic enhancement applies all settings configured in the in the ScanFix Configuration dialog box and the ScanFix Advanced Settings dialog box. Auto enhancement applies to bi-tonal (black and white) images only. Refer to Enabling Image Processing Options, page 116 for information on configuring Document Manager for image processing.

To configure auto enhancement:
- From the Scan menu, select Configuration and then Auto Enhancement. The auto enhancement feature toggles on or off.

**Enhancement Settings**

When the licensed auto enhancement feature is enabled, all bi-tonal images added to AppXtender are enhanced using the configured enhancement settings. The effectiveness of this feature for improving OCR processing of scanned images in AppXtender depends entirely on how you configure image enhancement settings. Refer to Enabling Image Processing Options, page 116 for information on configuring Document Manager for image processing.

To configure image enhancement settings:
- From the Scan menu, select Configuration and then Enhancement Configuration.

The ScanFix Configuration dialog box appears. You may configure the settings to produce the desired results. For details on image enhancement settings, refer to Configuring Image Enhancement, page 488.

**Auto OCR**

AppXtender allows you to automatically process color and bi-tonal (black and white) pages using optical character recognition (OCR) as they are scanned. The Auto OCR feature automatically uses OCR to process all documents as they are scanned.
You can also manually process documents and pages using OCR. For more information, refer to Document and Page OCR, page 382.

**Note:** Make sure that the image is oriented correctly when you scan it to ensure accurate OCR results. Setting the scanner at 300 DPI provides the most accurate results.

To configure Auto OCR:
- From the Scan menu, select Configuration and then Auto OCR.

The Auto OCR feature toggles on or off. If you enable Auto OCR and scan an image, AppXtender displays the page in text view. You can use the Show Text button to switch between the text view and the image view of this page. For information, refer to Viewing Image Pages, page 318.

For more information, see:
- Optional Scanning Configurations, page 225

## Resolution Settings

The Resolution drop-down list is located on the scan toolbar and can be used to change the dots per inch (DPI) resolution setting. The DPI options available to you will vary depending on your scanner. Higher DPI settings produce larger file sizes, however higher settings also produce greater image clarity. A recommended setting is 200 DPI. If you require higher quality, you can select another option.

To configure resolution settings:
- From the Scan menu, select Resolution and then the DPI setting that you want to use.

For more information, see:
- Optional Scanning Configurations, page 225

## Mode Settings

The Mode drop-down list is located on the Scan toolbar and can be used to change the scanning mode. Some scanning mode examples are bi-tonal, 16-Level Gray, 256-Level Gray, and 24-Bit Color, and vary depending on your scanner. When selecting a scanner mode, remember that the 256-Level Gray option will roughly double the size of your file, while increasing clarity of the scanned page. The recommended setting for efficient scanning is bi-tonal.

### Table 29. Example File Sizes When Using Different Modes for Same Image

<table>
<thead>
<tr>
<th>Mode</th>
<th>File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bi-tonal</td>
<td>12 KB</td>
</tr>
<tr>
<td>256-Level Gray</td>
<td>3,367 KB</td>
</tr>
<tr>
<td>24-Bit Color</td>
<td>10,040 KB</td>
</tr>
</tbody>
</table>
To configure mode settings:
- From the Scan menu, select Mode and then the mode setting you want to use.

For more information, see:
- Optional Scanning Configurations, page 225

Page Size Settings

The Page Size drop-down list is located on the Scan toolbar and can be used to change the page size and orientation. The Page Size option sets the size of the page that you are scanning. The options listed for you vary depending on your scanner. Some page size examples are Legal, Letter, and B5.

To configure page size settings:
- From the Scan menu, select Page Size, the size, and if available, the orientation you want to use.

If you scan a page that is larger than the current page size setting, part of the image does not get scanned. If you scan a page that is smaller than the current page size setting, black areas are added to the edges of the scanned image, which means that the file size is larger than it needs to be.

For more information, see:
- Optional Scanning Configurations, page 225

Source Setting

The Source drop-down list allows you to choose a scanner source. Options available for you may include Flatbed, ADF Simplex and ADF Duplex, although the options vary depending on your scanner. The following table demonstrates the typical source settings and what they mean:

Table 30. Typical Source Settings

<table>
<thead>
<tr>
<th>Source Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flatbed</td>
<td>Flatbed refers to using the scanner’s top paper bed, similar to a copy machine.</td>
</tr>
<tr>
<td>ADF Simplex</td>
<td>Automatic Document Feeder (ADF) Simplex refers to using the automatic document feeder to scan only the front side of the document.</td>
</tr>
<tr>
<td>ADF Duplex</td>
<td>ADF Duplex refers to using the automatic document feeder to scan both sides of the document.</td>
</tr>
</tbody>
</table>
To configure source settings:
- From the Scan menu, select Source and then the source you want to use.

For more information, see:
- Optional Scanning Configurations, page 225

## Auto Rotation

AppXtender allows you to automatically rotate pages as they are being scanned. If you have configured your source as duplex, separate options are provided to set the rotation of front and back pages being scanned. If you have configured your source as something other than duplex, you only need to configure the front page rotation.

Rotation can be set to 90, 180 and 270 degrees. When you click the Front Rotation and Back Rotation buttons on the Scan toolbar, the setting toggles from None to 90 Degrees, to 180 Degrees, to 270 Degrees.

**Figure 95. Front Rotation Button and Back Rotation Button**

For more information, see:
- Optional Scanning Configurations, page 225
- Optional Scanning Configurations, page 225

## Front Page Rotation

To configure automatic rotation for all front pages:
- From the Scan menu, select Rotation (Front) and then the desired rotation setting (None, 90 Degrees, 180 Degrees, or 270 Degrees).

## Back Page Rotation

To configure automatic rotation for all back pages:
- From the Scan menu, select Rotation (Back) and then the desired rotation setting (None, 90 Degrees, 180 Degrees, or 270 Degrees).

**Note:** You do not need to configure Back Rotation if your scanner is not a duplex scanner.
### Scanner Driver Configuration

The Scanner Settings dialog box provides advanced features that relate to your scanner. The options vary depending on the scanner that you are using. Some examples of settings that may be included are brightness, dither, and contrast.

To access your scanner’s advanced settings:
- From the Scan menu, select Configuration and then Driver Configuration.

The Scanner Settings dialog box for your scanner appears. The options and buttons that appear on the Scanner Settings dialog box vary according to the scanner. For more information on configuring this dialog box, refer to the documentation provided with your scanner.

#### Figure 96. Sample Scanner Settings Dialog Box

Any changes made in this dialog box are reflected in the Scan toolbar. Additionally, any settings you change remain as the scanner settings until you change them.

For more information, see:
- Optional Scanning Configurations, page 225

### Scanning Documents

This topic provides steps for scanning documents into AppXtender. Refer to the ApplicationXtender Release Notes for information on supported scanner drivers.

**Note:** To use the Scan input method to add documents to either the _RSTAMP or _FORMS application, you must access the New Document command using the right-click/shortcut menu method (described in the following procedure).

#### To scan a document into AppXtender:

1. Select the appropriate settings on the Scan toolbar, the Scan menu, or the Scan tab of the Configuration dialog box.
   - You can customize several scanner properties to produce the desired scanning results. DPI settings, scanner feeder settings, automatic rotation, automatic image enhancement, brightness,
dither, and other settings can be configured. Advanced settings available for each scanner are driver-specific and change from scanner to scanner. The Scanner Settings dialog box allows you to set additional parameters. For instructions, refer to Optional Scanning Configurations, page 225.

The following configurable options may also affect the scanning process:

- The Remove Blank Pages option discards pages from the scanning process that do not meet the threshold you choose on the sliding Threshold bar.
- The Synchronized Scan option allows you to slow down manual and automatic feed and view each page as it is scanned.

These options can be set on the Scan tab in the Configuration dialog box. For more information, refer to Scan Tab, page 115.

2. Close any currently displayed documents.

3. Prepare the paper documents for scanning. Document preparation requirements depend on the standards set for your company. Consult your AppXtender system administrator for guidelines. Some document preparation suggestions include:
   - Remove sticky notes, paper clips, and staples (if appropriate).
   - Make sure the documents are stacked with the correct orientation.
   - If you are using an automatic document feeder, make sure the pages to be scanned are in good enough condition to run through the feeder.

4. Feed to your scanner the paper that you want to scan.

5. Right-click the application name in the Application view. From the shortcut menu that appears, select New Document and then Scan. AppXtender scans the document.

6. If the Reason Code Required dialog box appears, select the check boxes for the functionality that you will need when the document has been created (Print, Export, and/or Email), enter a comment about the document you are creating in the text box, and click OK.

**Figure 97. Reason Code Required Dialog Box**
7. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)

**Figure 98. Signature Properties Dialog Box**

![Signature Properties Dialog Box]

The document appears in the Document Display view.

**Note:** While pages are being scanned, a Cancel button appears on the AppXtender status bar. Click the Cancel button at any time to stop scanning. Also, 30 seconds after each image has been fully scanned, it is automatically saved as a BIN file to the document write path for the application.

8. If necessary, you can rescan the page just scanned. Make sure the page is displayed in the Document Display view.

![](Caution.png) **Caution:** The Rescan feature will not replace the most recently scanned page if the page is not displayed in the Document Display view or if 30 seconds have passed since the image was scanned. To replace pages after the document has been saved, select the Replace option from the Page menu. For more details refer to Replacing Pages, page 349.

From the Scan menu, select Rescan.

9. Enter the appropriate index data for this document in the Index view.
The index information can be entered for the document at any time. You can enter it after the first page is scanned or the last.

10. Click Save.

For more information, see:
- Chapter 4, Scanning

**Scanning Pages**

Additional pages can be added from any scanner certified for use with AppXtender. The following topics describe the addition of a single page by scanner. Scanned pages can be inserted before or after a displayed page, or appended to the end of a document.

- Inserting a Scanned Page before the Current Page, page 235
- Inserting a Scanned Page after the Current Page, page 235
- Appending a Scanned Page to a Document, page 235

**Note:** The following configurable options may affect the scanning process:

- The Remove Blank Pages option discards pages from the scanning process that do not meet the threshold you choose on the sliding Threshold bar.

- The Synchronized Scan option allows you to slow down manual and automatic feed and view each page as it is scanned.
These options can be set on the Scan tab in the Configuration dialog box. For more information, refer to Scan Tab, page 115.

Inserting a Scanned Page before the Current Page

You can scan a new page into a document and add it as the previous page in the document (before the currently displayed page).

Note: The number of pages inserted depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to Scan Feeder Options, page 226.

To add a page before the current page by scanning:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.
2. From the Page menu, select New and then Scan. From the shortcut menu that appears, select Insert Before. AppXtender automatically scans the page and it appears as a new page in the Document Display view.

For more information, see:

- Scanning Pages, page 234

Inserting a Scanned Page after the Current Page

You can scan a new page into a document and add it as the next page in the document (after the currently displayed page).

Note: The number of pages inserted depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to Scan Feeder Options, page 226.

To add a page after the current page by scanning:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.
2. From the Page menu, select New and then Scan. From the shortcut menu that appears, select Insert After. AppXtender automatically scans the page and it appears as a new page in the Document Display view.

For more information, see:

- Scanning Pages, page 234

Appending a Scanned Page to a Document

You can scan a new page into a document and add it as the last page in the currently displayed document.

Note: The number of pages appended depends on the current feed mode and the number of pages in the scanner. For information on feed modes, refer to Scan Feeder Options, page 226.
To add a page to the end of the current document by scanning:

1. Make sure that the appropriate document is currently displayed.
2. From the Scan menu, select Scan Page. AppXtender automatically scans the page and it appears as a new page in the Document Display view.

For more information, see:
- Scanning Pages, page 234

Integrating QuickScan Pro with AppXtender

Document Manager allows you to create profiles that are stored in QuickScan Pro. QuickScan Pro uses the profiles to export documents to applications in AppXtender. For more information, refer to:
- Creating QuickScan Pro Export Profiles in Document Manager, page 236
- Exporting QuickScan Pro Documents to AppXtender, page 237
- Creating Profiles in QuickScan Pro, page 238

For information on installing and using QuickScan Pro, refer to QuickScan Pro online help and the following documentation: QuickScan Pro Release Notes, QuickScan Pro Quick Start Guide, QuickScan Pro Overview, and QuickScan Pro Exporter Software Development Kit.

Note: You need to have one QuickScan Pro license per installation of AppXtender Desktop.

Creating QuickScan Pro Export Profiles in Document Manager

To create QuickScan Pro export profiles in Document Manager:

1. Select File > Export QSP Indexer from the Document Manager menu bar. Document Manager displays the Select Applications dialog box.
2. Select the AppXtender target application. QuickScan Pro will export documents to the selected application.

3. Type a profile name.

4. Click OK. AppXtender creates an export profile and an index profile that are stored in QuickScan Pro.

Refer to QuickScan Pro documentation for information on how to create export profiles and index profiles in QuickScan Pro.

**Exporting QuickScan Pro Documents to AppXtender**

**To export documents from QuickScan Pro to AppXtender:**

1. Open the document in QuickScan Pro.

2. Select File > Index from the QuickScan Pro menu bar. QuickScan Pro displays the Index dialog box.

3. Select the index profile that was created in Document Manager. Refer to Creating QuickScan Pro Export Profiles in Document Manager, page 236 for more information.

4. Click Index. QuickScan Pro displays the Index pane, which lists the index fields for the AppXtender target application.

5. Index the document. Refer to QuickScan Pro documentation for more information on indexing documents.

6. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.
7. Select the export profile created with Document Manager.
8. Click Export. QuickScan Pro exports the document and its index information to the AppXtender target application.
9. Click OK to close the Export Page dialog box.

Creating Profiles in QuickScan Pro

The AppXtender Exporter Wizard allows you to configure an export profile that was created in QuickScan Pro. For more information, refer to:

- Creating a Profile for Single-Document Processing, page 238
- Creating a Profile for Batch Processing, page 239

Creating a Profile for Single-Document Processing

To create a profile for single-document processing:

1. Open the QuickScan Pro application.
2. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.
3. Select New exporter configuration.
4. Click Add. The Select an Exporter dialog box appears.
5. Select OpenText AppXtender Exporter.
6. Click OK. QuickScan Pro displays the Export Profile Editor.
7. Select the Configuration tab. The AppXtender Exporter Wizard appears.
8. Select the AppXtender data source that contains the target AppXtender application.
9. Click Next.
10. Type your AppXtender user name and password.
13. Select single-document processing options. The following table describes the options.
Table 31. Single-Document Processing Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merging Options</td>
<td>Appends the existing AppXtender document with the pages exported from QuickScan Pro if the AppXtender document has the same index fields defined in the profile.</td>
</tr>
<tr>
<td>Merge With Existing Documents</td>
<td>Enabling the Ignore ‘Unique Key’ fields restriction and Merge With Existing Documents options allows the Exporter Wizard to override the Part of Unique Key field in AppGen, if it is enabled for any of the fields in the target AppXtender application.</td>
</tr>
<tr>
<td>Ignore ‘Unique Key’ fields restriction</td>
<td></td>
</tr>
<tr>
<td>Full-Text Processing Queue</td>
<td>Sends the pages exported from QuickScan Pro to the selected AppXtender full-text engine.</td>
</tr>
<tr>
<td>OCR Settings</td>
<td>Specifies the AppXtender version number for OCR documents exported from QuickScan Pro. To save the OCR documents as the first version of the AppXtender document, select Version 1. To save the OCR documents as the second version of the AppXtender document, select Version 2.</td>
</tr>
</tbody>
</table>

14. Click Next.

15. Map QuickScan Pro index fields to AppXtender index fields:
   a. Select the QuickScan Pro index profile from the QuickScan Pro Indexer list box.
   b. Select the target AppXtender application from the AppXtender Application list box.
   c. Select an index field from the Indexer Fields window.
   d. Select the corresponding AppXtender index field from the Application Fields window.
   e. Click Add. The wizard adds the mapped index fields to the Links section of the wizard dialog box.
   f. Repeat Step a through Step e to map additional index fields.

16. Click Finish. QuickScan Pro displays a profile summary on the Export Profile Editor dialog box. Refer to QuickScan Pro documentation for procedures on exporting documents.

Creating a Profile for Batch Processing

To create a profile for batch processing:

1. Open the QuickScan Pro application.
2. Select File > Export from the QuickScan Pro menu bar. QuickScan Pro displays the Export dialog box.
3. Select New exporter configuration.
4. Click Add. The Select an Exporter dialog box appears.
5. Select OpenText AppXtender Exporter.
6. Click OK. QuickScan Pro displays the Export Profile Editor.
7. Select the Configuration tab. The AppXtender Exporter Wizard appears.
8. Select the AppXtender data source that contains the target AppXtender application.
9. Click Next.
10. Type your AppXtender user name and password.
14. Map QuickScan Pro index fields to an AppXtender batch:
   a. Select an index field from the Indexer Fields window.
   b. Select the target AppXtender application from the AppXtender Application list box.
   c. Select Batch Name from the Application Fields window.
   d. Click Add. The wizard adds the mapped batch to the Links section of the wizard dialog box.
   e. To include a batch memo, select a remaining index value from the Indexer Fields window, select Batch Memo from the Application Fields window, and then click Add.
15. Click Finish. QuickScan Pro displays a profile summary on the Export Profile Editor dialog box.
Refer to QuickScan Pro documentation for procedures on exporting batches.
Refer to Indexing Batches, page 213 for procedures on how to index the batch.
Chapter 5
Retrieving Documents

This section describes how to perform a search and retrieve a document in AppXtender.

- Introduction to Document Retrieval, page 241
- What is a Query?, page 242
- Searching a Single Application, page 243
- Searching Multiple Applications, page 259
- Displaying Documents from the Result Set, page 266
- Document Text Searches, page 286
- Managing Queries, page 290

Introduction to Document Retrieval

Because index information is attached to each document when it is stored using AppXtender, documents can be retrieved by searching for information contained in the index. By requiring index information for every document, AppXtender ensures that a document can be retrieved quickly and easily. AppXtender provides search capabilities that are both flexible and powerful. The following topics describe these capabilities:

- What is a Query?, page 242 defines and explains the AppXtender concept of a query.
- Searching a Single Application, page 243 describes how to retrieve documents using many of the AppXtender search capabilities such as basic queries, wildcard queries, expression range queries, list of values queries, ODMA attributes searching, compound queries, and full-text searching. If the application is configured for Centera retention or AppXtender software retention, and you have the appropriate retention privileges, you can search for documents that are under retention or retention hold.

The AppXtender Index Server, an AppXtender add-on module, provides AppXtender with full-text indexing capabilities for text and image documents. Text documents can be submitted directly to the AppXtender Index Server for indexing. Image documents can be submitted to the AppXtender Index Server, which can process the document using optical character recognition (OCR) and index the resultant text. AppXtender offers you a wide range of options for performing full-text (or keyword) searches on indexed document pages.

- Searching Multiple Applications, page 259 describes how to create and run queries that search multiple AppXtender applications for selected index and/or full-text information.
Displaying Documents from the Result Set, page 266 describes many of the options that may be available to you when you display a document from the result set (the list of results of your searches for documents). This topic describes checking in and checking out documents, displaying ApplicationXtender Reports Management (AppXtender Reports Mgmt) reports, and viewing full-text search results.

When you retrieve a document, AppXtender provides immediate access to a wide variety of other functions such as display, print, fax, delete, and save. These capabilities are available for one document or a selected range of documents. For information, refer to Chapter 7, Managing Documents.

For information on configuring the query result set, refer to Managing the Query View Result Set, page 99.

Document Text Searches, page 286 describes how to search for strings of text in text documents.

Managing Queries, page 290 describes how to save, run, edit, rename, and delete queries. This topic also describes how to make saved queries private or public.

What is a Query?

A query is a search that you use to retrieve stored documents in AppXtender. AppXtender allows you to search one application at a time or search across multiple applications at once.

You perform a query in the Query view. The Query view has one or more tabs, starting with the Search tab.

Figure 101. New Query Search Tab

The Query view Search tab has two parts.

- The top part allows you to perform queries based on the information stored in the document index fields. This is considered a query by index. For more information, refer to Entering Index Values as Search Criteria, page 245.

- The bottom part allows you to perform queries based on the text within the documents. This is considered a full-text query. For more information, refer to Entering Full-Text Values as Search Criteria, page 255.
If the application is configured for Centera retention or AppXtender software retention, and you have the Retention User privilege, the bottom part displays a Retention Options section that allows you to search for documents under retention or retention hold. For more information, refer to Appendix A, Working with Document Retention.

You can also perform queries based on both the index information and the full-text information. For more information, refer to Combination (Index and Full-Text) Queries, page 258.

If you want to perform queries that search across multiple applications, refer to Searching Multiple Applications, page 259.

For more information, see:

- Chapter 5, Retrieving Documents

## Searching a Single Application

You can create a new query to search for documents or AppXtender Reports Mgmt reports in one application.

### To create a new query:

1. You have the following choices:
   - Right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select New Query.
   - To query for an AppXtender Reports Mgmt generated report only, right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select Reports. (This option is only available if you have the Report View privilege.)

   The Search tab of the Query view appears.

   ![New Query Search Tab](image)

2. Enter search criteria for the query to locate the documents you want to retrieve. To perform the simplest type of query, enter index values in the Values column.
For more information on entering criteria for more advanced searches, refer to the following topics:

- Entering Index Values as Search Criteria, page 245
- Entering Full-Text Values as Search Criteria, page 255
- Combination (Index and Full-Text) Queries, page 258

3. To filter query results for documents that have been filed for Centera retention or AppXtender software retention, select one of the following options from the Show list box in the Query Options section of the tab:
   - All documents excluding documents on retention
   - Only documents on retention
   - Only documents on retention hold
   - Only documents on retention not on retention hold

   Refer to Appendix A, Working with Document Retention for more information.

   **Note:** Retention options do not appear in the list box if the application is not configured for retention.

4. Click Search.

   A Result Set tab appears in the Query view containing the documents or AppXtender Reports Mgmt reports that meet the search criteria.

   - If no documents or AppXtender Reports Mgmt reports are found meeting the specified search criteria, a No documents found message appears.
   - If one match is found, AppXtender displays that document. You may be prompted to check out the document or open it in read-only mode.

   As soon as you have opened the document, if you performed a full-text search, the Full Text Search Results dialog box appears. For information, refer to Viewing Full-Text Search Results, page 282.

   - If more than one match is found, the Result Set tab appears, allowing you to select a document for processing. The Result Set tab also appears when querying for AppXtender Reports Mgmt reports, regardless of whether one or many reports are found.
Figure 103. Result Set Tab

For more information, refer to:
- Displaying Documents from the Result Set, page 266
- Displaying AppXtender Reports Mgmt Reports, page 278
- Saving a Query, page 291

**Entering Index Values as Search Criteria**

AppXtender provides flexible options for searching for documents by index values. Exact index information can be entered as search criteria, or lists of values and ranges can be entered. When queries are executed, a Result Set tab appears listing document index records that met the search criteria you entered. If only one document met the criteria, AppXtender automatically displays it.

*Query by Index, page 246,* describes entering single index values in the index field Values column in the Search tab. There are several ways you can insert more complicated index value search criteria. Insertion of advanced index value search criteria is described in the following topics:
- Pasting Index Values from the Document Index View, page 246
- Wildcard Query, page 246
- Expression Range Query, page 247
- List of Values Query, page 249
- Searching by ODMA Attributes, page 251
- Compound Queries, page 253
Query by Index

The simplest form of query is an index value search. You can enter index values by typing the values in the Values column of the Search tab.

To enter index values:
- Under Values, next to any or all of the field names, enter the index information that you want to search for. You can type in an index value for some or all of the fields.

Note: If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.

For more information, see:
- Entering Index Values as Search Criteria, page 245

Pasting Index Values from the Document Index View

If you have a document displayed, you can copy index values from the Document Index view and paste them into the Query view Search tab. This feature allows you to find documents related to the displayed document.

To paste index values from the Document Index view:
1. Right-click in the Document Index view. From the shortcut menu that appears, select Copy Form.
2. Right-click in a gray area of the Query view Search tab. From the shortcut menu that appears, select Paste Form. The index values from the displayed document are pasted in the Values column.
3. If necessary, edit the pasted values.

For more information, see:
- Entering Index Values as Search Criteria, page 245

Wildcard Query

The asterisk (*) is a wildcard that matches any character or number of characters. A wildcard performs beginning with, ending with, and pattern searches. For example, MA* finds all the names beginning with the letters MA. The wildcard character can be used to narrow a search, controlling the number of documents returned in the Result Set tab.

To use a wildcard in an index value:
- Under Values, next to any or all of the field names, enter the index information that you want to search for, using the wildcard character to represent part of the index value.

Note: If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.
Note: Wildcards are valid for index fields with the data types Text, Time Stamp, SSN, Telephone, Zip Code, Boolean Choice, and User-defined List. Search expressions, such as an expression range or a list of values, should be used for all other data types. For information on performing searches with an expression range, refer to Expression Range Query, page 247. For information on performing searches with a list of values, refer to List of Values Query, page 249. For information on the types of index fields in your AppXtender application, consult your AppXtender system administrator or refer to the "Creating an Application" section of the ApplicationXtender Core Components Administrator’s Guide.

The following table shows how the wildcard character works.

Table 32. Search Specification Examples

<table>
<thead>
<tr>
<th>Search Specifications</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMITH</td>
<td>Returns all documents with a Name of SMITH.</td>
</tr>
<tr>
<td>SM*</td>
<td>Returns all documents with a Name that begins with the characters SM.</td>
</tr>
<tr>
<td>*ITH</td>
<td>Returns all documents with a Name that ends with the characters ITH.</td>
</tr>
<tr>
<td>S*H</td>
<td>Returns all documents with a Name that begins with the character S and ends with the character H.</td>
</tr>
<tr>
<td><em>ITH</em></td>
<td>Returns all documents with a Name that contains the character pattern ITH.</td>
</tr>
</tbody>
</table>

Caution: Avoid the following search strategies:

- Specifying the wildcard character by itself in a field
- Performing a search when all fields are left blank

Both of these approaches result in a search on all documents and negatively impact system performance on multi-user, networked systems.

For more information, see:

- Entering Index Values as Search Criteria, page 245

Expression Range Query

You can also find documents by entering a range of possibilities for each index field using the Search Expression dialog box. This feature gives you more options for narrowing your search within an index field.

Note: Expression range queries cannot be performed on fields with the Boolean Choice or User-defined List data types.

To insert a search expression as search criteria:

1. Select the index field you want to query. Press the [F8] key. The Search Expression dialog box appears. AppXtender displays the name of the field you are searching in the dialog box’s title bar.
2. Designate the type of search you want to perform by selecting an option from the Type of Comparison drop-down list. Available options are Between, Greater than, Greater than or equal, Less than, Less than or equal, or Not equal to.

3. In the Value text box, enter the appropriate Search Expression values. If you selected the Between type of comparison, also enter a value in the And text box.

4. Click OK. AppXtender adds the expression you created in the Search tab.

**Figure 105. Search with Expression**

**Note:** If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.

The following table provides an example of each type of comparison.
Table 33. Examples of Search Expressions

<table>
<thead>
<tr>
<th>Comparison</th>
<th>Example</th>
<th>AppXtender Finds Documents With</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between [ ]</td>
<td>Expression: ['925279', '925308']</td>
<td>Account numbers from 925279 through 925308</td>
</tr>
<tr>
<td>Greater than &gt;</td>
<td>Expression: &gt; 925279</td>
<td>Account numbers greater than 925279</td>
</tr>
<tr>
<td>Greater than or equal &gt;=</td>
<td>Expression: &gt;= 925279</td>
<td>Account numbers greater than or equal to 925279</td>
</tr>
<tr>
<td>Less than &lt;</td>
<td>Expression: &lt; 925279</td>
<td>Account numbers less than 925279</td>
</tr>
<tr>
<td>Less than or equal &lt;=</td>
<td>Expression: &lt;= 925279</td>
<td>Account numbers less than or equal to 925279</td>
</tr>
<tr>
<td>Not equal to &lt;&gt;</td>
<td>Expression: &lt;&gt; 925279</td>
<td>Account numbers other than 925279</td>
</tr>
</tbody>
</table>

**Note:** You can add search expressions ([F8]) to queries after they have been created by right-clicking the query and selecting Edit.

For more information, see:

- Entering Index Values as Search Criteria, page 245

**List of Values Query**

List of Values logic allows you to define as many alternatives for every search field as you wish. In the List of Values dialog box, for example, you could enter "123-45-6789", "111-11-1111", and other Social Security numbers (SSN) to search for multiple values.

AppXtender locates all documents that contain any entry in that field. In the example above, all documents with "123-45-6789" in the SSN field *and* all documents with "111-11-1111" (as well as any others you added) are located and listed in the Result Set tab. By allowing you to specify more alternatives, the List of Values operation provides for more inclusive searches that retrieve a larger set of documents.

**To insert a list of values as search criteria:**

1. Select the index field you want to query. Press [F5]. The List of Values dialog box appears.
2. In the Field Value text box, enter one of the field values that you want to query. AppXtender allows you to add as many values for the selected field as you want. The following table explains each of the buttons in the dialog box.

**Table 34. List of Values Dialog Box Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds each value entered into the Field Value text box.</td>
</tr>
<tr>
<td>Replace</td>
<td>Overwrites the selected value with a corrected value.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes an unwanted value.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Removes all values in the Field Value list.</td>
</tr>
</tbody>
</table>

3. When all values have been entered, click OK. AppXtender adds the list you created to the Search tab.
Retrieving Documents

Figure 107. Search with List

For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.

Note: You can add lists of values ([F5]) to queries after they have been created by right-clicking the query and selecting Edit.

For more information, see:
- Entering Index Values as Search Criteria, page 245

Searching by ODMA Attributes

AppXtender uses Open Document Management API (ODMA) to let you create AppXtender documents and check them into AppXtender from ODMA-compliant Application. When you create an AppXtender document from an ODMA-compliant application, you have the opportunity to enter the following optional information about the document: title, subject, author, keywords, and comment. These pieces of information, plus the user name (and domain, if the Windows security provider is used) under which the document was created, are considered to be ODMA attributes of the document. After such a document is created, you have the opportunity to change the title, subject, author, keywords, and comment. These changes can be performed from either within the ODMA-compliant application or within AppXtender.

If your AppXtender workstation has been configured to allow searching by ODMA attributes, you can search for documents by title, subject, author, keywords, comment, and the user name under which the document was created. ODMA attributes in the Query View’s Search tab are identified by brackets [ ].
Figure 108. Searching by ODMA Attributes

The following table refers you to other documentation for more information.

Table 35. More Information on ODMA Attributes

<table>
<thead>
<tr>
<th>For Information On</th>
<th>Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring your workstation to allow searching by ODMA attributes</td>
<td>Chapter 2, Customizing Your AppXtender Document Manager Workstation “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide</td>
</tr>
<tr>
<td>Using ODMA-compliant applications to create and modify AppXtender documents</td>
<td>Chapter 8, Using ODMA With AppXtender Documents</td>
</tr>
<tr>
<td>Modifying the ODMA attributes of a document from within AppXtender</td>
<td>Chapter 7, Managing Documents</td>
</tr>
</tbody>
</table>
For more information, see:
- Entering Index Values as Search Criteria, page 245

**Compound Queries**

By combining multiple search expressions, you can find a wide range of AppXtender documents with a single query. At its simplest, you can create a compound search expression with two sets of search criteria. For example, if you enter index data to search for all documents with Sarah and SSN 111-11-1111 or Ruth and SSN 222-22-2222, the Result Set can return index records in any of the following combinations: Sarah and SSN 111-11-1111, Ruth and SSN 222-22-2222, or both.

For more complex search expressions, you can create a single query with up to four sets of search criteria. When executed, the Result Set can return index records that match a set of search criteria or any combination of search criteria. For examples, refer to Compound Query Examples, page 254.

**To insert additional columns to create a compound query:**

1. To add columns to the Query view Search tab, right-click in the heading of the Values column. From the shortcut menu that appears, select Add Column.

   **Figure 109. Add Column Shortcut Menu**

   ![Figure 109. Add Column Shortcut Menu](image)

   A new Values column is added to the Query view Search tab.

2. Repeat step 1 until you have added the appropriate number of columns.

   **Note:** If you want to delete a column from the Query view Search tab, right-click in the Values column. From the shortcut menu that appears, select Delete Column.

3. Under each Values column and next to any or all of the field names, enter the index information that you want to use as search criteria.

   **Note:** If an index field contains an asterisk, you can select search criteria from a pre-defined list of values.
Figure 110. Query View Search Tab with Compound Query

![Figure 110. Query View Search Tab with Compound Query](image)

Note: If you want more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.

### Compound Query Examples

The following table shows how the compound search expression works.

**Table 36. Compound Search Expression Examples**

<table>
<thead>
<tr>
<th>Search Specification</th>
<th>Result</th>
</tr>
</thead>
</table>
| Mark and SSN 444-44-4444 | Could return any of the following combinations:  
|                        | • Document index records with "Mark and SSN 444-44-4444"  
| Neil and SSN 555-55-5555 | • Document index records with "Neil and SSN 555-55-5555"  
|                        | • Document index records with "Mark and SSN 444-44-4444" and document index records with "Neil and SSN 555-55-5555" |
| Mark and SSN 444-44-4444 | Could return any of the following combinations:  
| Neil and SSN 555-55-5555 | • Document index records with "Mark and SSN 444-44-4444"  
| Bill and SSN 666-66-6666 | • Document index records with "Neil and SSN 555-55-5555"  
|                        | • Document index records with "Bill and SSN 666-66-6666"  
|                        | • Document index records with "Mark and SSN 444-44-4444" and document index records with "Neil and SSN 555-55-5555" |
### Entering Full-Text Values as Search Criteria

If you have submitted documents to the AppXtender Index Server, you can search the full text of those documents using the bottom portion of the Search tab.

You can select one of the full-text search options for your query. The options include All Words, Any Words, Exact Phrase, or Expression. The following table details the function of each.

#### Table 37. Full-Text Search Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Words</td>
<td>Finds documents that contain ALL of the words you enter.</td>
</tr>
<tr>
<td>Any Words</td>
<td>Finds documents that contain ANY of the words you enter.</td>
</tr>
<tr>
<td>Exact Phrase</td>
<td>Finds documents that contain the exact phrase you enter.</td>
</tr>
<tr>
<td>Expression</td>
<td>Finds documents using a Search Expression.</td>
</tr>
</tbody>
</table>

**Note:** A full-text search retrieves only documents that have been submitted to the AppXtender Index Server. If none of your documents have been submitted, the full-text searching features are not available. For more information, refer to **Submitting Documents to a Full-text Queue, page 219.** If your documents have been submitted to the AppXtender Index Server and full-text searching is still not available, refer to **Troubleshooting, page 221.**

To enter full-text values as search criteria:

- In the full-text search text box at the bottom of the Query view Search tab, enter the text string for which you want to search.
  - To search for multiple words and use the All Words or Any Words options, enter the words with spaces between them (for example, AEX Simon).
  - To search for a phrase and use the Exact Phrase option, enter the words exactly as you want to find them, including spaces.
To search for an expression and use the Expression option, refer to Building Full-Text Search Expressions, page 257.

To search a specific language, type the search string in the following format:

\(<\text{LANG/language ID}>\text{search string}\)

where \text{language ID} is the two-letter code for the language and \text{search string} is the full-text-search value; for example, \(<\text{LANG/ZH}>\text{software}\).

\textbf{Note:} Only the K2 full-text engine supports full-text searches in languages other than English. The engine uses the default user language if the search string does not specify a language.

\textbf{Figure 111. Query View Search Tab with Full-Text Search Portion Indicated}

Keep in mind the following points:

- The AND and OR options in the Search tab can be used to combine a full-text search statement with an index value search statement. For more information on combination searches, refer to Combination (Index and Full-Text) Queries, page 258.

- If the application is configured to use the K2 full-text engine, a Thesaurus check box becomes available in the full-text search criteria area. The thesaurus feature allows you to search for words that are related to your search criteria. It contains a list of synonyms or keys for possible words to be used in a search. When the Thesaurus check box is enabled and a full-text search is performed, AppXtender also searches for words that are listed as synonyms or keys for that word in the thesaurus control file. The thesaurus control file (*.ctl) is installed when you install K2 servers. For more information on the thesaurus control file and its configuration, refer to the K2 Collection Reference Guide.

- When you index a document’s full text content using the AppXtender Index Server, a text view of the document is included with the document. The next time you retrieve the document, the text view of the document is available. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.
Building Full-Text Search Expressions

The Expression option allows you to find documents using a Search Expression. You build a Search Expression by combining the words or text strings that you want to search for with expression operators such as **and** and **or**. You can combine operators for a more complex search. AppXtender interprets the search expression from left to right.

The information in this topic applies only when the full-text engine is ProIndex. For information on building full-text search expressions when the full-text engine is K2, refer to the *K2 Query Language Quick Reference*, which is available on the AppXtender/Web Access setup CD.

The following table describes each of the expression operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>When you use the <strong>and</strong> operator between two words, AppXtender searches for documents that contain both words.</td>
</tr>
<tr>
<td>Or</td>
<td>When you use the <strong>or</strong> operator between two words, AppXtender searches for documents that contain at least one of the words.</td>
</tr>
<tr>
<td>And Not</td>
<td>When you use the <strong>and not</strong> operator between two words, AppXtender searches for documents that contain the first word, but not the second.</td>
</tr>
<tr>
<td>Near ()</td>
<td>When you use the <strong>near ()</strong> operator after two words, AppXtender searches for documents in which both words occur in any order, within a range that you specify between the parentheses.</td>
</tr>
<tr>
<td>Character wildcard</td>
<td>When you use a question mark (?) in a string of text, AppXtender searches for documents that contain that string of text, except that AppXtender allows any single character to take the place of the question mark. (If you are searching for multiple words, make sure that another operator is used between each word.)</td>
</tr>
<tr>
<td>String wildcard</td>
<td>When you use an asterisk (*) in a string of text, AppXtender searches for documents that contain that string of text, except that AppXtender allows any number of characters or even the lack of a character to take the place of the asterisk. (If you are searching for multiple words, make sure that another operator is used between each word.)</td>
</tr>
<tr>
<td>Parentheses</td>
<td>By default, AppXtender interprets a search expression from left to right, interpreting each search operator one at a time, and narrowing the results with each subsequent search. You can use parentheses to group search expressions to control the order in which AppXtender performs these searches. When you use parentheses in an expression, AppXtender searches first for documents that contain the expression in parentheses.</td>
</tr>
</tbody>
</table>

The following table provides an example for each of these operators.
### Table 39. Examples of Expression Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Example</th>
<th>AppXtender Finds Documents With</th>
<th>AppXtender Highlights All Occurrences of</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>AEX and Simon</td>
<td>Both AEX and Simon</td>
<td>AEX and Simon</td>
</tr>
<tr>
<td>Or</td>
<td>AEX or Simon</td>
<td>Either AEX or Simon</td>
<td>AEX and Simon</td>
</tr>
<tr>
<td>And Not</td>
<td>AEX and not Simon</td>
<td>AEX but not Simon</td>
<td>AEX</td>
</tr>
<tr>
<td>Near ()</td>
<td>AEX near (10) Simon</td>
<td>Both AEX and Simon, within a range of 10 words of each other</td>
<td>AEX and Simon</td>
</tr>
<tr>
<td>?</td>
<td>A?X</td>
<td>A string of 3 consecutive characters, in which the first must be A, the second may be any character, and the last must be X</td>
<td>Matching words</td>
</tr>
<tr>
<td>*</td>
<td>S*</td>
<td>Any string that begins with S</td>
<td>Matching words</td>
</tr>
<tr>
<td>()</td>
<td>AEX and (Simon or Schiff)</td>
<td>Either Simon or Schiff first, and of those documents, AppXtender finds ones that also have AEX</td>
<td>AEX, Simon, and Schiff</td>
</tr>
</tbody>
</table>

For more information, see:
- Entering Full-Text Values as Search Criteria, page 255

## Combination (Index and Full-Text) Queries

You can perform a query that searches for documents using both index data and full text. This combination query combines the searching power of an index value query and a full-text query.

**To insert index values and full-text values as search criteria:**

1. Enter values in the index portion of the Search tab, as if you were performing a query by index. For information, refer to Query by Index, page 246.
2. Enter text in the full-text text box and select options at the bottom of the Search tab, as if you were performing a full-text query. For information, refer to Entering Full-Text Values as Search Criteria, page 255.
3. You have the following choices:
   - If you want to query for documents that include both the index value and the full-text value, click the AND option button.
   - If you want to query for documents that include either the index value or the full-text value, click the OR option button.
For more information on displaying AppXtender documents and checking documents out of AppXtender after you run your search, refer to Displaying Documents from the Result Set, page 266.

For more information, see:
- Searching a Single Application, page 243

## Searching Multiple Applications

In AppXtender, regular queries are restricted to a single application. With the Cross Application Query feature, you can create and run queries that search multiple AppXtender applications for selected index and/or full-text information. For example, you could search three different applications for information on the Social Security number "111-22-3333" or you could search for all documents containing the text "software releases."

For more information on Cross Application Queries, refer to the following topics:
- Creating a New Cross Application Query, page 259
- Performing a Cross Application Query, page 263
- Modifying a Cross Application Query, page 266

**Note:** The Reports query, accessible from the application right-click menu, can be used to retrieve an entire AppXtender Reports Mgmt report, but you can only query one application at a time using that feature. For instructions, refer to Searching a Single Application, page 243. Cross application queries for documents generated through AppXtender Reports Mgmt, however, are supported.

## Creating a New Cross Application Query

You can configure your Cross Application Query with the New Cross Application Query feature. Using the New Cross Application Query Configuration tab, you set query parameters, including which applications you want to include in the query, and, within the applications, which fields you want to use. Further, you define the fields used as search fields for querying, and which fields display in the result set. When configuring queries, the index fields chosen should be common across the selected applications for maximum effectiveness.

For example, a query can be performed across multiple applications to search for specific employee information. This query could include two applications (for example, PAYROLL and HR) and the fields NAME and SSN. A query called EMP INFO could be created using the Configuration tab that defines these parameters. A search can then be performed to find specific employee data from these two applications using the Cross App Query feature.

When you create a new query, you must perform the following steps:
- Selecting the applications to be included in the Cross Application Query
- Selecting the application fields to be included in the Cross Application Query

The following procedure describes these steps in more detail.
To create a new Cross Application Query:

1. Right-click the name of the application you want to query in the Application view. From the shortcut menu that appears, select New Cross App Query. The New Cross Application Query Configuration tab appears.

Figure 112. New Cross Application Query Configuration Tab

2. Under Applications, select one of the applications that you want to include in the query. Click Add. The application you selected is added to the Query Applications list. Repeat this step for each additional application that you want to include.

Note: More than one item can be added at a time. To select more than one item in sequence, select the first item, then press and hold the [SHIFT] key while selecting the last item in the group. To select two or more items out of sequence, press and hold the [CTRL] key while selecting each item.

3. The applications you added should appear beneath Query Applications, along with associated index fields. If you want to delete an application from the query, select the application name from beneath Query Applications, and click Remove.
Figure 113. New Cross Application Query with Applications Added

4. Note the red icon next to each field name. This icon indicates the Cross Application Query status for each field. For an explanation of each icon, click Legend. The following table also provides an explanation of each icon.

Table 40. Cross Application Query Icon Legend

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Field will not be used in the query (this is the default setting for application fields in Cross Application Query).</td>
</tr>
<tr>
<td>?</td>
<td>Field is used as a search criterion.</td>
</tr>
<tr>
<td>✔</td>
<td>Field will display in query result set, but will not be used as a search criterion.</td>
</tr>
</tbody>
</table>

5. Configure the fields for the Cross Application Query. You have the following choices for each field:
   - To make a field searchable, click the icon until it becomes a question mark. At least one search criteria index field must be common to at least two of the included applications.

   Each application must share a searchable field with at least one other included application. For example, if you are searching three applications, the first and second applications could have the Name field in common and the second and third applications could have the Social Security Number field in common.
If a selected application does not have any fields in common with any of the other selected applications, you will receive an error, which states "Application X does not share any searchable fields with other applications" and will not be able to use the query.

- To allow a field to appear in Result Set view, click the icon until it becomes a check mark.
- To exclude a field from both the Search tab and the Result Set tab, click the icon until it becomes a red "forbidden" icon.

**Note:** Keep in mind that at least one searchable index field must be common to all included applications to use Cross Application Query. All search criteria index fields should be common to all included applications to ensure relevancy of returned documents.

![Caution: Most Cross Application Query search field formats should match exactly across applications. Exceptions include phone number and date fields. While formatting can differ between phone number fields, the number of digits must match. For example, a phone number field with the format (nnn)nnn-nnnn can be used with a phone number field using the nnn-nnn-nnnn format, but neither format could be used with an nnn-nnnn phone number format.](image)

**Note:** When using a date field as a Cross Application Query search field, it is not necessary that the date format match exactly. However, the date fields’ month, date, and year components must be in the same order. For example, if one application index field uses a dd-mmm-yy format and another application field uses the format dd-mm-yyyy, a successful Cross Application Query can be created, but a date field with the format yy-mm-dd cannot be used with a dd-mm-yy format.

**Figure 114. New Cross Application Query Configuration: Designating Query Fields**
Note: If an index field has been configured to display in the Result Set and is not common to all applications, it displays in the Result Set, but shows no information for documents whose applications do not contain the index field.

6. After fields have been configured, you have the following choices:
   • Click OK to save the query configuration for the current session and return to AppXtender.
   • Click Apply to apply changes and return to the Cross Application Query Configuration tab.
   • Click Cancel to close the Cross Application Query Configuration tab without saving the query.

Note: Clicking OK only saves the query for the current AppXtender user session. To save the query for future use, refer to Saving a Query, page 291.

If you click OK, you return to AppXtender. Your query appears on the Application View pane beneath each application that you have configured it to use. By default, it is entitled New Query [1], where [1] contains the number that corresponds to the query’s order of creation (in other words, if you have already created three regular or cross application queries during an AppXtender session, the query is titled New Query [4]).

Figure 115. Cross App Query: Application Display View

Note: In the Application View, the icon located to the left of a query signifies the type of query created. Regular queries use a question mark icon (❓). Cross application queries are preceded by the Cross App Query icon (❖).

For more information, see:
   • Searching Multiple Applications, page 259

Performing a Cross Application Query

As soon as a Cross Application Query has been created, you can perform a Cross Application Query. For more information about configuring cross application queries, refer to Creating a New Cross Application Query, page 259.
Pre-configured cross application queries appear on the Application View pane beneath each application they have been configured to search. The icon located to the left of the query signifies whether it is a regular query (question mark icon) or a Cross Application Query (Cross App Query icon).

Figure 116. Icons for Regular Query and Cross App Query

To run a Cross Application Query:

1. Select the Cross Application Query you want to run and right-click. From the shortcut menu that appears, select Edit Query. The Query View pane appears with the Search tab active. The fields that have been configured for searching appear within the Search tab.

Figure 117. Cross Application Query Search Tab

2. Under Values, type the values that you want to search for next to the appropriate fields. For example, next to the INVOICE # field, type the number of the invoice that you want to find. Repeat this step for each field that you want to search. Just as in a regular query, you can use expressions, wildcards, full-text, and combination queries.

For more information on entering criteria for more advanced searches, refer to the following topics:

• Entering Index Values as Search Criteria, page 245
• Entering Full-Text Values as Search Criteria, page 255
• Combination (Index and Full-Text) Queries, page 258

Note: To display all information for the applications chosen, leave the fields blank.

3. If the application is configured for Centera retention or AppXtender software retention, and you have the Retention User privilege, a Retention Options section displays on the Search tab of the Query view. For procedures on searching for documents under retention or retention hold using these options, refer to Appendix A, Working with Document Retention.

264
4. Click Search. Cross App Query runs the selected query and searches for documents that match the search criteria.

The Result Set tab appears in the Query View pane and displays the results of the search. The number of hits (a hit is a document that matches the search criteria) displays at the top of the Result Set tab, next to Result Set. Each hit is listed, by application, with the fields that were specified as searchable or displayable on the Cross Application Query Configuration tab. (For information about configuring fields to appear in the Cross Application Query Result Set, refer to Creating a New Cross Application Query, page 259.) For each item listed, the number of pages in the document is also listed.

**Figure 118. Cross Application Query Result Set Tab**

![Cross Application Query Result Set Tab](image)

As soon as you have retrieved the documents you need, you can open those documents or process them from the result set.

If you only retrieve one document, depending on the configuration of the AppXtender system, you may be prompted to check out the document. For more information on checking out AppXtender documents, refer to Selecting a Document Display Mode, page 271.

**Note:** The maximum number of results displayed in the Result Set query does not exceed the number of Maximum Query Results configured on the Display tab within Configuration multiplied by the number of applications included in the Cross Application Query. For example, a Cross Application Query that applies to three applications run in an AppXtender session that allows for 50 maximum query results returns the first 50 results from each application, and yields a maximum of 150 query results in the Result Set.

**Note:** AppXtender security affects Cross Application Queries on an application and document security level. For example, if you have been restricted from viewing an application that is included in a Cross Application Query, only those documents from visible applications appear in the Result Set. In addition, if you have been restricted from viewing documents using AppXtender’s Document Level Security, restricted documents are not retrieved during a Cross Application Query. If you have questions about your security privileges, consult your AppXtender system administrator or refer to the "Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
For more information, see:
- Searching Multiple Applications, page 259

**Modifying a Cross Application Query**

After a Cross Application Query has been created, you can modify it by accessing the Edit Cross Application Query Configuration tab to change its parameters, if necessary.

**To modify a Cross Application query:**

1. In the Application view, right-click the Cross Application Query that you want to modify.
2. From the shortcut menu that appears, select Configure. The Edit Cross Application Query dialog box appears.
3. Make the necessary changes to the query information. For detailed instructions, refer to Creating a New Cross Application Query, page 259.
4. When you have completed changes, you have the following choices:
   - Click OK to save the query for the current session and return to AppXtender.
   - Click Apply to apply changes and return to the Cross Application Query Configuration tab.
   - Click Cancel to close the Cross Application Query Configuration tab without saving your changes.

**Note:** If your query has not yet been named and saved, clicking OK only saves the query for the current AppXtender user session. To save the query for future use, refer to Saving a Query, page 291.

For more information, see:
- Searching Multiple Applications, page 259

**Displaying Documents from the Result Set**

As soon as a query is executed, the Result Set tab appears in the Query view. If only one document matches the specified search criteria, AppXtender automatically displays that document.

When multiple documents match the specified search criteria, or if you ran an AppXtender Reports Mgmt report query, the results are listed in the Result Set tab.

**Note:** In order to display a document or its properties in AppXtender, you must have the Display privilege enabled. For more information, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

You can adjust the way that results and columns appear in the Result Set tab. For more information, refer to Managing the Query View Result Set, page 99.

You can also save the result set as a text file. For more information, refer to Saving the Result Set as a Text File, page 396.

In addition to searching applications for and viewing documents, AppXtender contains a feature called Reports view that allows you to search applications and view AppXtender Reports Mgmt generated reports, open the document associated with the section of the report currently being
viewed, or view the report associated with the active document. This function is available to users who have the Report View privilege.

Retrieving AppXtender Reports Mgmt reports uses the same index querying functions as retrieving AppXtender documents, and like AppXtender documents, you can print, export, and delete pages, and delete reports as appropriate.

More information on the Report view function in AppXtender can be found in Displaying AppXtender Reports Mgmt Reports, page 278.

For more information, see:
• Chapter 5, Retrieving Documents
• Displaying AppXtender Documents, page 267
• Selecting a Document Display Mode, page 271
• Displaying AppXtender Reports Mgmt Reports, page 278
• Viewing Full-Text Search Results, page 282
• Viewing Documents from Unknown Data Sources, page 284
• Viewing Documents from a Volume, page 285

**Displaying AppXtender Documents**

You can display a document or AppXtender Reports Mgmt report directly from the Result Set tab in AppXtender, whether you retrieved it from a single application or multiple applications.

More information on viewing AppXtender Reports Mgmt reports and associated documents can be found in Displaying AppXtender Reports Mgmt Reports, page 278.

**Figure 119. Result Set Tab**

<table>
<thead>
<tr>
<th>ACCOUNT#</th>
<th>MEMBER NAME</th>
<th>SSN</th>
<th>DOC TYPE</th>
<th>DATE</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>925411</td>
<td>ISABLE SIMON</td>
<td>242-43-3617</td>
<td>STMT</td>
<td>01-FEB-97</td>
<td>1</td>
</tr>
<tr>
<td>925598</td>
<td>SIMON SHIF</td>
<td>249-15-4308</td>
<td>STMT</td>
<td>01-FEB-97</td>
<td>7</td>
</tr>
</tbody>
</table>

The page icons in the Result Set indicate a document’s status, as described in the following table.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>Blue page</td>
<td>This document is available. You can choose to open it in normal document display mode (if AppXtender is in normal mode) or you can choose whether to check it out or open it in read-only mode (if AppXtender is in check in/check out mode).</td>
</tr>
<tr>
<td>![Image]</td>
<td>Blue page with red check mark</td>
<td>This document is currently checked out. Unless you were the one who checked it out, you can only open it in read-only mode. If you checked it out, you can open it to edit it or you can open it in read-only mode.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Gray page</td>
<td>This document is a previous revision of a document. You can open it only in read-only mode.</td>
</tr>
<tr>
<td>![Image]</td>
<td>Blue page with clock on lower right corner</td>
<td>This document has been filed for either Centera retention, AppXtender software retention, or Records Manager retention. You cannot modify a document under retention; however, you can check out the document and create a new version of the document. For information on filing a document for retention, refer to Filing Documents for Retention, page 531. Before you can modify a document that is filed for Records Manager retention, you must check the document out. For information on filing a document for Records Manager retention, refer to Appendix B, Working with Records Manager for AppXtender</td>
</tr>
<tr>
<td>![Image]</td>
<td>Clock face and lock on page</td>
<td>Indicates a retention hold has been applied to the document.</td>
</tr>
</tbody>
</table>

If you want to find out who has a document checked out or would like to view document summary or index information for a document, you can access a document's properties from the result set. You can also open documents from the Result Set.

**To view document properties from the Result Set:**

2. When you are finished viewing the document properties, click OK to return to the Result Set tab.
Note: If your search retrieved a single document, AppXtender automatically displays that document. If you have been prompted to check out the document, refer to Selecting a Document Display Mode, page 271 for information on checking out a document on display.

To display a document from the Result Set:

- Double-click the document in the Result Set. The behavior of the document after you choose to display it (or AppXtender automatically displays it) depends on the following factors:
  - Whether the Reason Code option is enabled for the current application.
  - Whether the Prompt for checkout on open document option is enabled in AppXtender AppGen for the current application.
  - Whether the Prompt for check out on open option is enabled in the Data tab of the AppXtender Configuration dialog box for your AppXtender workstation.
  - Whether the document has been checked out (by you or another user).

If the Reason Code option is enabled for the current application, the Reason Code Required dialog box appears first. To allow printing, e-mailing, or export of the displayed document, enable the Print, Email, or Export check boxes, respectively. Any options you do not enable will not be available for the displayed document. In the text box, you must add a comment explaining the reason for opening the document. Once you enable the appropriate actions and enter a comment, click OK to continue opening the document.
Figure 121. Reason Code Required Dialog Box

The following table describes the behavior of the displayed document.

Table 42. Behavior of the Displayed Document

<table>
<thead>
<tr>
<th>If</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neither of the options for Prompt for check out is enabled and the document is not checked out.</td>
<td>The document opens and appears immediately in the Document Display view. If you would like to modify the document, you can make edits without checking the document out, or you can check out the document using a command from the Document menu. This prevents other users from being able to access the document until you check it back in – useful for edits that may take more than the current AppXtender session.</td>
</tr>
<tr>
<td>Either of the options for Prompt for check out is enabled, and the document is not checked out.</td>
<td>The Check Out dialog box appears. You can choose to check out the document or open it in read-only mode.</td>
</tr>
<tr>
<td>Either of the options for Prompt for check out is enabled, and you have already checked out the document.</td>
<td>The Open AppXtender Document dialog box appears. You can choose to open your checked out copy of the document or open a read-only copy of the document in the AppXtender repository (the version originally checked out prior to any revisions you made).</td>
</tr>
</tbody>
</table>
If | Then
---|---
The application Prompt for check out on open option is enabled. | The document opens in read-only mode and cannot be checked out.
The application Prompt for check out on open option is enabled. | The document opens in read-only mode and cannot be checked out.
*Another user* has checked the document out (regardless of the status of the Prompt for check out on open option). | The document opens automatically in read-only mode. You may not make edits to the document until the other user checks the document back in.

For details on the display modes for AppXtender documents, refer to the Selecting a Document Display Mode, page 271.

For more information, see:
- Displaying Documents from the Result Set, page 266

### Selecting a Document Display Mode

The steps that are necessary to display an AppXtender document depend on whether your workstation is configured to use AppXtender in its normal operational mode or whether it is configured to use check in/check out mode.

If your workstation is in normal AppXtender mode, you can display a document and make changes to it without checking it out, as long as it has not been checked out by another user. You can also choose to check out an open document, open a read-only copy of a document that is checked out by you or someone else, or open your checked out version of a document.

If your workstation is configured to use check in/check out mode, documents in AppXtender can be opened in read-only mode or checked out so that they can be modified.

For more information, see:
- Displaying Documents from the Result Set, page 266
- What is Check In/Check Out Mode?, page 272
- What is the Normal AppXtender Mode?, page 272
- What is the Normal Document Display Mode?, page 273
- What is the Read-only Document Display Mode?, page 273
- What is the Check Out Document Display Mode?, page 273
- Opening a Document in Normal Document Display Mode, page 274
- Opening a Document in Read-Only Mode, page 274
- Opening a Document in Check Out Mode, page 276
What is Check In/Check Out Mode?

Your AppXtender workstation is in check in/check out mode when the Prompt for check out when open option for your workstation is enabled. This option can be found on the Data tab of the AppXtender Configuration dialog box. An AppXtender application is in check in/check out mode when the Prompt for checkout when open documents option of the application configuration is enabled in AppXtender AppGen. Check in/check out mode is enabled for you if it is enabled for either your workstation or the current application.

When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. If you select to open a document that is not checked out by another user, you are prompted to choose whether to check the document out or view it in read-only mode. Documents in read-only mode cannot be modified. To modify a document, you must check it out.

**Note:** The final revision option on check-in is only available when the AppXtender application is in check in/check out mode.

The application may also be configured so that comments are required when you check in or check out documents.

For more information, see:
- Selecting a Document Display Mode, page 271
- Data Tab, page 134

What is the Normal AppXtender Mode?

Your AppXtender workstation is in normal mode when the Prompt for check out when open option for your workstation is not enabled. This option can be found on the Data tab of the AppXtender Configuration dialog box. An AppXtender application is in normal mode when the Prompt for checkout when open documents option of the application configuration is not enabled in AppXtender AppGen. Normal mode is enabled for you if it is enabled for both your workstation and the current application.

When AppXtender is in normal mode, use of revision control with AppXtender documents is optional. You can open and modify documents, and when you close them, the modifications are automatically saved to the AppXtender document repository.

You can check out documents while AppXtender is in normal mode, if you want to prevent other users from making modifications while you are working on a document. This is useful if modifications to a document may extend through more than the current AppXtender session. However, you are not required to check out a document to modify it.

When AppXtender is in normal mode, if you open a document that is checked out by someone else, it automatically opens as read-only and you cannot modify the document until it is checked back in. If you select to open a document that is checked out by you, you are prompted to choose whether to open your checked out copy of the document or a read-only copy of the document.

For more information, see:
- Selecting a Document Display Mode, page 271
- Data Tab, page 134
What is the Normal Document Display Mode?

The normal document display mode opens a document and allows you to make changes to it without checking the document out. The normal document display is only available when opening a document that is not checked out by anyone while AppXtender is in normal mode.

For more information, see:
• Selecting a Document Display Mode, page 271

What is the Read-only Document Display Mode?

The Read-only display mode opens a document that cannot be modified. Read-only mode for a document is indicated by a ‘(RO)’ notation in the title bar. A document can be opened in read-only mode in several circumstances.

In AppXtender normal mode, if you have already checked a document out and you attempt to open the document, you can select to open the document in read-only mode. If someone else has a document checked out and you attempt to open the document, the document automatically displays in read-only mode. In either case, opening the document in read-only mode opens the AppXtender repository copy of the document – in other words, the copy of the document that was originally checked out before any changes were made to it (by you or anyone else).

When AppXtender is in check in/check out mode, you can choose to open a document in read-only mode if it is not checked out, or if it is already checked out by you. If a document is checked out by someone else, you can only open it in read-only mode.

AppXtender displays the read-only document in the Document Display view and allows you to perform export functions on the document (as long as you have the user rights to perform those functions in AppXtender).

However, you cannot make permanent modifications to a document if you open the document in read-only mode. You cannot add new pages or page versions to the document, add annotations or redactions, modify the document index, or use the Enhance Image feature for document pages. You can launch foreign files or edit inserted objects and make changes, but the changes are not saved.

If you open a document in read-only mode and decide that you want to make changes, as long as the document has not been checked out by another user, you can check it out using the Check Out command from the Document menu.

For more information, see:
• Selecting a Document Display Mode, page 271

What is the Check Out Document Display Mode?

Documents can be checked out so that other users cannot access the document. When you check out a document, AppXtender saves a copy of the document to a temporary storage location. That copy becomes your working copy of the document. The original document remains in the AppXtender repository and is the version that users will receive if they open the document in read-only mode.
When you make changes to the checked out document, the changes are made to the working copy. When you are done making changes, you can check in the new revision of the document and AppXtender saves the document revision (keeping the older revision if you choose to do so).

If you decide that you would rather not check in the modified document, you can cancel the check out. When you cancel the check out, AppXtender deletes the working copy that it stored temporarily and treats the AppXtender repository copy (original version) of the document as the most recent revision.

For more information, see:
- Selecting a Document Display Mode, page 271

---

**Opening a Document in Normal Document Display Mode**

You can only open a document in normal document display mode if your AppXtender workstation is configured to use the normal AppXtender mode of operation and the document you select to open is not checked out by another user.

If the document appears in the Document Display view without any additional messages or dialog boxes, and you can make changes to it without checking it out, you have opened the document in normal document display mode.

You can make changes to the document and close it to save the changes, or you can check out the document to lock the document so that only you have access to it, then work on it and check it back in.

**Note:** Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

For more information, see:
- Selecting a Document Display Mode, page 271

---

**Opening a Document in Read-Only Mode**

You can open a document in read-only mode to view the document without modifying it.

You have several choices (depending on the behavior of AppXtender when you attempt to display a document):
- If the Check Out dialog box appears, the document has not been checked out by anyone and AppXtender is in check in/check out mode. Select Open as Read-Only and click OK to open the document in read-only mode.
Figure 122. Check Out Dialog Box (Check in/Check out Mode)

The document opens in read-only mode and cannot be modified unless you check it out manually by selecting Check Out from the Document menu.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

- If the application has Prompt for checkout on open enabled and the document has been finalized, the document opens automatically in read-only mode and cannot be checked out.

- If the document appears in the Document Display view without any messages or dialog boxes, but document modification commands (such as annotations or add page options) are grayed out, you have opened the document in read-only mode.

Read-only mode is indicated by (RO) in the title bar. Documents checked out by another user automatically open in read-only mode, regardless of whether your workstation is configured for normal or check in/check out mode.

You may notice that the Check Out option in the Document menu is active. However, if you try to check out a read-only document that is checked out by someone else, the following message appears saying that the document will be opened in read-only mode.

You cannot check out the document or modify it until the person who has it checked out checks it back in.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

- If the Open AppXtender Document dialog box appears, it means you already have the document checked out. In this case, the Open AppXtender Document dialog box appears regardless of whether your workstation is in normal or check in/check out mode. Despite the fact that you have the document checked out, you can still open the document in read-only mode rather than checking it out. Click Read Only to open the document in read-only mode.

If you open the document in read-only mode, AppXtender keeps the document checked out by you, but opens a read-only copy of the document that was originally checked out by you – before any changes were made. If you then choose to manually check the document out again, the document copy that you have checked out, with changes made since the original check out, opens in place of the read-only copy.
For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

**Note:** Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Selecting a Document Display Mode, page 271

## Opening a Document in Check Out Mode

As long as a document is not checked out by another user (and as long as you have the appropriate user privileges), you can check it out to work on it. (Checking out a document requires the Display, Delete Doc, Delete Page, and Add Page privileges.) You can then make changes to the document.

After you check out a document, you must eventually check it back in if you want your changes to be saved to the AppXtender document repository. Until you check the document in, any other user retrieving the document retrieves a read-only copy of the document, and the version they receive is the version you checked out before you made changes.

In addition, other users cannot check the document out or make modifications until you check it back in. In order to release the document for check out or modification by other users, you must either check the document in or cancel the check out.

**Note:** Your system administrator has the ability to cancel the check out of a document from ApplicationXtender Application Generator (AppXtender Admin) and may cancel check out if a document remains checked out when other users need that document. For information on checking in documents or canceling a document check-out, refer to Working with Checked Out AppXtender Documents, page 431. For instructions on canceling the check out of a document from AppXtender AppGen, refer to the “Managing Applications” section of the ApplicationXtender Core Components Administrator’s Guide.

You have several choices for document check out (depending on the behavior of AppXtender when you attempt to display a document):
- If the document appears in the Document Display view without any additional messages or dialog boxes, and the document modification commands (such as annotations and add page options) are active, you have opened the document in normal document display mode.

  From the Document menu, select Check Out to check out the document. The Check Out dialog box appears. You can add a comment regarding the reason for check out or other information. (This comment appears in the AppXtender Document Properties dialog box for the document until the document is checked in or the check in is canceled. For instructions on viewing this dialog box, refer to AppXtender Document Properties, page 394.) Click OK to check out the document.
Figure 123. Check Out Dialog Box (Normal Document Display Mode)

Note: Comments can have up to 250 characters.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

• If the Check Out dialog box appears, the document has not been checked out by anyone and your workstation is configured for check in/check out mode. Select the Check Out option. You can add a comment regarding the reason for check out. (This comment appears in the AppXtender Document Properties dialog box for the document until the document is checked in or the check in is canceled. For instructions on viewing this dialog box, refer to AppXtender Document Properties, page 394.) Click OK to check the document out.

Figure 124. Check Out Dialog Box (Check in/Check out Mode)

Note: Comments can have up to 250 characters.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

• If the Open AppXtender Document dialog box appears, you already have the document checked out. The Open AppXtender Document dialog box appears regardless of whether your workstation is configured for normal or check in/check out mode. Click OK to re-open the document.

Note: When you re-open a checked out document, AppXtender opens the currently checked out copy of the document, complete with any changes you have made since you checked it out. Remember that the changes are not saved to AppXtender until you check the document back in.

For more information on document display, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.
Note: Two options determine whether AppXtender is in normal document display mode or check in/check out mode. One determines the mode for the workstation and the other determines the mode for the application. Check in/check out mode is enabled for you if it is enabled for your workstation or for the current application. For details, consult your AppXtender system administrator or refer to the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Selecting a Document Display Mode, page 271

Displaying AppXtender Reports Mgmt Reports

AppXtender Reports Mgmt reports consist of multiple documents and multiple pages and may exist in either Adobe PDF or ASCII (text) format. Because AppXtender Reports Mgmt reports are generated for existing AppXtender applications that may already contain multiple documents, AppXtender allows you to search an application specifically for AppXtender Reports Mgmt reports. In addition, AppXtender allows you to view associated AppXtender Reports Mgmt reports for a displayed document, or conversely, the associated AppXtender document for the displayed page of the AppXtender Reports Mgmt report.

For more information, refer to the following topics:
- Requirements for Displaying AppXtender Reports Mgmt Reports, page 278
- Searching for an AppXtender Reports Mgmt Report, page 279
- Displaying the AppXtender Reports Mgmt Report for the Current Document, page 282

Requirements for Displaying AppXtender Reports Mgmt Reports

The following requirements must be met for you to query an AppXtender application for an AppXtender Reports Mgmt report or to view an AppXtender Reports Mgmt report associated with a displayed document.

- The AppXtender Reports Mgmt report type that was used to generate the AppXtender documents must have been configured to enable report view in AppXtender.
- You must have logged into AppXtender with the CX/AppXtender Reports Mgmt option.
- You must have the Report View privilege (as set by the system administrator in ApplicationXtender Application Generator (AppXtender AppGen)).

If you do not have the Report View privilege, the menu options discussed here for accessing the AppXtender Reports Mgmt reports are not available to you.

In addition, if you want to make modifications to the AppXtender Reports Mgmt report, you must have the proper document operation privileges. For example, you must have Print privilege to print and export a report and Delete Doc and Delete Page privileges to delete a report or report pages respectively.
Note: For more information on generating AppXtender Reports Mgmt reports and processing the reports so that they can be viewed in AppXtender, consult your AppXtender system administrator or refer to your ApplicationXtender Reports Management Administrator's Guide.

For more information, see:
- Displaying AppXtender Reports Mgmt Reports, page 278

## Searching for an AppXtender Reports Mgmt Report

The following procedure describes how to search for an AppXtender Reports Mgmt report.

**To query an application for an AppXtender Reports Mgmt report:**

1. Right-click the application you want to query. A shortcut menu appears.

   **Figure 125. AppXtender Application Shortcut Menu**

2. Select the Reports option from the shortcut menu. The Query view Search tab appears.

   **Figure 126. Query View: Query Reports Search Tab**
3. Enter the search criteria for the AppXtender Reports Mgmt report you want to find. For information on running queries in AppXtender, refer to Searching a Single Application, page 243.

4. Click Search. If any reports are found matching your search criteria, the Result Set tab appears, listing those reports. If no reports are found, a No documents found message appears.

From the Result Set tab, you may choose to open or delete the listed reports.

Displaying AppXtender Reports Mgmt reports from the Result Set functions identically to displaying other AppXtender documents from the Result Set. For instructions, refer to Displaying Documents from the Result Set, page 266.

For more information, see:
- Displaying AppXtender Reports Mgmt Reports, page 278

### AppXtender Reports Mgmt Report Function Commands

When the report is open, notice that the Document and Page menu options have completely changed to reflect available AppXtender functionality for the open report. The functionality of those commands are outlined in the following table.

**Table 43. AppXtender Reports Mgmt Report Function Commands**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>New</td>
<td>Adds a new document to the application. Methods available for adding a document are the same as for any AppXtender document. For more information on the available input methods, refer to Chapter 3, Creating Documents.</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Deletes the entire report from the application.</td>
</tr>
<tr>
<td>Page</td>
<td>Next Page</td>
<td>Displays the next page of the report.</td>
</tr>
<tr>
<td></td>
<td>Previous Page</td>
<td>Displays the previous page of the report.</td>
</tr>
</tbody>
</table>
Menu | Command | Function
--- | --- | ---
Goto Page | Allows you to navigate to a specific page of the report. |
Print | Allows you to print the currently displayed page or the entire report. |
Export | Allows you to export the report using the formatting set in the Export tab of your AppXtender Configuration. |
Goto Document | Opens the AppXtender document associated with the currently displayed page of the report. |

Notice that the main difference in menu commands when an AppXtender Reports Mgmt report is displayed is that the navigation between pages has moved from the Document menu to the Page menu.

For more information on document display and navigation, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.

In addition to the standard navigation commands, when the report is open, the Page menu includes a Goto Document command. Since AppXtender Reports Mgmt reports consist of multiple documents, you may wish to view a specific document separately from the report. This can be done using the Goto Document command that is available when an AppXtender Reports Mgmt report is displayed.

For more information, see:
- Displaying AppXtender Reports Mgmt Reports, page 278

**Displaying the Document for Current AppXtender Reports Mgmt Report Page**

The following procedure describes how to display the AppXtender document associated with the currently displayed AppXtender Reports Mgmt report page.

**To view the document for the current AppXtender Reports Mgmt report page:**

1. Query for and display the appropriate AppXtender Reports Mgmt report.
2. Navigate to a report page that coincides with a page in the AppXtender document you want to view.
3. Select the Goto Document option from the Page menu.

The associated document appears in the Document Display view.

As soon as the document is displayed, the menu commands appear as they usually do whenever a similar AppXtender document is open.

For more information on document display and navigation, refer to Chapter 6, Viewing Documents. For more information on processing options for documents, refer to Chapter 7, Managing Documents.
For more information, see:

- Displaying AppXtender Reports Mgmt Reports, page 278

**Displaying the AppXtender Reports Mgmt Report for the Current Document**

In addition to the standard AppXtender document commands, whenever a document that is part of an AppXtender Reports Mgmt report is open, AppXtender allows you to open the associated report without having to query the application for the report.

If you open a document that has an associated AppXtender Reports Mgmt report, and you have the Report View privilege, the Document menu has a Show Report option active. Selecting this option opens the AppXtender Reports Mgmt report associated with the open document.

**To open an AppXtender Reports Mgmt report for an associated AppXtender document:**

1. Query for and display the appropriate AppXtender document.
2. Select the Show Report option from the Document menu.
3. The associated report appears in the Document Display view.

For information on available report functions and navigation, refer to AppXtender Reports Mgmt Report Function Commands, page 280.

For more information on document display and navigation, refer to Chapter 6, Viewing Documents.

For more information on processing options for documents, refer to Chapter 7, Managing Documents.

For more information, see:

- Displaying AppXtender Reports Mgmt Reports, page 278

**Viewing Full-Text Search Results**

If you performed a full-text search, the Result Set includes a Hits column.

**Figure 127. Query View Result Set with Full-Text Hits**

<table>
<thead>
<tr>
<th>MEMBER NUMBER</th>
<th>CHECK NUMBER</th>
<th>Pages</th>
<th>Hits</th>
</tr>
</thead>
<tbody>
<tr>
<td>925221</td>
<td>114</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>925221</td>
<td>115</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>925247</td>
<td>160</td>
<td>2</td>
<td>5</td>
</tr>
</tbody>
</table>
The following table compares the results of full-text searching, depending on which full-text engine (ProIndex or K2) the application is configured to use.

**Table 44. Results of Full-Text Searching**

<table>
<thead>
<tr>
<th></th>
<th>ProIndex</th>
<th>K2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hits Column</td>
<td>Displays the number of &quot;hits&quot; for each document. A hit is an occurrence of the word or words you specified in the full-text search.</td>
<td>Displays the word &quot;Found&quot; instead of the number of hits.</td>
</tr>
<tr>
<td>Highlighting</td>
<td>The string of text that you searched for is highlighted everywhere that it occurs in the document. No other text is highlighted.</td>
<td>The string of text that you searched for is highlighted everywhere that it occurs in the document. In addition, text that matches individual words in your search string are also highlighted.</td>
</tr>
</tbody>
</table>

If you retrieved a document using full-text index values, as soon as you display a document (and check it out if necessary), the Full Text Search Results dialog box appears. When the dialog box appears, the text of the document also appears in the Document Display view and the first occurrence of the text you searched for is highlighted.

**Figure 128. Full-Text Search Results Dialog Box**
To view the full-text search results:
• If the application is configured to use a ProIndex full-text engine, you have the following choices:
  — To find the previous occurrence of the text, click Previous.
  — To find the next occurrence, click Next.
  — To show all occurrences, click Show All Hits on this Page.
• If the application is configured to use a K2 full-text engine, you have the following choices:
  — To show all occurrences of the text on the previous page, click Previous.
  — To show all occurrences of the text on the next page, click Next.

For more information, see:
• Displaying Documents from the Result Set, page 266

### Viewing Documents from Unknown Data Sources

If you attempt to open an AppXtender document from an external source (for example, an
AppXtender document that has been saved on your computer desktop, or a document/document
reference that has been e-mailed to you), and the data source it resides on is not recognized (which
can happen if a data source is named differently on different computers), the Pick a Data Source
dialog box may appear. This dialog box will appear if you have enabled the Allow map of unknown
data sources to existing data sources check box on the Configuration View tab. If the Allow map
of unknown data sources to existing data sources check box is not enabled, you receive an error
message that states that the data source is not found.

To choose a data source from the Pick a Data Source dialog box:
• When the Pick a Data Source dialog box appears after opening an AppXtender document from an
  unknown data source, select the correct data source from the Data Source Name list and click OK.
Figure 129. Pick a Data Source Dialog Box

The specified data source can not be found. It may not be named correctly on your workstation. You can pick one data source from the list below that you think represents the data source specified and click OK to continue.

<table>
<thead>
<tr>
<th>Data Source Name</th>
<th>DSN Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demo</td>
<td>System</td>
<td>&lt;No Description&gt;</td>
</tr>
<tr>
<td>Oracle</td>
<td>System</td>
<td>&lt;No Description&gt;</td>
</tr>
<tr>
<td>SQLServer2000</td>
<td>System</td>
<td>&lt;No Description&gt;</td>
</tr>
<tr>
<td>SQLServer7</td>
<td>System</td>
<td>&lt;No Description&gt;</td>
</tr>
</tbody>
</table>

Note: If the correct data source does not appear within the Pick a Data Source dialog box, the AppXtender system administrator should add it using AppXtender Admin. For more information about adding a data source, consult your AppXtender system administrator or refer to the "AppXtender Data Sources" section of the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Displaying Documents from the Result Set, page 266

Viewing Documents from a Volume

If you attempt to open an AppXtender document which has been stored to a volume label search drive, the Volume Label Search Drives dialog box appears.
To display the document:

1. Select the drive in which the document is stored.
2. Click OK. The document is displayed.

For more information, see:
- Displaying Documents from the Result Set, page 266

Document Text Searches

AppXtender allows you to search for strings of text in text and PDF documents. Document text searches do not rely on the AppXtender Index Server (AppXtender Index Server), so they can be executed on documents that have not been indexed for full-text retrieval.

Note: The AppXtender Index Server provides far more efficient full-text search capabilities than the document text search feature.

Document text searches can be performed on the displayed document, or on multiple documents at once from the Result Set tab. For more information, refer to the following topics:
- Text Search from the Document Display View, page 287
- Text Search from the Result Set, page 288
- Special Search Characters, page 289
Text Search from the Document Display View

You can perform text searches from the Document Display view. This feature is useful if you know which document has the text you need to find because it saves you the trouble of reading through the entire document to find the text.

To find text within a displayed document or page:

1. Display a text document or page. From the Edit menu, select Text Search. The Search dialog box appears.

   **Figure 131. Find Text Search Dialog Box**

   ![Search Dialog Box](image)

2. Enter the text you are searching for in the Find Text box.

3. If you want to find any combination of upper or lowercase text that matches the criteria, select Ignore Case.

4. If you want AppXtender to use fuzzy logic when searching for a match, select Fuzzy. When the Fuzzy check box is selected, AppXtender also finds matches that are not perfect, not just letter-for-letter matches. For example, when searching for "safe" with Fuzzy selected, AppXtender also finds "sale", "café", and "same" because the last or first two letters in each word match the reference. It does not find "case" or "fame" because the spelling of these words differs too much from the search term.

5. Under Scope, indicate whether you want to search the displayed page or all pages in the document.
   - To search the displayed page, select Page.
   - To search all pages, select Doc.

6. Under Direction, indicate which way you want AppXtender to search on the page.
   - To find the next occurrence, select Next.
   - To find the previous occurrence, select Previous.
7. Under Origin, indicate where on the page you want AppXtender to start searching.
   • To search from the previous search match, select Last Match.
   • To start at the top of the page, select Top.

8. Click OK. AppXtender processes the search.
   • If AppXtender finds any text that matches the criteria, AppXtender highlights the first text
     match located.
   • If no match is found for the criteria, a No Match Found message appears.

9. If a match was found and you want to locate another match in the selected direction, from the
    Edit menu, select Text Search Again.

For more information, see:
• Document Text Searches, page 286
• Special Search Characters, page 289

**Text Search from the Result Set**

You can perform document text searches directly from the Result Set tab. Using the Result Set, you
 can perform text searches without displaying documents, and perform searches across multiple
documents.

**To find text within documents in the Result Set:**

1. Select the documents you want to search from the Result Set.

2. Right-click the Result Set. From the shortcut menu that appears, select Text Search. The Result
   Set Text Search dialog box appears.

   ![Figure 132. Result Set Text Search Dialog Box](image)

3. Enter the text string you want to find in the Search String text box. Use the drop-down list
to select one of your previous text searches.

4. If you want AppXtender to use fuzzy logic when searching for a match, select Fuzzy search.
   When the Fuzzy search check box is selected, AppXtender also finds matches that are not perfect,
   not only letter-for-letter matches. For example, when searching for "safe" with Fuzzy search
   selected, AppXtender also finds "sale", "café", and "same" because the first two or last two letters
   in each word match the reference. It does not find "case" or "fame" because the spelling of these
   words differs too much from the search term.
5. If you want to find any combination of upper or lowercase text that matches the criteria, select Ignore case.

6. Click OK. A new Text Search tab appears in the Query view, displaying the results.

**Figure 133. Text Search Result Tab**

![Text Search Result Tab](image)

The Text Search tab contains a line report with all located matches. The entire line containing the matched text string is shown on the report, with the text string appearing as a hyperlink in blue text with an underline. To view the document page containing the text string, click the text string. AppXtender displays that document page with the text match highlighted.

If you open a new document from the Text Search tab, depending on the configuration of the AppXtender system, you may be prompted to check out the document. For more information on checking out AppXtender documents, refer to Selecting a Document Display Mode, page 271.

After a successful text search, the Result Set tab contains only the documents that you had selected, and of those, only the ones that matched your search criteria.

For more information, see:

- Document Text Searches, page 286
- Special Search Characters, page 289

**Special Search Characters**

You can use special characters as search operators when performing text searches. Unlike the asterisk, which can be used to locate strings of characters, these operators all find only a single character. For example, the search string "wildcar!" would locate the word "wildcard" but not the word "wildcards" because the exclamation point represents only one character.

**Note:** AppXtender displays the search string once on the Text Search Result Set even if it contains multiple hits. Each hit is highlighted on the line. All results in the Text Search Result Set are displayed as "Courier New" in **bold**, *italics*, and _underlined_. When a line with multiple hits is double-clicked from the Text Search Result Set, all of the hits on that line are highlighted on the page.

The following table describes the special search characters.

---

289
Table 45. Wildcard Character Results

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Finds</th>
</tr>
</thead>
<tbody>
<tr>
<td>@</td>
<td>Any single alphabetic character. For example, the search string &quot;Wa@hington&quot; would find the word &quot;Washington.&quot;</td>
</tr>
<tr>
<td>#</td>
<td>Any single numeric character. For example, the search string &quot;30#&quot; would find the number &quot;301.&quot;</td>
</tr>
<tr>
<td>!</td>
<td>Any single non-space character. For example, &quot;batc!&quot; would find &quot;batch&quot;</td>
</tr>
<tr>
<td>?</td>
<td>Any single character including the search wildcard characters. For example, the search string &quot;neil?mycompany.com&quot; would find &quot;<a href="mailto:neil@mycompany.com">neil@mycompany.com</a>&quot;</td>
</tr>
</tbody>
</table>

Note: These special search characters can only be used for text search.

For more information, see:
- Document Text Searches, page 286
- Text Search from the Document Display View, page 287
- Text Search from the Result Set, page 288

Managing Queries

Common AppXtender queries that you may perform frequently can be saved. This allows you to execute the query in a few short steps. Saved queries can be made public, so that all users can run them; or kept private, so that they only appear on your AppXtender desktop. For information on query management functions, refer to the following topics:
- Saving a Query, page 291
- Running a Query, page 291
- Editing a Query, page 292
- Making a Query Public or Private, page 292
- Renaming a Saved Query, page 293
- Embedding an AppXtender Query in Another Application, page 293
- Deleting a Query, page 294

Your AppXtender system administrator may have decided to give you access to preconfigured groups of documents through the use of saved queries.
Saving a Query

You can save any query that you have created, whether the query is a standard AppXtender query or a Cross Application Query.

To save a query:
1. You have the following choices:
   - Click Save in the Search tab.
   - If you have already run the query, right-click the name of the query in the Applications view. From the shortcut menu that appears, select Save As.

   The Save Query dialog box appears.

   **Figure 134. Save Query Dialog Box**

   ![Save Query Dialog Box](image)

2. Enter a name in the Query Name text box.
3. You have the following choices:
   - If you want the query to be public, click the Available to all users check box to enable it.
   - If you want the query to be private, click the Available to all users check box to disable it.
4. Click OK.

   For more information, see:
   - Managing Queries, page 290

Running a Query

You can run an existing query from the Application view at any time.
To execute a saved query:
- Right-click the Query Name in the Application view. From the shortcut menu that appears, select Run Query.

For more information, see:
- Managing Queries, page 290

**Editing a Query**

If you have saved queries, or if you have existing queries that you created earlier in your current AppXtender session, you can edit the contents of the query.

**Note:** If you would like to make changes to the application selection and index field selection for a Cross Application Query, you can do so. For more information, refer to Modifying a Cross Application Query, page 266.

**To edit a saved query:**
1. Right-click the Query Name in the Application view. From the shortcut menu that appears, select Edit Query.
2. The Query view Search tab appears with the contents of the query.
3. Make the appropriate changes and click Save.

For more information, see:
- Managing Queries, page 290

**Making a Query Public or Private**

You can share any saved query with all users or restrict its usage to your sessions only. The padlock icon located next to the query name indicates whether it is public or private.

In the following figure, the locked padlock next to "My Cross App Query" indicates that the query is for private use. The unlocked padlock next to "Everyone's Cross App Query" indicates that all AppXtender users have access to the query, if they have been granted access to at least one of the applications in the Cross Application Query.

**Figure 135. Public and Private Queries**

![COLDAPP - DEMO COLD APPLICATION](image)
- My Cross App Query
- Everyone's Cross App Query

**Note:** If you do not have access to all applications within a Cross Application Query, the results from the restricted applications do not appear in the Result Set. If you have questions about your security privileges, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.
To change a private query to a public query:

- Right-click the Query Name in the Application view. From the shortcut menu that appears, select Make Public.

**Note:** If Make Public is disabled, the saved query is currently public.

To change a public query to a private query:

- Right-click the Query Name in the Application view. From the shortcut menu that appears, select Make Private.

**Note:** If Make Private is disabled, the saved query is currently private.

For more information, see:

- Managing Queries, page 290

## Renaming a Saved Query

You can rename a saved query.

**To rename a saved query:**

1. Make sure that the appropriate application is active.
2. Expand the application node. Click the plus sign to the left of the application name. The application node expands and a list of all saved or unsaved queries for that application appears.

   **Figure 136. Expanded Application Node**

   ![Expanded Application Node](image)

3. From the list of queries, double-click a query.
4. Type a new name for the query and press [ENTER].

For more information, see:

- Managing Queries, page 290

## Embedding an AppXtender Query in Another Application

You can embed an AppXtender query in any application that supports OLE.
To embed an AppXtender query:

1. In the application that supports OLE, run the command to insert an object and, when prompted to select an object type, select AppXtender QueryFile. For detailed instructions, refer to the documentation provided with the application.

2. If the AppXtender Login dialog box appears, enter a valid user name and password and click Login.
   The New AppXtender Query Object dialog box appears.

3. You have the following choices:
   • If you want to embed a query that searches for documents in only one application, select Normal Query.
   • If you want to embed a query that searches for documents in multiple applications, select Cross App Query.

4. Click OK.

5. Configure the query. For instructions, see Searching a Single Application, page 243 or Searching Multiple Applications, page 259.

6. Save the query. For instructions, see Saving a Query, page 291. The query is embedded.
   For more information, see:
   • Managing Queries, page 290

Deleting a Query

If necessary, you can delete saved queries.

To delete a saved query:
   • Right-click the Query Name in the Application view. From the shortcut menu that appears, select Delete Query.

For more information, see:
   • Managing Queries, page 290
Chapter 6

Viewing Documents

This section topic explains all document view functions including display of subsequent pages in a multiple-page document, version viewing, rotation, scaling, zoom (both in and out), and sticky view.

Note: For instructions on viewing documents listed in the Result Set, refer to Displaying Documents from the Result Set, page 266.

• Introduction to Viewing Documents, page 295
• Selecting Pages to View within a Document, page 295
• Viewing Multiple Documents and Pages, page 302
• Page View Functions Available for Multiple Page Types, page 304
• Viewing Specific Page Types, page 317
• Document View Properties, page 329
• Page Information, page 336

Introduction to Viewing Documents

An effective mechanism for storage and retrieval of data is one of the most important features of a useful document imaging system. As soon as a document is retrieved from storage, however, the focus shifts from your ability to access data to your ability to manipulate data. The flexibility to display a retrieved document in a way that highlights the important data in the document aids in efficient data processing.

AppXtender offers a wide variety of display options. For example, you can easily switch from page to page, alter the display of a page's size and position, focus on one part of a page, or return to a desired page display format by default.

Selecting Pages to View within a Document

When you view an AppXtender document with multiple pages or page versions, you can use AppXtender page navigation commands to move from page to page and to view different parts of a page. You can use toolbar buttons, menu commands, keystroke combinations or hot keys, and thumbnails in the Thumbnail view to display specific pages in a document. You can use keystroke
combinations or hot keys, toolbar buttons, and menu commands to switch between different versions of a displayed page.

For more information, see:
- Chapter 6, Viewing Documents
- Next, Previous, and Go To Page, page 296
- Viewing Thumbnails, page 297
- Viewing Versions of a Page, page 300
- Viewing Subpages, page 301

### Next, Previous, and Go To Page

When you display a document, AppXtender always displays the first page in the Document Display view. If the document has more than one page, the Next Page, Previous Page, and Go To Page functions can be used to move from page to page. You may choose from several different methods of accessing subsequent pages or page versions: the Document menu, the keyboard, or the Image toolbar.

As you navigate from one page to another, or from one version to another, the title bar and status bar indicate the page and version number of the currently displayed page.

**Note:** If you are using Split View, the behavior of the Next Page and Previous Page commands depends on the current configuration of the PgUp/PgDn in Dual-Page View option in the Configuration dialog box. For information on this option, refer to PgUp/PgDn in Dual-Page View, page 110. For information on Split View, refer to Split View, page 303.

For more information, see:
- Selecting Pages to View within a Document, page 295
- Next Page, page 296
- Previous Page, page 297
- Go To Page, page 297

### Next Page

To move forward one page:
- While any page of the document is displayed, from the Document menu, select Next Page.

**Note:** If the last page of the document is currently displayed, the Next Page menu command displays the first page of the document.
For more information, see:
• Next, Previous, and Go To Page, page 296

**Previous Page**

To move back one page:
• While any page of the document is displayed, from the Document menu, select Previous Page.

**Note:** If the first page of the document is currently displayed, the Previous Page menu command displays the last page of the document.

For more information, see:
• Next, Previous, and Go To Page, page 296

**Go To Page**

If there is more than one page in the document, you can use the Go To Page dialog box to display a particular page.

**To display a specific page within a multiple-page document:**

1. From the Document menu, select Go To Page. The Go To dialog box appears.

   **Figure 137. Go To Dialog Box**

   ![Go To Dialog Box](image)

2. In the Page text box, enter the page number of the page that you want to display. You can either type the number or use the arrow buttons to specify a page number.

3. Click OK. The page appears.

For more information, see:
• Next, Previous, and Go To Page, page 296

**Viewing Thumbnails**

Thumbnails are a series of miniature images or icons, representing the pages of the currently displayed document. You can use thumbnails to view many pages of a single document simultaneously. For more information on what you can do with thumbnails, refer to the following topics:

• Displaying the Thumbnail View, page 298
• Displaying Thumbnails, page 298
Displaying the Thumbnail View

To show or hide the Thumbnail view:
• From the View menu, select Thumbnail.

Note: Depending on the configuration of your AppXtender workstation, thumbnails do not always appear when the Thumbnail view appears. For information on displaying thumbnails in the Thumbnail view, refer to Displaying Thumbnails, page 298.

For more information, see:
• Viewing Thumbnails, page 297

Displaying Thumbnails

You can display thumbnails in a variety of ways.

For more information, see:
• Viewing Thumbnails, page 297
• Displaying Thumbnails for a Displayed Document, page 298
• Displaying only Thumbnails, page 299

Displaying Thumbnails for a Displayed Document

When you already have a document displayed in the Document Display view, you can choose to view thumbnails for the document.

To display thumbnails for the displayed document:
1. Display the document for which you want to view thumbnails. (For instructions on displaying a document, refer to Chapter 5, Retrieving Documents.)
2. From the Document menu, select Thumbnails. (If the Thumbnails option is not available, display the Thumbnail view. For instructions, refer to Displaying the Thumbnail View, page 298.) Thumbnails for the displayed document appear.

Note: Your workstation may be configured to automatically display the Thumbnail view when you open a document. The Always display the thumbnail of the active document option on the Thumbnail tab of the Configuration dialog box allows this configuration. For more information, see Thumbnail.
Displaying only Thumbnails

You can also choose to only display thumbnails when you select a document from the result set. You can then click one of the thumbnails to display a particular page.

Note: Your AppXtender workstation may be configured to automatically display only thumbnails when you double-click a record in the result set. The Display thumbnail of the document when double-click on a query result option on the Thumbnail tab of the Configuration dialog box allows this configuration. For information, see Thumbnail Tab, page 147 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

If your workstation is not configured to automatically display only thumbnails when you double-click a record in the result set, you can use the following procedure:

To display only thumbnails:
1. Perform a query to generate the Result Set. (For information on generating the Result Set, refer to Chapter 5, Retrieving Documents.)
2. From the Result Set, select the record for the document for which you want to view thumbnails.
3. Right-click your selection. From the shortcut menu that appears, select Thumbnail. Thumbnails for the selected document appear.

Displaying a Page from the Thumbnail View

After you display the thumbnails for a document in the Thumbnail view, you can select a thumbnail to display that document page.

To display a page using the Thumbnail view:
• Double-click the thumbnail of the page you want to display.
  Depending on your system settings, you may be prompted to check out the document. For more information, refer to Opening a Document in Check Out Mode, page 276.

For more information, see:
• Viewing Thumbnails, page 297

Creating an AppXtender Document Shortcut

You can create a shortcut on your Windows desktop by dragging a thumbnail to the desktop. You can then use this thumbnail to open AppXtender and immediately retrieve and display that page.
To create an AppXtender document shortcut on your desktop:

- Drag a thumbnail from the AppXtender window to your desktop. An icon appears on your desktop.

**Note:** When you select the thumbnail on your desktop to open the document, AppXtender will prompt you to log in if you are not already logged in. Depending on your system settings, you also may be prompted to check out the document. For more information, refer to *Opening a Document in Check Out Mode*, page 276.

For more information, see:

- Viewing Thumbnails, page 297

## Viewing Versions of a Page

If more than one version of a page exists, the newest version is displayed by default. You can access all other versions through the Page menu, the Page version toolbar buttons, or hot key combinations.

AppXtender orders page versions as they are created. The original page becomes version 1; the next variation of that page is version 2; and so on. System-generated version numbers are displayed in the status bar and the title bar.

**Figure 138. Page Version in Status Bar**

The following topics describe the commands you can use to navigate from one version of a page to another:

- **Previous Version, page 300**
- **Next Version, page 301**
- **Newest Version, page 301**
- **Oldest Version, page 301**

**Note:** The PgUp/PgDn in Dual-Page View option in the AppXtender Configuration dialog box has no effect on the behavior of these version navigation commands.

**Note:** For information on page versions and ODMA, refer to *Chapter 8, Using ODMA With AppXtender Documents.*

### Previous Version

To display the previous version of the page:

- From the Page menu, select Show Version and then Previous.

**Note:** If the first version is displayed, the Previous menu command displays the most recent (last) version of the page.
For more information, see:

- Viewing Versions of a Page, page 300

Next Version

To display the next version of the page:

- From the Page menu, select Show Version and then Next.

Note: If the most recent (last) version is displayed, the Next menu command displays the first version of the page.

For more information, see:

- Viewing Versions of a Page, page 300

Newest Version

To display the newest page version:

- From the Page menu, select Show Version and then Newest.

For more information, see:

- Viewing Versions of a Page, page 300

Oldest Version

To display the oldest page version:

- From the Page menu, select Show Version and then Oldest.

For more information, see:

- Viewing Versions of a Page, page 300

Viewing Subpages

If there is more than one subpage in a page (for example, in an ICE, TIFF, DCX, or PDF format page), you can use the Next Subpage, Previous Subpage, and Go To Subpage functions to move from subpage to subpage. As you navigate from one subpage to another, the status bar indicates the subpage number of the currently displayed subpage. For instructions on printing a range of subpages, refer to Printing or Faxing Documents and Pages, page 354. For instructions on converting subpages to pages, refer to Converting Subpages to Pages, page 393.
To move forward one subpage:
• From the Page menu, select Next Subpage.

To move back one subpage:
• From the Page menu, select Previous Subpage.

Note: You can add a Next Subpage button or a Previous Subpage button to the Image toolbar. For instructions on customizing a toolbar, refer to Customizing Toolbars, page 90.

To display a specific subpage:
1. From the Page menu, select Go To Subpage. The Go To dialog box appears.
2. In the Subpage text box, enter the number of the subpage that you want to display. You can either type the number or use the arrow buttons to specify a number.
3. Click OK. The subpage appears.

For more information, see:
• Selecting Pages to View within a Document, page 295

Viewing Multiple Documents and Pages

AppXtender can display multiple documents simultaneously. Using the Windows Tile and Cascade features, AppXtender shows all open documents side-by-side or neatly stacked. These tools are accessed from the Windows menu or the toolbar on AppXtender’s main screen. You can also configure the Document Display view to show multiple pages of the same document simultaneously or view an opened document in a supplementary window.

For more information, see:
• Chapter 6, Viewing Documents
• Cascade, page 302
• Tile, page 303
• Split View, page 303
• Displaying Documents in a Duplicate Window, page 303

Cascade

The Cascade command cascades, or stacks, all displayed document windows from the top left corner to the bottom right corner. The active document is displayed on the top.
To cascade all open document pages:
• From the Window menu, select Cascade.

For more information, see:
• Viewing Multiple Documents and Pages, page 302

**Tile**

The Tile command shows all open documents side-by-side in the Document Display view.

To tile open documents:
• From the Window menu, select Tile. AppXtender tiles all open windows. If there are less than four windows open, they are tiled horizontally. Otherwise, the windows are tiled horizontally and vertically.

For more information, see:
• Viewing Multiple Documents and Pages, page 302

**Split View**

Split View splits the Document Display view so that multiple pages of the same document are displayed.

*Note:* When you use Split View, the behavior of the Next Page and Previous Page commands depends on the current configuration of the PgUp/PgDn in Dual-Page View option in the Configuration dialog box. For information on this option, refer to *PgUp/PgDn in Dual-Page View, page 110*. For information on the Next Page and Previous Page commands, refer to Next, Previous, and Go To Page, page 296.

To enable split view:
• From the View menu, select Split Horizontally or Split Vertically.

To disable split view:
• From the View menu, select No Split.

For more information, see:
• Viewing Multiple Documents and Pages, page 302

**Displaying Documents in a Duplicate Window**

The Duplicate Document feature allows you to view an opened document in a supplementary window.

**To open a duplicate document window:**

1. Display a document from the Result Set. (For instructions on displaying a document, refer to Displaying Documents from the Result Set, page 266.)
2. From the Document menu, select Duplicate Document (or press [CTRL] + [F5]). The document appears in another window (in read-only mode).

For more information, see:
• Viewing Multiple Documents and Pages, page 302

Page View Functions Available for Multiple Page Types

The way pages appear in AppXtender and the viewing options available depend on the file type of the page. When you add a page or a document, you use a specific method to bring the document or page into AppXtender. The file type of each document page depends on the method used to add the document page and the native file format of the file that you brought in to create the document page.

The following topics describe functions that can be used with multiple page types:
• Using Sticky View, page 304
• Using Zoom, page 306
• Using Rotate, page 310
• Using the Magnifier, page 311
• Using Scale-to-Gray, page 312
• Using Regions, page 313

The page types that allow each of these functions are listed at the beginning of each of these topics.

Note: You can determine the page type of most AppXtender document pages by looking at the Type value on the Information tab of the Image Information dialog box for the page. For details on viewing information for a page, refer to Page Information, page 336.

Using Sticky View

Sticky View means that AppXtender can “remember” display settings (zoom, rotation, scale-to-gray, etc.) for similar page types. For example, bi-tonal (black and white) pages can be “stuck” to open with certain zoom and rotation settings. A different Sticky View could be set for bitmaps. Sticky View can be helpful when scanning similar paper documents, by displaying the page at its actual size to facilitate monitoring the quality of the scan. AppXtender automatically discerns which page type is displayed and responds with the appropriate settings.

You can use Sticky View with the following page types:
• Images
• COLD/ERM with Image Overlay
• COLD/ERM with Text Overlay
• COLD/ERM/Text with no overlay
• Text (as defined in the File Types tab of the Configuration dialog box)
• OLE Objects

Note: For more information on the File Types tab of the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Sticky View is different from the default display configuration in that the pages are not stored with the sticky settings; the pages appear in Sticky View simply for document creation and retrieval. The sticky settings are in effect until Sticky View is turned off.

Sticky View applies the following settings:
• Zoom, as described in Using Zoom, page 306
• Rotation, as described in Using Rotate, page 310
• Scale-to-gray, as described in Using Scale-to-Gray, page 312
• Form overlay, as described in Viewing Documents with Form Overlay, page 318

You can also save multiple sticky view settings for each image type and switch between each of the saved sticky view settings. For more information, refer to Saving Sticky View Settings, page 94 and Switching Sticky View Settings, page 305.

Switching Sticky View Settings

As soon as you have saved a sticky view setting, you can use the Switch View command to display a document using a Save Settings view, or the Sticky View button to cycle through each of the saved sticky view settings. Depending on the number of views saved, you can display a document with up to five different view settings. For information on saving views, refer to Saving Sticky View Settings, page 94.

To switch between sticky views from the View menu:

1. Display a document.
2. From the View menu, select Sticky View and then Switch View. The Switch View menu appears. Highlight the appropriate view (for example, View 1).

Figure 139. Switch View Menu

<table>
<thead>
<tr>
<th>View 1</th>
<th>Alt+1</th>
</tr>
</thead>
<tbody>
<tr>
<td>View 2</td>
<td>Alt+2</td>
</tr>
<tr>
<td>View 3</td>
<td>Alt+3</td>
</tr>
<tr>
<td>View 4</td>
<td>Alt+4</td>
</tr>
<tr>
<td>View 5</td>
<td>Alt+5</td>
</tr>
</tbody>
</table>

A check mark appears next to the selected view and the document appears with the selected sticky view setting.
To switch between sticky views from the Image toolbar:

1. Display the document.
2. Click the arrow next to the Next Sticky View button on the Image toolbar.

3. Select a sticky view setting. AppXtender displays the document using the selected sticky view setting.

Note: You can cycle through each of the sticky view settings by clicking the Next Sticky View button. If the last sticky view setting is displayed, clicking the Next Sticky View button displays the first available sticky view setting in the Sticky View menu.

For more information, see:
- Using Sticky View, page 304

Using Zoom

Zoom allows you to either focus precisely on a specific region of the page or view an entire page on the screen at one time. The Zoom feature enlarges or reduces the selected page to the next size in the zoom cycle. As soon as the largest size is reached, both the menu command for Zoom In and the Zoom In toolbar button are grayed to indicate that further enlargement is not possible. Similarly, if the smallest size is reached, the Zoom Out menu command and toolbar button are grayed.

You can set the default display scale in the Configuration dialog box. (For information on changing the default display scale in the Configuration dialog box, refer to View Tab, page 104.) When a document is displayed in AppXtender, the document appears in this default scale. You can also change the scale for the currently displayed page only, without affecting the default display parameters. AppXtender provides a wide variety of scaling options.
You can use the Zoom feature with the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)
- OLE Objects
- PDFs

**Note:** The zoom features can be used on text documents if Allow Zoom is selected and a variable size text font is configured for your workstation. The COLD tab and Fonts tab of the AppXtender Configuration dialog box allow these configurations. For information on the Allow Zoom option, see Saving and Loading Settings, page 150 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide. For information on choosing text fonts, refer to Fonts Tab, page 112.

For more information, see:

- Page View Functions Available for Multiple Page Types, page 304
- Zoom In, page 307
- Zoom Out, page 308
- Zoom To Percent, page 308
- Zoom Percent, page 308
- Fit to Window, page 309
- Fit to Window Width, page 309
- Fit to Window Height, page 309
- Actual Size, page 310

**Zoom In**

This option enlarges (or zooms in on) the displayed document by cycling through pre-set magnification levels.
To zoom in or enlarge the displayed document:
• From the View menu, select Zoom and then Zoom In.

For more information, see:
• Using Zoom, page 306

**Zoom Out**

This option reduces the displayed size of (or zooms out on) the displayed document by cycling through pre-set magnification levels.

To zoom out or decrease the size of the displayed document:
• From the View menu, select Zoom and then Zoom Out.

For more information, see:
• Using Zoom, page 306

**Zoom To Percent**

Like other Windows applications, AppXtender allows you to select how big or how small you want the displayed page to appear. Zooming to 100%, for example, shows the displayed page at actual size. You can use this option to view varying amounts of detail on different pages.

To zoom the displayed page to a specific ratio:
• Right-click the document. From the shortcut menu that appears, select a zoom ratio. The pre-set options range from 25% to 400%.

For more information, see:
• Using Zoom, page 306

**Zoom Percent**

You can also apply a specific zoom percent to a displayed document. When this feature is accessed from the View menu, any changes to the zoom parameters apply to the displayed document only. (For information on setting the zoom percent default for all images, refer to View Tab, page 104.)

To define the zoom percentage for a document:

1. From the View menu, select Zoom and then Zoom Percent. The Zoom Percent dialog box appears. The zoom percent range is from 1% to 1600%.
2. In the Zoom % text box, enter the zoom percentage that you want to apply. You can type in a value or you can use the up and down arrows to select the percentage.

3. Click OK. The selected zoom percent is applied to the document.

For more information, see:
- Using Zoom, page 306

**Fit to Window**

The selected page can be scaled so that the entire page fits in the Document Display view.

To fit the entire displayed page within the window:
- From the View menu, select Zoom and then Fit To Window. The page adjusts so that its entire height and width fit in the window.

For more information, see:
- Using Zoom, page 306

**Fit to Window Width**

The selected page can be scaled so that its entire width is visible in the Document Display view.

To fit the displayed page’s entire width within the window:
- From the View menu, select Zoom and then Fit To Window Width. The page adjusts so that it fits the window left to right.

For more information, see:
- Using Zoom, page 306

**Fit to Window Height**

The selected page can be scaled so that its entire height is visible in the Document Display view.
To fit the displayed page’s entire height within the window:
- From the View menu, select Zoom and then Fit To Window Height. The page adjusts so that it fits the window top to bottom.

For more information, see:
- Using Zoom, page 306

**Actual Size**

The selected page can be scaled to its actual size. This means that each stored pixel is represented by a monitor pixel.

To display a page in its actual size:
- From the View menu, select Zoom and then Actual Size.

The page adjusts so that it appears in the window at actual size.

For more information, see:
- Using Zoom, page 306

**Using Rotate**

The Rotate feature allows you to rotate pages and is especially useful when documents and images were not saved in the proper orientation. You can use rotation with the following page types:
- Images
- COLD/ERM with Image Overlay

For more information, see:
- Page View Functions Available for Multiple Page Types, page 304
- Rotate Left, page 310
- Rotate Right, page 311

**Rotate Left**

This command rotates the displayed page 90° to the left.
To rotate a displayed document page to the left:
• From the View menu, select Rotate Left.

For more information, see:
• Using Rotate, page 310

**Rotate Right**

This command rotates the displayed page 90° to the right.

To rotate a displayed document page to the right:
• From the View menu, select Rotate Right.

For more information, see:
• Using Rotate, page 310

**Using the Magnifier**

AppXtender provides a Magnifier feature that allows you to pinpoint an area of an image to zoom. When the Magnifier button is selected, the mouse pointer becomes a magnifier, and a click of the mouse displays the selected document region in the Magnifier dialog box.

You can use the Magnifier with the following page types:
• Images
• COLD/ERM with Image Overlay

**To use the Magnifier:**

1. From the View menu, select Zoom and then Magnifier. The Magnifier dialog box appears, and the mouse pointer changes to a magnifying glass.

   **Figure 144. Magnifier Dialog Box**
2. You have the following choices:
   - Click the image in the area that you want to magnify. A dotted rectangle appears where you clicked and the image within that rectangle is magnified in the Magnifier dialog box.
   - Drag the mouse pointer over the image. The mouse pointer changes to include a dotted rectangle. As you drag the pointer, the image within the dotted rectangle is magnified in the Magnifier dialog box. When you release the mouse button, the dotted rectangle remains on the image and the image within that rectangle remains magnified in the Magnifier dialog box.

   Figure 145. Document Display View with Magnified Area

3. You can change the zoom percent in the Magnifier dialog box.
   - To increase the magnification, slide the arrow to the right.
   - To decrease the magnification, slide the arrow to the left.

   The display in the Magnifier window changes to reflect the new magnification.

For more information, see:
- Page View Functions Available for Multiple Page Types, page 304

Using Scale-to-Gray

A selected bi-tonal (black and white) document can be scaled to gray to increase readability. You can use Scale-To-Gray with the following page types:
- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
To increase readability:
• From the View menu, select the Scale-to-Gray option.

For more information, see:
• Page View Functions Available for Multiple Page Types, page 304
• Scale-to-Gray, page 107

Using Regions

You can select regions of an image or text page and process those regions in many ways. You can also print a region or process it with OCR. For more information, refer to Printing or Faxing a Region, page 361 and Document and Page OCR, page 382.

You can use regions with the following page types:
• Images
• ERM with Image Overlay
• ERM with Text Overlay
• ERM/Text with no overlay
• Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on defining file types in the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring AppXtender Workstations" section of the ApplicationXtender Installation Guide.

For more information, see:
• Page View Functions Available for Multiple Page Types, page 304
• Enabling Select Mode, page 313
• Drawing a Region, page 314
• Magnifying a Region, page 314
• Copying a Region to the Windows Clipboard, page 316
• Clearing Regions, page 317

Enabling Select Mode

When pages are first displayed in AppXtender, the view mode is defaulted to Pan mode. Pan mode viewing is identified by the AppXtender cursor appearing as a hand in the interface. In order to select a region of a page for processing, you must change the AppXtender page viewing mode from Pan to Select.

To change page view mode from Pan to Select:
• If the page currently displayed is in Pan mode, click the Pan Mode button in the toolbar.
Figure 146. Pan Mode Button

The button is "disabled" and the cursor, when placed over the displayed page, changes to an arrow.

To return page view mode from Select to Pan:

- If the page currently displayed is in Select mode, click the Pan Mode button in the toolbar. The button is "enabled" and the cursor, when placed over the displayed page, changes to a hand.

For more information, see:
- Using Regions, page 313

Drawing a Region

When you draw a region, you are selecting a region for processing. You can draw a region on the following page types:

- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on defining file types in the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

To draw a region:

1. Make sure that Pan Mode is disabled. For information, refer to Enabling Select Mode, page 313.
2. Drag the pointer over the region you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.

For more information, see:
- Using Regions, page 313

Magnifying a Region

The Magnify Region feature allows you to focus on one region of an image and enlarge it for better viewing or manipulation.

You can magnify a region on the following page types:

- Images
- COLD/ERM with Image Overlay

To magnify a region:

- Right-click the highlighted region. From the shortcut menu that appears, select Magnify.
Figure 147. Page Region with Shortcut Menu

If Magnify is selected, the region appears with its enlarged view in a Magnify window. The Magnify window has its own menu bar, with File and Edit commands.

Figure 148. Magnify Window

You have several choices. The following table describes commands that you can use in the File menu and Edit menu of the Magnify window:

Table 46. Magnify Window Menu Commands

<table>
<thead>
<tr>
<th>To Do This</th>
<th>From This Magnify Menu</th>
<th>Select This Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the magnified region to a separate file. (Print privilege is required.)</td>
<td>File</td>
<td>Save As</td>
</tr>
<tr>
<td>Print the magnified region. (Print privilege is required.)</td>
<td>File</td>
<td>Print</td>
</tr>
<tr>
<td>Exit the Magnify window.</td>
<td>File</td>
<td>Exit</td>
</tr>
</tbody>
</table>
### Viewing Documents

<table>
<thead>
<tr>
<th>To Do This</th>
<th>From This Magnify Menu</th>
<th>Select This Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy the region to the Windows Clipboard. (Print privilege is required.)</td>
<td>Edit</td>
<td>Copy</td>
</tr>
<tr>
<td>Preserve the magnified region’s original height/width ratio.</td>
<td>Edit</td>
<td>Keep Aspect Ratio</td>
</tr>
<tr>
<td>Display information about the magnified region, such as size, width, and height.</td>
<td>Edit</td>
<td>Information</td>
</tr>
</tbody>
</table>

**Note:** Only users with the Print privilege can perform operations that result in information "exported" from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the *ApplicationXtender Core Components Administrator’s Guide.*

For more information, see:
- Using Regions, page 313

### Copying a Region to the Windows Clipboard

If you have the Print privilege, you can copy a region on the following page types:
- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

**Note:** For more information on defining file types in the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the *ApplicationXtender Installation Guide.*

When you copy a region to the Windows Clipboard, you copy the data in that region in its native format.

**To copy a region to the Windows Clipboard:**

1. Right-click the highlighted region.
2. You have the following choices:
   - From the shortcut menu that appears, select Copy. The image in the selected region is copied to the Windows Clipboard.
   - From the shortcut menu that appears, select Cut. The image in the selected region is copied to the Windows Clipboard and the region is cleared.

For information on using the contents of the Windows Clipboard to create new documents and pages in AppXtender, refer to Adding a Document from the Windows Clipboard, page 173.
Note: Only users with the Print privilege can perform operations that result in information "exported" from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Using Regions, page 313

Clearing Regions

When you clear a region, you clear the selection of that region. When you clear all regions, you clear the selection of any regions selected on the document page. You can clear a region on the following page types:
- Images
- COLD/ERM with Image Overlay
- COLD/ERM with Text Overlay
- COLD/ERM/Text with no overlay
- Text (as defined in the File Types tab of the Configuration dialog box)

Note: For more information on defining file types in the Configuration dialog box, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

To clear regions:
1. Right-click the highlighted region.
2. You have the following choices:
   - From the shortcut menu that appears, select Clear All Region(s). All of the regions on the page are cleared.
   - From the shortcut menu that appears, select Delete. The region is cleared.

Note: The Delete command does not change or remove pixels from the image.

For more information, see:
- Using Regions, page 313

Viewing Specific Page Types

Each of the specific page types has functionality that is exclusively available with that page type. For information on viewing options that are only available for specific page types, refer to the following topics:
- Viewing Image Pages, page 318
- Viewing Text Pages, page 318
- Viewing PDF Files, page 324
Viewing Image Pages

When you are viewing a page that is an image, you can OCR the contents of the image and then switch between the image view and the OCR text view as needed. For more information on processing a document, page, or page region using OCR, refer to Document and Page OCR, page 382.

When image documents or pages have been processed using OCR, you can view them in either text or image format. Using the View menu or the Show OCR Text button on the Image toolbar, you can toggle between text or image view.

To switch views:

- From the View menu, select OCR Text.

If you have RecoStar installed and selected as the AppXtender OCR engine, and if you have AppXtender configured to use a forms template during OCR processing, the text view contains only the text specified by the RecoStar template. Otherwise, the text view contains all of the text on the image. For information on selecting an OCR engine, and for information on configuring AppXtender to use a forms template during OCR processing, see OCR Tab, page 335 consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

For information on processing a document or page using OCR, refer to Document and Page OCR, page 382.

For more information, see:

- Viewing Specific Page Types, page 317

Viewing Text Pages

For more information, refer to the following topics:

- Viewing Documents with Form Overlay, page 318
- Title Locking on Text Pages, page 320
- Customizing Color Bar Settings for an Application, page 321

Viewing Documents with Form Overlay

Depending on your AppXtender configuration, you can display text documents with an image form overlay, with a text overlay, or in a plain text view without an overlay. When text documents are displayed in plain text or using a text form overlay, they appear as text documents. When text documents are displayed using an image form overlay, they appear as images. Using the View menu or the Form Overlay button on the Image toolbar, you can toggle between text or image view. (Form overlays cannot be added to PDF documents.)
For more information, see:
- Viewing Text Pages, page 318
- COLD/ERM Display as Image Only, page 319
- Modifying the Form Overlay, page 319

**COLD/ERM Display as Image Only**

The Display as Image Only option in the AppXtender Configuration dialog box restricts you from viewing a text document with a text form overlay or in plain text view without form overlay. If your AppXtender workstation is configured to Display as Image Only, you can only view COLD/ERM documents with form overlay using an image form overlay. For information on configuring Display as Image Only on your AppXtender workstation, see Saving and Loading Settings, page 150 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Only users with the Configure WS privilege can configure the Display as Image Only option. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

To switch views:
- From the View menu, select Form Overlay and then Image.

For information on creating a form overlay, refer to the ApplicationXtender Reports Management Administrator’s Guide.

For more information, see:
- Viewing Documents with Form Overlay, page 318

**Modifying the Form Overlay**

You can make changes to the layout of form overlays from within AppXtender. The modifications can be applied and viewed while the text document is displayed. Both image and ASCII form overlays can be modified.

**Note:** Only the SYSOP user or users with the Configure WS privilege can change the position of a form overlay. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

**To change the settings for an overlay:**

1. To display a document with a form, from the View menu, select Form Overlay and then Position. AppXtender displays the COLD Form Position dialog box. The text is displayed in a grayed out region on the form.

2. Make changes to the text positioning, and click Update at any time to apply the changes without exiting. The following table describes some different methods to change each aspect of the text positioning:
Table 47. Text Positioning Methods

<table>
<thead>
<tr>
<th>To Change This</th>
<th>Enter a New Value in This Text Box</th>
<th>Click This Button</th>
<th>Drag This to a New Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>The left offset</td>
<td>Left</td>
<td>Left or Right</td>
<td>The text region</td>
</tr>
<tr>
<td>The top offset</td>
<td>Top</td>
<td>Up or Down</td>
<td>The text region</td>
</tr>
<tr>
<td>The characters per inch</td>
<td>CPI</td>
<td></td>
<td>The left or right border of the text region</td>
</tr>
<tr>
<td>The lines per inch</td>
<td>LPI</td>
<td></td>
<td>The top or bottom border of the text region</td>
</tr>
</tbody>
</table>

3. Click OK. The COLD Form Position dialog box closes and the changes you made are applied.

For more information, see:
- Viewing Documents with Form Overlay, page 318

**Title Locking on Text Pages**

AppXtender allows you to partition a text page vertically or horizontally, creating a non-scrollable title region. Data above a horizontal title and data to the left of a vertical title becomes stationary, while the data below or to the right of the title can still be browsed.

Using this feature, a line of existing text can be transformed into a title (or heading) for the text below. This feature can be useful in cases where the headings for lengthy columns normally scroll off the screen as you move down the page. Setting a title directly below those headings keeps them in place even when displaying data several screens below.

**To lock a title on a document:**

1. Display the appropriate document.
2. Enable Pan Mode (if necessary) by clicking the Pan Mode button on the toolbar. When Pan Mode is enabled, this button should appear pushed in, and your cursor, when placed over the displayed page, turns into a hand.
3. Right-click the area where you want to apply the title lock.
4. From the shortcut menu that appears, select either Set Horizontal Title, Set Vertical Title, or Set Horizontal and Vertical Title. AppXtender adds a blue line indicating the location of the title. Text to the left of vertical titles or above horizontal titles does not scroll.

To clear a title lock:
- Right-click the page. From the shortcut menu that appears, select Clear Title.

**Note:** Titles remain in place if the document is minimized, but clear when you navigate to another page or when you close the document.
Customizing Color Bar Settings for an Application

The COLD tab of an application's Properties dialog box allows you to view text documents with a "color" bar background. When a document is displayed with the Color Bar enabled, the background is composed of alternating bars of a selected color and white. Each band is the width of three lines (in the default setting). You can change the color and the width of the bands.

This feature applies primarily to documents generated by AppXtender Reports Management. If your AppXtender workstation has any file extensions associated with the Text file type, the color bar feature also applies to files with these extensions. For instructions on configuring file types, see File Types Tab, page 132 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

The default color bar settings for all applications are configured in the COLD tab of the AppXtender Configuration dialog box. For instructions, see Saving and Loading Settings, page 150 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide. You can customize the color bar settings for the text documents in an application.

To customize color bar settings for an application:

1. Right-click an application. From the shortcut menu that appears, select Properties. The Properties dialog box for the selected application appears.
2. Click the COLD tab.

For more information, see:
- Viewing Text Pages, page 318
3. Click the Use default color bar settings check box to clear it. The color bar settings for the selected application are now controlled by the Properties dialog box for the application, rather than the AppXtender Configuration dialog box for the workstation.
4. Click the Show color bar check box to specify whether you want the color bar to appear for text documents. A check mark indicates that color bar is on. No check mark indicates that color view is off.

5. Specify the width of the color bar. In the Lines box, type the number of lines that you want to use or select the number by using the up or down arrow.

6. Specify the color to be used in the color bar. In the Color list, click the color of your choice. (If the color that you want to use is not listed, select Custom. The standard Windows Color dialog box appears, allowing you to create a color for the color bar.)

7. When all desired settings have been selected, choose one of the following options:
   - Click OK to save changes and close the dialog box.
   - Click Cancel to close the dialog box without saving changes.
   - Click Apply to save changes and keep the dialog box open.

For more information, see:
- Viewing Text Pages, page 318
- Viewing Application Properties, page 62
- Configuring the Title Bar, page 91
**Viewing PDF Files**

AppXtender uses Adobe PDF Library to display Portable Document Format (PDF) files. The PDF file appears in PDF format in the Document Display view.

For more information, see:
- Viewing Specific Page Types, page 317

**Viewing Foreign Files**

Typically, AppXtender-supported foreign files are displayed in the Document Display view as icons. However, when you enable the AppXtender Web Access Verity KeyView (AppXtender Web KeyView Viewer) feature, AppXtender can display the contents of a foreign file. This feature allows you to access the contents of the file without a third-party viewer. If you want to view the contents of a Microsoft Word file, for example, you do not need to have a native application, such as Microsoft Word, installed on your workstation. The appearance of a foreign file in AppXtender Web Access Verity KeyView is similar to its appearance in its native viewer, but not exactly the same.

When the content of an AppXtender-supported foreign file is displayed, you can launch the foreign file in its native application. For more information, refer to Launching Foreign Files, page 325.

You can also access page information for a foreign file from a shortcut menu (if it is displayed as an icon). For details on viewing information for a document page, refer to Page Information, page 336.

For a list of the foreign files that can be viewed using the AppXtender Web KeyView Viewer feature, refer to Creating _RSTAMP and _FORMS Documents, page 192.

For more information, see:
- Viewing Specific Page Types, page 317
- Configuring a Viewer for Foreign Files, page 324
- Viewing Foreign Files with the AppXtender Web KeyView Viewer, page 325
- Viewing Foreign Files as Icons, page 325
- Launching Foreign Files, page 325
- Closing a Foreign File, page 326

**Configuring a Viewer for Foreign Files**

The Use AppXtender Web KeyView Viewer to display foreign files option on the View tab of the AppXtender Configuration dialog box controls whether the AppXtender Web KeyView Viewer is used to display foreign files in the Document Display view. You can enable the Use KeyView to display foreign files option to cause AppXtender to display foreign files using the AppXtender Web KeyView Viewer. If you disable the option, AppXtender displays foreign files as icons.

**To configure foreign file display:**

1. From the File menu in AppXtender, select Configuration. The AppXtender Configuration dialog box appears.
2. Click the View tab to activate it.

3. You have the following choices:
   - To use the AppXtender Web KeyView Viewer to view foreign files, enable the Use KeyView to display foreign files option. For additional information about viewing foreign files with AppXtender Web KeyView Viewer, refer to Viewing Foreign Files with the AppXtender Web KeyView Viewer, page 325.
   - To view foreign files as icons, disable the Use AppXtender Web KeyView Viewer to display foreign files option. For additional information about viewing foreign files as icons, refer to Viewing Foreign Files as Icons, page 325.

For more information, see:
- Viewing Foreign Files, page 324
- Viewing Foreign Files with the AppXtender Web KeyView Viewer
- Viewing Foreign Files as Icons, page 325

**Viewing Foreign Files with the AppXtender Web KeyView Viewer**

When you view a foreign file using the AppXtender Web KeyView Viewer, the contents of the file display in the Document Display view.

When you display a foreign file with the AppXtender Web KeyView Viewer, they are read-only. However, you can also launch the foreign file in its native application for editing, even when it is displayed using the AppXtender Web KeyView Viewer. For instructions, refer to Launching Foreign Files, page 325.

**Viewing Foreign Files as Icons**

When you do not enable use of the AppXtender Web KeyView Viewer with foreign files, an icon represents the file in the Document Display view.

When foreign files are displayed as icons, you can access page information or document view properties from the Document Display view. You can also launch the foreign file in its native application. For instructions, refer to the following topics:
- Launching Foreign Files, page 325
- Page Information, page 336
- Document View Properties, page 329

**Launching Foreign Files**

You can launch a foreign file to edit it in the source application for the foreign file as long as you have the source application installed on your workstation. When you finish working in the application, you exit the application. You can then choose to save the revised file as a new page version of the page from which you launched the file, replace the original page version with the new page version, or cancel changes to the file (depending on your user privileges).
User privileges affect your ability to edit foreign files. If your user profile does not include the Add Page privilege, the changes that you make while editing the object are not saved in AppXtender. If your user profile does not include the Delete Page privilege, you are only allowed to save the edited foreign file as a new page version or discard changes.

If you are running AppXtender in check in/check out mode and you opened the displayed document in read-only display mode, you can still launch the foreign file and edit it, but changes to the file are not saved when you close it. If a document is in read-only mode, the document name in the title bar should have "-RO" after it.

To launch a foreign file and edit it:
- From the Page menu, select Launch Foreign File.

The source application for the foreign file opens. For information on editing the object, refer to the documentation for the source application.

**Figure 151. Foreign File in Source Application**

For more information, see:
- Viewing Foreign Files, page 324

**Closing a Foreign File**

To close the foreign file and return to the Document Display view:
1. From the File menu for the source application, select Exit.
2. The behavior of AppXtender after you close the source application depends on your user permissions.
   • If the Update Foreign File dialog box appears, refer to Updating a Foreign File, page 327.

   **Figure 152. Update Foreign File Dialog Box**

   ![Update Foreign File Dialog Box]

   • If a message asking whether you would like to save the file as a new page version appears, refer to Saving a Foreign File, page 327

For more information, see:
• Viewing Foreign Files, page 324

### Updating a Foreign File

To update a foreign file:
• If the Update Foreign File dialog box appears, you have the following choices:
  — To save the updated file as a new page version in the page from which you launched the file, select Save this file as a new page version and click OK.
  — To replace the page version from which you launched the file with the updated file, select Replace existing page version with this file and click OK.
  — To discard any changes you made to the foreign file and revert to the version of the file before you edited it, select Discard the changes made to this file and click OK.
  — To discard any changes you made to the foreign file and revert to the version of the file before you edited it, click Cancel.

For more information, see:
• Closing a Foreign File, page 326

### Saving a Foreign File
Viewing Documents

To save the foreign file as a new page version or cancel changes:
• If a message appears asking whether you would like to save the file as a new page version, you have the following choices:
  — To save the updated file as a new page version in the page from which you launched the file, click Yes.
  — To discard any changes you made to the foreign file and revert to the version of the file before you edited it, click No.

For more information, see:
• Closing a Foreign File, page 326

Viewing OLE Objects

You can activate an OLE Object and edit it in the AppXtender Document Display view as long as the source application for the OLE Object is installed on your AppXtender workstation.

User privileges affect your ability to edit foreign files. If your user profile does not include the Add Page privilege, the changes you make while editing the object are not saved in AppXtender.

If you are running AppXtender in check in/check out mode and you opened the displayed document in read-only display mode, you can still activate the OLE Object and edit it, but changes to the file are not saved when you close it. If a document is in read-only mode, the document name in the title bar should have “-RO” after it.

OLE embeddable objects can be displayed and edited in AppXtender either as an icon or as the object content. The following table describes each display method.

Table 48. Description of Each OLE Object Display Method

<table>
<thead>
<tr>
<th>Display Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon</td>
<td>The object is embedded (stored) in the document, and a graphic representation of the object appears in the Document Display view. By double-clicking the page, you can view or edit the object in its native format. Any changes to the object are immediately reflected in the AppXtender document.</td>
</tr>
<tr>
<td>Content</td>
<td>The content of the object appears in the Document Display view. By double-clicking the page, you can edit the object in its native format. Any changes to the object are immediately reflected in the AppXtender document.</td>
</tr>
</tbody>
</table>

For an example of each of these display methods, refer to the following figures.
To edit an OLE Object:
• Double-click the icon or image. The source application menus replace the AppXtender menus.
  For information on editing the object, refer to the documentation for the source application.

To close the object and return to the Document Display view:
• From the File menu, select Close.

To return to the Document Display view without saving changes:
• From the File menu, select Cancel.

For more information, see:
• Viewing Specific Page Types, page 317

## Document View Properties

AppXtender allows you to modify the view properties of a displayed page. The AppXtender Configuration dialog box allows you to set default parameters that are used when displaying a document or page in AppXtender. However, you can use the Properties dialog box to customize your page display for only the displayed page. There are four tabs in the Properties dialog box – General, Image, Text, and OCR. Each tab has options that allow you to customize the view for the displayed document. The following topics detail each tab:

- General Tab, page 329
- Image Tab, page 331
- Text Tab, page 334
- OCR Tab, page 335

**Note:** This feature is available for foreign files displayed as icons, but not for foreign files displayed with KeyView. For instructions on displaying foreign files as icons, refer to Configuring a Viewer for Foreign Files, page 324.

### General Tab

The General tab allows you to configure mouse action and document display options.

**To configure mouse action and document display for a page:**

1. Right-click the document. (If you are using the Acrobat Viewer to display a PDF file within the Document Display view, right-click the Acrobat Viewer toolbar.)
2. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the General tab.
3. Enable the options you want to use. The following table provides details on each option.

**Table 49. AppXtender View Control Properties - General Tab Options**

<table>
<thead>
<tr>
<th>To Do This</th>
<th>Do This</th>
<th>Default Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make the mouse pointer into a scrolling device so that you can drag the image in Document Display view to a new position.</td>
<td>Enable the Scroll image option.</td>
<td>Enabled</td>
</tr>
<tr>
<td>Make the mouse a selection tool so that you can draw regions around all or a part of the image in Document Display view for processing.</td>
<td>Enable the Select image option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>Make the mouse a selection tool so that you can select annotations for processing.</td>
<td>Enable the Select annotation option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>Do not allow the shortcut menu to appear when you right-click a document in the display view (default).</td>
<td>Uncheck the Right-click context menu option.</td>
<td>Disabled</td>
</tr>
<tr>
<td>Allow the shortcut menu to appear when you right-click a document in the display view (after it has been disabled).</td>
<td>Close the displayed document and re-open.</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
To Do This | Do This | Default Status
--- | --- | ---
Allow the horizontal or vertical scrollbars to display in Document Display view. | Enable the Display scrollbars option. | Enabled
Specify the zoom ratio for the document image in Document Display view. | In the Zoom ratio text box, enter a value. | (Depends on settings in the AppXtender Configuration dialog box, Display tab)

Some of these options can be implemented more easily with toolbar buttons. The following table lists these options and their corresponding toolbar buttons:

**Table 50. AppXtender View Control Properties - General Tab Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Button</th>
<th>For More Information, Refer To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll image</td>
<td>![Scroll image icon]</td>
<td>Document Display View, page 69</td>
</tr>
<tr>
<td>Select image</td>
<td>![Select image icon]</td>
<td>Using Regions, page 313</td>
</tr>
<tr>
<td>Select annotation</td>
<td>![Select annotation icon]</td>
<td>Chapter 9, Annotations</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>![Zoom ratio icon]</td>
<td>Using Zoom, page 306</td>
</tr>
</tbody>
</table>

4. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:
- Document View Properties, page 329

### Image Tab

The Image tab provides display and screen resolution options for the current page, if it is an image.

**To configure display and screen resolution for an image:**

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the Image tab.
2. Enable the options you want to use. The following topics describe each option:
   - Display Palette, page 332
   - Display Image in its Actual Scale, page 333
   - Screen Resolution, page 333

3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:
   - Document View Properties, page 329

**Display Palette**

The Display palette drop-down list provides options for viewing the image in a variety of palettes. Keep in mind that image size, image clarity, and file size increase with the number of colors in a palette. Also, keep in mind that file processing slows as file size increases.

For a color image, you have the following choices:
• Median Cut Palette  • Bayer - Monochrome
• Fixed Palette     • Bayer - 4 Gray Shades
• 3-3-2 Palette    • Bayer - 16 Gray Shades
• Thumbnail Palette • Bayer - Fixed Palette
• 1-1-1 Palette    • Bayer - 3-3-2 Palette
• Monochrome Palette • Bayer - 1-1-1 Palette
• 16 Gray Shades Palette • Floyd/Steinberg - Monochrome
• 256 Gray Shades Palette • Floyd/Steinberg - 4 Gray Shades
                     • Floyd/Steinberg - 16 Gray Shades

For a bi-tonal (black and white) image, you have the following choices:
• Monochrome Palette
• Scale to Gray - 16 Shades
• Scale to Gray - 256 Shades

For more information, see:
• Image Tab, page 331

**Display Image in its Actual Scale**

A check mark in this box allows the image to be scaled to its actual size. (This option can be implemented more easily with a menu command. For information, refer to Actual Size, page 310.)

For more information, see:
• Image Tab, page 331

**Screen Resolution**

This option is available only when you enable the Display image in its actual scale check box. If you enable the Use customized screen display resolution (DPI) check box, AppXtender allows you to designate customized horizontal or vertical settings. (The default values in the Horizontal and Vertical boxes depend on the settings in the Display tab of the AppXtender Configuration dialog box. For more information, refer to Screen DPI, page 110.)
For more information, see:
• Image Tab, page 331

Text Tab

The Text tab provides various display options for currently displayed text documents.

To configure display options for a text document:

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the Text tab.

2. Enable the options you want to use. The following table provides information on each option.

Table 51. AppXtender View Control Properties - Text Tab Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Select this option to display the text document with a color bar background (helps make documents with information in columns more readable).</td>
</tr>
<tr>
<td>Height (Lines)</td>
<td>To configure the height of each color bar, enter the number of lines to display with the selected color.</td>
</tr>
<tr>
<td>Select Font</td>
<td>Select the font type for text document display.</td>
</tr>
<tr>
<td>Bold</td>
<td>Select this option to display font in bold.</td>
</tr>
<tr>
<td>Italic</td>
<td>Select this option to display font in italics.</td>
</tr>
</tbody>
</table>
Option | Function
--- | ---
Tab Size | Type in a number or use the arrows to enter the number of characters for tab settings within a text document. Tabs are automatically set at intervals of that length within the text document.
Form Overlay | Select the type of form overlay for this document: No overlay, ASCII overlay, or Image overlay.
Overlay Font | Select the font type for form overlay display.

*Note:* The Form Overlay option can be implemented more easily with the Form Overlay toolbar button. For more information, refer to *Viewing Documents with Form Overlay, page 318.*

3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:
- *Document View Properties, page 329*

## OCR Tab

The OCR tab provides options for optical character recognition (OCR) output.

**To display the Properties dialog box:**

1. Right-click the document. From the shortcut menu that appears, select Properties. The Properties dialog box appears. Click the OCR tab.

2. Enable the options you want to use. The following table provides basic information on each option. For more detailed information, see *OCR Tab, page 145* consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

### Table 52. AppXtender View Control Properties - OCR Tab Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
</table>
| OCR Engine    | This option allows you to select the OCR engine for AppXtender to use. Only RecoStar OCR Engine is available.  
|               | • RecoStar OCR Engine                                                     |
| OCR Language  | This option allows you to select a language for OCR processing.            |
| OCR Result Format | This option allows you to select the file format for output from the OCR engine. Options include Plain Text. |

An explanation of the OCR Result Formats is provided in the following table.
Table 53. AppXtender View Control Properties - OCR Result Format Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain text</td>
<td>The plain text format is an ASCII text format, readable on MS-DOS/Windows operating systems. Plain text format retains formatting options that are available in MS-DOS text format, such as bold and italics.</td>
</tr>
</tbody>
</table>

3. When all desired options have been configured, you have the following choices:
   - Click OK to save changes and exit the dialog box.
   - Click Cancel to exit without saving changes.
   - Click Apply to save any changes you have made without exiting the dialog box.

For more information, see:
- Document View Properties, page 329

Page Information

AppXtender supplies valuable information for every page of a document. This can be useful in determining the size of a particular image, for example, or the path location.

Note: This feature is available for foreign files displayed as icons, but not for foreign files displayed with KeyView. For instructions on displaying foreign files as icons, refer to Configuring a Viewer for Foreign Files, page 324.

To view information for a document page:
1. Display the page in AppXtender.
2. Right-click the page. (If you are using the Acrobat Viewer to display a PDF file within the Document Display view, right-click the Acrobat Viewer toolbar.)
3. From the shortcut menu that appears, select Information. The Image Information dialog box appears, open to the Information Tab.

Figure 156. Information Tab

The Information tab provides the following details:
Table 54. Image Information - Information Tab Options

<table>
<thead>
<tr>
<th>Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Number of pixels or characters being used for width of page.</td>
</tr>
<tr>
<td>Height</td>
<td>Number of pixels or lines being used for height of page.</td>
</tr>
<tr>
<td>Bits Per Pixel</td>
<td>Number of bits for each pixel.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Resolution of the page.</td>
</tr>
<tr>
<td>File Size</td>
<td>Compressed page file size (in bytes).</td>
</tr>
<tr>
<td>Compression</td>
<td>Type of compression used for this page.</td>
</tr>
<tr>
<td>Type</td>
<td>Page file type (TIFF, JPEG, etc.).</td>
</tr>
</tbody>
</table>

4. To view information specific to the files associated with the document, click the Files tab.

Figure 157. Image Information Dialog Box: Files Tab

The Files tab provides the following details:

Table 55. Image Information - Files Tab Description

<table>
<thead>
<tr>
<th>Info</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Filename</td>
<td>Path location and file name of the stored page.</td>
</tr>
<tr>
<td>Annotation Filename</td>
<td>Path location and file name of the page's annotations, if any.</td>
</tr>
</tbody>
</table>

For more information, see:

- Chapter 6, Viewing Documents
A full range of document management functionality is available in AppXtender, including the ability to print, fax, e-mail, delete, and export documents and pages. AppXtender supports standard interfaces, so special print or fax drivers are not necessary to use the print and fax functions. Users may also modify a document’s index.

**Note:** Only users with the Print privilege can perform operations that result in information being exported from the AppXtender system. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the ”Managing Security” section of the *ApplicationXtender Core Components Administrator’s Guide*.

- Adding Pages to Documents, page 340
- Modifying Document Indexes, page 350
- Applying Digital Signatures, page 351
- Applying IRM Protection to ApplicationXtender Content, page 353
- Printing or Faxing Documents and Pages, page 354
- E-Mailing Documents and Pages, page 362
- Exporting Documents and Pages, page 370
- Moving or Copying Document Pages, page 381
- Document and Page OCR, page 382
- OCR Indexing Documents, page 387
- Submitting Documents to a Full-text Queue, page 387
- Submitting Documents/Reports to BI Gateway, page 390
- Submitting Documents to ApplicationXtender Workflow Manager, page 393
- Converting Subpages to Pages, page 393
- AppXtender Document Properties, page 394
- Saving the Result Set as a Text File, page 396
- Checking in and Canceling Changes, page 397
- Deleting Documents, Pages, Versions, and Batches, page 399
Adding Pages to Documents

As soon as a document has been created, additional pages can be attached as you require. Subsequent pages can be the same file type as the first page or any other file type. Pages can be inserted before or after the displayed page, or appended to the end of the active document.

AppXtender has safeguards in place to prevent mismanagement of document pages. Additional pages cannot be added to the wrong document, because the desired document must be displayed to add pages. The document's title bar always shows the active page and total number of pages. Different versions of a single page can also be created, allowing users to structure closer associations between one object and another.

Before attaching a new page to a document, make sure that the desired document is displayed and, if necessary, checked out by you. For more information on checking out and displaying a document, refer to Chapter 5, Retrieving Documents. All commands for page management are located in the Page menu on the main screen. AppXtender allows for various methods of input, such as scanning, using the Windows Clipboard, inserting an object, or importing a file, so there is no restriction on a document's structure or content. The input methods are discussed here in detail.

For more information, see:
- Chapter 7, Managing Documents
- Adding a Page by Scanning, page 340
- Adding a Page from the Windows Clipboard, page 341
- Adding a Page by Inserting an Object, page 343
- Adding a Page by Importing a File, page 346
- Adding a Page by Dragging a File, page 347
- Adding a Page from the Fax-in Queue, page 347
- Replacing Pages, page 349
- Reordering Pages, page 350
- Page Versions, page 350

Adding a Page by Scanning

Additional pages can be added from any scanner supported or certified for use with AppXtender. For detailed scanning procedures, refer to Scanning Pages, page 234. For a list of supported and certified scanners, refer to Selecting a Scanner, page 224.
Adding a Page from the Windows Clipboard

AppXtender allows for the sharing of data between programs using the Windows Clipboard. The contents of the Clipboard can be pasted into AppXtender as a new page. Because the Clipboard holds any type of data, the new page can be an image, data from another application (such as Microsoft Word or PowerPoint), or even a page from a different AppXtender application.

Your ability to view the resulting page depends on the type of file you have copied and pasted. If AppXtender supports the file type that you copy and paste, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to Support for Viewing of Imported Files in AppXtender, page 167.

Pages can be pasted before or after a displayed page, or appended to the end of a document. For more information, refer to:
- Adding a Page by Pasting, page 341
- Adding a Page in a Selected Format, page 342
- Adding Pages to Documents, page 340

Adding a Page by Pasting

To add a page from the Windows Clipboard:

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.
2. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.
3. From the Page menu, select New and then Clipboard Paste. A shortcut menu appears.

   Note: If there is not a valid page in the Windows Clipboard, AppXtender dims the Insert After, Insert Before, and Append menu options, meaning they are not available for selection. If this is the case, verify that the data has been moved to the Clipboard successfully. The Clipboard viewer (supplied with Windows) can be used to view the contents of the Clipboard at any time.

4. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.

The content of the Clipboard appears in the Document Display view as a new page.
For more information, see:

- Adding a Page from the Windows Clipboard, page 341

### Adding a Page in a Selected Format

**To paste a page in a different format:**

1. Move the desired data to the Windows Clipboard. Typically, this is performed through a program’s Edit menu, and some programs have shortcuts to accomplish this function.

2. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.

3. From the Page menu, select New and then Clipboard Paste Special. A shortcut menu appears.

4. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.

   The Paste Special dialog box appears.

   **Figure 158. Paste Special Dialog Box**

5. Under As, select a format.

6. If the Display As Icon check box is available, indicate how you want the new page to be displayed and edited. You have the following choices:
   - To display the object as an icon, enable the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

   For information, refer to Viewing OLE Objects, page 328.
7.  Click OK. The content of the Clipboard appears in AppXtender as a new page.  
For more information, see:
  • Adding a Page from the Windows Clipboard, page 341

Adding a Page by Inserting an Object

Data from other applications that support ActiveX embeddable objects can be added as pages in existing documents. The object is embedded (stored) in the document, and a graphic representation of the object appears in the Document Display view. To view the page in its native format, double-click the page's graphic representation. AppXtender starts the source application.

For more information, see:
  • Adding Pages to Documents, page 340
  • Create New Object, page 343
  • Insert Object from File, page 344

Create New Object

To add a page as a new object:
1.  Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.

2.  From the Page menu, select New and then Insert Object. A shortcut menu appears.

3.  You have the following choices:
   • If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   • If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   • If you want the new page to be added as the last page in the document, select Append.

An Insert Object dialog box appears, listing all ActiveX server applications on the workstation.
Managing Documents

Figure 159. Insert Object Dialog Box

4. Select Create New.

5. Under Object Type, select the name of the application that you want to use to create the new page.

6. Indicate how you want the new page to be displayed and edited. You have the following choices:
   - To display the object as an icon, enable the Display As Icon check box.
   - To display the object as its content, disable the Display As Icon check box.

For information, refer to Viewing OLE Objects, page 328.

7. Click OK.
   - If you enabled the Display As Icon check box, AppXtender starts the source application.
   - If you disabled the Display As Icon check box, the source application menus replace the AppXtender menus.

8. Complete the ActiveX object and return to the AppXtender Document Display view.
   - If you are editing the object in the source application, select Close & Return from the File menu.
   - If you are editing the object in AppXtender, select Close from the File menu.

   AppXtender displays the object as a new page in the Document Display view.

For more information, see:
   - Adding a Page by Inserting an Object, page 343

Insert Object from File

To add a page as an object from an existing file:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.

2. From the Page menu, select New and then Insert Object. A shortcut menu appears.
3. You have the following choices:
   • If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   • If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   • If you want the new page to be added as the last page in the document, select Append.

An Insert Object dialog box appears, listing all ActiveX server applications on the workstation.

4. Select Create from File to insert the contents of a file into the AppXtender document.

**Figure 160. Insert Object Dialog Box**

5. Enter the path and file name to insert, or click Browse to find the file.

6. Indicate how you want the new page to be displayed and edited. You have the following choices:
   • To display the object as an icon, enable the Display As Icon check box.
   • To display the object as its content, disable the Display As Icon check box.

For information, refer to Viewing OLE Objects, page 328.

7. Click OK.
   • If you enabled the Display As Icon check box, AppXtender starts the source application.
   • If you disabled the Display As Icon check box, the source application menus replace the AppXtender menus.

8. Edit the ActiveX object (if necessary) and return to the AppXtender Document Display view.
   • If you are editing the object in the source application, select Close & Return from the File menu.
   • If you are editing the object in AppXtender, select Close from the File menu.

AppXtender displays the object as a new page in the Document Display view.
Adding a Page by Importing a File

You can create a new page by importing an existing file. You can import any file type. Your ability to view the resulting page depends on the type of file you have imported. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to Support for Viewing of Imported Files in AppXtender, page 167.

To add a page by importing a file:

1. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.

2. From the Page menu, select New and then Import File. A shortcut menu appears.

3. You have the following choices:
   - If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   - If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   - If you want the new page to be added as the last page in the document, select Append.

The Import File dialog box appears, allowing selection of any file.

Figure 161. Import File Dialog Box

4. Navigate to and select the file that you want to import and click Open. AppXtender displays the new page in the Document Display view.
Adding a Page by Dragging a File

You can create a new page by dragging a file from another program, such as Microsoft Outlook, Microsoft Word, or Windows Explorer. You can drag any file type into AppXtender. Your ability to view the resulting page depends on the type of file you have imported. If AppXtender supports the file type that you import, the content of the file appears in the Document Display view. Unsupported file types, or foreign file types, are represented in the Document Display view by an icon (unless the KeyView Viewer is enabled). AppXtender stores foreign file types in their native file format. For more information, refer to Support for Viewing of Imported Files in AppXtender, page 167.

To add a new page by dragging a file:
1. Make sure that the appropriate document is currently displayed. For instructions, refer to Displaying AppXtender Documents, page 267.
2. Drag the file from Windows Explorer and drop it in the AppXtender Document Display view. AppXtender adds the page before the currently displayed page, and the new page appears in the Document Display view.

For more information, see:
• Adding Pages to Documents, page 340

Adding a Page from the Fax-in Queue

This topic describes the addition of a single page by fax-in queue.

To add a page by fax-in queue:
1. Make sure that the appropriate document is currently displayed.
2. From the Page menu, select New and then Fax-in Queue. A shortcut menu appears.
3. You have the following choices:
   • If you want the new page to be added as the next page in the document (after the currently displayed page), select Insert After.
   • If you want the new page to be added as the previous page in the document (before the currently displayed page), select Insert Before.
   • If you want the new page to be added as the last page in the document, select Append.
4. If the Login to Fax Server dialog box appears, enter the name of the fax server, your user name, and your password.
5. If you are using Castelle FAX Press for your Fax In Server, you have the following choices:
   - If you want to import faxes from your personal queue, enable the Import from personal queue check box.
   - If you want to import faxes from the unassigned queue, disable the Import from personal queue check box.

   **Note:** The Import from personal queue check box does not appear on the Login to Fax Server dialog box if you are using RightFax for your fax-in server.

6. Click Login. The FAX Server Import dialog box appears, listing each of the incoming faxes from the selected queue (personal or unassigned).

**Figure 163. FAX Server Import Dialog Box**

<table>
<thead>
<tr>
<th>Date</th>
<th>Pages</th>
<th>In/Out</th>
<th>Fax Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>2</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>3</td>
<td>IN</td>
<td>OK</td>
</tr>
<tr>
<td>1/4/2001</td>
<td>1</td>
<td>IN</td>
<td>OK</td>
</tr>
</tbody>
</table>

**Note:** If you are using RightFax for your fax-in server, you can customize the way columns display in the FAX Server Import dialog box. Customizable options include column title, column order, which columns appear, and the type of faxes that appear. For more information, see
Fax-in Tab, page 147 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

7. If you want to preview faxes in the list, click the Preview check box. The faxes in the currently selected queue appear in AppXtender. Use the Prev and Next buttons to navigate through the fax-in queue, page by page.

8. If you want to delete a fax, select the fax that you want to delete and click Delete.

9. If you do not want the selected fax to be deleted after you import it, click the Delete after import option to disable the option.

10. If you want to copy the fax’s index information to replace the index information for the document to which you are adding the page, right-click on the fax. From the shortcut menu that appears, select Copy.

   Note: In order to copy and paste index information, the columns in the FAX Server Import dialog box must have the same labels and appear in the same order as the fields in the Index view once the fax has been imported.


For more information, see:
• Adding Pages to Documents, page 340

Replacing Pages

AppXtender can replace an unwanted page with a new page in one function. Separate add and delete commands are not necessary.

To replace a page:

1. Display the page that you want to replace.

2. From the Page menu, select Replace and then the appropriate source for adding the new page. A message appears requesting confirmation that you want to proceed with the page replacement.

   Figure 164. Replace Page Confirmation Message

   ![Replace Page Confirmation Message]

3. Click Yes. AppXtender automatically deletes the displayed page. Depending on the type of page you selected, a dialog box may appear, just as if you were simply adding a page. For instructions, refer to Adding Pages to Documents, page 340
Reordering Pages

To reorder document pages:
1. Display a page in the Document Display view.
2. Select Page > Reorder and then select the new page location from the shortcut menu.

Page Versions

Document Manager allows you to save up to 255 versions of a single document page.

To create a new page version:
1. Display the original page.
2. Select Page > New Version and then select a method for creating the new page version:
   - Select Insert Object to add or create an object.
   - Select Import File to import an existing file.
   - Select Fax-in Queue to add a fax file.
   - Select Current View to add the currently displayed image as a new version. This option allows for greater flexibility when processing images or PDF pages. For example, use this option to save a rotated image as a new version of the original image.

   Note: Document Manager saves annotations that you added to the new image. Document Manager stores the new image or PDF page as a TIFF file if your Image Storage Format settings are set to Default.

Refer to the following topics for more information on managing page versions:
- Viewing Versions of a Page, page 300
- Deleting Versions, page 400
- Purging Versions, page 400

Modifying Document Indexes

Index information is used to identify and organize documents. Data in a document's index may require modification if a data entry error occurred or if the index information changes. You can modify indexes in the AppXtender Document Index view.

If the index to be modified utilizes the Key Reference feature, changing the data changes the underlying index record in the Key Reference table. If the field where the modification occurs is a data field, the modification is automatically reflected in the indexes for any documents indexed with the same key field value as the active document. If the key field value is modified, the change affects only the key field value for the current document.

To modify a document's index:
1. Display the document that you want to modify.
2. From the View menu, select Document Index and a location for the view to appear relative to the Document Display view (Left, Right, Top, or Bottom). The Document Index view appears.

Figure 165. Index View

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCOUNT#</td>
<td>925598</td>
</tr>
<tr>
<td>MEMBER NAME</td>
<td>SIMON SHIF</td>
</tr>
<tr>
<td>SSN</td>
<td>243-15-4308</td>
</tr>
<tr>
<td>DOC TYPE</td>
<td>STM</td>
</tr>
<tr>
<td>DATE</td>
<td>01 FEB 97</td>
</tr>
</tbody>
</table>

3. Edit the contents of the desired index fields.
4. Click Save. The changes to the document index are saved.

For more information, see:
- Chapter 7, Managing Documents

### Applying Digital Signatures

If digital signatures have been enabled for an AppXtender application, you can electronically sign any page version in that application. Like a written signature, the purpose of a digital signature is to guarantee that the individual signing the page really is who he or she claims to be and that the document has not changed since the date of the signature. When a page of a document is signed, the signature is applied to the BIN file for the currently displayed version of the page.

For information on digital signature configuration, refer to your AppXtender system administrator or refer to the ApplicationXtender Installation Guide.

**To sign a page version:**

1. Display the page version that you want to sign. If it has not already been signed, the icon on the right end of the AppXtender status bar indicates that the page version security is invalid.

   Figure 166. Page Security Invalid Icon

2. From the Page menu, select Apply Digital Signature. (If a signature already exists for the displayed page, a message asks whether you want to apply another signature. Click Yes.) Depending on your workstation configuration, the Signature Properties dialog box may appear.
Managing Documents

Figure 167. Signature Properties Dialog Box

3. If a default certificate has not been designated, you can select a certificate.

4. If a default comment has not been provided, you can enter a comment so that others may later understand why you are signing this page at this time.

5. Click OK. Depending on the configuration of the selected certificate, you may be asked to provide a password.

Figure 168. Signing Data with Key Dialog Box

6. Enter your password and click OK.

When the process of applying a signature is complete, the icon on the right end of the AppXtender status bar indicates that the page version has been secured.
Viewing Signature History

You can view the history of signatures for a page version.

To view signature history:

1. Display the page version for which you want to view the signature history.
2. From the Page menu, select Signature History. The Signature History dialog box appears, listing the date, user name, computer name, and comment for each signature.

Applying IRM Protection to ApplicationXtender Content

If OpenText Documentum ApplicationXtender with Information Rights Management (ApplicationXtender with IRM) is enabled for the AppXtender application from which you want to email or export content, you can apply IRM protection to the content during the email or export process. You apply protection to content, either documents or selected document pages, by assigning an IRM Document Policy template to the documents or pages from within ApplicationXtender. The Document Policy template specifies who can access the protected content, the actions they can perform on it, and how long they can access it.

If the Administrator has configured mandatory IRM protection for an ApplicationXtender application, you must apply an IRM policy to the content before emailing or exporting it. In addition, you cannot perform the following tasks for such applications:

- Display content using the native viewer. If Document Manager is configured to display documents in the native viewer rather than using KeyView, enable the Use KeyView to display foreign files option in the View tab of the Configuration dialog box.
- Export or email content that cannot be protected such as multimedia and .zip files.

When you email or export IRM-protected ApplicationXtender content, ApplicationXtender overrides the default settings defined on the E-Mail or Export tab of the Configuration dialog box, respectively. For example, if you apply IRM protection to a document in a format that can be converted to PDF
such as TIFF, ApplicationXtender automatically converts the protected document to PDF regardless of whether the **Use PDF format if possible** option is enabled on the E-Mail or Export configuration tab.

If the ApplicationXtender document you are emailing or exporting contains pages in different formats, for example, .doc and .pdf, ApplicationXtender Document Manager creates a protected file for each format.

Refer to **E-Mailing Documents and Pages**, page 362 or **Exporting Documents and Pages**, page 370 for procedures on emailing or exporting ApplicationXtender documents and pages, including IRM-protected content. Refer to **Specifying IRM Options**, page 354 for procedures on using the Select Policy dialog box to apply IRM protection to ApplicationXtender content.

## Specifying IRM Options

You specify IRM options for the document or document page(s) that you are exporting or emailing using the Select Policy dialog box. IRM options include the IRM policy template to be applied to the content as well as the recipient(s) of the protected content. Recipients are users and/or groups created by an Administrator on the IRM Server. Because recipients access the IRM-protected content using a Documentum IRM client, either IRM Client for Microsoft Office or IRM Client for Adobe Acrobat, they do not have to be AppXtender users. When you apply IRM protection to a document, ApplicationXtender saves the name of the selected policy. The next time you apply IRM protection to a document in the same application/data source, the previously chosen policy is selected on the Select Policy dialog box by default.

**To specify IRM options:**

1. In Policy, select the IRM policy template that you want to apply to the document or document page(s) that you are exporting or emailing.
2. In Authorized Users and Groups, select one or more recipient(s) from the list of users and/or groups who are authorized to receive IRM-protected content. All user and group names that have the permissions defined in the policy template are selected initially. You can deselect these users and groups, as appropriate.
3. Click **OK**.

## Printing or Faxing Documents and Pages

AppXtender allows you to print or fax documents, pages, or regions of an image. For information, refer to the following topics:

- **Printing or Faxing Documents**, page 355
- **Printing or Faxing Pages**, page 359
- **Printing or Faxing a Region**, page 361
- **Changing AppXtender Printer Fonts**, page 361

**Note:** AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.
Note: Only users with the Print privilege can perform operations that result in information being exported from the AppXtender system. These operations include printing or faxing documents and pages. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: For information on configuring print options, see Print Tab, page 121 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Printing or Faxing Documents

There are three ways to print or fax a document in AppXtender: from the Result Set tab, from the Document menu, or from the Main toolbar. When printing or faxing from the Document menu or toolbar, the document must be displayed first. The Result Set tab allows you to print or fax without displaying the document.

Documents can be faxed directly from AppXtender using standard Windows fax devices like fax servers and local fax hardware and software. Any fax device installed as a standard printer port can be used to fax AppXtender documents. If your fax device is listed in the Name drop-down list on a standard Print dialog box, you can fax AppXtender documents to it. The method to fax documents is similar to printing, except that AppXtender starts your fax software application and allows you to enter identifying information for the fax destination (such as phone number, name, and so on).

You can add an identifying text string called an endorsement to documents that you print or fax in AppXtender. You can configure endorsements to print in one of the four corners of the document.

For information, refer to the following topics:
- Printing or Faxing from the Result Set, page 355
- Printing or Faxing a Displayed Document, page 357
- Endorsing Printed or Faxed Pages, page 359

Printing or Faxing from the Result Set

Documents listed in the Result Set can be printed or faxed without first being displayed.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a document from the Result Set:

1. Select the document or documents to be printed or faxed on the Result Set tab, and right-click your selection.
2. From the shortcut menu that appears, select Print.
3. If the Reason Code Required dialog box appears, enter a comment in the text box and click OK. (The appropriate task option check box is selected automatically and cannot be cleared.)
Figure 170. Reason Code Required Dialog Box

The standard Windows Print dialog box appears.

Figure 171. Print Dialog Box

4. Choose the printer or fax device from the Name list and the number of copies you want.

5. Specify the pages to be printed or faxed. You have the following choices:
   - To print or fax all pages of each selected document, under Print Range, select All.
   - To specify page ranges or individual pages of each selected document, under Print Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to
indicate a page range. For example, to print or fax pages 2, 3, 4, and 7 of a document, type “2-4, 7” in the text box.

If a selected page contains subpages, every subpage in that page is printed or faxed.

6. If you do not want the AppXtender annotations to be included on the documents that you are printing or faxing, click the Hide annotations check box.

**Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

7. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

8. Click OK. The selected documents are sent to the printer or fax device and a message appears, containing the status of the operation. This message is displayed until all pages of all documents have been sent to the printer or fax device. Click Cancel at any time to cancel the print or fax operation. (If you selected a fax device, AppXtender starts your fax software, so that you can enter information to complete the fax operation.)

For more information, see:

- Printing or Faxing Documents, page 355

## Printing or Faxing a Displayed Document

You can choose to print or fax every page or a range of pages of the displayed document using the Document menu or the Print toolbar button.

**Note:** If a PDF document does not contain annotations, the Print PDF Document command may provide better performance than the regular Print command. However, if any page or version of the document is a file type other than PDF, you must use the regular Print command to print or fax the document.

**Note:** AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

**To print or fax a displayed document:**

1. Display the document that you want to print or fax.
2. From the Document menu, select Print or Print PDF Document. The standard Windows Print dialog box appears.
3. Select the printer or fax device from the Name list and the number of copies you want.

4. Specify the pages to be printed or faxed. You have the following choices:
   - To print or fax all pages of the displayed document, under Print Range, select All.
   - To specify page ranges or individual pages of the displayed document, under Print Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to print or fax pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

   If a selected page contains subpages, every subpage in that page is printed or faxed.

5. If you do not want AppXtender annotations to be included on the documents you are printing or faxing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

6. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. (This option is not available when using the Print PDF Document command.) The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

7. Click OK. The selected pages of the displayed document are sent to the printer or fax device. If the Print PDF Document command was used and if the document contains annotations, each page of the document is converted to an image with the annotations before printing or faxing. A message appears containing the status of the print or fax operation. This message is displayed until all pages of the document have been sent to the printer or fax device. Click Cancel at any time to cancel the operation.
Managing Documents

**Note:** The Print button on the Main toolbar can be configured to print or fax either the currently displayed document or the currently displayed page. It can also be configured to open the standard Windows Print dialog box for the currently displayed page so that you can select what you want to print or fax. This option appears on the Print tab of the Configuration dialog box. For more information, see Print Tab, page 121 consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

For more information, see:
- Printing or Faxing Documents, page 355

**Endorsing Printed or Faxed Pages**

This feature allows users to print or fax documents with an identifying text message in one corner. You can print or fax up to 10 lines of text, with up to 80 characters per line. Endorsements print on all pages as long as the option is enabled. This feature can be configured on the Print tab of the Configuration dialog box. For more information, see Print Tab, page 121 consult your system administrator or refer to the "Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

**Note:** Endorsements cannot be printed or faxed for HTML documents.

For more information, see:
- Printing or Faxing Documents, page 355

**Printing or Faxing Pages**

You can print or fax a displayed page using the Page menu or the Print toolbar button.

**Note:** If a PDF page does not contain annotations, the Print PDF Page command may provide better performance than the regular Print command. However, if the page is not in PDF format, the Print PDF Page command is not available.

**Note:** AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

**To print or fax a page:**

1. Within AppXtender, display the desired page.
2. From the Page menu, select Print or Print PDF Page. The standard Windows Print dialog box appears.
Managing Documents

Figure 173. Print Dialog Box

3. If the Print dialog box appears, select the printer or fax device from the Name drop-down list and the number of copies you want.

4. If the displayed page contains subpages, you have the following choices:
   - To print or fax all subpages of the displayed page, under Print Range, select All.
   - To specify a range of subpages or individual subpages of the displayed page, under Print Range, select Pages and type comma-delimited subpage numbers in the text box. Use a dash to indicate a range. For example, to print or fax subpages 2, 3, 4, and 7 of a page, type "2-4, 7" in the text box.
   - To print or fax only the currently displayed subpage, under Print Range, select Selection.

5. If you do not want AppXtender annotations to be included on the documents you are printing or faxing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

6. If you want to print or fax the text of text annotations displayed as icons on a separate page, click Print text note. (This option is not available when using the Print PDF Page command.) The document prints or faxes along with a separate page containing the text from the annotations displayed as icons.

7. Click OK. The displayed page is printed or faxed. If the Print PDF Page command was used and if the page contains annotations, the page is converted to an image with the annotations before printing or faxing.

   The printing message box appears with the status of the job. Click Cancel to quit the job at any time.
Note: The Print button can be configured to print or fax either the currently displayed document or the currently displayed page. It can also be configured to open the standard Windows Print dialog box for the currently displayed page so that you can select what you want to print or fax. This option appears on the Print tab of the Configuration dialog box. For more information, see Print Tab, page 121 consult your system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

For more information, see:
• Printing or Faxing Documents and Pages, page 354

Printing or Faxing a Region

You can print or fax a specific region of an AppXtender page.

Note: AppXtender uses Windows print drivers to perform faxing operations. In order to fax pages in AppXtender, you must install Windows-compliant fax software.

To print or fax a region:
1. Make sure that Pan Mode is disabled. For information, refer to Document Display View, page 69.
2. Drag the pointer over the region that you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.
3. Right-click the highlighted region.
4. From the shortcut menu that appears, select Print. The image in the selected region is sent to the workstation's default printer (which may actually be a fax device).

For more information on using regions, refer to Using Regions, page 313.

For more information, see:
• Printing or Faxing Documents and Pages, page 354

Changing AppXtender Printer Fonts

You can set the font for printing or faxing text pages. Various font types, font styles, and font sizes are available when printing or faxing text pages. Each workstation can configure a different font setting. Fonts can be set for text pages, text form overlays, and fixed and variable font sizes.

To set the print fonts:
1. From the File menu, select Configuration to open the AppXtender Configuration dialog box.
2. Click the Fonts tab to activate it.
3. Select the font to configure from the Printer Fonts list, and then click Change.
4. Select the appropriate font and style.
5. Click OK to save the settings.

Note: For more information on configuring the Fonts tab, refer to Fonts Tab, page 112.
For more information, see:
- Printing or Faxing Documents and Pages, page 354

**E-Mailing Documents and Pages**

You can e-mail multiple AppXtender documents, an individual AppXtender document, an AppXtender document reference, or a specific AppXtender page. You can e-mail an AppXtender page or document to anyone, even if the recipient does not have AppXtender.

**Note:** Only authorized users can access IRM-protected AppXtender content. Refer to **Applying IRM Protection to ApplicationXtender Content, page 353** for additional information.

Depending on the number of pages in the document, e-mailing an entire document may consume valuable time and space. Two available alternatives are document references and combining pages.

For more information, refer to the following topics:
- E-Mailing from the Result Set, page 362
- E-Mailing Displayed Documents, page 365
- E-Mailing Document References, page 367
- E-Mailing Pages, page 369

For information on configuring AppXtender to combine pages for e-mail, see **E-Mail Tab, page 124** consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the **ApplicationXtender Installation Guide**.

**Note:** To e-mail documents, document references, or pages, you must have the Add Page privilege in your user profile. Also, only users with the Print privilege can perform e-mail functions that result in information being exported from AppXtender. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the **ApplicationXtender Core Components Administrator's Guide**.

If ApplicationXtender with IRM is enabled for the AppXtender application from which you want to e-mail content, you can apply IRM protection to any e-mailed document or page that is in a supported format. Refer to **Applying IRM Protection to ApplicationXtender Content, page 353** for additional information.

**E-Mailing from the Result Set**

You can send multiple AppXtender documents through electronic mail. The delivered mail message contains each page as an attachment.

There are two ways to send a document by e-mail. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files sent. These files can then be opened in any application that supports the file type. For more information on the Use multi-page files option, see **E-Mail Tab, page 124** consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the **ApplicationXtender Installation Guide**.
When AppXtender documents are e-mailed, the recipient does not have to be an AppXtender user. Documents are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, see E-Mail Tab, page 124 consult your AppXtender system administrator or refer to the “Configuring ApplicationXtender Workstations” section of the ApplicationXtender Installation Guide.

Note: When you e-mail IRM-protected ApplicationXtender content, ApplicationXtender overrides the default e-mail settings defined on the E-Mail configuration tab. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

To e-mail an AppXtender document:

1. Select the document or documents to be mailed on the Result Set tab, and right-click your selection.

2. From the shortcut menu that appears, select Mail. The E-mail Document Pages dialog box appears.

Figure 174. E-mail Document Pages Dialog Box

3. Specify the pages to be mailed. You have the following choices:
   - To mail all pages of each selected document, under Page Range, select All Pages.
   - To specify page ranges or individual pages of each selected document, under Page Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to indicate a page range. For example, to mail pages 2, 3, 4, and 7 of a document, type “2-4, 7” in the text box.

   If a selected page contains subpages, every subpage in that page is mailed.

4. If you do not want the AppXtender annotations to be included on the documents that you are mailing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

5. If you want to apply IRM protection to the document page(s) you are e-mailing, click the **Restrict access to sensitive information** check box. This check box appears only if ApplicationXtender with IRM is configured for the current application.
Note: IfIRM protection is *required* for the current application, this check box is already selected and you cannot deselect it. In this case, you *must* apply an IRM policy to the content before e-mailing it.

6. Click **OK**. If the **Restrict access to sensitive information** check box described in Step 5 is selected, the Select Policy dialog box appears.

   Complete the options on the Select Policy dialog box using the procedures in **Specifying IRM Options**, page 354, if necessary, then click **OK**.

7. If the Reason Code Required dialog box appears, enter a comment in the text box and click **OK**. (The appropriate task option check box is selected automatically and cannot be cleared.)

   AppXtender displays the processing request message for each document and then a mail dialog box corresponding to your e-mail system appears.

**Figure 175. Mail Message with AppXtender Document Attachments**

Note that the name of each attachment corresponds to the text that appears in the Document Display view title bar when the page is displayed. For more information on configuring the title bar, refer to **Configuring the Title Bar**, page 91.

Also note that all specified pages are attached to the message. If the Use multi-page files option is enabled, however, certain files are combined into one file. For more information on which file types are combined, **E-Mail Tab**, page 124consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

8. If you want to reduce the size of the message, you can delete attachments, leaving behind only the pages that you want to send.

9. Address the message to the desired user.
10. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachments, provided the appropriate application for opening the attached file has been installed.

   **Note:** Only authorized users can access IRM-protected AppXtender content. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

For more information, see:
- E-Mailing Documents and Pages, page 362

**E-Mailing Displayed Documents**

You can route entire documents to other AppXtender users through electronic mail. The delivered mail message contains the document as a set of attachments.

There are two ways to send a document by e-mail. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files sent. These files can then be opened in any application that supports the file type. For more information on the Use multi-page files option, see E-Mail Tab, page 124 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Depending on the number of pages in the document, you can also save valuable time and space by sending a document reference. For more information, refer to E-Mailing Document References, page 367.

When AppXtender documents are e-mailed, the recipient does not have to be an AppXtender user. Documents are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, see E-Mail Tab, page 124 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** When you e-mail IRM-protected ApplicationXtender content, ApplicationXtender overrides the default e-mail settings defined on the E-Mail configuration tab. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for more information.

**To e-mail an AppXtender document:**

1. Perform a query and display the document to be mailed.
2. From the Document menu, select Mail Document Pages. The E-mail Document Pages dialog box appears.
3. Specify the pages to be mailed. You have the following choices:
   • To mail all pages of each selected document, under Page Range, select All Pages.
   • To specify page ranges or individual pages of each selected document, under Page Range, select Pages and type comma-delimited page numbers in the Range text box. Use a dash to indicate a page range. For example, to mail pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.

   If a selected page contains subpages, every subpage in that page is mailed.

4. If you do not want the AppXtender annotations to be included on the documents that you are mailing, click the Hide annotations check box.

   Note: The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

5. If you want to apply IRM protection to the document page(s) you are e-mailing, click the **Restrict access to sensitive information** check box. This check box appears only if ApplicationXtender with IRM is configured for the current application.

   Note: If IRM protection is required for the current application, this check box is already selected and you cannot deselect it. In this case, you must apply an IRM policy to the content before e-mailing it.

6. Click OK. If the **Restrict access to sensitive information** check box described in Step 5 is selected, the Select Policy dialog box appears.

   Complete the options on the Select Policy dialog box using the procedures in **Specifying IRM Options**, page 354, if necessary, then click OK.

7. AppXtender displays the processing request message for each document and then a mail dialog box corresponding to your e-mail system appears.
Note that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to Configuring the Title Bar, page 91.

Also note that all specified pages of the document are attached to the message. If the Use multi-page files option is enabled, however, certain files are combined into one file. For more information on which file types are combined, see E-Mail Tab, page 124 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

8. If you want to reduce the size of the message, you can delete attachments, leaving behind only the pages that you want to send.

9. Address the message to the desired user.

10. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachments, provided the appropriate application for opening the attached file has been installed.

   Note: Only authorized users can access IRM-protected AppXtender content. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

For more information, see:
• E-Mailing Documents and Pages, page 362

E-Mailing Document References

AppXtender allows you to route document references to other AppXtender users through electronic mail. The delivered mail message contains an icon representing the sent information. The recipient double-clicks on that icon to display the documents in AppXtender.
Managing Documents

The following requirements apply when e-mailing a document reference:
• The recipient must be using AppXtender.
• The recipient must have access to the same AppXtender database as the sender.
• The data source accessing that database must have the same name on the recipient’s workstation as it is on the sender’s workstation.
• The recipient must have access to the same document storage location as the sender.

To e-mail an AppXtender document reference to another AppXtender user:
1. Display the document to be mailed.
2. From the Document menu, select Mail Reference. A mail dialog box corresponding to your e-mail system appears.

Figure 178. Mail Message with AppXtender Document Reference Attachment

![Mail Message with AppXtender Document Reference Attachment]

Notice that the message contains an icon representing the AppXtender document and that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to Configuring the Title Bar, page 91.

3. Address the message to the desired user.
4. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can double-click the icon to display the document in AppXtender.
For more information, see:

- E-Mailing Documents and Pages, page 362

**E-Mailing Pages**

AppXtender pages can be routed to other users through electronic mail. When AppXtender pages are e-mailed, the recipient does not have to be an AppXtender user. Pages are sent in the format selected in the E-Mail tab of the Configuration dialog box. For information on selecting a format, see E-Mail Tab, page 124, consult your AppXtender system administrator, or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** When you e-mail IRM-protected ApplicationXtender content, ApplicationXtender overrides the default e-mail settings defined on the E-Mail configuration tab. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for more information.

**To send an AppXtender page to another user via e-mail:**

1. Display the page to be mailed.

2. From the Page menu, select Mail. Then do one of the following:
   - If IRM protection is optional for the current application, an E-mail Page dialog box appears Figure 179, page 369. Continue to Step 3
   - If IRM protection is required for the current application, the Select Policy dialog box appears. Continue to Step 4.
   - If IRM is disabled for the current application, skip to Step 5.

**Figure 179. E-mail Page dialog box**

3. Click the **Restrict access to sensitive information** check box if you want to apply IRM protection to the page you are e-mailing, then click OK. The Select Policy dialog box appears.

   **Note:** If the Administrator has configured mandatory IRM protection for an ApplicationXtender application, you must apply an IRM policy to the content before e-mailing it.

4. Complete the options on the Select Policy dialog box using the procedures in Specifying IRM Options, page 354, if necessary.

5. A dialog box corresponding to your e-mail system appears.
Notice that the AppXtender page appears as an icon in the mail message window and that the subject of the message corresponds to the Document Display view title bar. For more information on configuring the title bar, refer to Configuring the Title Bar, page 91.

6. Address the mail to the desired user.

7. Complete the message by adding any other comments, and send it using your e-mail program’s Send command. When the user receives the message, he or she can open the attachment, provided the appropriate application for opening the attached file has been installed.

   Note: Only authorized users can access IRM-protected AppXtender content. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

For more information, see:
• E-Mailing Documents and Pages, page 362

Exporting Documents and Pages

You can export an entire AppXtender document or a specific AppXtender page to any available file location. For more information, refer to the following topics:
• Exporting Displayed Documents, page 371
• Exporting Documents from the Result Set, page 375
• Exporting Pages, page 378

Depending on the number of pages in the document, exporting an entire document may consume valuable time and space. An alternative is combining pages and exporting them as a single file.
using the Use multi-page files option on the Export tab of the Configuration dialog box. For more information, see Export Tab, page 129 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** Only users with the Print privilege can perform operations that result in information exported from the AppXtender system. These operations include exporting documents, pages, and COLD/ERM. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

If ApplicationXtender with IRM is enabled for the AppXtender application from which you want to export content, you can apply IRM protection to any exported document or page that is in a supported format.

### Exporting Displayed Documents

AppXtender makes documents available to other software applications through the Export feature on the Document menu. The document to export must be displayed to begin the procedure.

**Note:** Document pages containing embedded objects cannot be exported. You may be able to use Save As in the native application to export the contents of the document page.

For more information, refer to the following topics:
- Exporting a Displayed Document to a File, page 371
- Exporting a Displayed Document to an XPS File, page 374
- Exporting OCR Output from a Displayed Document, page 374

### Exporting a Displayed Document to a File

There are two ways to export a document. One method creates as many files as there are pages in the document, each file containing a single page of the document. The other method, using multi-page files, combines sequential pages of the same page type, reducing the number of files exported. These files can then be opened in any application that supports the file type of the exported file. For more information on the Use multi-page files option, see Export Tab, page 129 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

When documents are exported, AppXtender adds a page number representation to the end of whatever file name is specified. If, for example, the name of the file to be exported is TEST.BMP, the first page of the exported document is TEST-P0001.BMP, the second page TEST-P0002.BMP, etc. If pages are compressed with the Use multi-page file option, the new format is TEST-P0001 - P0002.TIF.

When a document containing subpages is exported, the subpages for each page are consolidated into one page.

Document pages are exported in the file formats specified in the Export tab of the AppXtender Configuration dialog box. For information on configuring the exported file formats, see Export Tab, page 129 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.
Managing Documents

**Note:** When you export IRM-protected ApplicationXtender content, ApplicationXtender overrides the default export settings defined on the Export configuration tab. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

To export an AppXtender document to a file:

1. Perform a query and display the document you want to export.
2. From the Document menu, select Export and then Images. An Export Document Pages dialog box appears.

**Figure 181. Export Document Pages Dialog Box**

![Export Document Pages Dialog Box](image)

3. Enter the name and path of the files to be exported.
4. Specify the pages to be exported. You have the following choices:
   - To export all pages of the document, under Page Range, select All Pages.
   - To specify page ranges or individual pages, under Page Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to export pages 2, 3, 4, and 7 of a document, type "2-4, 7" in the text box.
If a selected page contains subpages, every subpage in that page is exported.

5. If you do not want AppXtender annotations to be included on the documents you are exporting, click the Hide annotations check box.

**Note:** The availability of the Hide annotations option depends on your user profile. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.

6. If you want to apply IRM protection to the documents you are exporting, click the **Restrict access to sensitive information** check box. This check box appears only if ApplicationXtender with IRM is configured for the current application.

**Note:** If IRM protection is required for the current application, this check box is already selected and you cannot deselect it. In this case, you **must** apply an IRM policy to the content before exporting it.

7. Click **Save**. If the **Restrict access to sensitive information** check box described in Step 6 is selected, the Select Policy dialog box appears. Complete the options on this dialog box using the procedures in **Specifying IRM Options**, page 354, if necessary, then click **OK**. The document is exported. If IRM protection was applied, a protected version of the document is exported.

**Note:** If the Use multi-page files option is enabled, certain files are combined into one file. For more information on which file types are combined, see **Export Tab**, page 129 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

8. When AppXtender has finished exporting the documents, you can look in Windows Explorer to view the exported files.

**Figure 182. Windows Explorer with Sample Exported Document**
For more information, see:
- Exporting Displayed Documents, page 371

Exporting a Displayed Document to an XPS File

AppXtender allows you to export a displayed document to an XPS file by using the Microsoft XPS Document Writer to print the document.

To print a displayed document to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to Printing or Faxing a Displayed Document, page 357 for more information.

**Note:** Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.

Exporting OCR Output from a Displayed Document

You can export the displayed document to Text using AppXtender’s optical character recognition (OCR) feature.

When documents are exported, AppXtender adds a page number representation to the end of whatever file name is specified. If, for example, the name of the file to be exported is TEST.TXT, the first page of the exported document is TEST-P0001.TXT, the second page TEST-P0002.TXT, etc. The Use multi-page files option does not combine pages exported and processed using OCR.

AppXtender uses OCR to process the displayed document pages and exports them to Text.

**Note:** This feature is available for both bi-tonal (black and white) and color images.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to Using Rotate, page 310.

**Note:** To improve the OCR output, consider enhancing images before exporting. For more information, refer to Chapter 10, Image Enhancement.

To process (using OCR) and export the displayed document:

1. From the Document menu, select Export and then OCR. An OCR Export Document Pages dialog box appears.
2. Enter the name and path for the files to be exported. Choose the desired file type from the Save as type drop-down list. The only available option is Text Document.

3. From the Language drop-down list, select the language that is most appropriate for the document that you are exporting.

4. Specify the pages to be exported. You have the following choices:
   - To export all pages of the document, under Page Range, select All Pages.
   - To specify page ranges or individual pages, under Page Range, select Pages and type comma-delimited page numbers in the text box. Use a dash to indicate a page range. For example, to export pages 2, 3, 4, and 7 of a document, type “2-4, 7” in the text box.

   If a selected page contains subpages, every subpage in that page is exported.

5. Click Save.

For more information, see:
- Exporting Displayed Documents, page 371

### Exporting Documents from the Result Set

Multiple text and PDF documents can be exported from the AppXtender Result Set to a single text or PDF document. When exporting multiple documents, AppXtender adds a page break to the end of each document. The documents are exported in the default format selected in the Export COLD Document Pages(s) dialog box.
Managing Documents

Note: This procedure applies only to text and PDF documents, including documents created by CX and AppXtender Reports Mgmt.

To export text/PDF documents to a file:

1. Perform a query to find the desired text or PDF files. AppXtender displays the results of the search in the Result Set tab. Highlight the documents to include in the export to a single document.

2. Right-click the selected documents in the Result Set.

3. From the shortcut menu that appears, select Export COLD Document(s). AppXtender displays the processing request message and then the Export COLD Document Page(s) dialog box appears.

Figure 184. Export COLD Document Page(s) Dialog Box

4. Enter a name for the new text or PDF document.

5. From the Files of type drop-down list, select the default file format. You have the following options:
   • Text Files
   • PDF Files
   • COLD Files

   Note: If both PDF and TXT files are selected from the result set, selecting COLD Files from the Save as type drop-down list will tell the system to take the first document in the selected files and only export that file type, either PDF or TXT respectively.

6. Click Save.

7. If the Reason Code Required dialog box appears, enter a comment in the text box and click OK. (The appropriate task option check box is selected automatically and cannot be cleared.)
Figure 185. Reason Code Required Dialog Box

All selected documents in the result set are exported as a single document with the selected file name. A message appears indicating that the export request is being processed.

8. When AppXtender has finished exporting the document, you can look in Windows Explorer to view the file.

Figure 186. Windows Explorer with Sample Exported Document

For more information, see:
- Exporting Documents and Pages, page 370

Exporting a Document from the Result Set to an XPS File

AppXtender allows you to export a document from the result set to an XPS file by using the Microsoft XPS Document Writer to print the document.

To print a document from the result set to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to Printing or Faxing from the Result Set, page 355 for more information.
Note: Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.

Exporting Pages

A document page may be useful in another application. Through the Export feature on the Page menu, AppXtender provides two options for exporting AppXtender pages: to a file or to text through optical character recognition (OCR). For more information, refer to the following topics:

- Exporting a Page to a File, page 378
- Exporting a Page to an XPS File, page 380
- Exporting Page OCR Output, page 380

Exporting a Page to a File

Exporting a page to a file creates a single file that can then be opened in any application that supports the file type of the exported file. The page to be exported must be displayed. Pages are exported in the default format selected on the Export tab in the AppXtender Configuration dialog box. For more information, see Export Tab, page 129 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

Note: When you export IRM-protected ApplicationXtender content, ApplicationXtender overrides the default export settings defined on the Export configuration tab. Refer to Applying IRM Protection to ApplicationXtender Content, page 353 for additional information.

Note: You must have the Configure WS privilege to access the Export tab.

When a page containing subpages is exported, the subpages are consolidated into one page.

To export the displayed page to a file:

1. From the Page menu, select Export and then Image. The Export Page dialog box appears.
Figure 187. Export Page Dialog Box

2. Enter the name and path of the file to be exported.

3. If you want to apply IRM protection to the page(s) you are exporting, click the **Restrict access to sensitive information** check box. This check box appears only if ApplicationXtender with IRM is configured for the current application.

   **Note**: If IRM protection is *required* for the current application, this check box is already selected and you cannot deselect it. In this case, you *must* apply an IRM policy to the content before exporting it.

4. Click Save. If the **Restrict access to sensitive information** check box described in **Step 3** is selected, the Select Policy dialog box appears.

   Complete the options on the Select Policy dialog box using the procedures in **Specifying IRM Options**, page 354, if necessary, then click **OK**. The page is exported. If IRM protection was applied, a protected version of the page is exported.
For more information, see:
• Exporting Pages, page 378

Exporting a Page to an XPS File

AppXtender allows you to export a page to an XPS file by using the Microsoft XPS Document Writer to print the page.

To print a page to an XPS file, select Microsoft XPS Document Writer from the Name list box on the Print dialog box. Refer to Printing or Faxing Pages, page 359 for more information.

Note: Contact your system administrator or refer to the Microsoft Web site for more information on generating and viewing XPS files.

Exporting Page OCR Output

You can export the currently displayed page to Text, using AppXtender’s OCR feature. AppXtender processes the displayed page using OCR and exports it to Text.

Note: Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to Using Rotate, page 310.

Note: To improve the OCR output, consider enhancing images before exporting. For more information, refer to Chapter 10, Image Enhancement.

To process (using OCR) and export the displayed page:

1. From the Page menu, select Export and then OCR. The OCR Export Page dialog box appears.

   Figure 188. OCR Export Page Dialog Box
2. Enter the name and path of the file to be exported. Select the desired format from the Save as drop-down list. The only available option is Text Document.

3. From the Language drop-down list, select the language that is most appropriate for the page that you are exporting.

4. Click Save.
   The page is exported.

For more information, see:
• Exporting Pages, page 378

Exporting to an Existing File Name

If you attempt to export an AppXtender document or page using an existing file name, a message appears asking whether you want to replace the existing file. This message might appear several times, once for every file that would be replaced by the export procedure. You have the following choices:
• If you want to replace the specified file, click Yes.
• If you want to allow the export procedure to replace files without prompting you about each one, click Yes to all.
• If you do not want to replace the specified file, click No.
• If you want to cancel the export procedure, click Cancel.

For more information, see:
• Exporting Documents and Pages, page 370

Moving or Copying Document Pages

Document Manager allows you to move or copy document pages from the Document Display view to another application. Document Manager processes the pages as a batch. You must have the Batch Scan privilege for the target application and the Delete Page privilege for the source application to move or copy pages.

Note: ApplicationXtender Document Manager does not support moving or copying pages when an application is writing to Centera.

To move or copy document pages from Document Display view:

1. Display the document in Document Display view.

2. Select Document > Copy or Move Pages from the menu bar. Document Manager displays a view for specifying move or copy options.
3. Specify the pages:
   • To specify a continuous page range, insert a hyphen between the first and last page; for example, 1−4.
   • To specify separate pages, insert a comma between each page; for example, 2,4.

4. To move or copy all versions of the specified pages, select Include page versions. Document Manager moves or copies only the current page versions if you do not select this option.
   
   **Note:** If you move or copy multiple versions of a one-page document, Document Manager converts the page versions to separate pages in the target application.

5. Select the target application.

6. Specify how you want to index the batch:
   • To index the batch immediately after moving or copying the pages, select Index new Batch document.
   • To index the batch from a batch list at a later time, clear Index new Batch document.

7. Specify how Document Manager creates the batch:
   • To move the pages from the source application, click Move.
     
     **Note:** Document Manager does not display the Move button if you do not have the Delete Page privilege for the source application.
   • To leave a copy of the pages in the source application, click Copy.

8. Index the batch. If you did not select Index new Batch document, retrieve the batch from the Batch Index list when you are ready to index the batch. Refer to Batch Indexing from a List, page 215 for more information.

---

### Document and Page OCR

You can use optical character recognition (OCR) to process documents, individual pages, and page regions.

AppXtender supports basic document OCR through its integrated RecoStar OCR engine. Any displayed document image can be processed using OCR to produce a text version of the document.
**Note:** The specific OCR functionality available at each AppXtender Document Manager workstation is set up when the AppXtender system administrator configures the workstation. For information on configuring for OCR, see OCR Tab, page 145 consult your AppXtender system administrator or refer to the ‘Configuring ApplicationXtender Workstations’ section of the ApplicationXtender Installation Guide.

**Note:** Before you process an image with OCR, make sure that the image is oriented correctly. You may need to rotate the image so that it is not upside-down or sideways. For information on rotating an image, refer to Using Rotate, page 310.

**Note:** To improve the OCR performance, consider enhancing images before processing. For more information, refer to Chapter 10, Image Enhancement.

If you use OCR to process a document that has text hidden under a redaction, the hidden text is not included in the text view of the document.

For more information, refer to the following topics:
- Processing a Document Using OCR, page 383
- Processing a Page Using OCR, page 384
- Processing a Region Using OCR, page 386
- Submitting Documents to an OCR Queue, page 386

## Processing a Document Using OCR

AppXtender supports document OCR through its integrated RecoStar OCR engine. All bi-tonal and color image pages in the document are OCR processed. (Other page types are ignored.)

**To OCR an AppXtender document:**

1. Display the document to be processed in Document Display view.
2. To begin processing, from the Document menu, select OCR.

   When OCR processing starts, a small window containing the message "Processing Image..." is displayed. (You can click Cancel at any time to abort the process.)

**Figure 189. OCR Processing Window**
When processing finishes, the OCR processing window closes automatically. In AppXtender Document Manager, Document Display view refreshes to show the text generated during the OCR process. You can use the Show Text button to switch between the text view and the image view of each page in the document. For information, refer to Viewing Image Pages, page 318.

Figure 190. Text View of AppXtender Document After OCR

For more information, see:
- Document and Page OCR, page 382

**Processing a Page Using OCR**

AppXtender supports OCR of individual document pages through its integrated RecoStar OCR engine. Both bi-tonal and color image pages can be OCR processed.

**To process a page with OCR:**

1. Display the page that you want to process.
2. To begin processing, from the Document menu, select OCR.

   When OCR processing starts, a small window containing the message “Processing Image...” is displayed. (You can click Cancel at any time to abort the process.)
When processing finishes, the OCR processing window closes automatically. In AppXtender Document Manager, Document Display view refreshes to show the text page generated during the OCR process. You can use the Show Text button to switch between the text view and the image view of each page in the document. For information, refer to Viewing Image Pages, page 318.
For more information, see:  
• Document and Page OCR, page 382

Processing a Region Using OCR

In addition to using OCR to process a page or an entire document, you can also select a region of a page and OCR only that region.

To process a region using OCR:
1. Make sure that Pan Mode is disabled. For information refer to Document Display View, page 69.
2. Drag the pointer over the region that you want to select. As you drag the pointer, it draws a rectangle and highlights the area within the rectangle in green. This rectangle is the selected region.
3. Right-click the highlighted region.
4. From the shortcut menu that appears, select OCR this Region. The region is processed using OCR. A text editor appears with the results of the OCR.

For more information on using regions, refer to Using Regions, page 313.

For more information, see:  
• Document and Page OCR, page 382

Submitting Documents to an OCR Queue

You can submit a document to an OCR queue. For information on creating an OCR queue in the AppXtender Index Server, or for information on managing queues, refer to the ApplicationXtender Index Server Administrator’s Guide. For information on configuring your workstation to automatically use a particular queue, see OCR Tab, page 145consult your AppXtender system administrator or refer to the ApplicationXtender Installation Guide.

**Note:** Documents in the OCR queue are processed by the OCR engine on the AppXtender Index Server, not the OCR engine on your AppXtender workstation. Therefore, the options under Text View on the OCR tab of the Configuration dialog box do not apply when you submit a document to an OCR queue.

To submit a document to an OCR Queue:
1. Display the document that you want to submit to the OCR queue.
2. From the Document menu, select Submit OCR Job.
3. If the Submit OCR Job dialog box appears, select a queue from the Processing Queue list, select a language from the OCR Language list, and click OK.
Managing Documents

Figure 193. Submit OCR Job Dialog Box

The job is submitted to the OCR queue for OCR processing, and a confirmation message appears

**OCR Indexing Documents**

OCR Indexing is not supported.

**Submitting Documents to a Full-text Queue**

AppXtender allows you to submit documents to the AppXtender Index Server for full-text indexing. By adding documents to the AppXtender Index Server, you can expand your queries for AppXtender documents to include keywords contained within the document. Text documents can be submitted directly to the AppXtender Index Server for indexing. Bi-tonal images must first be processed using OCR, and then the resultant text submitted for indexing. PDFs with text can be submitted directly, and PDFs containing images only are first processed using OCR. (For information on OCR, refer to Document and Page OCR, page 382.)

You can submit a displayed document from the Document menu, or you can submit multiple documents from the Result Page without first displaying them. For more information, refer to the following topics:

- Submitting from the Result Set, page 388
- Submitting a Displayed Document, page 389

Your AppXtender workstation may be configured so that the AppXtender Index Server automatically uses optical character recognition (OCR) to process any image documents submitted for indexing. The Full Text tab of the Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.

**Note:** The ProlIndex full-text engine cannot process documents of more than 2000 pages. However, the K2 full-text engine can process documents of up to 250,000 pages.

If you submit for full-text indexing a document that has text hidden under a redaction, the hidden text is not included in the full-text index of the document.
Submitting from the Result Set

Documents can be submitted to the AppXtender Index Server for full-text indexing from the Result Set tab of the Query view. Multiple documents can be selected and processed together.

**To submit documents to the AppXtender Index Server from the Result Set:**

1. Perform a query for the documents you want to submit to the AppXtender Index Server. The results appear in the Query view Result Set tab.
2. From the Result Set, select the index records for the documents that you want to submit to the AppXtender Index Server.
3. Right-click the Result Set. From the shortcut menu that appears, select Submit Full Text Index Job.

   **Note:** If the Submit Full Text Index Job command is not available, refer to Troublethesothing, page 221.

   If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.)

**Figure 194. Submit Full-text Index Job Dialog Box**

![Submit Full-Text Index Job dialog box](image)

4. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, enable Convert to text (if necessary) to process (using OCR) any bi-tonal pages that are submitted, select a language, and click OK.

   AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in all of the selected documents. When the AppXtender Index Server has finished processing the documents, a message appears.

5. Click OK to clear the message. You now have the ability to find these documents by performing a full-text query that searches for text in these documents.

   **Note:** When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document and is available the next time you retrieve the document. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.
Managing Documents

Note: If you encounter any problems submitting a document to the AppXtender Index Server, refer to Troubleshooting, page 221.

For more information, see:
- OCR Indexing Documents, page 387

Submitting a Displayed Document

Displayed documents can be submitted to the AppXtender Index Server for full-text indexing from the Document menu. Only the document displayed is processed.

To submit a displayed document to the AppXtender Index Server:

1. Display the document that you want to submit for full-text indexing.

2. From the Document menu, select Submit Full Text Index Job.

   Note: If the Submit Full Text Index Job command is not available, refer to Troubleshooting, page 221.

   If your workstation is configured to prompt you for queue selection upon submission of full-text index jobs, the Submit Full-Text Index Job dialog box appears. (The Full Text tab of the Configuration dialog box allows this configuration. For information, see Full Text Tab, page 143 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" section of the ApplicationXtender Installation Guide.)

Figure 195. Submit Full-text Index Job Dialog Box

![Submit Full-Text Index Job Dialog Box](image)

3. If the Submit Full-Text Index Job dialog box appears, select the appropriate queue, enable Convert to text (if necessary) to process (using OCR) any bi-tonal pages that are submitted, select a language, and click OK.

   AppXtender submits the job to the configured full-text queue. The AppXtender Index Server processes all of the pages in the displayed document. When the AppXtender Index Server has finished processing the document, a message appears.

4. Click OK. You now have the ability to find this document by performing a full-text query that searches for text in this document.
Managing Documents

**Note:** When you index a document’s full text using the AppXtender Index Server, a text view of the document is added to the document. The next time you retrieve the document, a text view of the document is available. For foreign files, RTF files, HTML files, and PDF files, if the application is using the ProIndex full-text engine, only the first 256 lines of each document page are included in the text view for that page. The entire document page is full-text indexed, but only the first 256 lines are returned as a text view.

**Note:** If you have trouble submitting a document to the AppXtender Index Server for full-text indexing, refer to Troubleshooting, page 221.

For more information, see:
- OCR Indexing Documents, page 387

**Submitting Documents/Reports to BI Gateway**

Business intelligence solutions allow users to perform one or more of the following tasks:
- Access and analyze data
- Identify patterns and correlations within their set of data
- Create predictive models that anticipate behavior based on historic trends in the data

Business intelligence applications generally extract data only from ASCII files in which the data has already been organized into rows (records) and columns (fields). If your AppXtender Reports Mgmt license supports the business intelligence gateway (B.I. gateway) feature, you can use AppXtender Reports Mgmt to extract data from your reports and export this data in a format that can be used in business intelligence applications. By default, this export is performed simultaneously with the upload of indexed documents to AppXtender.

In addition, if you have already used AppXtender Reports Mgmt to generate indexed AppXtender documents from reports, you can submit those reports from AppXtender to AppXtender Reports Mgmt and use AppXtender Reports Mgmt to process those reports again.

To configure AppXtender for business intelligence:

1. In ApplicationXtender Reports Management (AppXtender Reports Mgmt), you must:
   - Specify a data export path
   - Configure the B.I. Gateway tab for the report type

   AppXtender Reports Mgmt creates an ERMX.INI file, which is placed in the data export path configured. The information in the ERMX.INI file includes all of the report types for the data source selected, the applications for the data source selected, and each report type associated with the specified applications.
For specific instructions on completing these tasks, refer to the *ApplicationXtender Reports Management Administrator's Guide*.

2. From the Paths tab of the AppXtender Configuration dialog box, enter the path where the ERMX.INI file is stored in the Business Intelligence Gateway path text box. This path should be equivalent to the B.I. gateway path configured in AppXtender Reports Mgmt.
Figure 197. AppXtender Configuration Dialog Box - Paths Tab

Caution: If the path entered on the Paths tab of the Configuration dialog box does not match that of the location of the ERMX.INI file, an error message appears indicating that the ERMX.INI file could not be found. You will not be able to proceed with any submissions if this is not resolved.

Once you have configured the appropriate information in AppXtender Reports Mgmt and configured the Business Intelligence Gateway path in AppXtender, you are ready to begin submitting your documents and reports to BI Gateway.

To submit documents/reports to BI Gateway:

1. You have the following options:
   • From the result set tab, right-click on the documents or reports you want to submit to BI Gateway. From the shortcut menu that appears, select Submit to BI Gateway.
   • With a report displayed in the Document Display, you can select Submit to BI Gateway from the Document menu.

2. If there is more than one report type associated with the application the Select ERMX Report Type dialog box is displayed. Select the report type that you want to use.

3. A progress indicator dialog box is displayed. Click Cancel if you want to cancel the submission.
Once the submission is complete, two files are placed in the directory with the ERMX.INI file. One is an .INI file and the other is either a .PDF or .TXT file, depending on the type of document that was submitted. Both files use a naming convention that includes the workstation name as well as a time and date stamp. For example, WSMREED_01_11_13_143840.INI means that the file was submitted from the WSMREED workstation at 2:38 p.m. on November 13, 2001.

For more information, see:
- Chapter 7, Managing Documents

### Submitting Documents to ApplicationXtender Workflow Manager

If you have ApplicationXtender Workflow Manager (AppXtender Workflow) installed, business processes can be initiated from the query results set singly or in batches. This feature is useful to start business process instances for documents that have previously been added to AppXtender.

**To submit documents to AppXtender Workflow Manager:**

1. Select the documents from the results set window. For more information on running a query, refer to Running a Query, page 291.
2. Right-click and select Submit to Workflow from the shortcut menu.

Submitting the documents to AppXtender Workflow initiates new business processes based on the configuration of your AppXtender Workflow system.

For more information, see:
- Chapter 7, Managing Documents

### Converting Subpages to Pages

If your documents contain subpages (for example, in an ICE, TIFF, DCX, or PDF format page), you can convert the subpages to pages. Conversion allows easier navigation and manipulation of data within a document. The conversion is allowed only when the following conditions are all met:
- The displayed page is neither Minolta ICE nor Minolta COLD.
- The displayed page is the latest version of the page.
- There is no annotation on the page.
- The number of pages in the document does not exceed 32,000.

**To convert subpages to pages:**

1. Display the page that contains subpages.
2. From the Page menu, select Convert Subpages to Pages. The status bar and Document Display view title bar change to reflect the conversion, but the underlying storage of data to BIN files does not change.

   For example, consider a document that contains one page, which itself contains three subpages. This page is stored as one BIN file in the write path for the application. Before conversion, no
page information appears in the Document Display view title bar, but "Page 1/1 Subpage 1/3" appears in the status bar. After conversion, "Page 1 of 3" appears in the Document Display view title bar and "Page 1/3" appears in the status bar. The document now contains three pages, each of which contains one subpage. These three pages continue to be stored as one BIN file.

For more information, see:
- Chapter 7, Managing Documents

### AppXtender Document Properties

The AppXtender Document Properties dialog box is most useful to you if you check out documents and check them in as new revisions, or if you are using ODMA. (For information on checking documents in and out, refer to Selecting a Document Display Mode, page 271. For information on ODMA, refer to Chapter 8, Using ODMA With AppXtender Documents.)

**To view the properties for an AppXtender document:**

1. In the Result Set, right-click the document for which you want to view information.
2. From the shortcut menu that appears, select Properties. The Document Properties dialog box appears, displaying the General tab.
3. Review the information in the General tab. The following table describes each field on the General tab:

#### Table 56. General Tab Fields

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Name</td>
<td>Name of the application where the document is stored.</td>
</tr>
<tr>
<td>Revision</td>
<td>The major and minor revision numbers for the existing AppXtender document. Each time you check in a document, you have the opportunity to check it in as a new major revision or minor revision. If this is a new AppXtender document, this field contains a no revisions message. If the document has been finalized, the word &quot;Final&quot; follows the version number.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name of the person who initially created the document. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Created On</td>
<td>Date and time the document was created.</td>
</tr>
<tr>
<td>Modified By</td>
<td>User name of the person who last modified the document. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Modified On</td>
<td>Date and time the document was last modified.</td>
</tr>
<tr>
<td>Check Out By</td>
<td>User name of the person who last checked out the document (if the document is currently checked out). If the Windows security provider is used, the domain name also appears.</td>
</tr>
</tbody>
</table>
### Table 57. Summary Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suggested text to display in the document window's title bar. The title can be up to 127 characters long.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject matter of the document. The subject can be up to 127 characters long.</td>
</tr>
<tr>
<td>Author</td>
<td>Author of the document. The author's name can be up to 127 characters long.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of keywords assigned to the document. AppXtender treats each line that you enter as a keyword, regardless of whether spaces, commas, or other delimiters are included in the line. To start a new keyword, press [ENTER] to go to the next line in the Keywords text box. Each keyword can be up to 99 characters long.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments can be up to 250 characters long.</td>
</tr>
</tbody>
</table>

4. Click the Summary tab.

5. You can enter information in the Title, Subject, Author, Keywords, and Comment text boxes. In AppXtender or in ODMA, you can search for the information that you have entered in these text boxes in order to find and open the document. For more information, refer to Searching by ODMA Attributes, page 251. The following table describes each field on the Summary tab:

### Table 57. Summary Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suggested text to display in the document window's title bar. The title can be up to 127 characters long.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject matter of the document. The subject can be up to 127 characters long.</td>
</tr>
<tr>
<td>Author</td>
<td>Author of the document. The author’s name can be up to 127 characters long.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of keywords assigned to the document. AppXtender treats each line that you enter as a keyword, regardless of whether spaces, commas, or other delimiters are included in the line. To start a new keyword, press [ENTER] to go to the next line in the Keywords text box. Each keyword can be up to 99 characters long.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments can be up to 250 characters long.</td>
</tr>
</tbody>
</table>

6. If the document has been checked out and revised or if the document was created in an ODMA-compliant application, click the Revision History tab to refer to a list of all revisions made to the document.

The Revision History tab contains the revision number, the user name (and domain, if the Windows security provider is used) of the person who made the revision, and the date the revision was made.

**Note:** A major revision is indicated by a change in the first number, such as 2.0 or 3.0. Changes in the second number, such as 1.1, 1.2, and 1.3, identify minor revisions.
7. You can perform any one of the following tasks when working with the list of revisions:
   • To view comments entered when the document was checked in, select the revision and then click Detail. The revision History Detail dialog box appears.

   **Figure 198. History Detail Dialog Box**

   ![History Detail Dialog Box](image)

   Click Close when you are finished to return to the Revision History tab.

   • To view the selected revision, click Open. The AppXtender Document Properties dialog box closes and the document appears in the Document Display view.

   • To delete the selected revision, click Delete.

   **Note:** The Delete button is available only when the selected document is not open in the Document Display view.

8. If you have made any changes that you want to save on the AppXtender Document Properties dialog box, click OK.

For more information, see:
   • Chapter 7, Managing Documents

### Saving the Result Set as a Text File

You can save the index records listed in the Result Set to a text file.

**To save the contents of the Result Set to a text file:**

1. Right-click the Result Set.
2. From the shortcut menu that appears, select Save As. The Save As dialog box appears.
3. Enter a file name and path, and then click Save. The index records listed in the Result Set are saved to a text file.

For more information, see:

- Chapter 7, Managing Documents

## Checking in and Canceling Changes

When AppXtender is in check in/check out mode, you must check out a document in order to modify it. When AppXtender is in normal mode, you can open and modify documents without checking them out, which saves changes to the AppXtender document repository upon closing. However, normal mode also allows you to check out documents to prevent other users from making modifications.

A checked out document is a "working copy" of an AppXtender document that remains a working copy until it is checked back in and is separate from the AppXtender document repository copy. When you finish modifying the document, you must then decide how (or whether) to resave the working copy of the document to the AppXtender document repository.

The original version (the version that was originally checked out) of the document remains in the AppXtender database as the current version until the working copy is checked in. This allows you to either check in the working copy of a document as a new revision or cancel all changes made and revert to the original version of the document.

**Note:** If the application has the Prompt for check out on open option enabled, you also have the option to save the document as a final revision. Final document revisions can be accessed only in read-only mode and cannot be modified. For more information, refer to "Creating an Application" in the ApplicationXtender Core Components Administrator’s Guide.

For more information on checking out a document, refer to Selecting a Document Display Mode, page 271.
Checking in a Document in AppXtender

This topic describes how to check in a document in AppXtender.

**Note:** AppXtender documents accessed using the ODMA function can be checked in to AppXtender through the ODMA interface. For more information on checking documents in through ODMA, refer to Chapter 8, Using ODMA With AppXtender Documents.

**To check in a document in AppXtender:**

1. Make sure the checked out document is open in AppXtender.

2. From the Document menu, select Check In. The Check In AX Document dialog box appears.

   If the application is set up with final revision functionality, the dialog box includes a Final Revision check box.

   **Note:** For information on enabling final revision functionality by enabling the Prompt for checkout on open option when setting up a new application, refer to "Entering Application Information" in the ApplicationXtender Core Components Administrator’s Guide.

3. You have the following choices:
   - Select New Document Revision to check the document in as a new revision of the document.
   - Select Replace Current Revision to replace the current revision of the document.

4. If you want to finalize the document and you check the document in as a New Document Revision, you may also select whether to check it in as a Major Revision or a Minor Revision.

5. If the dialog box includes a Final Revision check box, select the check box.

   **Note:** You can open final revisions of documents only in read-only mode and cannot make changes to them. Depending on your user privileges, you may be able to delete final revision documents from the repository.

6. Enter any comments about the revision in the Comment text box. You can enter up to 250 characters.

7. Click OK. The document is checked in and is now available for revision by other users (unless it has been finalized, in which case, it is available only in read-only mode).
Canceling the Check Out of a Document

You may also decide after making modifications to a checked out document that you do not want to save the changes you made. However, as long as the document is checked out by you, other users cannot make modifications to the document until you check it back in.

AppXtender provides you with the Cancel Check Out function, which allows you to check a document back into AppXtender for use by other users without saving any modifications. Essentially what the command does is remove the "checked out" property from the document.

To cancel the check out of a document:

1. Open the checked out document in AppXtender.
2. From the Document menu, select Cancel Check Out. A warning message appears.
3. If you want to check the document back into AppXtender without saving any of the modifications you made to the document, click OK.
   The document is checked back in and is now available to other AppXtender users. Any modifications you made to the document are discarded and AppXtender reverts to the document version that you originally checked out.

Deleting Documents, Pages, Versions, and Batches

AppXtender (AppXtender) allows you to delete documents, pages, versions, or batches. For more information, refer to the following topics:

- Deleting Versions, page 400
- Purging Versions, page 400
- Deleting Pages, page 401
- Cutting Pages, page 402
- Deleting Documents, page 402
- Deleting Batches, page 403

You can also replace pages. For information on replacing pages, refer to Replacing Pages, page 349.

Note: In order to delete documents, pages, versions, or batches, you must have the correct privileges associated with your user profile. For more information, consult your system administrator or refer to the "Managing Security" section of the AppXtender Core Components Administrator's Guide.
Deleting Versions

A single version can be deleted using the Delete Version command in the Page menu.

⚠️ Caution: As soon as the deletion is confirmed, the version is permanently lost. Caution should be exercised because recovery of the version is not possible.

**To delete one version of a page:**

1. Display the page version you want to delete.
2. From the Page menu, select Delete Version. A delete page version confirmation message appears.
3. Click Yes to delete the version. Click No to exit without deleting the version.

The AppXtender status bar and title bar reflect the version changes. When the version is deleted, AppXtender deletes the object (*.BIN) file associated with it.

For more information, see:
* Deleting Documents, Pages, Versions, and Batches, page 399

Purging Versions

The Purge version feature allows you to delete several versions of a page with one command. AppXtender deletes all versions created before the displayed version. If there are six versions of a page, for example, and version four is displayed, purge version would delete versions one, two, and three. Versions four, five, and six are preserved and renumbered to one, two, and three. This is useful when only the most recent version of a page is required.

⚠️ Caution: As soon as the purge is confirmed, the older versions are permanently lost. Caution should be exercised because recovery of the versions is not possible.

**To purge a version:**

1. Display the page version you want to keep.
2. From the Page menu, select Purge Version. AppXtender displays a purge version confirmation message.
3. Click Yes to delete all versions created before the displayed version. Click No to exit without purging versions. The AppXtender status bar and title bar reflect the changes. When each version is deleted, AppXtender deletes the object (*.BIN) file associated with it.
For more information, see:
- Deleting Documents, Pages, Versions, and Batches, page 399

Deleting Pages

You can delete pages from an AppXtender document at any time. When a page is deleted, AppXtender also deletes the object file (*.BIN). You can perform this deletion from the Document Display view or from the Thumbnail view. For more information, refer to the following topics:
- Deleting a Page from the Document Display View, page 401
- Deleting Pages from Thumbnail View, page 401

Note: The delete function deletes all versions of the currently displayed page.

Caution: As soon as the deletion is confirmed, the page is permanently lost. Caution should be exercised because recovery of the page is not possible.

Deleting a Page from the Document Display View

You can delete a single page from an AppXtender document in the Document Display View.

To delete a page:
1. Within AppXtender, display the page that you want to delete.
2. From the Page menu, select Delete. A delete confirmation message appears.
3. Click Yes to delete the displayed page. Click No to quit.

For more information, see:
- Deleting Pages, page 401

Deleting Pages from Thumbnail View

You can delete a page or multiple pages from an AppXtender document at any time. When a page is deleted, AppXtender also deletes the object file (*.BIN) associated with the object.

To delete pages from a document, using the Thumbnail view:
1. Select all of the thumbnails that represent pages you want to delete. You have the following choices:
   - To select one thumbnail, click the thumbnail.
   - To select multiple consecutive thumbnails, click the first thumbnail, then click the last while holding down the [SHIFT] key.
   - To select multiple non-consecutive thumbnails, hold down the [CTRL] key while clicking thumbnails.
2. Right-click the selection. From the shortcut menu that appears, select Delete. A delete confirmation message appears.

3. Click Yes to delete the selected pages. Click No to quit.

For more information, see:
• Deleting Pages, page 401

Cutting Pages

You can cut pages from an AppXtender document. When a page is cut, AppXtender deletes the object file (*.BIN) and moves the page to the Windows Clipboard.

⚠️ Caution: As soon as the deletion is confirmed, the page exists only in the Clipboard. Caution should be exercised because recovery of the page is not possible unless you paste the page back into an AppXtender document.

To cut a page:
1. Within AppXtender, display the page that you want to cut.
2. From the Edit menu, select Cut. A delete confirmation message appears.
3. Click Yes to delete the displayed page. Click No to quit. The page is copied to the Windows Clipboard.

For more information, see:
• Deleting Documents, Pages, Versions, and Batches, page 399

Deleting Documents

There are two places from which you can delete documents in AppXtender: the Result Set tab and the Document Display view. As with other types of AppXtender functionality, you must have the necessary privileges to delete documents.

Note: Read-only documents cannot be deleted in the Document Display view.

When a document is deleted, the index information for the document and the document pages (*.BIN files) are deleted. If multiple index records reference a single document, deleting the document removes that document and all of the index records referencing it. To delete only one of the index records referencing a document, you must perform that deletion from the Result Set. (For information on allowing multiple index records to reference a single document in an application, consult your AppXtender system administrator or refer to the "Creating an Application" section of the ApplicationXtender Installation Guide.)

For more information, refer to the following topics:
• Deleting Documents from a Result Set, page 403
• Deleting Displayed Documents, page 403
Caution: As soon as the deletion is confirmed, the document is permanently lost. Caution should be exercised because recovery of the document is not possible.

Deleting Documents from a Result Set

You can delete a single document or multiple documents from the Result Set tab.

To delete documents from a result set:

1. On the Result Set tab, select the documents that you want to delete.
2. Right-click to access a shortcut menu. When the shortcut menu appears, select Delete. A delete confirmation message appears.
3. To delete the selected document, click Yes. To quit, click No.

For more information, see:
• Deleting Documents, page 402

Deleting Displayed Documents

With the exception of read-only documents, you can delete displayed documents from the Document Display view.

Caution: As soon as the deletion is confirmed, the document is permanently lost. Caution should be exercised because recovery of the document is not possible.

To delete a displayed document:

1. Display the document that you want to delete.
2. From the Document menu, select Delete. A delete confirmation message appears.
3. To delete the displayed document, click Yes. To quit, click No.

For more information, see:
• Deleting Documents, page 402

Deleting Batches

You can delete a batch from the Batch Index list.

Caution: As soon as the deletion is confirmed, the batch is permanently lost. Caution should be exercised because recovery of the batch is not possible.

To delete a batch from the Batch Index list:

1. From the Utilities menu, select Batch Index (List). The Batch Index (List) dialog box appears.
2. In the Batches for application drop-down list, select the application that contains the batch that you want to delete. A list of batches appears in the table.

3. Select the batch that you want to delete.

4. Click Delete. A delete confirmation message appears.

5. To delete the batch, click Yes. To quit, click No.

For more information, see:

- Deleting Documents, Pages, Versions, and Batches, page 399
Chapter 8

Using ODMA With AppXtender Documents

This section contains information on the different ways in which you can use ODMA-compliant applications to work with AppXtender documents.

- Introduction to ODMA, page 405
- AppXtender ODMA Support, page 406
- Configuring ODMA Support in AppXtender, page 407
- Creating New AppXtender Documents through ODMA, page 409
- Retrieving AppXtender Documents through ODMA, page 419
- Working with Checked Out AppXtender Documents, page 431
- Using Non-AppXtender Documents in ODMA-Compliant Applications, page 441

Introduction to ODMA

The Open Document Management API (ODMA) is the standard method for desktop applications to integrate with a Document Management System (DMS), such as AppXtender. ODMA provides a set of interfaces that applications can use to perform a subset of the content management functionality in ApplicationXtender (AppXtender). ODMA support also provides direct access to AppXtender functions from within other applications. If the applications you typically use are ODMA-compliant, you can use ODMA support to create, modify, and retrieve AppXtender documents from those applications – without having to open AppXtender.

AppXtender uses ODMA to let you create AppXtender documents and check them into AppXtender from ODMA-compliant applications. You can also retrieve and check out AppXtender documents, modify them, and then check them back in as new document revisions or page versions. If you want to open a document as a read-only document (open it without checking it out), you can choose to do that through ODMA. When you have an existing AppXtender document checked out, you can modify the content of the document, the document summary information, or the AppXtender index information for the document. If you create a new document, you may enter the index information when you save the document to AppXtender.
This section contains information on the different ways in which you can use ODMA-compliant applications to work with AppXtender documents.

- Several commonly used applications are ODMA-compliant and are supported for use with AppXtender.

  For more information on the ODMA-compliant applications that can be used to work with AppXtender documents, refer to AppXtender ODMA Support, page 406.

- To use the AppXtender ODMA feature, ODMA support must be enabled in AppXtender.

  For more information on enabling ODMA support in AppXtender, refer to Configuring ODMA Support in AppXtender, page 407.

- You can create new AppXtender documents from supported ODMA-compliant applications.

  For more information on creating new AppXtender documents from ODMA-compliant applications, refer to Creating New AppXtender Documents through ODMA, page 409.

- You can open existing AppXtender documents in supported ODMA-compliant applications. You can open a document in read-only mode, so that you can view it and modify it. However, you cannot save modifications back as a new document revision of the same AppXtender document or as new or replacement page version within the same AppXtender document. You can also choose to check the document out so you can make modifications to it.

  For more information on opening existing AppXtender documents in ODMA-compliant applications, refer to Retrieving AppXtender Documents through ODMA, page 419.

- If you checked out a document and made modifications to it, you can check those changes back into AppXtender in the form of a new document revision, a new page version, or a replacement page version. If you want to close the document but you are not ready to check it back in, you can choose to keep it checked out. If you decide that you do not want to keep the changes you have made at all and would like the document to remain as it was when you checked it out, you can choose to cancel the check out of the document.

  For more information on saving, closing, and checking in modified existing AppXtender documents, refer to Working with Checked Out AppXtender Documents, page 431.

- If you have ODMA support enabled in AppXtender and would like to open or save documents that are not AppXtender documents, you can still do so using the File Selection button.

  For more information on opening and saving non-AppXtender documents, refer to Using Non-AppXtender Documents in ODMA-Compliant Applications, page 441.

### AppXtender ODMA Support

The following table lists the AppXtender-supported applications that are ODMA-compliant:
Table 58. AppXtender-Supported Applications for ODMA

<table>
<thead>
<tr>
<th>Format</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word Processing</td>
<td>Microsoft Word 2000</td>
</tr>
<tr>
<td></td>
<td>Microsoft Word 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Microsoft Word 2003</td>
</tr>
<tr>
<td></td>
<td>WordPerfect 12</td>
</tr>
<tr>
<td>Standard Graphic</td>
<td>Visio 2000</td>
</tr>
<tr>
<td></td>
<td>Visio 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Visio 2003</td>
</tr>
<tr>
<td>Presentation</td>
<td>Microsoft PowerPoint 2000</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint 2002 (XP)</td>
</tr>
<tr>
<td></td>
<td>Microsoft PowerPoint 2003</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Project 2000</td>
</tr>
</tbody>
</table>

⚠️ Caution: Use of ODMA with any of the Corel Office 2000 suite of products causes system failure and is not supported with AppXtender.

For more information, see:
- Chapter 8, Using ODMA With AppXtender Documents

**Configuring ODMA Support in AppXtender**

Your workstation may be configured so that you can enable or disable ODMA support using the Data tab in the Configuration dialog box.

**To configure ODMA support:**

1. From the File menu, click Configuration. The Configuration dialog box appears.
2. Click the Data tab to activate it.

**Note:** If the Data tab does not display in your Configuration dialog box, consult your AppXtender system administrator for assistance in enabling this feature, or refer to the ApplicationXtender Core Components Administrator’s Guide.
Using ODMA With AppXtender Documents

Figure 200. Configuration Dialog Box: Data Tab

3. You have the following choices:
   - If you would like to enable ODMA support, click the ODMA support check box to select the option if it is not already selected.
   - If you would like to disable ODMA support, click the ODMA support check box to clear the option if it is selected.

4. To save changes to ODMA support configuration, click OK.

5. If any ODMA-compliant applications are open, you must close and reopen them for the change to take effect.

If you have enabled ODMA support, the Save as a New AX Document dialog box appears in any AppXtender-supported ODMA-compliant applications when you choose to save a document and the Open AX Document dialog box appears when you choose to open a document. If you have disabled ODMA support, these dialog boxes do not appear.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator.
or refer to the "Appendix D: Import Wizards" section of the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:

- Chapter 8, Using ODMA With AppXtender Documents

Creating New AppXtender Documents through ODMA

When ODMA support is enabled in AppXtender and you save a document for the first time or close a document in an ODMA-compliant application, you are prompted to enter AppXtender index information. You can also enter additional identifying information for the document by filling in document properties information. An AppXtender dialog box opens within the interface of the ODMA-compliant application, allowing you to log into AppXtender and select an AppXtender application. You can then save the document as an AppXtender document.

For example, you can create a Microsoft Word document just as you normally would. The first time you save the document, if ODMA support is enabled in AppXtender, you can then index and store the document to AppXtender without leaving the Microsoft Word interface or even starting AppXtender.

The following procedure provides an overview of creating an AppXtender document through ODMA:

To create a document through ODMA:

1. Enable ODMA support on the Data tab of the Configuration dialog box in AppXtender.
   For details on configuring ODMA support, refer to Configuring ODMA Support in AppXtender, page 407 or consult your AppXtender system administrator.

2. Edit a blank file or open a file in an ODMA-compliant application.
   For more information on opening existing files when ODMA support is enabled, refer to Opening Non-AppXtender Documents with ODMA, page 410.

3. Save the document to AppXtender.
   If the document is a new document, the first time you save it you are prompted to save the document as a new AppXtender document. If you are working on a document that you have saved outside of AppXtender previously, you can save the document as an AppXtender document. For more information on saving new documents to AppXtender, refer to Saving New ODMA Documents to AppXtender, page 411.

4. Enter document properties for the new AppXtender document.
   You can enter the information into the index fields by typing, by using automated indexing features, or both. You can enter document summary information into summary fields by typing. For more information on indexing new AppXtender documents through ODMA, refer to Entering AppXtender Document Properties, page 414.

5. Check the new document into AppXtender.
   When you have entered document properties for the document, the Check In New AX document dialog box appears. You can then check the document in and store it in AppXtender with the index information as a new AppXtender document. For more information, refer to Checking a New Document into AppXtender, page 418.
For more information, see:
• Chapter 8, Using ODMA With AppXtender Documents

Opening Non-AppXtender Documents with ODMA

When you enable ODMA support in AppXtender, AppXtender causes any ODMA-compliant applications to display an AppXtender dialog box when you open a document. You can use the File Selection button in this dialog box to open existing, non-AppXtender documents. As soon as you have opened a document, you can edit it and save it to AppXtender.

To open a document from an ODMA-compliant application when ODMA is enabled in AppXtender:

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank document appears.

2. You have the following choices:
   • If you want to create a new document in the ODMA-compliant application, you can make changes to the displayed document. When you are ready to save the document to AppXtender, refer to Saving New ODMA Documents to AppXtender, page 411.
   • If you want to save an existing document to AppXtender, from the File menu, select Open. The Open AppXtender Document dialog box appears.

Figure 201. Open AppXtender Document Dialog Box: Application Tab
3. Click File Selection. A standard Open dialog box appears. Navigate to the drive or folder and select the file you want to open.

Figure 202. Open Dialog Box

The selected document is opened in the ODMA-compliant application. You can then make changes to the displayed document if needed. When you are ready to save the document to AppXtender, refer to Saving New ODMA Documents to AppXtender, page 411.

For more information, see:
• Creating New AppXtender Documents through ODMA, page 409

**Saving New ODMA Documents to AppXtender**

As soon as you create a new document or open an existing document in an ODMA-compliant application, you can save the document into AppXtender, thereby creating a new AppXtender document. During the process, you can add document summary attributes to the document to further identify the document. You must enter AppXtender index information for the document in order to save it to AppXtender.

**Note:** If you are working with a document that you have already saved outside of AppXtender, you must select Save As to save it as an AppXtender document. Selecting Save only saves modifications back to the location where you originally saved and does not create a document in AppXtender.

**Note:** To perform most ODMA functions, including checking in, saving, or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more
information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

**To save documents to AppXtender:**

1. Select Save As from the File menu. The Save As dialog box appears.

2. From the Select the AppXtender data source drop-down list, select the AppXtender data source that you want to access.

   **Note:** You can log into only those data sources for which you have a user account.

3. Click Login. One of the following events occurs:

   - If you are using the CM security provider and you did not select Remember password or if that option was not available to you, the Login dialog box appears. Type an AppXtender user name that is valid for the selected data source. Type a password and click Login to log into the AppXtender data source.

   - If you selected the Remember password option, or if you are using the Windows security provider, AppXtender remembers your user name and password and bypasses the Login dialog box. A list of applications for the selected data source appears in the Select the AppXtender application view. If you want to disable the Remember password option, click the Login button again. The Login dialog box appears. Disable Remember Password or make whatever changes you would like and then click Login to log into the AppXtender data source.

   A list of applications appears in the Select the AppXtender application view.

4. In the Select the AppXtender application list, double-click an application name.

5. If the Reason Code Required dialog box appears, enter a comment in the text box explaining the reason for opening the document and click OK.

   **Figure 203. Reason Code Required Dialog Box**

   ![Reason Code Required Document dialog box](image)

   This application is Reason Code Required. Please provide the comment when creating or accessing the document.

6. If the Signature Properties dialog box appears, select a certificate, enter a comment, specify whether you want these settings to be used by default, and click OK. (Depending on the configuration of the selected certificate, you may be asked to provide a password.)
Figure 204. Signature Properties Dialog Box


For more information, see:
- Creating New AppXtender Documents through ODMA, page 409

Reason Code Required Dialog Box

The Reason Code Required dialog box allows you to enter a comment explaining the reason for opening the document. This dialog box appears if the AppXtender system administrator has enabled the Reason Code option for the application, for compliance with current standards. When you have entered a comment, click OK.

For more information on the Reason Code option, refer to the “Creating an Application” section of the ApplicationXtender Installation Guide or consult your AppXtender system administrator. For more information on the Reason Code Required dialog box, see:
- Saving New ODMA Documents to AppXtender, page 411
- Opening a Document from the Result Set, page 422
Logging into AppXtender in an ODMA-compliant Application

The Login dialog box allows you to log into AppXtender for the purpose of saving new documents to the AppXtender database or opening existing AppXtender documents. For more information, see:

- Saving New ODMA Documents to AppXtender, page 411
- Opening an AppXtender Application to Search, page 420

Entering AppXtender Document Properties

When you have logged into an AppXtender data source and selected an AppXtender application from the data source, the AX Document Properties dialog box appears. The General tab is active by default. You can use this dialog box to view general properties for the document, to enter document summary information, and to enter AppXtender index values. The following topics describe each of the tabs in the dialog box:

- For more information on viewing the general properties for the new AppXtender document, refer to AppXtender Document Properties: the General Tab, page 415.
- For more information on entering document summary attributes for the new document, refer to AppXtender Document Properties: the Summary Tab, page 416. These attributes are saved with the document and can be used to search for the document later.
- For more information on entering AppXtender index information, refer to AX Document Properties: the Index Tab, page 417. The index values you enter are saved with the document and can be used to search for the document later, both through ODMA and through the AppXtender interface.

Note: When you have finished entering document properties, the document remains open and you can continue to work in it. You check out the document at that point. Any changes you save using the Save command are saved to a temporary copy of the document in the AppXtender repository. When you close a document that you have saved to AppXtender, the Check in New AX Document dialog box appears and you check the document into AppXtender. For more information on the document check-in process, refer to Checking a New Document into AppXtender, page 418.

For more information, see:

- Creating New AppXtender Documents through ODMA, page 409

Viewing General Information about an AppXtender Document

The General tab of the AppXtender Document Properties dialog box provides general information about an AppXtender document. For more information, see:

- AppXtender Document Properties, page 394
AppXtender Document Properties: the General Tab

The General tab of the AX Document Properties dialog box provides general information about the document you are adding to AppXtender. The information on the General tab is dimmed to indicate that you cannot modify it. This tab is active by default when the AppXtender Document Properties dialog box displays.

To view the General tab:

1. If the General tab is not active, click it to activate it. The General tab appears.
2. Review the information in the General tab. The following table describes each field on the General tab:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>App Name</td>
<td>Name of the application where the document is stored.</td>
</tr>
<tr>
<td>Revision</td>
<td>Revision information for the existing AppXtender document. If this is a new AppXtender document, this field contains a no revisions message. If the document has been finalized, the word &quot;Final&quot; follows the version number.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name of the person who initially created the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Created On</td>
<td>Date and time the document was created in AppXtender.</td>
</tr>
<tr>
<td>Modified By</td>
<td>User name of the person who modified the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Modified On</td>
<td>Date and time the document was last modified.</td>
</tr>
<tr>
<td>Check Out By</td>
<td>User name of the person who checked out the document in AppXtender. If the Windows security provider is used, the domain name also appears.</td>
</tr>
<tr>
<td>Check Out On</td>
<td>Date and time the document was checked out.</td>
</tr>
<tr>
<td>Check Out Comment</td>
<td>Comments left before the AppXtender document was checked out.</td>
</tr>
</tbody>
</table>

3. You have the following choices:
   - Activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to the Index Tab, page 417 or the Summary Tab, page 416.
   - Click OK if you have finished viewing and entering AppXtender document properties for the new document.

Clicking OK from the Document Properties dialog box saves the document to an AppXtender repository temporarily until you are ready to check in. At this point, you must close the file to prompt the Check In New AX Document dialog box.
Using ODMA With AppXtender Documents

Note: Clicking OK on the AppXtender Document Properties dialog box before entering index information automatically displays the Index tab. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK on the message, and re-enter the index information on the Index tab.

For more information, see:
• Entering AppXtender Document Properties, page 414

Viewing Summary Information about an AppXtender Document

The Summary tab of the AX Document Properties dialog box provides summary information about an AX document. For more information, see:
• AppXtender Document Properties: the Summary Tab, page 416
• AppXtender Document Properties, page 394

AppXtender Document Properties: the Summary Tab

To add ODMA document summary attributes:
1. Click the Summary tab. The Summary tab appears.
2. Enter information in the desired fields. All fields in the Summary tab are optional.

The following table describes each field on the Summary tab:

Table 60. Summary Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Suggested text to display in the document window’s title bar. The title can be up to 127 characters long.</td>
</tr>
<tr>
<td>Subject</td>
<td>The subject matter of the document. The subject can be up to 127 characters long.</td>
</tr>
<tr>
<td>Author</td>
<td>Author of the document. The author’s name can be up to 127 characters long.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of keywords assigned to the document. AppXtender treats each line that you enter as a keyword, regardless of whether spaces, commas, or other delimiters are included in the line. To start a new keyword, press [ENTER] to go to the next line in the Keywords text box. Each keyword can be up to 99 characters long.</td>
</tr>
<tr>
<td>Comment</td>
<td>Comments can be up to 250 characters long.</td>
</tr>
</tbody>
</table>
3. You have the following choices:
   • Activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to AppXtender Document Properties: the General Tab, page 415 or AX Document Properties: the Index Tab, page 417.
   • When you have finished viewing and entering AppXtender document properties for the new document, click OK.

As soon as you click OK, you are returned to the document that you have been working on. The document is now a document in AppXtender that you have checked out. If you continue to make changes, those changes are saved whenever you select Save. When you close the document, the Check In New AppXtender Document dialog box appears with New Document Revision and Major Revision options enabled. For more information on checking a new document into AppXtender, refer to Checking a New Document into AppXtender, page 418.

Note: If you do not fill in AppXtender index information, the Document Properties dialog box still displays and the Index tab automatically becomes active. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK on the message, and re-enter index information on the Index tab.

For more information, see:
   • Entering AppXtender Document Properties, page 414

**AX Document Properties: the Index Tab**

The Index tab of the AX Document Properties dialog box is the equivalent of the Index View in AppXtender. You enter index field values on this tab to identify the document for later retrieval. You must enter AppXtender index information in order to successfully create a new AppXtender document.

To index a document:

1. Click the Index tab. The Index tab appears.

2. Enter the information in the fields by typing or by using automated indexing features, or both. For more information on AppXtender indexing features, refer to Indexing New Documents, page 205.

   Note: All fields displayed in bold are required fields. You must enter information into these fields.

3. You can activate one of the other two tabs by clicking on the appropriate tab. For more information, refer to AppXtender Document Properties: the General Tab, page 415 or AppXtender Document Properties: the Summary Tab, page 416.

4. When you have finished viewing and entering AppXtender document properties for the new document, click OK.

As soon as you click OK, you are returned to the document that you have been working on. The document is now a document in AppXtender that you have checked out. If you continue to make changes, those changes are saved whenever you select Save. When you close the document, the Check In New AX Document dialog box appears with New Document Revision and Major Revision options enabled. For more information on checking a new document into AppXtender, refer to Checking a New Document into AppXtender, page 418.
Note: If you do not fill in AppXtender index information, the AX Document Properties dialog box will still display and the Index tab will automatically become active. If you click OK again without entering index information or if you enter invalid index information, a message appears indicating that the index failed. Click OK. Re-enter the index information on the Index tab.

For more information, see:
• Entering AppXtender Document Properties, page 414

Viewing Revision History Information for an AppXtender Document

The Revision History tab of the AX Document Properties dialog box provides a list of all revisions made to an AppXtender document. The Revision History tab contains the revision number, the user name (and domain, if the Windows security provider is used) of the person who made the revision, and the date the revision was made.

Note: A major revision is indicated by a change in the first number, such as 2.0 or 3.0. Changes in the second number, such as 1.1, 1.2, and 1.3, identify minor revisions.

You can perform any one of the following tasks when working with the list of revisions:
• To view comments entered when the document was checked in, select the revision and then click Detail. The revision History Detail dialog box appears. Click Close when you are finished to return to the Revision History tab.
• To view the selected revision, click Open. The AX Document Properties dialog box closes and the document appears in the Document Display view.

For more information, see:
• Entering AppXtender Document Properties, page 414
• AppXtender Document Properties, page 394

Checking a New Document into AppXtender

When you have finished entering document properties for the new AppXtender document and have also finished editing it, the final step is checking the document into AppXtender.

To check a new document into AppXtender:
   When you are checking a new document in, the only option that is available is New Document Revision – Major Revision. This is because no previous revisions of the document exist, so saving as a minor revision or a new or replacement page version is not possible.
2. Type any comments about the new document into the Comment text box.
3. Click OK.
For more information, see:
- Creating New AppXtender Documents through ODMA, page 409

Retrieving AppXtender Documents through ODMA

When you open a document using ODMA, you access an AppXtender dialog box that allows you to search for AppXtender documents. Searching for documents from an ODMA-compliant application is very similar to searching for documents in AppXtender. You enter AppXtender index information or full-text search criteria to retrieve documents, and the results display on a separate result set tab. When you are retrieving documents from an ODMA-compliant application, you can also search using document attribute information.

In Microsoft Word, for example, when you open a document while ODMA support is enabled, a dialog box containing document information, a Search tab, and a Result Set tab appears. You can enter search criteria, perform a query, and then open a document from the Result Set tab (if this document was originally in AppXtender as a Microsoft Word document). The document then displays in Microsoft Word and can be edited like any Microsoft Word document.

When a document is stored to AppXtender using ODMA, the file is stored as a foreign file in AppXtender. You can retrieve any AppXtender document that was saved as a foreign file in AppXtender (or was saved through ODMA-compliant applications) into an ODMA-compliant application that can read that file type. For example, if you imported a Microsoft Word file into AppXtender through the AppXtender interface, that document page is a foreign file and you can open it in Microsoft Word using ODMA.

To retrieve a document through ODMA:

1. When retrieving AppXtender documents from an ODMA-compliant application, you first select a data source and log into that data source. You can then select an AppXtender application to search.
   For more information on logging into a data source, refer to Logging into Multiple Data Sources, page 60. For more information on opening an AppXtender application to search, refer to Opening an AppXtender Application to Search, page 420.

2. You can use the ODMA and AppXtender functionality to perform a query, such as a keyword or wildcard query, to search for a document. After you enter the search criteria, the documents that met the search criteria appear in the Result Set tab.
   For more information on opening an AppXtender application to search, refer to Searching for Documents, page 421.

3. You can then select the document that you want to open from the Result Set list tab.
   For more information on opening an AppXtender application to search, refer to Opening a Document from the Result Set, page 422.

4. When you open the document, you are prompted to either check out the document or open it in read-only mode.
   For more information on opening an AppXtender application to search, refer to Choosing a Viewing Mode for an AppXtender Document, page 425.
For more information, see:

- Chapter 8, Using ODMA With AppXtender Documents

### Opening an AppXtender Application to Search

To retrieve a document from AppXtender, you must log into an AppXtender Data Source and select the AppXtender application where the document is stored.

**To open a document in AppXtender using an ODMA-compliant application:**

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank Microsoft Word document opens.
2. From the File menu, select Open. The Open AppXtender Document dialog box appears.

**Figure 205. Open AppXtender Document Dialog Box: Application Tab**

3. From the Select the AppXtender data source drop-down list, select the AppXtender data source that you want to access.

**Note:** You can log into only those data sources for which you have a user account.

4. Click Login. One of the following events occurs:
   - If you are using the CM security provider and you did not select Remember password or if that option was not available to you, the Login dialog box appears. Type an AppXtender user name that is valid for the selected data source. Type a password and click Login to log into
Using ODMA With AppXtender Documents

the AppXtender data source. A list of applications for the selected data source appears in the Select the AppXtender application view.

- If you selected the Remember password option, or if you are using the Windows security provider, AppXtender remembers your user name and password and bypasses the Login dialog box. A list of applications for the selected data source appears in the Select the AppXtender application view. If you want to disable the Remember password option, click the Login button again. The Login dialog box appears. Disable Remember Password or make whatever changes you would like and then click Login to log into the AppXtender data source.

5. Double-click the name of the AppXtender application that you would like to search in the Select AppXtender application list.

For more information, see:
- Retrieving AppXtender Documents through ODMA, page 419

Searching for Documents

After you select an application and open it, the Search tab of the Open AppXtender Document dialog box appears.

Figure 206. Open AppXtender Document Dialog Box: Search Tab
To search for an AppXtender document in an ODMA-compliant application:

1. You have several choices:
   - If you want to search for documents using known ODMA attributes, enter information in the document properties fields. These fields appear in brackets in the Fields column.
   - To search using AppXtender index values, enter information in the index fields. These fields appear in all capital letters in the Fields column.
   - To search using full-text information, enter keywords in the text box at the bottom of the screen.

   You can search using any combination of information. When you enter both document properties and application properties, AppXtender assumes that you want documents with both the entered document properties AND the application properties. All forms of AppXtender search functionality, including wildcards, lists of values, and search expressions, can be used to search both the document properties and the application properties.

   If you are using full-text criteria, you have the following choices:
   - You can search for the document properties and application properties AND the full-text criteria by selecting the AND option.
   - You can search for the document properties and application properties OR the full-text criteria by selecting the OR option.
   - If the application is configured to use a K2 full-text engine, you can search for words that are related to your search criteria by selecting the Thesaurus option.

   Note: For more information on advanced and full-text search options, refer to Chapter 5, Retrieving Documents.

2. If you want to search for previous document revisions, click the Include Previous Document Revision check box.

   Note: If an asterisk appears in a Values text box in the Application Properties window, you can select search criteria from a user-defined list. To do so, highlight the Values text box that has an asterisk in it and double-click. From the drop-down list that appears, select a value.

3. Click Search. The result of your search is displayed in the Result Set view of the Open AppXtender Document dialog box.

   Note: If no documents met the search criteria, a message appears indicating that no documents were found. Click OK. The Result Set view appears empty. To run another query, click the Search tab; otherwise, click Cancel to exit.

For more information, see:
   - Retrieving AppXtender Documents through ODMA, page 419

Opening a Document from the Result Set
When your search is complete, the results appear in the Result Set tab. You can choose to open a document listed in the Result Set and check it out or you can open it as a read-only document.

- When you check out a document, you take possession of that document and other users can only open it in read-only mode until you check it back in.
- When you open a document as a read-only document, the document is not checked out by you and could be checked out and modified by another user while you have it open. If someone else has already checked out a document, you can only open it in read-only mode.

The folder icons in the Result Set indicate a document's status.

**Table 61. Folder Icons in the Result Set**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Yellow folder with red check mark]</td>
<td>Yellow folder with red check mark</td>
<td>This document is currently checked out. Unless you are the one who has checked it out, you can only open it in read-only mode. If you check it out, you can open it to edit it, or you can open it in read-only mode.</td>
</tr>
<tr>
<td>![Yellow folder]</td>
<td>Yellow folder</td>
<td>This document is not checked out. You can choose to check it out or to open it in read-only mode.</td>
</tr>
<tr>
<td>![Dimmed folder]</td>
<td>Dimmed folder</td>
<td>This document is a previous revision of a document. This folder appears only if you have selected the Include Previous Document Revision check box. You can only open it in read-only mode.</td>
</tr>
</tbody>
</table>

**Figure 207. Open AX Document Dialog Box: Result Set Tab**
If you want to find out who has a document checked out, or view the document summary or index information for a document, you can access a document's properties from the result set. For instructions, refer to Viewing Properties from the ODMA Result Set, page 425.

You can also open documents from the Result Set.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

**To open a document from the Result Set:**

1. Double-click the document in the Result Set.
2. If the Reason Code Required dialog box appears, enter a comment in the text box explaining the reason for opening the document and click OK.

![Figure 208. Reason Code Required Dialog Box](image)

3. What appears next depends on the status of the document. You have the following choices:
   - If the Check out dialog box appears, you can either check out the document or open it in read-only mode. For information on checking out a document, refer to Opening a Document that is Checked In, page 427. For information on opening a document in read-only mode, refer to Opening a Document in Read-Only Mode, page 428.
   - If the Open AX Document dialog box appears, you can choose to open the document in check out mode or in read-only mode. If you open the document in check out mode, the document opens with the latest modifications that you made since checking it out. If you open the document in read-only mode, the document opens using the version that was originally checked out (prior to any changes you made). For information on checking out a document, refer to Opening a Document that is Checked out by You, page 427. For information on
opening a document in read-only mode, refer to Opening a Document in Read-Only Mode, page 428.

- If a message appears stating that someone else has the document open, or that you do not have the privileges to check out the document, you can only open the document in read-only mode. When you open the document in read-only mode, the document opens in the form that it was in when it was checked out. For information on opening a document in read-only mode, refer to Opening a Document in Read-Only Mode, page 428.

For information on opening AppXtender documents in check out mode or in read-only mode, refer to Choosing a Viewing Mode for an AppXtender Document, page 425.

For more information, see:
- Retrieving AppXtender Documents through ODMA, page 419
- Viewing Properties from the ODMA Result Set, page 425

**Viewing Properties from the ODMA Result Set**

If you want to find out who has a document checked out, or would like to view document summary or index information for a document, you can access a document’s properties from the result set.

**To view document properties from the Result Set:**

1. Right-click a document in the Result Set tab.

2. From the shortcut menu that appears, select Properties. The AX Document Properties dialog box for that document appears, with the General tab active.
   
   For more information on AppXtender document properties, refer to AppXtender Document Properties, page 394.

3. When you are finished viewing the document properties, click OK to return to the Result Set tab.

For more information, see:
- Opening a Document from the Result Set, page 422

**Choosing a Viewing Mode for an AppXtender Document**

When you open an AppXtender document through ODMA, you choose whether to open the document in check out mode or in read-only mode.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
For more information, see:
• Retrieving AppXtender Documents through ODMA, page 419
• What is Read-only Mode?, page 426
• What is Check Out Mode?, page 426
• Opening a Document that is Checked In, page 427
• Opening a Document that is Checked out by You, page 427
• Opening a Document in Read-Only Mode, page 428

What is Read-only Mode?

Read-only mode displays the document in the ODMA-compliant application. You can make modifications to the document, but to save the modified document to AppXtender, you must save it as a new document.

For more information, see:
• Choosing a Viewing Mode for an AppXtender Document, page 425

What is Check Out Mode?

Documents can also be "checked out" so modifications can be made. When you check out a document, AppXtender makes a copy of the document in the AppXtender repository. This becomes your "working copy" of the document. The original version of the document remains the current version in AppXtender until you check the document back in.

When you make changes to the checked-out document, the changes are made to the working copy. When you are done making changes, you can check the document back in AppXtender as either a New Revision (Major or Minor), New Page Version or Replace Page Version. To keep track of previous changes you must select New Document Revision.

If you decide that you would rather not check in the modified document, you can cancel the check out. When you cancel the check out, AppXtender deletes the copy that it stored temporarily and treats the revision at checkout as the most recent revision.

Note: The final revision option on check-in is not available when checking in documents through ODMA.

For more information on opening documents in the different modes, refer to the following topics:
• Opening a Document that is Checked In, page 427.
• Opening a Document that is Checked out by You, page 427
• Opening a Document in Read-Only Mode, page 428
Opening a Document that is Checked In

When you open a document that is checked in, the Check Out dialog box appears. When you check out this document, AppXtender makes a working copy of the document. When you make changes to the document that you checked out, you save those changes to the working copy of the document.

When you are done making changes, you can decide whether you want to check the document back into AppXtender, saving the document permanently to the AppXtender repository. If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the working copy of the document that was created when you checked out the document. When you cancel the check out, all changes made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.

Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

Note: For more information on reopening a document that you have checked out, refer to Opening a Document that is Checked out by You, page 427.

To check out a document:

1. When you open the document, the Check Out dialog box appears with the Check Out option selected. Leave Check Out selected if you intend to modify the document.

2. If you want to add a comment in the Comment text box, enter the desired information. If you check out the document, your comments can be viewed by other users in the General tab of the AX Document Properties dialog box. The Comments feature is not available if you open the document in Read-Only mode.

   Note: Comments can be up to 250 characters long.

3. Click OK. ODMA opens the document in the ODMA-compliant application.

Note: If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

For more information, see:
• Choosing a Viewing Mode for an AppXtender Document, page 425

Opening a Document that is Checked out by You

When you open a document that you checked out and have not yet checked back in, the Open AX Document dialog box appears.
When you check out a document that is checked in, AppXtender makes a working copy of the document. When you reopen the document after choosing to Save Changes and Keep Checked Out, you reopen that working copy. Any changes you made since checking it out are reflected in the document.

When you are done making changes, you can decide whether you want to check the document back into AppXtender, saving the document permanently to the AppXtender repository. If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the working copy of the document that was created when you checked out the document. When you cancel the check out, all changes made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.

To open a document checked out by you:

- When you open the document, the Open AX Document dialog box appears. Click OK to reopen the working copy of the document created when you checked the document out.

ODMA opens the document in the ODMA-compliant application.

**Note:** If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

For more information, see:

- Choosing a Viewing Mode for an AppXtender Document, page 425

---

**Opening a Document in Read-Only Mode**

When you open a document in read-only mode, you can make changes to the document, but you cannot save those changes back to AppXtender as a revision or page version of the same AppXtender document.

There are three circumstances in which you can open a document in read-only mode:

- If the document is not checked out, you can choose to open it in read-only mode rather than checking it out.

  For more information on opening in read-only mode a document that is not checked out, refer to Opening a Document that is not Checked Out in Read-only Mode, page 429.

- If you have the document checked out, but you do not want to reopen the checked out copy, you can open the original revision of the document at check out in read-only mode.

  For more information on opening in read-only mode a document that you have checked out, refer to Opening a Document that is Checked out by You in Read-only Mode, page 429.

- If someone else has the document checked out, you can only open the document in read-only mode.

  For more information on opening in read-only mode a document that someone else has checked out, refer to Opening a Document that is Checked out by Someone Else in Read-only Mode, page 430.
**Note:** You must have the Display privilege enabled to view a document in read-only mode. For more information, consult your AppXtender system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Choosing a Viewing Mode for an AppXtender Document, page 425

**Opening a Document that is not Checked Out in Read-only Mode**

When you open in read-only mode a document that is not checked out, you make a copy of the current revision of the document. You can make changes to that copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.

In addition, someone else can check out the document that you opened while you have it open. The changes that they make are not reflected in the copy you have open, and you do not receive any notification that changes have occurred.

**Note:** You can check the document properties for a document from the result set before you open it. On the General tab, the revision number for the document is listed. If you are opening the same document in read-only mode on an ongoing basis, you may want to check the document properties and note the revision number each time to see whether any new revisions are checked in since you last viewed the document. For more information on viewing document properties from the Result Set, refer to Opening a Document from the Result Set, page 422.

**To open a document in read-only mode:**

1. When you open the document, the Check Out dialog box appears with the Check Out option selected. Select Open as Read-Only to open the document in read-only mode.
   
   **Note:** Comments are not available when you select Open as Read-Only.

2. Click OK. ODMA opens the document in the ODMA-compliant application in read-only mode.

**Note:** If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

For more information, see:
- Opening a Document in Read-Only Mode, page 428

**Opening a Document that is Checked out by You in Read-only Mode**

When you open a document that is already checked out by you in read-only mode, you make a copy of the current revision of the document in AppXtender. This is the document as it was before you checked it out and made any changes. The working copy of the document is not opened. Instead, you view the document as it is currently in AppXtender. Any changes you may have made to the copy you checked out are not reflected in the read-only copy.

You can make changes to the read-only copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.
Note: If you want to open the copy that you checked out to continue making modifications to it and to check it back in, refer to Opening a Document that is Checked out by You, page 427.

To open a document that is checked out by you in read-only mode:

- When you open the document, the Open AX Document dialog box appears. Click Read-Only to open the document in read-only mode.

ODMA opens the document in the ODMA-compliant application in read-only mode.

Note: If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.

For more information, see:

- Opening a Document in Read-Only Mode, page 428

### Opening a Document that is Checked out by Someone Else in Read-only Mode

If someone else has a document checked out, you can only open it in read-only mode. When you open a document that is checked out by someone else in read-only mode, you make a read-only copy of the current revision of the document in AppXtender. This is the document as it was when it was checked out. The copy does not reflect any changes that may have been made to it by the person who checked it out.

You can make changes to the read-only copy; however, there is no way to check that copy back in as a document revision or new or replacement page version related to the original document.

Note: You can check the document properties for a document from the result set before you open it to see who has checked the document out. On the General tab, the person to whom the document is checked out is listed. For more information on viewing document properties from the Result Set, refer to Opening a Document from the Result Set, page 422.

To open a document that is checked out by someone else in read-only mode:

- When you open the document, a message box appears. Click OK to open the document in read-only mode or click Cancel to return to the Result Set tab without opening the document.

#### Figure 209. AppXtender Message Box

If you click OK, ODMA opens the document in the ODMA-compliant application in read-only mode.

Note: If you open a document that was saved as a foreign file in AppXtender through ODMA, a message appears indicating that you might not be able to open the file. As long as the file is of a type supported by the currently open ODMA-compliant application, it should open successfully in the application. Click OK to continue the operation, or click Cancel to exit.
For more information, see:
- Opening a Document in Read-Only Mode, page 428

**Working with Checked Out AppXtender Documents**

You can make changes to an AppXtender document that you have checked out through ODMA. AppXtender allows you to save changes to a temporary location and then decide what to do with the modified document when you close it. When you close the document, you can choose to check it back in, to save changes to the document and keep it checked out, or to cancel check out of the document.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator’s Guide.

When you check the document in, you can choose to save it as a new document revision, creating a new revision document and saving the document that you originally checked out as a previous revision. You can also choose to add the revised document as a new page version within the document page you checked out, or as a replacement page version for the page that you originally checked out.

If you are not yet ready to check the document in, you can save changes to the copy of the document that AppXtender made when you checked the document out, and keep the document checked out. When you reopen the document, you reopen the modified copy. For more information on reopening a document that you have checked out, refer to Opening a Document that is Checked out by You, page 427.

If you decide that you do not want to check the document in, you can cancel the check out. Canceling a check out discards the temporary copy of the document that was created when you checked out the document. When you cancel the check out, all changes that you made since checking out the document are discarded and AppXtender treats the document revision that you originally checked out as the latest document revision.

- For information on saving changes to checked out AppXtender documents while you work, refer to Saving Checked Out AppXtender Documents, page 432.
- For information on closing checked out AppXtender documents from ODMA-compliant applications, refer to Closing a Checked Out AppXtender Document, page 433.

**Note:** If you open a document in read-only mode and make changes to it, you can only save the modified document as a new AppXtender document, not as a new document revision or a new or replacement page version. For more information on creating new AppXtender documents through ODMA, refer to Creating New AppXtender Documents through ODMA, page 409.
Note: as made are permanent the document revision new a to you changes AppXtender saved.

For more information, see:
• Chapter 8, Using ODMA With AppXtender Documents

**Saving Checked Out AppXtender Documents**

When you check out a document from AppXtender into an ODMA-compliant application, you can make modifications to that document and save them as you go. Every time you save a change, AppXtender temporarily saves the document to the AppXtender document repository, but does not make any changes to the original document that you checked out. By keeping a temporary copy of the document until you are ready to check it in, AppXtender allows you to work on the document as you normally would. You can save as frequently as you want, but you do not have to decide whether to permanently commit those changes to the document until you check the document in (or cancel the document checkout).

To save changes to a checked out document in an ODMA-compliant application:
• From the File menu in the ODMA-compliant application, select Save. Any changes you have made since the last save are saved to the temporary copy of the document.

**Caution:** Do not use the Save As command to save changes to a document. Selecting Save As prompts AppXtender to save the document as a new AppXtender document, rather than saving changes to a temporary copy. If you accidentally select Save As instead of Save, click Cancel to return to the document, then select Save to save your changes.

**Note:** In the event that you decide to check the changed document back into AppXtender, all of the changes you made to the document are saved as a new permanent AppXtender revision document or as a new or replaced page version in the AppXtender document you originally checked out. You chose how the modified document is saved when you check it in.

**Note:** In the event that you decide to cancel checkout of the document, the modified document that has been temporarily saved to the AppXtender document is discarded (and the original document that you checked out is not changed).

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
For more information, see:
- Working with Checked Out AppXtender Documents, page 431

## Closing a Checked Out AppXtender Document

When you close a document that you have checked out from AppXtender, AppXtender prompts you to choose whether to check the document back in, save changes and keep the document checked out, or cancel the document check out.

**Note:** If you close a document that has not yet been saved at all or that was opened as a read-only document from AppXtender, you must save that document as a new AppXtender document to add the modified document to AppXtender. For more information on saving new documents to AppXtender, refer to Creating New AppXtender Documents through ODMA, page 409.

The following table summarizes the effect of each of the choices available to you when you close a checked out AppXtender document:

<table>
<thead>
<tr>
<th>Command in ODMA</th>
<th>Result</th>
</tr>
</thead>
</table>
| Close> Check In | **Result in AppXtender:** Saves a new revision of the AppXtender document (in the form of a new revision, or a new or replacement page version), keeping the previous revision in AppXtender, and checks in the document. Uses the same document index information as the previous revision unless you change it.  
**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved appears.  
For more information, refer to Checking In an AppXtender Document, page 434. |
| Close> Save Changes and Keep Checked Out | **Result in AppXtender:** Saves your changes to the AppXtender document repository without yet creating a new AppXtender document, keeping the previous revision in AppXtender, and keeps the document checked out in your name.  
**Result in Document in ODMA Application:** Document in ODMA application closes, but remains checked out. You can open the document again by searching for the index information you entered. When you open the document, you are given a choice to open and edit it as a checked out document, or to open it in read-only mode (which opens the current revision of the document in AppXtender). |
<table>
<thead>
<tr>
<th>Command in ODMA</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close&gt; Cancel Check Out</td>
<td><strong>Result in AppXtender:</strong> Reverts to the state of the document when you checked it out, and discards any changes (even if you have selected Save Changes and Keep Checked Out in the interim). <strong>Result in Document in ODMA Application:</strong> Document in ODMA application closes and the copy that you had open is deleted. You can open the original version of the document by searching for the index information you entered. When you open the document, the page that displayed when you last checked out the document appears. For more information, refer to Canceling the Check Out of an AppXtender Document, page 440.</td>
</tr>
</tbody>
</table>

For more information, see:
- Working with Checked Out AppXtender Documents, page 431
- Checking In an AppXtender Document, page 434
- Saving Changes to an AppXtender Document and Keeping It Checked Out, page 439
- Canceling the Check Out of an AppXtender Document, page 440

### Checking In an AppXtender Document

When you check in a document, you save a new revision of the AppXtender document to the AppXtender repository, either in the form of a new major or minor document revision or in the form of a new or replacement page version. If you choose to check the document in as a new document revision, AppXtender keeps the previous document revision but marks it as a previous revision. If you choose to check the document in as a new page version, AppXtender adds the document as a new page version in the AppXtender document that you originally checked out. If you choose to check the document in as a replacement page version, AppXtender replaces the page version in the AppXtender document that you originally checked out with the new document. When you check in a document, AppXtender uses the same document index information as the previous revision unless you change it after you choose to check it in.

**Note:** To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the “Managing Security” section of the ApplicationXtender Core Components Administrator’s Guide.
For more information, see:

- Closing a Checked Out AppXtender Document, page 433
- Understanding Document Revisions, page 435
- Checking in a New Document - Major Revision, page 437
- Checking in a New Document - Minor Revision, page 438
- Checking in a New Page Version, page 438
- Checking in a Replacement Page Version, page 439

Understand Document Revisions

Using ODMA allows AppXtender to perform revision control on AppXtender documents created or accessed through ODMA. When you store a document in AppXtender using ODMA, you can check that document into AppXtender. "Checking in" and "checking out" documents allows AppXtender to track the revisions of a document in the AppXtender system. When you check a document in, you release the document from your control and put it back into the AppXtender system. If you want to modify the document again, you need to check it back out before doing so. Whenever a document is checked in, AppXtender saves the new revision of the document in the way that you indicate: as a new document, as a major revision, or as a minor revision.

Note: When you save a document to AppXtender for the first time, you are only given the option to save the document as a major new document revision because the document did not exist previously. For more information on creating new AppXtender documents through ODMA, refer to Creating New AppXtender Documents through ODMA, page 409.

When you open a document from the result set using ODMA, you must choose whether to check that document out or open it read-only. Checking the document out ensures that while you are working on the document, other users are not able to make modifications to the same document.

Note: If you open a document in read-only mode and attempt to save changes to it, AppXtender makes you save the document as a new AppXtender document. For more information on creating new AppXtender documents through ODMA, refer to Creating New AppXtender Documents through ODMA, page 409.

If you modify a checked-out document, you can check it back into AppXtender. Because AppXtender allows you to check documents in through ODMA, you can control how the document is resaved.

If you want to save iterations of a document chronologically, you can do so using ODMA. If every time you save a document, you save it as a major revision or minor revision, when you search for a document, you can choose to retrieve previous document revisions through ODMA. You then enter the AppXtender index information for the document through ODMA to retrieve all revisions of the document. The Include Previous Document Revision check box must be selected in order to retrieve all revisions of the document. Document revisions allow you to further categorize your AppXtender documents by saving entire revisions of a document in a chronological order and yet associating all of the revisions with the same AppXtender document index information.

When you choose to save an ODMA document as a page version, it has the same effect as adding a foreign file as a page version through the AppXtender interface. You can access the most recent page version of the first page in a document through ODMA support. However, you cannot view earlier page versions from an ODMA-compliant application. To do so, you must use AppXtender.
For this reason, if you primarily access documents from the ODMA interface and wish to access the previous drafts of a document, you should save the document as a major or minor document revision rather than a page version.

The following table explains what the possible choices are when you are checking in a document through ODMA:

### Table 63. Checking In a Document Through ODMA

<table>
<thead>
<tr>
<th>Check In Option</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>New document revision – Major revision</td>
<td><strong>Result in AppXtender:</strong> Saves a new revision of the AppXtender document, keeping the previous version, and checks in the document. Uses the same document index information as the previous version unless you change it. Each major revision augments the version number for the document by 1. (For example, version 1 becomes version 2.)&lt;br&gt;&lt;br&gt;<strong>Result in Document in ODMA Application:</strong> Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the latest document revision appears. In order to access previous revisions of the document, the Include Previous Document Revision check box must be checked when searching.  For more information, refer to Checking in a New Document - Major Revision, page 437.</td>
</tr>
<tr>
<td>New document revision – Minor revision</td>
<td><strong>Result in AppXtender:</strong> Creates a new AppXtender document, keeping the previous version, and checks in the document. Uses the same document index information as the previous version unless you change it. Each minor revision augments the version number for the document by .1. (For example, version 1 becomes version 1.1.)&lt;br&gt;&lt;br&gt;<strong>Result in Document in ODMA Application:</strong> Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display. You can access the previous versions of the document by checking the Include Previous Document Revision check box when searching.  For more information, refer to Checking in a New Document - Minor Revision, page 438.</td>
</tr>
<tr>
<td>Check In Option</td>
<td>Result</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| New page version | **Result in AppXtender:** Adds the current document as a new page version in the checked out AppXtender document and checks in the document. Uses the same document index information as the previous version unless you change it. You can view older page versions by opening the document in AppXtender. This is the default setting when you save a document to AppXtender through ODMA.  

**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display.  

For more information, refer to Checking in a New Page Version, page 438. |
| Replace page version | **Result in AppXtender:** Replaces the page version that was retrieved when the AppXtender document was checked out and checks in the document. Uses the same document index information as the previous version unless you change it. The page version that you modified has been replaced and cannot be retrieved through AppXtender.  

**Result in Document in ODMA Application:** Document in ODMA application closes and is checked in. You can open the document again by searching for the index information you entered. When you open the document, the page that you saved will display.  

For more information, refer to Checking in a Replacement Page Version, page 439. |

For more information, see:  
- [Checking In an AppXtender Document, page 434](#)  

### Checking in a New Document - Major Revision

When you save a document to AppXtender for the first time, you are only given the option to save the document as a New Document Revision – Major Revision. You can check a document into AppXtender as a New Document Revision – Major Revision. When you choose to check a document in as a new document revision, AppXtender creates a new document with the same index information and marks the previous revision of the document as a previous revision. When you select Major Revision, AppXtender increments the document revision number by 1. For example, if the document you opened was revision 1.0, the new revision number is 2.0.

When you check the document out again, information about the revision number of the document can be viewed in the AppXtender Document Properties dialog box. You can retrieve read-only copies of previous versions of the document when you search for documents (and save them as new
documents if needed). If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.

**To check a document into AppXtender as a New Document Revision - Major Revision:**

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Select New Document Revision. The Major Revision and Minor Revision options become available.
3. Select Major Revision.
4. If you want to add a comment to the document, type the information in the Comment text box.
5. Click OK. The document is saved to AppXtender again as a New Document - Major Revision.
   For more information, see:
   - Checking In an AppXtender Document, page 434

**Checking in a New Document - Minor Revision**

You can check a document into AppXtender as a minor new document revision. When you choose to check a document in as a New Document – Minor Revision, AppXtender creates a new document with the same index information and marks the previous revision of the document as a previous revision. When you select New Document - Minor Revision, AppXtender increments the document revision number by .1. For example, if the document you opened was revision 1.0, the new revision number is 1.1.

When you check the document out again, information about the revision number of the document can be viewed in the AX Document Properties dialog box. You can retrieve read-only copies of previous revisions of the document when you search for documents (and save them as new documents if needed). If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.

**To check a document into AppXtender as a minor new document revision:**

1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Select New Document Revision. The Major Revision and Minor Revision options become available.
3. Select Minor Revision.
4. If you want to add a comment to the document, type the information in the Comment text box.
5. Click OK. The document is saved to AppXtender again as a minor new document revision.
   For more information, see:
   - Checking In an AppXtender Document, page 434

**Checking in a New Page Version**

You can check a document back into AppXtender as a new page version in order to replace the document that you opened from AppXtender. ODMA displays only the newest version page of a document, so when you check your current revision in as a new page version, you see only that version when you next open the document. You can, however, access earlier page versions
through AppXtender. Use of this option is recommended only if you access documents through both AppXtender and ODMA. If you are only accessing documents through ODMA, use the New Document Revision options to track separate revisions.

To check a document into AppXtender as a new page version:
1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. If you want to add a comment to the document, type the information in the Comment text box.
3. Click OK. The document is saved to AppXtender again as a new page version.
For more information, see:
* Checking In an AppXtender Document, page 434

Checking in a Replacement Page Version

You can check a document back into AppXtender as a new page version to replace the document that you opened from AppXtender. ODMA displays only the newest version page of a document, so after you check your current revision in as a new page version, you see only that version when you next open the document. You can, however, access earlier page versions through AppXtender. Use of this option is recommended only if you are accessing documents through both AppXtender and ODMA. If you are only accessing documents through ODMA, use the New Document Revision options to be able to track separate revisions.

To check in a document to AppXtender by replacing the current page version:
1. The Check In AX Document dialog box appears with the New Page Version option selected.
2. Click Replace Current Page Version to replace the page that you originally opened with the edited ODMA document.
3. If you want to add a comment to the document, type the information in the Comment text box.
4. Click OK. The document is saved to AppXtender again with the current page version replaced.
For more information, see:
* Checking In an AppXtender Document, page 434

Saving Changes to an AppXtender Document and Keeping It Checked Out

When you close an AppXtender document, you do not have to check it in or discard the work that you have already done. If you reach a point where you need to close the document you have checked out from AppXtender but you are not yet ready to check the document in, you can save a temporary copy of the document to the AppXtender repository and keep the document checked out. You can then reopen the document and continue to work on it. This option allows you the freedom to work on a document until you are ready to check it in, without forcing you to commit your changes until you decide that a changed document is ready to be checked in and saved as a permanent AppXtender document revision or page version. This feature also prevents other users from overwriting your changes as you modify the document.
Note: To perform most ODMA functions, including checking in or checking out documents or deleting or replacing document revisions, you need to have the Display, Delete Doc, Delete Page, and Add Page privileges. To modify indexes you also need the Modify Index privilege. If you have only the Display privilege, you can only open ODMA documents in a read-only mode. For more information on the user privileges enabled for your account, consult your system administrator or refer to the "Managing Security" section of the ApplicationXtender Core Components Administrator's Guide.

To close a document, save changes, and keep the document checked out:

1. From the File menu in the ODMA-compliant application, select Close. If there are unsaved changes in the document, the ODMA-compliant application prompts you to save changes. The dialog box that appears depends on the application that you are working in.

2. You may have the following choices:
   - To continue closing the document and save changes to the temporary document copy, select Yes.
   - To continue closing the document without saving changes to the temporary document copy, select No. (Only the changes that have been saved already are saved in the temporary document copy.)
   - To cancel and keep the document open, select Cancel.

3. If you selected Yes or No, the Close Checked Out Document dialog box appears.

4. To save changes to the temporary copy of the document saved to the AppXtender repository and keep the document checked out by you, select Save Changes and Keep Checked Out and click OK.

For more information on reopening a document that you have checked out, refer to Opening a Document that is Checked out by You, page 427.

For more information, see:
- Closing a Checked Out AppXtender Document, page 433

Canceling the Check Out of an AppXtender Document

When you close a checked out AppXtender document, you are prompted to choose what to do with the document. If you decide that you do not want to keep any of the changes that you have made since you checked out the document, you can decide to cancel the document check out. By canceling the document check out, you put the document back in check in mode. The document revision remains the same.

Caution: Canceling document checkout discards all changes made since the document was checked out, even if you have saved changes while you worked. Canceling document checkout discards the temporary copy of the document where working changes were saved.

To close a document and cancel the document checkout:

1. From the File menu in the ODMA-compliant application, select Close. If there are unsaved changes in the document, the ODMA-compliant application prompts you to save changes. The dialog box that appears depends on the application that you are working in
2. You probably have the following choices:
   • To continue closing the document and save changes to the temporary document copy (which are deleted if you cancel document checkout), select Yes.
   • To continue closing the document without saving changes to the temporary document copy (which are deleted if you cancel document checkout), select No.
   • To cancel and keep the document open, select Cancel.
3. If you selected Yes or No, the Close Checked Out Document dialog box appears.
4. To cancel the document checkout and discard the temporary copy of the document saved to the AppXtender document repository, select Cancel Checkout and click OK.

For more information, see:
• Closing a Checked Out AppXtender Document, page 433

Using Non-AppXtender Documents in ODMA-Compliant Applications

When you enable ODMA support in AppXtender, AppXtender causes any ODMA-compliant applications to display an AX dialog box when you open or close a document. You can use the File Selection button in this dialog box to open and save non-AppXtender documents. The File Selection button allows you to save non-AppXtender documents to other storage devices such as a local hard drive, network drive, or a floppy disk.

To open a Non-AppXtender document from an ODMA-compliant application when ODMA is enabled in AppXtender:

1. From the Windows Start menu, select Programs. From the Programs menu, select an ODMA-compliant application, such as Microsoft Word. A blank document appears.
2. To open an existing non-AppXtender document, select Open from the File menu. The Open AppXtender Document dialog box appears.
3. To open a non-AppXtender document, click File Selection. A standard Open dialog box appears. Navigate to the drive or folder and select the file you want to open.
**Figure 210. Open Dialog Box**

The selected document is opened in the ODMA-compliant application.

For more information, see:

- Chapter 8, Using ODMA With AppXtender Documents
Chapter 9

Annotations

This section describes how to attach annotations to a document or a batch page to highlight important information. You can also add annotations to images, text, and Portable Document Format (PDF) files.

- Introduction to Annotations, page 443
- Annotation Types, page 445
- Saving Annotations, page 445
- Creating Line and Shape Annotations, page 445
- Creating Text Annotations, page 454
- Working with Rubber Stamp Annotations, page 457
- Overlapping Annotations, page 467
- Assigning an Annotation to an Annotation Group, page 468
- Assigning a Default Annotation Group, page 468
- Showing or Hiding Annotations, page 469
- Modifying Annotation Settings, page 476
- Printing Text Annotations, page 484
- Removing Annotations, page 485

Introduction to Annotations

Assuming you have been granted the appropriate user privileges, several types of annotations are available to you when viewing documents. You can add manual marks, such as lines, arrows, and highlights, to a page to emphasize information. You can use the polyline annotation feature to add lines with multiple nodes. You can also add shapes, such as ovals, rectangles, and rounded rectangles, and use polygons to emphasize asymmetrically shaped areas. You can add comments in the form of text annotations, and display them as either actual text or sticky note icons. You may also be able to apply preconfigured rubber stamps, such as Confidential or Draft, to documents.

When creating annotations, you can customize annotation properties such as line width and color to create desired effects. To make a line or shape annotation opaque, you can apply redaction to the annotation. You can also overlap annotations by moving one annotation in front of or behind another.
annotation. When printing and e-mailing documents, you can use the show/hide feature to hide the annotations with a single click.

**Figure 211. AppXtender Page With Annotations**

<table>
<thead>
<tr>
<th>CLINICAL RECORD</th>
<th>PATIENT ADMISSION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. PATIENT’S NAME AND ADDRESS (Mechanical imprinting, if available):</td>
<td>2. AGE OR DATE OF BIRTH</td>
</tr>
<tr>
<td>Alexandria VA  22041</td>
<td>01/01/51</td>
</tr>
<tr>
<td>TO:</td>
<td>DATES OF TREATMENT</td>
</tr>
<tr>
<td>Health Care Provider</td>
<td>HOSPITALIZATION</td>
</tr>
</tbody>
</table>

There is no limit to the number of annotations you can place on a page; however, a large number of annotations could slow down or distort page rendering.

Annotations can easily be deleted or saved. In addition, using the Cancel Changes function, you can remove changes made to annotations since the last save.

Only users who have appropriate privileges can create, modify, move, hide, or delete annotations and redactions. For example, to hide a redaction that you created, you must have the Edit Redaction privilege. To hide a redaction another user created, in addition to having the Edit Redaction privilege, you must also have the Global Annotations privilege.

**Note:** Contact your AppXtender administrator if you have any questions about your annotation privileges.

For more information, see:
- Annotation Types, page 445
- Creating Line and Shape Annotations, page 445
- Creating Text Annotations, page 454
- Working with Rubber Stamp Annotations, page 457
- Assigning a Default Annotation Group, page 468
- Overlapping Annotations, page 467
- Showing or Hiding Annotations, page 469
- Modifying Annotation Settings, page 476
- Printing Text Annotations, page 484
- Removing Annotations, page 485
Annotation Types

You can annotate pages with the following types of annotations:

• Line annotations including straight lines, freehand lines, arrows, and polylines.

• Shape annotations including rectangles, rounded rectangles, ovals, and polygons. Shape annotations have an outline and a fill color, both of which are configurable.

• Highlight annotations are similar to rectangle annotations except that they have no outline and the default color is not configurable.

• Text annotations have both outline and fill color configuration options. They can be displayed as icons or text.

• Rubber Stamp annotations are pre-defined annotations created by the system administrator (for example, Draft, Final, Paid In Full, Confidential). In addition to standard annotation attributes, rubber stamp annotations have attributes such as type (text or image) and content (text string or embedded bitmap).

Annotations can be transparent or non-transparent (opaque). Lines, shapes, highlights, and rubber stamps are transparent by default. Text annotations, on the other hand, are non-transparent by default. You must have redaction privileges to create or modify non-transparent annotations.

For more information, see:

• Chapter 9, Annotations
• Creating a Line Annotation, page 450
• Creating a Shape Annotation, page 452
• Creating a Highlight Annotation, page 453
• Working with Rubber Stamp Annotations, page 457
• Default Redaction Setting, page 448

Saving Annotations

You have these options for saving an annotation to a document page:

• Select Annotate> Save from the Document Manager menu bar.

• Press w.

• Close the document or batch.

Refer to Modifying Annotation Settings, page 476 for information on modifying annotations after they have been saved to a page.

Creating Line and Shape Annotations

The process to create line and shape annotations involves configuring annotation properties and then creating the annotation on the page.
For information on these tasks, refer to the following section topics:

- Configuring Annotation Settings, page 446
- Creating a Line or Shape Annotation, page 449

**Configuring Annotation Settings**

The first step in creating a line or shape annotation is to check the current annotation properties and, if necessary, change the defaults. For example, all annotation have default color settings that you can change. You can select a different line color, fill color, or both before adding an annotation to a document. Another property you may want to modify is the default line width, making the line broader or more narrow.

**Note:** Default colors for text annotations are set separately from line and shape annotation settings. For information on configuring text annotations, refer to Creating Text Annotations, page 454.

For information on configuring annotation properties, refer to the following section topics:

- Default Line Width, page 446
- Default Color for Highlight Annotations, page 447
- Default Color for Line and Shape Annotations, page 447
- Default Filled or Hollow Setting, page 448
- Default Redaction Setting, page 448

**Note:** Only users with appropriate privileges can control the annotation features. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security” chapter of the ApplicationXtender Core Components Administrator's Guide.

**Default Line Width**

The line width of lines and shapes added as annotations is configurable. Line width settings are used for line annotations and the outlines of shape annotations. You can change the default line width from the Annotation menu or from the Annotation toolbar.

**To set the width of lines and arcs:**

1. From the Annotate menu, select Settings and then Line Width. The Line Width drop-down box appears.
2. Select the new line width.

Any new annotations you create will have the line width setting you selected. You can change the line width setting of an existing annotation in the Annotation Properties dialog box. For more information, refer to Modifying Annotation Settings, page 476.
For more information, see:
• Creating Line and Shape Annotations, page 445

Default Color for Line and Shape Annotations

Color is used for all annotations. Color settings for line and shape annotations are separate from color settings for text or highlight annotations.

You can set the default color settings for line or shape annotations from the Annotation menu or from the Annotation toolbar.

To set the color of lines and shapes:

1. From the Annotate menu, select Settings and then Colors. The Color drop-down box appears.

![Figure 212. Color Drop-Down Box](image)

Under the grid of colors, notice the two overlapping rectangles. The color in the top rectangle represents the color of shape outlines and lines. The color in the bottom rectangle represents the fill color for all shape annotations.

2. To set the fill color, right-click a color in the grid of colors. The color you selected appears in the bottom rectangle, indicating the fill color for all shape annotations.

3. To set the outline color, click a color in the grid of colors. The color you selected appears in the top rectangle, indicating the color of shape outlines and lines. Any line or shape annotations created from now on appear with the colors you selected.

You can change the color of an existing line or shape annotation in the Properties dialog box. For more information, refer to Modifying Annotation Settings, page 476.

For more information, see:
• Creating Line and Shape Annotations, page 445

Default Color for Highlight Annotations

The default color for highlight annotations is yellow and cannot be changed.

After creating a highlight annotation, you can change the highlight color from the Annotation Properties dialog box. For more information, refer to Modifying Annotation Settings, page 476.
For more information, see:
• Creating Line and Shape Annotations, page 445

Default Filled or Hollow Setting

The filled/hollow setting is used for annotation shapes. You can fill an annotation shape with the default fill color or you can make a shape hollow. You can change the default filled/hollow setting from the Annotation menu or from the Annotation toolbar.

**Note:** Highlight annotations are similar to shape annotations, except that they are always filled, regardless of the filled/hollow setting.

Generally, this feature is used with redaction to block large areas of the page from view. When both fill and redaction are enabled, both the outline and fill of the annotation are applied as opaque. For information on redaction, refer to Default Redaction Setting, page 448.

To toggle the fill setting on and off, choose one of the following options:
• Select Annotate> Settings> Filled.
• Press i.

If the button is active (lighter in color), new shape annotations have a fill of the default fill color. If the button is not active (same color as the other toolbar buttons) new shape annotations are added without a fill color.

Any annotations created from now on appear with the filled/hollow setting you selected. You can change the filled/hollow setting of an existing annotation in the Properties dialog box. For more information, refer to Modifying Annotation Settings, page 476.

For more information, see:
• Creating Line and Shape Annotations, page 445

Default Redaction Setting

Redaction is a security feature that enables you to block certain areas of an image or text page from view. You can change the default redaction setting from the Annotation menu or from the Annotation toolbar.

When enabled, the outline of the annotation is applied as opaque; underlying parts of the image are not visible. When disabled, the outline of the annotation is applied as transparent.

Redaction can be used in conjunction with the filled/hollow feature to make the entire shape of the annotation opaque (not just the outline). For information on filled and hollow annotations, refer to Default Filled or Hollow Setting, page 448.

To toggle redaction on and off, choose one of the following options:
• Select Annotate> Settings> Redaction.
• Press d.

If the button is active (lighter in color), the outline of any new annotation is opaque. If the Fill button is also active, both the outline and the fill of new annotations are opaque. If the Redaction button is
not active (same color as other toolbar buttons), both the outline and the fill (if one is configured) of new annotations are transparent.

Any annotations created from now on appear with the redaction setting you selected. You can change the redaction setting of an existing annotation in the Properties dialog box. For more information, refer to Modifying Annotation Settings, page 476.

For more information, see:
- Creating Line and Shape Annotations, page 445
- Interaction between Redactions and OCR/Full-text, page 449

Interaction between Redactions and OCR/Full-text

When applying redaction to annotations, keep the following points in mind:
- If you process with OCR a document that has text hidden under a redaction, the hidden text is not included in the text view of the document.
- If you full-text index a document that has text hidden under a redaction, the hidden text is not included in the full-text index of the document.
- If you use an annotation with redaction to hide text in a document that has been processed with OCR and then save the annotation change, the text view is deleted.
- If you use an annotation with redaction to hide text in a document that has been full-text indexed and then save the annotation change, the text view is deleted and the document is automatically resubmitted to the Index Server.
- If you use an annotation with redaction to hide text in a PDF file, the text is still considered a hit by a text search. When users display a PDF document and perform a text search with a word that is hidden under a redaction as search criteria, the search stops, but the highlighted word remains hidden.
- If you use an annotation with redaction to hide text in a PDF file, and if the PDF file is later submitted to the Index Server for full-text indexing, the text hidden behind the redaction is not removed. This means that even users who do not have the appropriate privileges to hide a redaction can find the document by performing a full-text search with the hidden text as search criteria.

For more information, see:
- Default Redaction Setting, page 448

Creating a Line or Shape Annotation

After configuring the properties of the annotation, you can add any one of several different types of annotations to the AppXtender page. You can apply any text, line, shape, or highlight annotation that best emphasizes the desired area of the image. Lines include straight lines, freehand lines, arrows, or polylines. Shapes include rectangles, rounded rectangles, ovals, or polygons. You can apply annotation text in a desired color and font format. AppXtender also allows you to create "rubber stamp" annotations, which can be a custom text string or embedded bitmap.
Annotations

Note: Only users with appropriate privileges can control the annotation features. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator’s Guide.

Note: If your user account has been configured with annotation group options, but does not have any annotation privileges, you must set your annotation group as default to use annotation features. For instructions on setting an annotation group as default, refer to Assigning a Default Annotation Group, page 468.

For more information, refer to the following section topics:
- Creating a Line Annotation, page 450
- Creating a Shape Annotation, page 452
- Creating a Highlight Annotation, page 453
- Working with Rubber Stamp Annotations, page 457

Creating a Line Annotation

You can add basic line annotations and polyline annotations to AppXtender pages. Basic line annotations are straight lines, freehand lines, and arrows. A polyline annotation is a series of connected straight lines.

For more information, refer to the following section topics:
- Creating a Basic Line Annotation, page 450
- Creating a Polyline Annotation, page 451

Creating a Basic Line Annotation

You can add straight lines, freehand lines, and arrows (basic line annotations) to AppXtender pages.

To add a basic line annotation to a page:
1. Display the page to which you want to add a basic line annotation.
2. Choose one of these options to select a type of line annotation:
   - Select Annotate> New from the Document Manager menu bar, and then select the annotation from the shortcut menu.
   - Click the appropriate button on the Annotation toolbar.
   - Press the keyboard shortcut.

   The following table describes the available line annotations.
Table 64. Creating Basic Lines

<table>
<thead>
<tr>
<th>To Create</th>
<th>Shortcut Menu Option</th>
<th>Button</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>A straight line</td>
<td>Straight Line</td>
<td></td>
<td>L</td>
</tr>
<tr>
<td>A freehand line</td>
<td>Freehand Line</td>
<td></td>
<td>F</td>
</tr>
<tr>
<td>An arrow</td>
<td>Arrow</td>
<td></td>
<td>A</td>
</tr>
</tbody>
</table>

The mouse pointer changes shape to reflect your selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new line annotation appears on the image.

4. Save the annotation. Refer to Saving Annotations, page 445 for more information.

For more information, see:
- Creating a Line Annotation, page 450

Creating a Polyline Annotation

You can add polyline annotations to AppXtender pages. A polyline is a line that connects more than one point, or node. The nodes defining the polyline do not have to be aligned. With the polyline feature, you can create line annotations that are not straight lines. Polyline annotations can contain angles and can even delineate shapes.

Note: A shape created with the polyline feature cannot be filled with color. You can use the polygon feature to create polygon shapes, which can be filled with color. For information on polygon annotations, refer to Creating a Polyline Annotation, page 451.

Each point in a polyline annotation is specified by a single left mouse click. You draw the line point by point, stretching each straight-line segment from the endpoint of the last.

To add a polyline annotation to a page:

1. Display the page to which you want to add a polyline annotation.
2. Choose one of these options to activate the polyline annotation symbol:
   - Select Annotate> New> Polyline from the Document Manager menu bar.
   - Press p.
3. Click where you want the polyline to start. This creates the first node in the line.
4. Move the pointer and click again to set the endpoint for the first segment of the polyline. This endpoint is the next node in the line.
5. Continue to draw line segments by moving the pointer and clicking wherever you want each segment to end. Each of these endpoints becomes a new node in the line. Each segment created is connected to the previous segment.

Note: To erase the polyline without adding it, right-click anywhere on the AppXtender page.
6. When the polyline is complete, double-click where you want the last node to appear. The annotation is added to the page.

7. Save the annotation. Refer to *Saving Annotations, page 445* for more information.

For more information, see:
- Creating a Line Annotation, page 450

### Creating a Shape Annotation

You can add basic shape annotations and polygon annotations to AppXtender pages. Basic shape annotations are rectangles, rounded rectangles, and ovals. A polygon annotation is a closed shape, composed of a series of connected, straight lines that can be filled with color like any other shape.

For more information, refer to the following topics:
- Creating a Basic Shape Annotation, page 452
- Creating a Polygon Annotation, page 453

### Creating a Basic Shape Annotation

You can add rectangles, rounded rectangles, and ovals (basic shape annotations) to AppXtender pages.

**To add a basic shape annotation to a page:**

1. Display the page to which you want to add a basic shape annotation.

2. Choose one of these options to select a shape annotation:
   - Select Annotate> New from the Document Manager menu bar, then select the annotation from the shortcut menu.
   - Click the appropriate button on the Annotation toolbar.
   - Press the keyboard shortcut.

   The following table describes the available shape annotations.

   **Table 65. Creating Basic Shapes**

<table>
<thead>
<tr>
<th>To Create</th>
<th>Shortcut Menu Option</th>
<th>Button</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>A rectangle</td>
<td>Rectangle</td>
<td>![Rectangle]</td>
<td>R</td>
</tr>
<tr>
<td>A rounded rectangle</td>
<td>Rounded Rectangle</td>
<td>![Rounded Rectangle]</td>
<td>N</td>
</tr>
<tr>
<td>An oval</td>
<td>Oval</td>
<td>![Oval]</td>
<td>O</td>
</tr>
</tbody>
</table>

   The mouse pointer changes shape to reflect the selection.

3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new shape annotation appears on the image.
4. Save the annotation. Refer to Saving Annotations, page 445 for more information.

For more information, see:

- Creating a Shape Annotation, page 452

**Creating a Polygon Annotation**

You can add polygon annotations to AppXtender pages. A polygon is a shape that does not have to be symmetrical, with sides comprised of straight lines. Each left mouse click defines the point of a corner (or node) of the polygon. AppXtender draws a figure by connecting each point created by a left mouse click from the first point created to the last point created and back to the first point. The nodes defining the polygon do not have to be in alignment. With the polygon feature, you can create asymmetrical shape annotations with many sides.

**To add a polygon annotation to a page:**

1. Display the page to which you want to add a polygon annotation.
2. Choose one of these options to activate the polygon annotation symbol:
   - Select Annotate> New> Polygon from the Document Manager menu bar.
   - Press g.
3. Click where you want the polygon to start. This action creates the first node in the shape.
4. Move the pointer and click again where you want to set the endpoint for the first side of the polygon. This endpoint is the next node in the shape. At this point, the shape appears as a line between the two points.
5. Draw the next node in the polygon by moving the pointer and clicking the left mouse button wherever the next node in the shape should be located. Lines stretch to this node from each of the two existing nodes, creating a triangle. Continue to add nodes in the shape as needed. When a new node is added, lines stretch from that node to the last node created and to the first node created for the shape.
   
   **Note:** To erase the polygon without adding it, you can right-click anywhere.
6. When the polygon is complete, double-click to add the annotation to the page.
7. Save the annotation. Refer to Saving Annotations, page 445 for more information.

For more information, see:

- Creating a Shape Annotation, page 452

**Creating a Highlight Annotation**

A highlight annotation allows you to emphasize or bring attention to a particular area of an AppXtender page.

**To add a highlight annotation to a page:**

1. Display the page to which you want to add a highlight annotation.
2. Choose one of these options to activate the highlighter annotation symbol:
   - Select Annotate > New > Highlight from the Document Manager menu bar.
   - Press h.
3. Drag the mouse pointer from a starting point to an end point. As you drag the pointer, a new highlight annotation appears on the image.
4. Save the annotation. Refer to Saving Annotations, page 445 for more information.
   For more information, see:
   - Creating a Line or Shape Annotation, page 449

Creating Text Annotations

AppXtender Document Manager has two tools for creating text annotations. For more information, refer to the following section topics:
   - Using the Annotation Text Editor, page 454
   - Using the In-place Text Editor, page 456

Using the Annotation Text Editor

The Annotation Text Editor is a dialog box text annotation tool.

To use the Annotation Text Editor to create a text annotation:
1. Display the page to which you want to add a text annotation.
2. Choose one of these options to activate the text annotation symbol:
   - Select Annotate > New > Text from the Document Manager menu bar.
   - Press t.
   Note: You must have redaction privileges to create and modify non-transparent text annotations.
3. Click the location on the AppXtender page where you want to place the text annotation. The Annotation Text Editor dialog box appears.
4. Under Annotation Text, type the text that you want to use as the annotation. Press Enter to start a new line in the editor.

5. Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.

6. Correct or confirm the spelling of any questionable words.
   
   **Note:** Click Help on the Check Spelling dialog box for more information on spell-checker options.

7. Click OK to close the AppXtender message box after all words have been checked.

8. Specify how you want Document Manager to display the text annotation:
   
   - To display this annotation as an icon, select Display As Icon.
   
   - To display the text as the annotation, clear the Display As Icon check box.

   **Note:** You must have the Global Annotations privilege to view or modify the text of a text annotation icon created by another user. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

9. If you want to define the font and color features for the annotation text, click Advanced. The advanced options appear.
10. Select the desired color and font size, and select the check boxes for any other desired font properties. Select the Set as Default check box to save the current settings as the default.

   **Note:** Any color selection in the text annotation editor applies only to text annotations and does not affect shape, line, or highlight annotations.

   **Note:** To modify the size of a text annotation, you must modify the text font.

11. Click OK to apply the text annotation to the image.

12. Save the annotation. Refer to Saving Annotations, page 445 for more information.

### Using the In-place Text Editor

The in-place text editor is a What You See Is What You Get (WYSIWYG) text annotation tool.

**To use the in-place text editor to create a text annotation:**

1. Display the page to which you want to add a text annotation.

2. Choose one of these options to activate the text editor:
   - Press Shift-t.
   - Press and hold down Alt, left-click the Text button on the Annotation toolbar, release Alt.

   The cursor becomes a pushpin.

3. Left-click and drag the pushpin over the page to define the border of the text editor.
4. Type the text annotation. Press Ctrl-Enter to start a new line in the editor.
5. Click Sp to check the spelling of the text annotation. The Check Spelling dialog box appears.
6. Correct or confirm the spelling of any questionable words.
   Note: Click Help on the Check Spelling dialog box for more information on spell-checker options.
7. Click OK to close the AppXtender message box after all words have been checked.
8. Click the green check mark to apply the text annotation to the image.
9. Save the annotation. Refer to Saving Annotations, page 445 for more information.

Working with Rubber Stamp Annotations

Rubber Stamps are pre-defined annotations that can be used to describe certain events. For example, you could have a rubber stamp that says "Added by Username on Date", where Username and Date are populated by your name and the date you added the annotation. Some rubber stamps can be composed of an image, so that you can place a signature or other relevant graphic on a page. When you select a rubber stamp, AppXtender places it on the AppXtender page wherever you click your mouse. You can move or delete a rubber stamp annotation, just as you can other types of annotations, but cannot edit its properties.

Note: Rubber stamps must be added and configured by the AppXtender system administrator before they are available for use. Also, only users with appropriate privileges can control the annotation features. If rubber stamps have not been configured, or if you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator.

For more information, see:
- Chapter 9, Annotations
- Creating a Text Rubber Stamp Annotation from an Existing File, page 462
- Creating an Image Rubber Stamp Annotation from an Existing File, page 464
- Adding Rubber Stamp Annotations to Pages, page 464
Creating a New Text Rubber Stamp Annotation

You can specify display properties for a text rubber stamp. You can also configure security so that a rubber stamp is used for a single application by a single user and/or group. If the AppXtender system is using the Windows security provider, you can also specify a domain.

To create a new text rubber stamp annotation:

1. From the Application view tree structure, right-click the _RSTAMP application. From the shortcut menu that appears, select New Text Rubber Stamp. The New Text Rubber Stamp dialog box appears.

Figure 216. New Text Rubber Stamp Dialog Box

2. The Rubber Stamp Text text box allows you to designate what text should be displayed when the rubber stamp is added to a page. You can add this information in two ways:
   - Type the text you would like to use for the rubber stamp in the Rubber Stamp Text text box. Type %crlf% to insert a carriage return. The text that follows %crlf% appears on a new line.
     You can also use format strings within the text you add to insert the user name and date. For a list of format strings that can be used, refer to the following table.
   - Select a pre-configured rubber stamp from the Rubber Stamp Text drop-down list. For a list of format strings that you can use, as well as pre-configured rubber stamps available from the drop-down list, refer to the following table.

Note: You can enter up to 255 characters in a text rubber stamp annotation.
Table 66. Rubber Stamp Format Strings

<table>
<thead>
<tr>
<th>Format String</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>%username%</td>
<td>Places the current user name as part of the stamp text. This format string identifies the user who created the rubber stamp annotation for the page.</td>
</tr>
<tr>
<td>%datestamp%</td>
<td>Places a short form of date stamp (for example 6/15/00), as part of the stamp text. This format string indicates the date when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td>%DATESTAMP%</td>
<td>Places a long form for date stamp (for example, &quot;Thursday, June 15, 2000&quot;), as part of the stamp text. This format string indicates the date when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td>%timestamp%</td>
<td>Places a time stamp as part of the stamp text. This format string indicates the time when the rubber stamp annotation was created for the page.</td>
</tr>
<tr>
<td>Approved</td>
<td>Places the text &quot;Approved&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Not Approved</td>
<td>Places the text &quot;Not Approved&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Confidential</td>
<td>Places the text &quot;Confidential&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Do Not Duplicate</td>
<td>Places the text &quot;Do Not Duplicate&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>For Internal</td>
<td>Places the text &quot;For Internal Distribution Only&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Distribution Only</td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td>Places the text &quot;Draft&quot; as part of the stamp text.</td>
</tr>
<tr>
<td>Reviewed by</td>
<td>Places the text &quot;Reviewed by&quot; and the current user name as part of the stamp text. This format string identifies the user who created the rubber stamp annotation for the page.</td>
</tr>
<tr>
<td>%username%</td>
<td></td>
</tr>
</tbody>
</table>

3. Select any of the following options to further customize the rubber stamp:
   - To make the rubber stamp transparent, select the Transparent check box. The default setting is checked but dimmed. This indicates that the local workstation redaction setting will be used. If the Transparent option is cleared, the rubber stamp is set to redacted.
   - In the Orientation drop-down list, choose the angle at which you would like the text to appear. Available options are 0, 90, 180, and 270. The default setting is 0.
   - In the Border drop-down list, select the type of border you would like to surround the rubber stamp text. Available options are None, Rectangle, and Round Rectangle. The default setting is Round Rectangle.
   - If a border is defined in the Border Size drop-down list, select the line width of the border in pixels from the Border Size spin box. Available options range from 0 to 20. If 0 is selected, the border is set to the line width set in the local workstation. The default setting is 0.
   - To change any font attribute, click Font. The Font dialog box appears. For further instructions, refer to Changing the Font of a Rubber Stamp, page 460.
   - To change the background color of the rubber stamp, click Back Color. The standard windows Color dialog appears. Choose a color or create a custom color to use for the text rubber stamp.
background color. (For further instructions, refer to your Windows documentation.) In the Color dialog box, click OK. The New Text Rubber Stamp dialog box reappears.

4. Consider resetting or saving default settings:
   - To reset rubber stamp properties to their default settings, click Restore Default in the New Text Rubber Stamp dialog box. All settings are restored to the default settings.
   - To save the current settings as the default rubber stamp settings, click Set As Default. The properties that you have assigned to the current rubber stamp will be used as the default settings for any new rubber stamp that you create.

5. When you have made all of the changes to the rubber stamp that you want to make, click OK. The index for the rubber stamp appears, along with the rubber stamp itself in XML format (XML is the underlying data structure used by rubber stamps to define the rubber stamp properties used for rendering the stamp on the page). The rubber stamp index has the following fields: NAME, DESC, APP, USER, and DOMAIN.

6. In the NAME index field, enter the name of the rubber stamp (this is the name that users will see when selecting a rubber stamp).

7. You have the following options:
   - In the DESC index field, you can enter a description of the rubber stamp.
   - To restrict the rubber stamp to a single application, enter the name of the application in the APP index field. If the APP field is left blank, the rubber stamp will be accessible in all applications.
   - To restrict the rubber stamp to a single user or group, enter the user or group name in the USER index field. If you leave the USER field blank, the rubber stamp is accessible to all users with Edit Annotations privileges.
     
     **Note:** If you assign a rubber stamp to a user name that is used by both a user and a group, the user and all members of the group will have access to the rubber stamp.

     **Note:** If the data source is using a directory service security provider, in order to restrict the rubber stamp to a single user or group, you must enter the name exactly as it appears in AppXtender Application Generator.

   - In the DOMAIN index field, if the AppXtender system is using the Windows security provider, you must enter a domain name for the user or group specified in the USER index field.

8. Click Save to save the rubber stamp.

For more information, see:
- Working with Rubber Stamp Annotations, page 457
- Changing the Font of a Rubber Stamp, page 460

**Changing the Font of a Rubber Stamp**

The Font dialog box allows you to change any font attribute of a rubber stamp.
To change font attributes of a rubber stamp:

1. In the Font dialog box, change the font properties of the text rubber stamp annotation as described in the following table:

   Table 67. Changing Properties of a New Text Rubber Stamp Annotation

<table>
<thead>
<tr>
<th>To change</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font format</td>
<td>Under Font, select a font type.</td>
</tr>
<tr>
<td>Font style</td>
<td>Under Font style, select the font attributes you would like to use.</td>
</tr>
<tr>
<td></td>
<td>Available options are Regular, Italic, Bold, and Bold Italic.</td>
</tr>
<tr>
<td>Point size</td>
<td>Under Size, select the point size for the specified font.</td>
</tr>
<tr>
<td>Font appearance</td>
<td>Under Effects, enable Strikeout if you want the text to appear with a</td>
</tr>
<tr>
<td></td>
<td>line through it, or Underline, if you want the text to appear underlined.</td>
</tr>
<tr>
<td>Color for the specified</td>
<td>Under Color, select a font color from the list.</td>
</tr>
<tr>
<td>font</td>
<td></td>
</tr>
<tr>
<td>Language scripts for the</td>
<td>The Script box is not currently enabled (reserved for future use).</td>
</tr>
<tr>
<td>specified font</td>
<td></td>
</tr>
</tbody>
</table>

The Sample box shows how the text will appear when the settings you choose are applied.

2. In the Font dialog box, click OK. The New Text Rubber Stamp dialog box reappears.
For more information, see:
- Working with Rubber Stamp Annotations, page 457

Creating a Text Rubber Stamp Annotation from an Existing File

You can import a rubber stamp directly into the _RSTAMP application using an Extensible Markup Language (XML) text file. The rubber stamp tag encapsulates the entire rubber stamp data structure. Anything outside the data structure is ignored. Once a rubber stamp is imported into the _RSTAMP application, you can then add the rubber stamp to an AppXtender page.

The following sample XML file defines a data structure for importing a rubber stamp, including the font, font size, border, and bold.

Figure 218. Sample Text Rubber Stamp XML Text File

```xml
<?xml version="1.0"?>
<rubberstamp>
  <![CDATA[The current logged in user: $username$]]>
  <border>2</border>
  <bordersize>5</bordersize>
  <forecolor>000000ff</forecolor>
  <backcolor>0000ffff</backcolor>
  <bold>1</bold>
</rubberstamp>
```

To create a text rubber stamp annotation from an existing file:

1. Right-click the _RSTAMP application.
2. From the shortcut menu that appears, select Import File. The Import File dialog box appears.

Figure 219. Import File Dialog Box
**Note:** You must configure the file types so that the file is imported as plain text. For more information on configuring file types, refer to File Types Tab, page 132 consult your AppXtender system administrator or refer to the "Configuring ApplicationXtender Workstations" chapter of the ApplicationXtender Core Components Administrator’s Guide.

3. Select the file that you want to import and click Open. AppXtender displays the new document in the Document Display view and the Index view.

**Figure 220. Imported Rubber Stamp with Index View**

4. Enter the index information for the new document as described in the following table:

**Table 68. Rubber Stamp Index Fields**

<table>
<thead>
<tr>
<th>Index Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Name of the rubber stamp.</td>
</tr>
<tr>
<td>DESC</td>
<td>Description of the rubber stamp.</td>
</tr>
<tr>
<td>APP</td>
<td>Application name associated with this rubber stamp. If this field is empty, this rubber stamp is available for all applications.</td>
</tr>
<tr>
<td>Index Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>USER</td>
<td>User name or group name associated with this rubber stamp. If this field is empty, this rubber stamp is available for all users.</td>
</tr>
<tr>
<td>DOMAIN</td>
<td>If the AppXtender system uses the Windows security provider, domain associated with this rubber stamp. If this field is empty, this rubber stamp is available to all domains. If the AppXtender system uses the CM security provider or a directory service security provider, leave this field blank. For more information about security providers, refer to the ApplicationXtender Core Components Administrator’s Guide.</td>
</tr>
</tbody>
</table>

5. Click Save. The new document is added to the list of available rubber stamps in the _RSTAMP application.

For more information, see:
• Working with Rubber Stamp Annotations, page 457

Creating an Image Rubber Stamp Annotation from an Existing File

You can create an image rubber stamp by importing it directly into the _RSTAMP application. Image rubber stamps allow you to use images in place of rubber stamp text. You can use an image rubber stamp to place signatures or other customized images on AppXtender pages.

To create an image rubber stamp annotation:
1. Right-click the _RSTAMP application.
2. From the shortcut menu that appears, select Import File. The Import File dialog box appears.
   Note: AppXtender supports the following extensions: BMP, TIFF, DCX, GIF, JPG, and PCX.
4. Enter the index information for the new document as described in the previous table.
5. Click Save. The new document is added to the list of available rubber stamps in the _RSTAMP application.

For more information, see:
• Working with Rubber Stamp Annotations, page 457

Adding Rubber Stamp Annotations to Pages
You can add rubber stamp annotations to AppXtender pages in a variety of ways. For information, refer to the following sections:

- Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps, page 465
- Adding a Rubber Stamp from the Select Rubber Stamp Dialog Box, page 466
- Applying a Rubber Stamp with the Rubber Stamp Shortcut Key, page 467

Adding a Rubber Stamp from the List of Most Recently Used Rubber Stamps

You can select a rubber stamp from the Rubber Stamp drop-down menu. This menu contains a list of up to 10 of the most recently used rubber stamps for the current application. Each menu item has an icon displayed to its left to identify the type of stamp (text or image).

To add a rubber stamp annotation using the Rubber Stamp drop-down menu:

1. Display the page to which you want to add a rubber stamp annotation.
2. Click the arrow next to the Rubber Stamp Annotation button on the Annotation toolbar.

   **Figure 221. Rubber Stamp Annotation Button**

   ![Rubber Stamp Annotation Button](image)

   The Rubber Stamp Annotation menu appears with up to 10 of the most recently used rubber stamps for the current application and the More Rubber Stamps option.

   **Figure 222. Rubber Stamp Annotation Drop-Down Menu**

   ![Rubber Stamp Annotation Drop-Down Menu](image)

3. Select the rubber stamp from the menu. The Rubber Stamp annotation button is then activated (the button appears in a lighter gray color), and the cursor changes to Rubber Stamp mode.

   **Figure 223. Cursor in Rubber Stamp Mode**

   ![Cursor in Rubber Stamp Mode](image)

4. Place your cursor where you want the rubber stamp to appear and click once. To add additional copies of the rubber stamp, click wherever you want the rubber stamp to appear.
5. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to its normal state.
For more information, see:
• Adding Rubber Stamp Annotations to Pages, page 464

**Adding a Rubber Stamp from the Select Rubber Stamp Dialog Box**

The Select Rubber Stamp dialog box contains a list of up to 256 rubber stamps. You can create more than 256 rubber stamps, but only 256 are returned and displayed in the dialog box. Each menu item has an icon displayed to its left to identify the type of stamp (text or image).

To add a rubber stamp annotation using the Select Rubber Stamp dialog box:

1. Display the page to which you want to add a rubber stamp annotation.
2. Select Annotate > New > Rubber Stamp from the Document Manager menu bar. The Select Rubber Stamp dialog box appears.

![Figure 224. Select Rubber Stamp Dialog Box](image)

3. Select a rubber stamp.
4. Click OK. (To cancel the rubber stamp selection, click Cancel.)
5. The Rubber Stamp annotation button is then activated (the button appears in a lighter gray color), and the cursor changes to Rubber Stamp mode.

![Figure 225. Cursor in Rubber Stamp Mode](image)

6. Place your cursor where you want the rubber stamp to appear and click once. To add additional copies of the rubber stamp, click wherever you want the rubber stamp to appear.
7. To deactivate the rubber stamp, click once on the Rubber Stamp button. The cursor returns to its normal state.
Note: Press s to apply the same rubber stamp to other images. To use the shortcut to apply a different rubber stamp, you must change the rubber stamp.

For more information, see:
• Adding Rubber Stamp Annotations to Pages, page 464

Applying a Rubber Stamp with the Rubber Stamp Shortcut Key

To apply a rubber stamp with the rubber stamp shortcut key:
1. Display the page to which you want to add a rubber stamp annotation.
2. Press s to activate the rubber stamp annotation symbol.
3. Left-click at the location where you want to apply the rubber stamp. Document Manager applies the most recently used rubber stamp.

Note: You must select a different rubber stamp if you want to link the shortcut key to the new rubber stamp.

For more information, see:
• Creating Line and Shape Annotations, page 445

Overlapping Annotations

AppXtender allows you to place multiple annotations on one image. You can overlap these annotations, extending one over the other. When a new annotation is created, it is placed on the top "layer" of the page. Through tools on the Annotation toolbar, you can place an annotation behind another annotation.

Note: When you draw a freehand annotation around an existing annotation on an AppXtender page, you cannot select the other annotation. For example, if you attempt to select an annotation that is "inside" a freehand annotation, only the freehand annotation is selected. In addition, when a freehand annotation crosses over another annotation, AppXtender may not allow you to select the other annotation.

Note: AppXtender can accurately pinpoint the exact hit for a simple shape annotation. For example, if you click the lines or border of a line annotation or a non-fill rectangle, oval, or rounded-rectangle, AppXtender determines whether or not the mouse pointer hit the simple shape annotation. However, since a freehand annotation is not a simple shape annotation, AppXtender uses a minimum rectangular area, which covers all the nodes of a freehand annotation, to determine whether or not the mouse pointer hit the freehand annotation.

To move annotations to the front layer:
1. Select the annotations that you want to move to the front. For instructions, refer to Selecting Annotations, page 476.
2. Choose one of these options to move the annotations:
   • Click the To front button on the Annotation toolbar.
   • Press Shift-semicolon (;).
To move the annotation to the back layer:

1. Select the annotations that you want to move to the back. For instructions, refer to Selecting Annotations, page 476.

2. Choose one of these options to move the annotations:
   - Click the To back button on the Annotation toolbar.
   - Press semicolon (;

For more information, see:

- Chapter 9, Annotations

Assigning an Annotation to an Annotation Group

If your user or group account is a member of an annotation group, you might be able to assign an annotation to that annotation group. For guidelines on which annotations should be assigned to each annotation group, consult your AppXtender administrator.

After you assign an annotation to an annotation group, users who are not members of the annotation group cannot view or modify the annotation. After you add a redaction to an annotation group, users who are not members of the annotation group cannot hide or modify the redaction. Depending on the options enabled for each user or group within the annotation group and depending on who created the annotation or redaction, users who are members of the annotation group may be able to view or view and modify annotations in the annotation group and hide or hide and modify redactions in the annotation group.

Note: Only users with appropriate annotation group options can assign annotations to annotation groups. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

To assign an annotation to an annotation group:

1. Select the annotations that you want to assign to an annotation group. For instructions, refer to Selecting Annotations, page 476.
2. Right-click the selected annotations.
3. From the shortcut menu that appears, select Group Assignment. Another shortcut menu appears, listing the annotation groups to which you can assign the currently selected annotations. (The annotation groups that are listed depend on properties of the selected annotations.)
4. From the second shortcut menu, select the annotation group to which you want to assign the annotation.

Assigning a Default Annotation Group

If your user account is a member of an annotation group, you might be able to specify that particular annotation group as a default annotation group. When a new annotation is created or when current
settings are applied to an annotation, the annotation is assigned to the default annotation group. If your AppXtender administrator instructs you that the annotations you create should be added to a specific annotation group, you can set that annotation group as a default to cause the annotations you create or modify to be automatically added to the group.

Note: Only users with appropriate annotation group options can specify an annotation group as default. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

To specify an annotation as a default annotation group:

1. From the Annotate menu, select Settings and then Default Annotation Group. The Select the Default Annotation Group dialog box appears.

   Figure 226. Select the Default Annotation Group Dialog Box

   ![Select the Default Annotation Group Dialog Box](image)

2. Select the group that you want to use as the default group.

3. Click OK.

   For more information, see:
   • Chapter 9, Annotations

### Showing or Hiding Annotations

It may be preferable for you to display, print, e-mail, or export AppXtender documents without annotations. The following sections describe how to do so:

- Hiding Annotations When Viewing Documents, page 470
- Hiding Annotations When Printing, page 471
Hiding Annotations When Viewing Documents

AppXtender provides an option to show or hide all annotations provided you have hide annotation privileges.

**Note:** Only users with appropriate privileges can hide annotations. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator's Guide*.

To show all displayed annotations:
- Select Show from the Annotate menu to place a check mark next to the Show option on the menu.

To hide all displayed annotations:
- Select Show from the Annotate menu to remove the check mark from the Show option on the menu.

For more information, see:
- **Showing or Hiding Annotations, page 469**
- **Hiding Annotations by Annotation Group, page 470**

Hiding Annotations by Annotation Group

If your user or group account is a member of an annotation group, you might be able to hide all annotations on a displayed page that have been assigned to that annotation group. For example, if your user account has been configured with the View Annotations option in an annotation group called ACCOUNTING, you can hide all unredacted annotations on a purchase order that have been added to the ACCOUNTING annotation group.

**Note:** Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator's Guide*.

**To show or hide annotations by annotation group:**

1. From the Annotate menu, select Show Groups. The Show/hide Annotation Groups dialog box appears.

---

- **Hiding Annotations When E-mailing, page 472**
- **Hiding Annotations When Exporting, page 474**

For more information, see:
- **Showing or Hiding Annotations, page 469**
2. Click the check box next to the name of the annotation group that you want to hide or show.

3. When each annotation group that you want to hide has no check mark and each annotation group that you want to show has a check mark, click OK. The annotations on the currently displayed page are shown or hidden according to your selections.

For more information, see:
- Showing or Hiding Annotations, page 469
- Hiding Annotations When Viewing Documents, page 470

**Hiding Annotations When Printing**

You can print AppXtender documents, pages, or regions of an image without annotations. AppXtender provides an option on the Print dialog box to hide all annotations. The Print dialog box can be accessed from the Document menu, Page menu, or Result Set tab. In order to hide annotations when printing AppXtender documents from the Document menu or AppXtender pages or regions from the Page menu, the AppXtender document or page must be displayed. You can hide annotations when printing from the Result Set tab without displaying the AppXtender document or page.

**Note:** Only users with appropriate privileges (including the Print privilege) can hide annotations while printing. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide.*
To print a document with or without annotations:

1. Select and right-click the documents you want to print from the result set. Select Print. The Print dialog box appears.

   **Figure 228. Print Dialog Box**

   ![Print Dialog Box](image)

2. From the Print dialog box, you have the following options:
   - To print the documents without annotations, select the Hide annotations check box.
   - To print the documents with annotations, clear the Hide annotations check box.

3. Click OK to begin printing.

For more information, see:
- Showing or Hiding Annotations, page 469
- Printing or Faxing Documents and Pages, page 354

**Hiding Annotations When E-mailing**

You can send AppXtender documents or pages by e-mail without annotations. For instructions, refer to the following sections:
- Hiding Annotations When E-mailing Documents, page 473
- Hiding Annotations When E-mailing Pages, page 474

**Note:** Only users with appropriate privileges (including the Print privilege) can hide annotations while e-mailing. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user.
account, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the ApplicationXtender Core Components Administrator's Guide.

For more information, see:
- Showing or Hiding Annotations, page 469

### Hiding Annotations When E-mailing Documents

The E-mail Document Pages dialog box allows you to hide all annotations when sending documents by e-mail.

**To e-mail a document with or without annotations:**

1. You have the following choices:
   - Select the document or documents to be mailed on the Result Set tab, and right-click your selection. From the shortcut menu that appears, select Mail.
   - Display the document you want to e-mail. From the Document menu, select Mail. The E-mail Document Pages dialog box appears.

   **Figure 229. Email Document Pages Dialog Box**

   ![Email Document Pages Dialog Box](image)

2. From the E-mail Document Pages dialog box, you have the following options:
   - To e-mail the document without annotations, select the Hide annotations check box.
   - To e-mail the document with annotations, clear the Hide annotations check box.

3. Click OK.

For more information, see:
- Hiding Annotations When E-mailing, page 472
- E-Mailing from the Result Set, page 362
- E-Mailing Displayed Documents, page 365
Hiding Annotations When E-mailing Pages

You can choose to hide or show all annotations on a page before e-mailing that page.

To e-mail a page with or without annotations:
1. Display the page you want to e-mail.
2. Show or hide annotations on the page as you want them to be e-mailed. For instructions, refer to Hiding Annotations When Viewing Documents, page 470.
3. From the Page menu, select Mail.

For more information, see:
- Hiding Annotations When E-mailing, page 472
- E-Mailing Pages, page 369

Hiding Annotations When Exporting

You can export AppXtender documents or pages without annotations. For instructions, refer to the following sections:
- Hiding Annotations When Exporting Documents, page 474
- Hiding Annotations When Exporting Pages, page 475

Note: Only users with appropriate privileges (including the Print privilege) can hide annotations while exporting. Only users with appropriate annotation group options can hide annotations that have been assigned to annotation groups. If you have questions about the privileges assigned to your AppXtender user profile, or about the annotation group configuration of your AppXtender user account, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

For more information, see:
- Showing or Hiding Annotations, page 469

Hiding Annotations When Exporting Documents

The Export Document Pages dialog box allows you to hide all annotations during export.

To export a document with or without annotations:
1. Display the document you want to export.
2. From the Document menu, select Export and then Images. The Export Document Pages dialog box appears.
3. From the Export Document Pages dialog box, you have the following options:
   • To export the document without annotations, select the Hide annotations check box.
   • To export the document with annotations, clear the Hide annotations check box.

4. Click Save to begin exporting.
   For more information, see:
   • Hiding Annotations When Exporting, page 474
   • Exporting a Displayed Document to a File, page 371

Hiding Annotations When Exporting Pages

You can choose to hide or show all annotations on a page before exporting that page.

To export a page with or without annotations:
1. Display the page you want to export.
2. Show or hide annotations on the page as you want them to be exported. For instructions, refer to Hiding Annotations When Viewing Documents, page 470.
3. From the Page menu, select Export and then Images.
   For more information, see:
   • Hiding Annotations When Exporting, page 474
   • Exporting a Page to a File, page 378
Modifying Annotation Settings

The properties of an annotation can be modified after it has been applied or saved to an image. You can alter the outline width, color, opacity, or fill of the annotation. For more information, refer to the following topics:

- Selecting Annotations, page 476
- Moving Annotations, page 477
- Resizing an Annotation, page 478
- Modifying Shape Annotations, page 478
- Modifying Text Annotations, page 480
- Editing Text Rubber Stamp Annotations, page 482

Note: Only users with appropriate privileges can modify annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

Note: If the AppXtender system has been converted from the CM security provider to the Windows security provider and you created and saved annotations while the CM security provider was in use, you must have both the Global Annotations and Edit Annotations privileges assigned to your profile in order to modify those annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the ApplicationXtender Core Components Administrator’s Guide.

Selecting Annotations

The following table describes the methods you can use to select annotations:

Table 69. Selecting Annotations

<table>
<thead>
<tr>
<th>To Select</th>
<th>Do This</th>
<th>Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>One annotation</td>
<td>Enable the Annotation Selection button on the Annotation toolbar. Click the annotation that you want to modify.</td>
<td><img src="image" alt="Annotation button" /></td>
</tr>
<tr>
<td>An annotation that is behind another annotation</td>
<td>Enable the Annotation Selection button on the Annotation toolbar. Click any annotation. Press the [TAB] key until the annotation that you want to modify is selected.</td>
<td><img src="image" alt="Annotation button" /></td>
</tr>
</tbody>
</table>
To Select | Do This | Button
--- | --- | ---
Multiple annotations | Enable the Annotation Selection button on the Annotation toolbar. Click one of the annotations that you want to modify. While holding the [SHIFT] key, click each additional annotation that you want to modify. | ![Annotation Selection Button]
All annotations | Click the Select All button on the Annotation toolbar. | ![Select All Button]

**Note:** Press the spacebar to toggle between annotation selection mode and pan mode.

The appearance of each annotation changes to indicate that it is selected. For example, a selected text annotation is enclosed in a gray frame, a selected arrow has a handle on each end, and a selected oval is enclosed in both a gray frame and handles.

**Figure 231. Selected and Unselected Annotations**

For more information, see:
- Overlapping Annotations, page 467
- Assigning an Annotation to an Annotation Group, page 468
- Modifying Annotation Settings, page 476
- Deleting Annotations, page 486

### Moving Annotations

You can use the mouse pointer to move a single annotation or multiple annotations together.

**To move annotations:**

1. Select the annotations that you want to move. For instructions, refer to Selecting Annotations, page 476.
2. Hold the pointer over the selected annotation or annotations. The pointer changes to crossed double arrows.
3. Drag the annotation or annotations to a new location. Changes to the selected annotation or annotations are reflected immediately.
4. Save your changes. Refer to Saving Annotations, page 445 for more information. For more information, see:
   • Modifying Annotation Settings, page 476

Resizing an Annotation

You can use the mouse pointer to resize any type of annotation, including text annotations created with the in-place text editor.

To resize a single annotation:

1. Select the annotation that you want to resize. For instructions, refer to Selecting Annotations, page 476.
2. Hold the pointer over one of the handles on the selected annotation. The pointer changes to a double arrow.
3. Drag the handle to a new location. Changes to the selected annotation are reflected immediately.
4. Save your changes. Refer to Saving Annotations, page 445 for more information. For more information, see:
   • Modifying Annotation Settings, page 476

Modifying Shape Annotations

To modify a shape annotation:

1. Select the annotation. For instructions, refer to Selecting Annotations, page 476.
2. Right-click and select Properties from the shortcut menu. The Annotation Properties dialog box appears.
The Annotation Properties dialog box provides information on the creation date, time, and user, and the latest modification date, time, and user for the annotation. If the AppXtender system is using the Windows security provider, the domain name is provided with each user name. If the annotation has been assigned to an annotation group, the name of that annotation group is also provided.

Note: There is no “fill” color for basic line annotations (for example, freehand, line, and arrow). When you select a basic line annotation, the two overlapping rectangles appear with the same color.

3. Change the properties of the annotation. The following table describes how to change each property in the Annotation Properties dialog box:

**Table 70. Modifying the Properties of a Shape Annotation**

<table>
<thead>
<tr>
<th>To Change</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opacity</td>
<td>Next to Options, click Redaction.</td>
</tr>
<tr>
<td>Fill status</td>
<td>Next to Options, click Filled.</td>
</tr>
<tr>
<td>Line color</td>
<td>Under Colors, click a new color.</td>
</tr>
<tr>
<td>Fill color</td>
<td>Under Colors, right-click a new color.</td>
</tr>
<tr>
<td>Line width</td>
<td>Under Line Width, click a new line width.</td>
</tr>
</tbody>
</table>

4. Click Apply. Document Manager applies the new properties to the annotation.

5. Click OK to close the Annotation Properties dialog box.
6. Save your changes. Refer to Saving Annotations, page 445 for more information. For more information, see:
   • Modifying Annotation Settings, page 476

### Modifying Text Annotations

Document Manager allows you to modify the properties of a text annotation and annotation text. **Note:** You must have redaction privileges to create and modify non-transparent text annotations. For more information, refer to:
   • Changing the Properties of a Text Annotation, page 480
   • Modifying Annotation Text, page 482

### Changing the Properties of a Text Annotation

**To change the properties of a text annotation:**

1. Select the text annotation. For instructions, refer to Selecting Annotations, page 476.
2. Right-click and select Properties from the shortcut menu.
   **Note:** Click the ellipses button (…) on the in-place text editor if it appears.
   The Annotation Text Editor dialog box appears.

   ![Annotation Text Editor Dialog Box](image)

   **Figure 233. Annotation Text Editor Dialog Box**

3. Click Advanced. The advanced options appear.
4. Change the properties of the annotation. The following table describes how to change each property in the Annotation Text Editor dialog box:

Table 71. Changing the Properties of a Text Annotation

<table>
<thead>
<tr>
<th>To Change</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display status</td>
<td>Click the Display as icon check box.</td>
</tr>
<tr>
<td>Font size</td>
<td>Under Font, select a value from the Size list box.</td>
</tr>
<tr>
<td>Font appearance</td>
<td>Under Font, click the check boxes that you want to change (Bold, Underline, Italic, and Strike out).</td>
</tr>
<tr>
<td>Outline status</td>
<td>Under Font, click the Transparent check box.</td>
</tr>
<tr>
<td>Text color</td>
<td>Under Colors, click a new color for the text.</td>
</tr>
<tr>
<td>Fill color</td>
<td>Under Colors, right-click a new fill color.</td>
</tr>
</tbody>
</table>

Note: Refer to Modifying Annotation Text, page 482 for more information.

5. Click Apply. Document Manager applies the new properties to the text annotation.

6. Click OK to close the Annotation Text Editor dialog box.

7. Save your changes. Refer to Saving Annotations, page 445 for more information.
For more information, see:
• Modifying Annotation Settings, page 476

Modifying Annotation Text

To modify annotation text:
1. Select the text annotation. For instructions, refer to Selecting Annotations, page 476.
2. Right-click and select Properties from the shortcut menu.
   The Annotation Text Editor appears if it was used to create the annotation.
   The in-place text editor appears if it was used to create the annotation.
   Note: If the in-place text editor window is too small in the Document Display view, the Annotation Text Editor appears after you select Properties from the shortcut menu.
3. Change the text.
4. Apply the new text:
   • Click the green check mark if you changed the text in the in-place text editor.
   • Click Apply if you changed the text in the Annotation Text Editor, and then click OK to close the editor.
5. Save your changes. Refer to Saving Annotations, page 445 for more information.

Editing Text Rubber Stamp Annotations

After you display the contents of an existing rubber stamp page in the Document Display view, you can make the appropriate changes to the rubber stamp. As soon as you apply the changes, the content of the rubber stamp page is updated. When you select that rubber stamp from now on, the rubber stamp appears with the updated changes.

To edit an existing rubber stamp:
1. Right-click the _RSTAMP application in the Applications view. From the shortcut menu that appears, select New Query. The Search tab of the Query view appears.
2. Under Values, next to any or all of the field names, enter the index information that you want to search for the document.

3. Click Search. The Result Set tab appears in the Query view containing the documents that met the search criteria. If only one document met the criteria, it automatically appears in the Document display view.

4. In the Result Set view, double-click the document that you want to display. The document appears in the Document Display view.

5. From the Annotate menu, select Edit Rubber Stamp. The Edit Text Rubber Stamp dialog box appears with the Apply button disabled.
6. Change the contents of the rubber stamp. The Apply button is enabled.

   **Note:** In Rubber Stamp Text, the maximum number of characters that you can enter is 255.

7. You have the following choices:
   
   - Click Apply to save changes and leave the Edit Text Rubber Stamp dialog box open.
   - Click OK to save changes and close the Edit Text Rubber Stamp dialog box.

   The contents of the rubber stamp page displayed in the Document Display view are updated.

For more information, see:

   - Modifying Annotation Settings, page 476

### Printing Text Annotations

You can print the contents of one or more text annotations.

**Note:** Only users with appropriate privileges can print text annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the “Managing Security” chapter of the *ApplicationXtender Core Components Administrator’s Guide*.

To print text annotations:

1. Select the text annotations that you want to print. For instructions, refer to Selecting Annotations, page 476.

2. Right-click the selected annotations.
3. From the shortcut menu that appears, select Print text. The standard Windows Print dialog box appears.
4. Click OK. The contents of the selected text annotations print.

Removing Annotations

You can remove annotations from a page by either erasing or deleting them.

**Note:** Only users with appropriate privileges can modify and delete annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide.*

**Note:** If the AppXtender system has been converted from the CM security provider to the Windows security provider and you created and saved annotations while the CM security provider was in use, you must have both the Global Annotations and Edit Annotations privileges assigned to your profile in order to modify and delete those annotations. If you have questions about the privileges assigned to your AppXtender user profile, consult your AppXtender system administrator or refer to the "Managing Security" chapter of the *ApplicationXtender Core Components Administrator’s Guide.*

For more information on removing annotations, refer to the following section topics:
- Erasing Annotations, page 485
- Deleting Annotations, page 486

Erasing Annotations

Use the eraser tool to remove a single annotation from the displayed image.

To erase an annotation:

1. Choose one of these options to activate the eraser tool:
   - Click the Eraser button on the Annotation toolbar. The button is available only when the displayed page contains an annotation.

   ![Annotation Toolbar Eraser Button](image)

   - Press e.

2. Click the annotation that you want to remove. It is erased from the page.
For more information, see:
- Removing Annotations, page 485

**Deleting Annotations**

You can delete one or more annotations from a displayed image.

To delete annotations:

1. Select the annotations that you want to delete. For instructions, refer to Selecting Annotations, page 476.
2. Choose one of these options:
   - Right-click, then select Delete from the shortcut menu.
   - Press x.

For more information, see:
- Removing Annotations, page 485
This section topic describes how to use AppXtender to enhance bi-tonal (black and white) images.

- Introduction to Image Enhancement, page 487
- Enhancing an Image, page 487
- Configuring Image Enhancement, page 488
- Performing Advanced Image Enhancement, page 490

### Introduction to Image Enhancement

AppXtender provides licensed image enhancement features that allow you to enhance bi-tonal (black and white) images. With the image enhancement utility, you can remove lines, realign, de-skew, and remove shading on AppXtender documents. Many of these options (de-skew, and horizontal and vertical registration) can be used to make images more readable. Other options (line removal, and inverse text correction) can be used to prepare documents for optical character recognition (OCR). For more information, see the following topics:

- Enhancing an Image, page 487
- Configuring Image Enhancement, page 488
- Performing Advanced Image Enhancement, page 490

### Enhancing an Image

AppXtender provides an array of bi-tonal image enhancement tools, including deskew, inverse and shade, speck and line removal.

**To enhance a bi-tonal image:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears.
Figure 239. Image Enhancement Dialog Box

Note: If annotations have been added to the image, the processed image appears without the annotations, unless they are redactions or non-transparent text annotations.

3. Click Apply. The image is enhanced according to the current enhancement configurations. The enhanced image appears in the Enhance Image dialog box.

4. The enhanced image can now be saved as a new page version or discarded.
   - To save the enhanced page, click Done. AppXtender saves the enhanced page as a new version and inserts it before the original page in the document. AppXtender does not replace or delete the original page.
   - To discard the enhanced page, click Cancel.

For more information, see:
- Chapter 10, Image Enhancement

Configuring Image Enhancement

AppXtender provides licensed image enhancement features for bi-tonal (black and white) images. Image enhancement allows you to de-skew, change the margin alignment, remove lines and specks, and convert inverse and shaded text to black on white. These functions can be used to prepare the images for OCR, display, print, or fax. Refer to Enabling Image Processing Options, page 116 for information on configuring Document Manager for image processing.

The settings for optimum bi-tonal image enhancement are built into AppXtender as defaults, but they can be changed to allow for exact specifications. The default parameters can be reset at any time in the Image Enhancement dialog box.

To configure image enhancement:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The ScanFix Configuration dialog box appears.
Enable the check boxes of the image enhancement options that you want to use. All enhancement options that are checked are executed when the displayed document is processed. The following table explains each image enhancement option.

### Table 72. Enhancement Options

<table>
<thead>
<tr>
<th>Enhancement Options</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image de-skew</td>
<td>Straightens skewed (crooked) images.</td>
</tr>
<tr>
<td>Inverse text correction</td>
<td>Detects areas of inverse text and converts the text into normal text.</td>
</tr>
<tr>
<td>Dot shading removal</td>
<td>Removes speck or dot shading from an image.</td>
</tr>
<tr>
<td>Sub image</td>
<td>Processes only specified area of an image.</td>
</tr>
<tr>
<td>Horizontal registration</td>
<td>Aligns the image with a consistent left margin.</td>
</tr>
<tr>
<td>Vertical registration</td>
<td>Aligns the image with a consistent top margin.</td>
</tr>
<tr>
<td>Horizontal line removal</td>
<td>Removes horizontal lines from an image.</td>
</tr>
<tr>
<td>Vertical line removal</td>
<td>Removes vertical lines from an image.</td>
</tr>
</tbody>
</table>

**Note:** You can also view explanations for each option by moving the pointer over the options. As the mouse pointer moves over the options listed, explanatory messages appear as tool tips.

2. Click OK.

Each option in the Configuration dialog box corresponds to a tab in the Advanced Settings dialog box. The tabs with advanced distinctions with in the Advanced Settings dialog box allow you to perform more detailed configuration of image enhancement. For information on configuring image enhancement with advanced settings, refer to Performing Advanced Image Enhancement, page 490.

### To configure image enhancement using system default settings:

1. From the Scan menu, select Configuration and then Enhancement Configuration. The Configuration dialog box appears.

2. Click Reset.
Performing Advanced Image Enhancement

Additional settings for each enhancement option are available to produce the desired results. These settings are accessed by clicking the Advanced button in the ScanFix Configuration dialog box. Details on each page of the Advanced settings dialog box are provided in the following sections:

- Using Advanced Deskew, page 490
- Using Advanced Registration, page 494
- Using Advanced Dot Shading Removal, page 498
- Using Speck Removal, page 503
- Using Advanced Line Removal, page 506
- Using Advanced Inverse Text Correction, page 510
- Smoothing Characters, page 513
- Using Manual Crop, page 516
- Resizing an Image, page 519
- Using Advanced Sub Image, page 522
- Using IntelligentCrop, page 526

Using Advanced Deskew

Skew refers to how much rotation the text has in relation to a horizontal reference line. An image that is not perfectly square is considered “skewed.” This option handles a maximum skew of 20%. A character protection feature eliminates rotational distortion induced in the straightening process, using text and horizontal lines to automatically detect and remove skew from an image.

The de-skew text option automatically straightens images that were skewed when scanned in from the scanner. De-skew text can be an integral tool in preparation for optical character recognition (OCR) because a 1% or 2% skew may cause an increase in OCR errors as many OCR engines fail to recognize characters. Other applications for de-skew include document imaging, forms processing, digital copying, faxing and image file compression. The process is invaluable for applications that require precise and consistent placement of text, such as forms processing and the intelligent OCR of columnar data. De-skewing an image can also improve the performance of compression.

When enabled, the De-skew feature optimizes the other image enhancing functions. It is advised that you turn on this feature. Visually, an image with positive skew rises from left to right across a page. An image with negative skew slants downward from left to right across a page. The de-skew process changes the width and height of your image.

To perform advanced deskew on an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure is slightly skewed.

**Figure 241. Before Using Deskew**

![Image Enhancement dialog box]

3. Click Configure. The ScanFix Configuration dialog box appears.
4. Enable the Image de-skew option.
5. Click Advanced. The ScanFix Advanced Settings dialog box appears.
6. Click the Deskew tab. If necessary, modify the settings on the Deskew tab. The following sections describe each setting:
   - **Minimum Detect Length**, page 493
   - **Maximum Acceptable Skew**, page 493
   - **Character Protection**, page 494

7. Click OK to save the settings. (Any settings saved become the defaults.)

8. In the Image Enhancement dialog box, click Apply. The image is de-skewed. The enhanced image appears in the Enhance Image dialog box. The example image in the following figure has been de-skewed.
Minimum Detect Length

This parameter sets the shortest line (text or graphics) AppXtender uses to detect skew. This measurement is in pixels. The default setting for Minimum Detect Length is 300 (1 inch at 300 DPI). This value should be at least 25% larger than Maximum Acceptable Skew. If a report of Failure to Detect Skew appears, decrease this value and reprocess the image.

Maximum Acceptable Skew

This parameter determines how much skew is acceptable. When AppXtender encounters an image skewed less than this value, it omits the De-Skew process. Using a higher value here causes AppXtender to process images with a lower percentage skew. If you set this to a lower value, lightly skewed images are accepted without de-skewing them. The default setting is 200. Lower numbers indicate greater skew.

Note: A setting of 100 corresponds to 1% skew, while a setting of 200 corresponds to 0.5% skew. Many OCR engines can handle a lightly skewed image, so very high values for Maximum Acceptable Skew may not improve performance.
**Character Protection**

This feature automatically removes rotational distortion from the de-skewed characters, because de-skewing an image often distorts text characters. Checking the box activates character protection. Character protection provides improved OCR results and a more attractive image, but is considerably slower than de-skew alone. It is a trade off between speed and OCR accuracy. Because this feature can dramatically increase processing time, it is recommended that the user leave it off unless OCR error rate is unacceptable.

**Using Advanced Registration**

Registration allows you to specify how far from the edge of an image you want the image data placed. AppXtender can automatically register an image in both the horizontal and vertical planes. The process is accurate and consistent to within 3 or 4 pixels. On a 300 DPI image, AppXtender can position your data within 1/100 of an inch. Registration automatically positions text horizontally and vertically on the page, providing a consistent left and top margin for documents. Registration control is helpful for document imaging and forms processing applications where accurate positioning is critical, because it makes OCR zoning of text fields in forms much more reliable.

**To perform advanced registration on an image:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a narrow left margin and a slightly thicker top margin.

**Figure 244. Before Using Registration**
3. Click Configure. The ScanFix Configuration dialog box appears.

4. Enable the Image de-skew option, unless you know the original is perfectly straight.

5. Enable the Horizontal registration option, the Vertical registration option, or both, depending on the level of precision that you need.

   You can activate and set the parameters for horizontal and vertical registration separately. For most operations where you require a consistent left margin, you should activate horizontal registration. In many cases, you can leave vertical registration deactivated. For applications where precise text location is important, you should activate both horizontal and vertical registration.

6. Click Advanced. The ScanFix Advanced Settings dialog box appears.

   **Figure 245. Registration Tab**

   ![ScanFix Advanced Settings](image)

   Registration aligns the image with consistent margins. Accurate to within 3 pixels on average. Form zoning and OCR require registration because page scan locations vary up to 1/2" without it.

   - **Horizontal Registration**
     - Central focus
     - Add only
     - Ignore holes
     - Resultant Left Margin: 150
     - Find Line For Register: 0
     - Advanced: Line Gap: 0, Line Thickness: 0, Registration Skip: 0

   - **Vertical Registration**
     - Central focus
     - Add only
     - Resultant Top Margin: 150
     - Find Line For Register: 0
     - Advanced: Line Gap: 0, Line Thickness: 0, Registration Skip: 0

7. Click the Registration tab. If necessary, modify the settings on the Registration tab. The following section topics describe each setting:
   - Horizontal/Vertical Registration, page 496
   - Advanced Registration Settings, page 497

8. Click OK to save the settings. (Any settings saved become the defaults.)
9. In the Image Enhancement dialog box, click Apply. The image is repositioned. The enhanced image appears in the Enhance Image dialog box window. The example image in the following figure has been repositioned. (Notice the thicker left and top margins.)

Figure 246. After Using Registration

For more information, see:
- Performing Advanced Image Enhancement, page 490

**Horizontal/Vertical Registration**

Using horizontal registration settings, AppXtender locates the left edge of the text and positions the left edge of the image a specified number of pixels from the left edge of text (or data). Using vertical registration settings, AppXtender locates the topmost edge of the text, and positions it a fixed distance from the top edge of the image.

**Note:** If you are designing a form for later processing, a black line 1/16” thick across the top and a 1/8” thick line down the left edge provides extremely reliable registration when you use Find Line for Register.

For more information, see:
- Using Advanced Registration, page 494
- Central Focus, page 497
- Add Only, page 497
• Ignore Holes, page 497
• Resultant Left/Top Margin, page 497
• Find Line for Register, page 497

Central Focus

This feature causes AppXtender to register using only the middle portion of the image border. Central Focus is useful for ignoring edge noise, letterheads, and logos.

Add Only

This feature causes expansion of the current margin (if it is smaller than the specified amount) to the size specified in the resultant left or top margin parameters.

Ignore Holes

Check this box to ignore binder holes and other left-edge noise when analyzing the margin. Leave this feature off unless you have holes or similar noise to avoid. This feature applies only to horizontal registration.

Resultant Left/Top Margin

This parameter determines how many pixels remain as a left or top margin after processing. Setting this value to 0 places text flush with the left or top edge of the image. A negative value crops the specified number of pixels from the left or top edge of the text.

Find Line for Register

This is a powerful feature for precise registration on forms, especially on forms with edge noise. Instead of using what it believes to be the edge of the text, AppXtender instead positions the text in the image based on the position of a vertical line. This line should be significantly larger than any text characters (in particular, those characters to the left of this line). Therefore, set this parameter to a value larger than the height of characters but less than the length of this line. Setting the value to 0 deactivates this feature.

Advanced Registration Settings

Registration parameters for Horizontal and Vertical Registration are identical. The only difference is the orientation. Horizontal parameters refer to the left edge of an image, while vertical parameters deal with the top edge. The vertical adjustment features allow you to control alignment of the image in the vertical plane.
The advanced features of the Registration process are located in the lower left corner of the Registration tab. The Advanced settings give you finer control over image registration, augmenting the find line to register parameters previously described. The registration skip parameters apply to both normal registration and registration to line.

For more information, see:
- Using Advanced Registration, page 494
- Line Gap, page 498
- Line Thickness, page 498
- Registration Skip, page 498

**Line Gap**

Line Gap values under 3 short gaps are simply ignored. However, setting these values over 3 reassembles broken lines into a whole line for registration purposes, and can dramatically improve success rate with the registration feature.

**Line Thickness**

AppXtender scans across or down your image looking for lines. In some cases, AppXtender can mistake dense text for a line. These parameters allow you to select the maximum line thickness as lower than the width of your text.

**Registration Skip**

Registration skip allows you to skip a number of scan lines before starting to look for valid information for registration. The skip feature is particularly valuable for dealing with unwanted data on the edge of an image. In some cases, you may want to skip over a form line or margin note that is seen as valid data. In other cases, this feature can be useful to skip over scanner artifacts that look like lines and data.

**Using Advanced Dot Shading Removal**

In order to simulate shades of gray, most black and white printers use dithering, also known as dot shading, to give the impression of gray shading. Some black and white scanners also use this technique when they scan color or grayscale images. AppXtender can automatically detect and remove dot shaded regions from your image, leaving any text inside the dot shaded regions intact. The noise removal features allow you to remove dot shading, or ‘dithered’ areas of an image, without degrading text.

Shade removal automatically removes dot shading from an image. This allows shaded text to be recognized as text (not as graphics), which increases OCR performance. Shade removal also enhances the compressibility of image files containing heavily shaded areas by 50% or more, handling a wide range of dot sizes.
To perform advanced dot shading removal on an image:

1. In AppXtender, display the document page that you want to enhance.

2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has dot shading (highlighting "1968 Cadillac," "1969 Cadillac," and "1970 Cadillac") that needs to be removed.

   **Figure 247. Before Using Dot Shading Removal**

   ![Image Enhancement dialog box](image)

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Dot shading removal option. Click Advanced. The ScanFix Advanced Settings dialog box appears.
Figure 248. Noise Removal Tab

4. Click the Noise Removal tab. If necessary, modify the Dot Shading Removal settings on the Noise Removal tab. The following sectiontopics describe each setting:
   - Minimum Area Width, page 501
   - Minimum Area Height, page 501
   - Horizontal Size Adjust, page 502
   - Vertical Size Adjust, page 502
   - Maximum Dot Size, page 502
   - Character Protection, page 494

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Dot shading is removed from the image. The enhanced image appears in the Enhance Image dialog box window. The dot shading in the example image has been removed.
Figure 249. After Using Dot Shading Removal

For more information, see:
- Performing Advanced Image Enhancement, page 490

Minimum Area Width

This parameter determines the smallest horizontal width of any shaded areas to be processed. The default setting is 100 pixels. Set this value higher to reduce errors.

For more information, see:
- Using Advanced Dot Shading Removal, page 498

Minimum Area Height

This parameter controls the smallest expected vertical thickness of any shaded area. The default setting is 50 pixels. Set this value higher to detect thicker shaded areas and decrease this value in order to detect shorter dot shaded zones.
Horizontal Size Adjust

This parameter controls the width of specks to be removed. The default setting is 0. Set the value to 1 if specks remain after automated processing; this removes specks that are 1 pixel wider than the size designated in the Maximum Dot setting. Set the value to -1 if the text is being degraded. This decreases the width of the specks being removed by 1 pixel, sparing small text.

For more information, see:
• Using Advanced Dot Shading Removal, page 498

Vertical Size Adjust

This parameter controls the height of specks to be removed. The default setting is 0. Set the value to 1 if specks remain after the automated process; this removes specks that are 1 pixel taller than the size set in Maximum Dot setting. Set the value to -1 if the text is being degraded. This decreases the height of the specks being removed by 1 pixel, sparing small text.

For more information, see:
• Using Advanced Dot Shading Removal, page 498

Maximum Dot Size

This setting determines the maximum size of individual dots that make up the dot shading. This determines the removal of dots up to and including this size. The default value is 5 pixels.

For more information, see:
• Using Advanced Dot Shading Removal, page 498

Character Protection

This feature automatically removes rotational distortion from the de-skewed characters, because de-skewing an image often distorts text characters. The options described in The following table allow you to select character protection with dot shading removal. You can protect against horizontal cuts, vertical cuts, or cuts in both directions. This feature is more effective on horizontal and vertical segments of characters than it is on their diagonal segments. This feature may also preserve dots that touch letters and improve OCR results.
Table 73. Character Protection Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select none in most cases as this feature dramatically increases processing time.</td>
</tr>
<tr>
<td>Horizontal cuts</td>
<td>Select the horizontal cuts button to protect character segments horizontally.</td>
</tr>
<tr>
<td>Vertical cuts</td>
<td>Select the Vertical cuts button to protect character segments vertically.</td>
</tr>
<tr>
<td>All cuts</td>
<td>Select All cuts and character segments running both directions are protected.</td>
</tr>
</tbody>
</table>

For more information, see:
•  Using Advanced Dot Shading Removal, page 498

Using Speck Removal

De-speck allows you to remove random horizontal and/or vertical specks (noise) from your image without degrading text.

To perform speck removal on an image:
1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a speck (above and to the right of "Fleetwood") that needs to be removed.

Figure 250. Before Using De-Speck
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

**Figure 251. Noise Removal Tab**

4. Click the Noise Removal tab. If necessary, modify the De-Speck settings on the Noise Removal tab. The following section topics describe each De-Speck setting:
   - Horizontal De-Speck, page 505
   - Vertical De-Speck, page 505
   - Isolated De-Speck, page 506

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Specks are removed from the image. The enhanced image appears in the Enhance Image dialog box window. The speck above and to the right of "Fleetwood" in the example image has been removed.
Figure 252. After Using De-Speck

For more information, see:
- Performing Advanced Image Enhancement, page 490

Horizontal De-Speck

This parameter sets the maximum horizontal size for de-speck, determining the width of specks to be removed. The default setting is 0. Slide the bar right to remove wider specks and slide the bar left to decrease erroneous text removal.

Horizontal Protection

Checking the Horizontal Protection box makes AppXtender check the horizontal plane to determine if the pixel group in question is part of a character.

For more information, see:
- Using Speck Removal, page 503

Vertical De-Speck

This parameter controls the maximum vertical size for de-speck; the height of specks to be removed. Increase this value to remove larger (taller) specks and decrease to prevent erroneous text removal. Setting this value too high can remove small vertical sections of characters.
**Vertical Protection**

Checking the Vertical Protection box makes AppXtender check the vertical plane to determine if the pixel group in question is part of a character.

For more information, see:
- Using Speck Removal, page 503

**Isolated De-Speck**

This feature removes specks that are not touching anything else in the image. Larger values can cause AppXtender to remove periods and the dots on the letters i and j. Isolated de-speck is faster than using both horizontal and vertical de-speck.

In the Isolated De-Speck text box, type a number. The value given sets the largest dimension for a speck in any direction. Press the [TAB] key and the advanced features become activated.

The Advanced Features area of the Noise Removal tab only applies to the Isolated De-Speck feature. The following table describes the options in the Advanced Features area:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-Speck Width</td>
<td>The width parameter allows you to set different values for the height and width of a speck. The value set in isolated de-speck becomes the height, and the value given here becomes the width. Essentially, this makes your box a rectangle and de-speck removes any speck that fits within the rectangle.</td>
</tr>
<tr>
<td>Diagonal Protection</td>
<td>In normal processing, the four pixels above, below, and to either side of a suspected speck are looked at. With this mode active, AppXtender looks at the four corners as well. Use this feature only when you find that the diagonal portion of text characters is being removed.</td>
</tr>
</tbody>
</table>

For more information, see:
- Using Speck Removal, page 503

**Using Advanced Line Removal**

Line removal settings removes horizontal and/or vertical lines from an image. Removing lines increases the accuracy of an OCR process. AppXtender automatically detects and removes horizontal or vertical lines – even the most degraded lines (under the Maximum Line Gap parameter). With the Advanced Character Repair feature, the accuracy of OCR improves greatly with difficult documents, such as typed forms and those with underlined words. You can activate horizontal line management separately from vertical line settings with independent parameters. Other than orientation, these features are identical.
Note: If line removal removes large text, you have several options. You can estimate the thickness of the horizontal segments of the largest text characters in your image, and set maximum line thickness to some value lower than that thickness. Another option is to set horizontal minimum line values to larger than the length of the longest horizontal segments of the largest text characters. Conversely, set vertical line management values higher than the longest vertical segment.

To perform advanced line removal on an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has a thick line along the right side that needs to be removed.

Figure 253. Before Using Vertical Line Removal

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Horizontal line removal option, the Vertical line removal option, or both. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Line Removal tab. If necessary, modify the settings on the Line Removal tab. The following section topics describe each setting:
   - Minimum Line Length, page 509
   - Maximum Line Thickness, page 509
   - Maximum Line Gap, page 510
   - Edge Cleaning, page 510
   - Character Repair, page 510

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Horizontal and vertical lines are removed from the image. The enhanced image appears in the Enhance Image dialog box window. The thick line along the right side of the example image has been removed.
Figure 255. After Using Vertical Line Removal

For more information, see:
• Performing Advanced Image Enhancement, page 490

Minimum Line Length

This parameter sets the minimum length of a line to detect and remove from the image. The line removal system can identify and remove very short horizontal lines, such as the one across a large capital T. The default setting is 150 horizontal pixels (1/2 inch at 300 DPI) and 150 vertical pixels.

For more information, see:
• Using Advanced Line Removal, page 506

Maximum Line Thickness

This parameter sets the thickness of a line for the system to detect. Some images have short graphic lines that you want to remove and large text characters you want to preserve. Because extremely large text is usually thicker than the lines on forms, you can use this feature to keep AppXtender from removing very large text in titles. The horizontal and vertical default setting is 20 pixels.

Note: The capital 'T' in a large title or headline has horizontal and vertical components that could be mistaken for lines and that could be removed. To avoid unintentional line removal, set the maximum line thickness parameter to a smaller value (like 10). You may also set minimum line thickness to be longer than the widest text.
For more information, see:
- Using Advanced Line Removal, page 506

**Maximum Line Gap**

This parameter sets the maximum size of a gap allowed in a line. This assures complete removal of lines containing gaps. The default setting is 1 pixel for both horizontal and vertical and works well for most clean images.

For more information, see:
- Using Advanced Line Removal, page 506

**Edge Cleaning**

Noise near a line is removed along with the line; this feature determines how far AppXtender looks for stray pixels near a line. The default setting is 2. Set this value to 3 or 4 if unwanted line shadow remnants remain, or 0 or 1 if adjacent text is degraded. The Character Repair feature can often repair text damaged by line removal.

For more information, see:
- Using Advanced Line Removal, page 506

**Character Repair**

This parameter sets the maximum width or height, in pixels, of characters to reconstruct after the line removal is performed. The default setting is 20 pixels. Set this parameter higher if text is not being adequately repaired and lower if unintentional reconstruction occurs. Setting this value to 0 disables character reconstruction.

**Note:** When you disable Character Repair, you may want to set your Edge Cleaning factor lower than 2 (the default) if line removal is damaging characters.

For more information, see:
- Using Advanced Line Removal, page 506

**Using Advanced Inverse Text Correction**

Inverse text detects white text with a black background (inverse text) and converts it to black text with a white background (normal text). This feature is especially useful in conjunction with OCR, which cannot read inverse text.

**To perform advanced inverse text correction on an image:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has inverse text that needs to be corrected.

**Figure 256. Before Using Inverse Text Correction**

![Image Enhancement Dialogue Box](image)

3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Inverse text correction option. Click Advanced. The ScanFix Advanced Settings dialog box appears.

**Figure 257. Inverse Text Tab**
4. Click the Inverse Text tab. If necessary, modify the settings on the Inverse Text tab. The following table describes each setting:

**Table 75. Inverse Text Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Area Height</td>
<td>This parameter controls the smallest vertical thickness of inverse text areas. The default setting is 50 pixels. Decrease this value if small areas of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
<tr>
<td>Minimum Area Width</td>
<td>This parameter controls the smallest horizontal width of inverse text areas. The default setting is 300 pixels. Decrease this value if small bands of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
<tr>
<td>Minimum Black On Edges</td>
<td>This parameter controls the smallest horizontal distance between the edge of an inverse text area and the inverse text itself. The default setting is 10 pixels. Decrease this</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>value if small areas of inverse text are missed or increase this value if normal text is treated as inverse.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Inverse text on the image is converted to normal text. The enhanced image appears in the Enhance Image dialog box window. The inverse text in the example image has been corrected.

**Figure 258. After Using Inverse Text Correction**

For more information, see:
- Performing Advanced Image Enhancement, page 490

### Smoothing Characters

Smoothing characters involves growing and eroding characters in an image and then using “sand” or "fill" operations to produce a finished look. Dot matrix print becomes readable using this setting. This feature allows for de-emphasizing bold text, bringing out faint text, and smoothing out the jagged edges of text.

**To smooth characters in an image:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The following figure has an example image with text that needs to be smoothed.
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 260. Smooth Tab
4. Click the Smooth tab. If necessary, modify the settings on the Smooth tab. The following table describes each setting:

**Table 76. Smooth Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grow</td>
<td>This feature makes single pixels &quot;grow&quot; into small dots, and expands the borders of text characters. It is very useful for making a font bolder and has the affect of &quot;connecting the dots&quot; of dot matrix print. Lower this value if characters start touching one another or integral spaces in letters close up.</td>
</tr>
<tr>
<td>Erode</td>
<td>This feature looks at groups of black pixels and removes the outer edges. This has the effect of making a speck or text character &quot;shrink&quot; by selected value. Setting this value to 2 erodes a 3 by 3 block of pixels to a single central pixel, or makes a 2 by 2 block of black pixels disappear entirely. Negative values are not allowed with this feature.</td>
</tr>
<tr>
<td>Sand and Fill</td>
<td>This feature improves an image's appearance by smoothing out the edges of characters. It does this by filling small pits and...</td>
</tr>
</tbody>
</table>
### Image Enhancement

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>removing small bumps on the edges of characters. Sand and fill options reduces its compressed image file size. Use larger values (from 1 to 5) for larger type size, pits and bumps.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. Characters on the image are smoothed. The enhanced image appears in the Enhance Image dialog box window. The text in the example image has been smoothed with the Grow option.

**Figure 261. After Smoothing Characters**

For more information, see:
- Performing Advanced Image Enhancement, page 490

### Using Manual Crop

Manual crop resizes an image by adding or removing a specified number of pixels from your image in the selected directions. This feature does not alter the image resolution. Only when values are entered into the crop text boxes do the pad text boxes become enabled.

**To crop an image manually:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The following figure has an example image with areas that need to be cropped out.
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 263. Crop Tab
4. Click the Crop tab. If necessary, modify the Manual Crop settings on the Crop tab. The following table describes each setting:

**Table 77. Manual Crop Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Crop/Pad</td>
<td>Removes the specified number of pixels from the top edge of the image. The manual crop function starts at the edge of the image and ignores image data. Pad adds the specified number of pixels (the value in top crop) to the top edge of the image.</td>
</tr>
<tr>
<td>Bottom Crop/Pad</td>
<td>Removes the specified number of pixels from the bottom edge of the image. This parameter can help remove unwanted noise from an image, or unwanted footer information. The bottom pad adds the specified number (from the bottom crop value) of pixels to the bottom edge of the image.</td>
</tr>
</tbody>
</table>
### Setting | Description
--- | ---
Left Crop/Pad | Removes the specified number of pixels from the left edge of the image. Left pad adds the specified number of pixels (in left crop) to the left edge of the image.
Right Crop/Pad | Removes the specified number of pixels from the right edge of the image. Right pad adds the specified number (from the right crop setting) of pixels to the right edge of the image.

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. The specified areas are cropped from the image. The enhanced image appears in the Enhance Image dialog box window. The example image has been cropped in the following figure.

**Figure 264. After Using Manual Crop**

For more information, see:
- Performing Advanced Image Enhancement, page 490

## Resizing an Image

AppXtender can alter the size of an image to user-defined dimensions. This feature does not change the resolution (DPI) of your image, but it compresses or expands the image data to match the new image size.

### To resize an image:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure needs to be resized.
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.
4. Click the Crop tab. If necessary, modify the Resize settings on the Crop tab. The following table describes each setting:

**Table 78. Resize Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resultant Width</td>
<td>Sets the output width of your image and magnifies or shrinks your image to this width.</td>
</tr>
<tr>
<td>Resultant Height</td>
<td>Sets the output height of your image and magnifies or shrinks your image to this height.</td>
</tr>
</tbody>
</table>

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. The image is resized. The enhanced image appears in the Enhance Image dialog box window. The example image in the following figure has been resized.
For more information, see:

- Performing Advanced Image Enhancement, page 490

**Using Advanced Sub Image**

This feature allows you to isolate a specified area from an image, called a Sub-Image. This extraction occurs after de-skew and register, but prior to any other processing. The sub-image is then processed with all other active features after discarding all remaining parts of the image.

**To enhance a sub image of an image:**

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears.
3. Click Configure. The ScanFix Configuration dialog box appears. Enable the Image de-skew option and the registration options.
   • For information on the Image de-skew option, refer to Using Advanced Deskew, page 490.
   • For information on the registration options, refer to Using Advanced Registration, page 494.

4. Enable the Sub image option and any other options for enhancements that you want to perform on the sub-image.

5. Click Advanced. The ScanFix Advanced Settings dialog box appears.
6. Click the Crop tab. If necessary, modify the Sub-Image settings on the Crop tab. The following section topics describe each setting:
   - Top Edge, page 525
   - Bottom Edge, page 525
   - Left Edge, page 525
   - Right Edge, page 526
7. Configure other tabs, if necessary, to perform enhancements on the sub-image.
8. Click OK to save the settings. (Any settings saved become the defaults.)
9. In the Image Enhancement dialog box, click Apply. AppXtender performs deskew and registration on the whole image, and then performs all other configured enhancements on the sub-image. The enhanced image appears in the Enhance Image dialog box window.
Figure 270. After Using Sub Image

For more information, see:
- Performing Advanced Image Enhancement, page 490

**Top Edge**

This value defines the top edge of sub-image to extract, measured in pixels from the top of the image after performing de-skew and registration. Use 0 to start from the very top of the image.

For more information, see:
- Using Advanced Sub Image, page 522

**Bottom Edge**

This value defines the bottom edge of the sub-image to extract, measured in pixels from the top of the image after de-skew and registration. Use 0 to signify the very bottom of the image.

For more information, see:
- Using Advanced Sub Image, page 522

**Left Edge**

This defines the left edge of the sub-image to extract, measured in pixels from the left edge of the image after processing de-skew and registration. Use 0 to start from the left edge of the image.

**Note:** Try using 1275 (4.25 inches at 300 DPI) to crop the left half of a typical 8.5 inch by 11 inch page.
For more information, see:
• Using Advanced Sub Image, page 522

Right Edge

This value sets the right edge of the sub-image to separate, measured in pixels from the left edge of the image after processing de-skew and registration. Use 0 to signify the image's right edge.

Note: Try using 1275 (4.25 inches at 300 DPI) to crop the right half of a typical 8.5 inch by 11 inch page.

For more information, see:
• Using Advanced Sub Image, page 522

Using IntelligentCrop

This option allows bleaching out black or shaded borders. Intelligent crop performs image analysis to determine where the edge of your data lies in relation to the edge of the image, automatically cropping the image to leave behind only the data you require.

To crop an image with IntelligentCrop:

1. In AppXtender, display the document page that you want to enhance.
2. From the Page menu, select Enhance Image. The Image Enhancement dialog box appears. The example image in the following figure has white space that needs to be cropped.

Figure 271. Before Using IntelligentCrop
3. Click Configure. The ScanFix Configuration dialog box appears. Click Advanced. The ScanFix Advanced Settings dialog box appears.

Figure 272. Crop Tab

![ScanFix Advanced Settings dialog box]

4. Click the Crop tab. If necessary, modify the IntelligentCrop settings on the Crop tab. The following table describes each setting:

Table 79. IntelligentCrop Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Crop</td>
<td>This feature detects black border around an image’s perimeter resulting from scanning or other input system and &quot;bleaches&quot; out this unnecessary feature without actually removing it.</td>
</tr>
<tr>
<td>White Crop</td>
<td>This feature trims the white space around the border of an image where no data appears. The value entered here is the white border size in pixels that remains after cropping. You can substitute this feature for registration, but it is not as precise. Setting the value to</td>
</tr>
</tbody>
</table>
### Setting Description

- 0 deactivates this feature. AppXtender performs black crop first if both are activated.

5. Click OK to save the settings. (Any settings saved become the defaults.)

6. In the Image Enhancement dialog box, click Apply. The border of the image is bleached or trimmed as specified. The enhanced image appears in the Enhance Image dialog box window. The white space surrounding the example image has been cropped.

**Figure 273. After Using IntelligentCrop**

For more information, see:
- Performing Advanced Image Enhancement, page 490
This appendix topic describes how to work with Centera retention and AppXtender software retention for Document Manager.

- Overview, page 529
- Filing Documents for Retention, page 531
- Extending a Retention Period, page 535
- Processing Documents for Retention Hold, page 539

Overview

Centera retention and AppXtender software retention are licensed features that protect documents from loss, whether accidental or malicious. The features also ensure documents are retained in an AppXtender repository for a prespecified period of time, in accordance with legal, regulatory, fiscal, or operational requirements.

Note: Your retention administrator creates retention policies or classes that determine how long documents must remain in the AppXtender repository.

For more information, refer to:
- Retention Concepts, page 529
- Identifying Retention Applications, page 530
- Filing Documents for Retention, page 531
- Extending a Retention Period, page 535
- Processing Documents for Retention Hold, page 539

Retention Concepts

Document Manager displays retention options if your AppXtender content management system is configured for Centera retention or AppXtender software retention and your retention administrator has assigned retention privileges to your AppXtender user account. The options allow you to file documents for retention or apply a retention hold to documents.
Documents that are filed for retention cannot be modified or deleted until the retention period expires. At the end of the retention period, your retention administrator determines if the document must be removed from the AppXtender repository or if the document should remain in the repository as a writable document. Contact your retention administrator if you need assistance with documents that have been filed for retention or placed on retention hold.

Retention administrators can create retention policies that are based on a date index field for an application. The system calculates the document's retention expiration date as the date in the index field plus the number of years or days configured for the policy. If you apply the new retention policy to a document that has multiple indexes, the retention end date is calculated based on the most recent date index value for the document. If the calculated retention expiration date has passed, the document is not filed for retention.

Documents under retention are in read-only mode; therefore, you cannot check them out of the AppXtender repository for modification. However, you can use the AppXtender Copy or Move Pages feature to create a new copy of the document. Because retention configuration information associated with the original document is not preserved in the copy of the document, you can modify the copy. Refer to Moving or Copying Document Pages, page 381 for procedures.

You can also create a copy of a document under retention using the AppXtender export and import features. Refer to Exporting Documents and Pages, page 370 and the document import section of Creating New Documents, page 164, respectively, for procedures.

**Identifying Retention Applications**

In the Document Manager Applications view, a folder and clock icon (имер) appears next to applications that are configured for retention. The following figure shows an application that is configured for retention and an application that is not.

**Figure 274. Document Manager Applications View: Application Folder Icons**
Note: The folder and clock icon also appears next to applications that are configured for Records Manager retention. Refer to Appendix B, Working with Records Manager for AppXtender for more information.

Filing Documents for Retention

Document Manager allows you to file a document for retention if your retention administrator assigned the retention user privilege to your AppXtender user account.

Note: Document Manager does not allow you to file AppXtender Reports Management documents for retention.

For more information, refer to:
• Filing a Document for Retention from Document Display View, page 531
• Filing a Document for Retention from the Query View Result Set, page 532
• Filing Multiple Documents for Retention, page 533

Filing a Document for Retention from Document Display View

To file a document for retention from the Document Display view:

1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.

2. Open the document in Document Display view. Refer to Chapter 6, Viewing Documents for more information.


Figure 275. Set Retention Options Dialog Box: Single Document, Document Display View
4. Select a retention class or policy from the Retention Class or Policy list box. The Description field displays information about the retention class or policy you selected such as the duration of the retention period. In addition, the dialog displays the current date and time and the expiration date and time in both your local time zone and in GMT.

**Note:** To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.

5. Click OK.

   Document Manager displays a document and clock icon next to the document in the Result Set after the storage device processes the request.

---

**Filing a Document for Retention from the Query View Result Set**

**To file a document for retention from the Query view Result Set:**

1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.

2. Right-click the document from the Result Set to open the Document Manager shortcut menu.

4. Select a retention class or policy from the Retention Class or Policy list box.

   **Note:** To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.

5. To apply the retention setting to previous versions of the document, enable File all available previous revisions for retention.

   **Note:** Document Manager applies the retention setting to the current version of the document if you do not enable File all available previous revisions for retention.

6. Click Set Retention.

   Document Manager displays a document and clock icon (legt) next to the document in the Result Set after the storage device processes the request.

---

**Filing Multiple Documents for Retention**

**To file multiple documents for retention:**

1. Query the application to locate the documents. Refer to Chapter 5, Retrieving Documents for more information.
2. Select the documents from the Query view Result Set.
   - To select multiple, consecutive documents:
     1. Select the first document.
     2. Press and hold Shift.
     3. Select the last document.
   - To select multiple, non-consecutive documents:
     1. Select the first document.
     2. Press and hold Ctrl.
     3. Select the documents.
3. Right-click to open the Document Manager shortcut menu.

**Figure 277. Set Retention Options Dialog Box: Multiple Documents**

5. Select a retention class or policy from the Retention Class or Policy list box.

   **Note:** To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.
6. To apply the retention setting to previous versions of the documents, enable File all available previous revisions for retention.

   **Note:** Document Manager applies the retention setting to the current versions of the documents if you do not enable File all available previous revisions for retention.

7. Click Set Retention.

   Document Manager displays a document and clock icon next to each document in the Result Set after the storage device processes the request.

### Extending a Retention Period

Document Manager allows you to extend the retention period for an existing document under retention if your retention administrator assigned the retention user privilege to your AppXtender user account. You extend a retention period by applying a new retention class or policy to a document(s). The expiration date of the new retention class or policy must be later than that of the original class or policy.

For more information, refer to:

- Extending the Retention Period from Document Display View, page 535
- Extending the Retention Period from the Query View Result Set, page 536
- Extending the Retention Period for Multiple Documents, page 538

### Extending the Retention Period from Document Display View

**To extend the retention period from Document Display view:**

1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.

2. Open the document in Document Display view. Refer to Chapter 6, Viewing Documents for more information.

4. Select the new retention class or policy that you want to apply to the document from the Retention Class or Policy list box.

   **Note:** To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.

5. In Options, specify whether you want to calculate the new retention period based on the current date or the original retention start date. The current date, date filed, current expiration date, and new expiration date appear in both your local time zone and in UTC (GMT) format.

6. Click OK.

---

**Extending the Retention Period from the Query View Result Set**

**To extend the retention period from the Query view Result Set:**

1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.

2. Right-click the document from the Result Set to open the Document Manager shortcut menu.

4. Select the new retention class or policy that you want to apply to the document from the Retention Class or Policy list box.

**Note:** To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.

5. In Options, do the following:
   a. Specify whether you want to file all available previous revisions of the document for retention.
      **Note:** Document Manager applies the retention setting to the current version of the document if you do not enable File all available previous revisions for retention.
   b. Specify whether you want to calculate the new retention period based on the current date or the original retention start date. The Retention Status and Operation Effect columns reflect the original and new retention expiration dates, respectively.

6. Click Set Retention.
Extending the Retention Period for Multiple Documents

To extend the retention period for multiple documents:

1. Query the application to locate the documents. Refer to Chapter 5, Retrieving Documents for more information.

2. Select the documents from the Query view Result Set.
   - To select multiple, consecutive documents:
     4. Select the first document.
     5. Press and hold Shift.
     6. Select the last document.
   - To select multiple, non-consecutive documents:
     1. Select the first document.
     2. Press and hold Ctrl.
     3. Select the documents.

3. Right-click to open the Document Manager shortcut menu.

Figure 280. Set Retention Options Dialog Box: Multiple Documents
5. Select the new retention class or policy that you want to apply to the documents from the Retention Class or Policy list box.

Note: To select a class or policy other than the default, you must have retention administrator privileges or the Retention Administrator must have configured the application to allow retention users to override the default.

6. In Options, do the following:
   a. Specify whether you want to file all available previous revisions of the document for retention.
      Note: Document Manager applies the retention setting to the current version of the document if you do not enable File all available previous revisions for retention.
   b. Specify whether you want to calculate the new retention period based on the current date or the original retention start date. The Retention Status and Operation Effect columns reflect the original and new retention expiration dates, respectively.

7. Click Set Retention.

Processing Documents for Retention Hold

The retention hold feature allows you to apply and remove retention holds. A retention hold prevents users from deleting documents after the retention period expires.

Note: You must have retention administrator privileges to use the retention hold feature.

For more information, refer to:
- Applying Retention Holds, page 539
- Removing Retention Holds, page 541
- Changing Retention Hold Labels, page 544

Applying Retention Holds

Document Manager allows you to apply a retention hold from Document Display view and the Query view Result Set. For more information, refer to:
- Applying a Retention Hold from Document Display View, page 539
- Applying a Retention Hold from the Query View Result Set, page 540

Applying a Retention Hold from Document Display View

To apply a retention hold from Document Display view:
1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.
2. Open the document in Document Display view. Refer to Chapter 6, Viewing Documents for more information.

**Figure 281. Retention Hold Options Dialog Box**

4. Select a retention hold label from the Retention Hold Label list box.

5. To create a new retention hold label, type the name of the new label (for example, W2) in the list box, and then click Create New.

6. Click OK.

Document Manager displays a retention hold icon (__) next to the document in the Result Set after the storage device processes the request.

**Applying a Retention Hold from the Query View Result Set**

**To apply a retention hold from the Query view Result Set:**

1. Query the application to locate the document(s). Refer to Chapter 5, Retrieving Documents for more information.

2. Right-click to open the Document Manager shortcut menu.

3. Select Place Retention Hold.

   Document Manager displays the Manage Retention Holds dialog box.

**Figure 282. Manage Retention Holds Dialog Box**

4. Select a retention hold label from the hold label list box or create a new label by typing the name of the new label (for example, W2) in the list box.

5. In Options, do the following:
   a. Specify whether you want to refresh the Query view after you exit this dialog box.
b. Specify whether you want to display documents already on retention hold to change the hold label.

c. Specify whether you want to set all previous revisions of the documents on retention hold.
   
   **Note:** If you leave this check box blank, Document Manager applies the retention hold setting to the current version of the documents only.

6. Select the button that represents the documents with which you want to work:
   - All documents
   - None of the documents
   - Documents that are not on retention hold
   
The check boxes in the document list automatically refresh based on your selection.

7. Click Set Holds to apply a retention hold to the selected documents.

8. Click Exit.

After the storage device processes the retention hold request, the Result Set displays a retention hold icon (usahaan) next to each document that you put on retention hold.

## Removing Retention Holds

Document Manager allows you to remove a retention hold from a single document or a set of documents. You cannot delete a document from the AppXtender repository until the retention period expires and the retention hold is removed from the document.

**Note:** You must have retention administrator privileges to remove a retention hold.

For more information, refer to:

- Removing a Retention Hold from Document Display View, page 541
- Removing a Retention Hold from the Query View Result Set, page 542
- Removing a Retention Hold from a Set of Documents, page 542

### Removing a Retention Hold from Document Display View

**To remove a retention hold from Document Display view:**

1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.

2. Open the document in Document Display view. Refer to Chapter 6, Viewing Documents for more information.

4. Click Yes to confirm you want to remove the retention hold. Document Manager removes the retention hold icon (_fk) from the Result Set after the Centera storage device processes the request.

Removing a Retention Hold from the Query View Result Set

To remove a retention hold from the Query view Result Set:
1. Query the application to locate the document. Refer to Chapter 5, Retrieving Documents for more information.
2. Right-click the document to open the Document Manager shortcut menu.
3. Select Remove Retention Hold. Document Manager displays the Retention Hold Options dialog box.

Removing a Retention Hold from a Set of Documents

You can remove a retention hold from a set of documents from either the Query view Result Set or the Utilities menu.
To remove multiple retention holds from the Query view Result Set:

1. Query the application to locate the documents. Refer to Chapter 5, Retrieving Documents for more information.

2. Right-click the document list to open the Document Manager shortcut menu.

3. Select Place Retention Hold.
   Document Manager displays the Manage Retention Holds dialog box.

4. In the hold label list box, select the retention hold label associated with the documents for which you want to remove the retention hold.

5. In Options, do the following:
   • Select Display documents already on retention hold to change hold label.
   • Select other options, as desired.

6. In Select, click Docs with Current Label. A check mark appears in the check box next to each document that is on retention hold using the label you selected in Step 4.

7. Click Remove Holds.

8. Click Exit.

To remove multiple retention holds using the menu:

1. Select Utilities > Remove Retention Holds from the Document Manager menu bar. Document Manager displays the Remove Retention Holds dialog box.
Figure 286. Remove Retention Holds Dialog Box

2. Select the application from the Application list box.
3. Select the retention hold label from the Label list box.
4. Click Display Docs. Document Manager displays the documents that have been filed for retention with the selected hold label.
5. Select the documents from which you want to remove the retention hold:
   - To select all the documents, click Select All.
   - To select a specific document, select the check box next to that document.
6. Click Remove Holds.
   Document Manager removes the retention hold icon (■) from each document in the Result Set after the Centera storage device processes the request.

Changing Retention Hold Labels

Retention users can change the hold label for documents already on retention hold.

1. Query the application to locate the documents. Refer to Chapter 5, Retrieving Documents for more information.
2. Right-click the document list to open the Document Manager shortcut menu.
3. Select Place Retention Hold.
   Document Manager displays the Manage Retention Holds dialog box.
4. In the hold label list box, select the retention hold label that you want to change.

5. In Options, do the following:
   • Select Display documents already on retention hold to change hold label.
   • Select other options, as desired.

6. In Select, click Docs with Current Label. A check mark appears in the check box next to each document that is on retention hold using the label you selected in Step 4.

7. Click Remove Holds.

8. Click Exit.
Appendix B

Working with Records Manager for AppXtender

This appendix describes how to transfer documents using Records Manager for AppXtender.

- Introduction to Records Manager for AppXtender, page 547
- RM for AppXtender Concepts, page 548
- Identifying RM for AppXtender Applications in AppXtender, page 550
- Transferring AppXtender Applications for Records Management, page 552
- Filing AppXtender Documents for Records Management, page 552
- Working With AppXtender Documents That Are Filed for Retention, page 557

Introduction to Records Manager for AppXtender

Records Manager for ApplicationXtender (RM for AppXtender) is a Department of Defense (DoD) compliant and certified records management module of AppXtender. From either the ApplicationXtender (AppXtender) or ApplicationXtender Web Access (AppXtender Web Access) desktop, users can transfer AppXtender documents into Documentum Records Manager (DRM), where the documents become official corporate records and are no longer accessible through AppXtender or AppXtender Web Access.

Users can also use RM for AppXtender to provide retention administration for documents in the AppXtender repository. RM for AppXtender retention administration ensures that documents that have been filed for retention remain in the AppXtender repository for a prespecified period of time.

Note: Retention and classification rules that the administrator configures determine this period of time and the conditions under which documents are retained and eventually archived or destroyed.

Depending on how your administrator has configured your AppXtender applications, you may be able to transfer documents to RM for AppXtender for records management, file documents in RM for AppXtender for retention administration for documents retained in AppXtender, or both.
There are several advantages for organizations using RM for AppXtender:

- Records in the RM for AppXtender filing system are protected from loss, whether accidental or malicious.
- Filing documents in RM for AppXtender for retention administration ensures that your organization meets all legal and policy requirements regarding how long to keep documents on file before disposing of them.
- In cases requiring supporting documentation, such as for litigation purposes, authorized users can quickly and easily find relevant retained records in RM for AppXtender.
- Authorized users can access documents in RM for AppXtender for retention administration regardless of which user originally transferred the document into the filing system. This means that you can access others’ documents from the RM for AppXtender system and they can access your documents.
- Documents transferred to the RM for AppXtender system can provide valuable reference information for your organization.

The following topics are discussed in this section:

- RM for AppXtender Concepts, page 548
- RM for AppXtender Concepts, page 548
- Transferring AppXtender Documents for Records Management, page 552
- Filing AppXtender Documents for Retention Administration, page 554
- Working With AppXtender Documents That Are Filed for Retention, page 557

RM for AppXtender Concepts

Understanding how the RM for AppXtender system functions can help you when you transfer documents from AppXtender to RM for AppXtender for records management, file documents for retention, or both.

Note: The RM for AppXtender authentication and authorization system controls which users can use AppXtender to transfer documents to RM for AppXtender and access documents from RM for AppXtender, as well as which users can log into the RM for AppXtender server to perform procedures such as document deletion. If you have questions about your user privileges, consult your records administrator.

This topic includes information on the following concepts:

- Filing Systems and File Plans, page 549
- Records Management, page 549
- Retention Administration, page 550
Filing Systems and File Plans

Records Manager for AppXtender applications allow you to transfer AppXtender documents to the appropriate filing system and file plan in the RM for AppXtender repository. Based on your organization’s specific requirements, your administrator designs and implements RM for AppXtender filing systems, file plans, and rules for records management and retention administration.

Note: AppXtender Reports Management reports cannot be transferred to the RM for AppXtender repository.

While multiple filing systems may be configured for each RM for AppXtender server, only one RM for AppXtender server may be configured per AppXtender data source group. The filing system may consist of one or more file plans, which hold official records and retained documents. There can be up to 20 levels of files in a file plan.

The following figure shows an example of a filing system called AXRM520 that has one file plan called Corporate_name and several file levels.

Figure 288. Example of File System Configuration in RM for AppXtender Server

Records Management

When you transfer an AppXtender document to Records Manager for AppXtender for records management, RM for AppXtender creates an official record using metadata from the AppXtender document. The official record for the document is filed in the specified filing system file plan in the RM for AppXtender system, and the document index in AppXtender is deleted. Although the document contents (page files, annotation files, etc.) remain in AppXtender after the transfer process, once a document is transferred to RM for AppXtender for records management, you cannot search for the document in AppXtender or make any changes to it.

Note: Since the index is deleted when a document is transferred to RM for AppXtender for records management, you can no longer access that document from AppXtender. For this reason, it is
imperative to verify that you are working with the correct AppXtender document before starting the transfer process.

**Retention Administration**

When you assign an AppXtender document to RM for AppXtender for retention administration, RM for AppXtender creates a copy of the document and a document profile and files both in the selected RM for AppXtender file plan for a pre-specified period of time. The exact amount of time is based on legal, regulatory, fiscal, or operational requirements relating to the type of document. The document contents (page files, annotation files, etc.) and document index remain in the AppXtender system.

**Note:** AppXtender Reports Management documents cannot be added to the RM for AppXtender repository.

As long as a document is under retention administration in RM for AppXtender, RM for AppXtender rather than AppXtender controls access to the document. Assuming you have the appropriate user privileges, you can use AppXtender queries to find the document in the repository. From AppXtender Search Result Set view, you can then view the document in Document Display view or check the document out and make changes to the document in AppXtender or AppXtender Web Access. For information on retrieving retained documents, refer to Working With AppXtender Documents That Are Filed for Retention, page 557.

**Note:** Unless the RM for AppXtender retention policy for a particular file allows deletion, you will not be able to delete the retained document in AppXtender before the retention time period expires.

At the end of the retention time period, the document may be archived or deleted from the system. Depending on how the retention policy is configured, document disposal may be carried out by either RM for AppXtender or AppXtender.

**Note:** Only users with the appropriate RM for AppXtender authentication and authorization privileges can delete documents from the RM for AppXtender system.

**Identifying RM for AppXtender Applications in AppXtender**

Like other AppXtender applications, applications configured for RM for AppXtender retention administration, records management, or both are represented in AppXtender Applications view by file folder icons. The appearance of the file folder icon indicates whether an application is a regular AppXtender application, an application configured for retention administration, an application configured for records management, or an application configured for both retention administration and records management.

The following figure shows four types of application file folder icons that may appear in Application view when you work with Records Manager for AppXtender. The table following the figure describes what each type of application folder icon represents.
Figure 289. Application Folder Icons on RM for AppXtender Desktop

The following table describes the configuration each type of application folder in Application view represents.

Table 80. RM for AppXtender Application Folder Icon Descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📂</td>
<td>Manila folders represent applications with neither records management nor retention administration.</td>
</tr>
<tr>
<td></td>
<td>Blue folders represent applications configured with records management.</td>
</tr>
<tr>
<td>🕒</td>
<td>Manila folders with a clock icon on the lower right corner represent applications configured with retention administration.</td>
</tr>
<tr>
<td>🕒</td>
<td>Blue folders with a clock icon on the lower right corner represent applications configured with both records management and retention administration.</td>
</tr>
</tbody>
</table>

Your desktop may also include an icon to access the RM for AppXtender server.

Figure 290. Records Management Servers Icon

Using this icon, AppXtender users with the required RM for AppXtender privileges can log into the Records Management server to search for records, view a list of records, open records, view record properties, and delete records. For more information on document access and management through the Records Management node, refer to the *Retention Manager for ApplicationXtender Integration Guide*. 
Transferring AppXtender Documents for Records Management

You use the Classify and Transfer function from the AppXtender Documents menu to transfer documents from AppXtender to the RM for AppXtender system for records management. During this procedure, you select the file plan from the RM for AppXtender filing system to which the document should be transferred.

Caution: Once AppXtender documents are transferred to the RM for AppXtender system for records management, they can no longer be accessed in AppXtender.

To transfer an AppXtender document to the RM for AppXtender system for records management:

1. From the AppXtender application configured for records management, search for the AppXtender documents to be transferred. For information on using AppXtender queries to retrieve documents, refer to Entering Index Values as Search Criteria, page 245.

   Note: Before you search for documents in RM for AppXtender, make sure the RM for AppXtender Indexer has been run to index any new documents added to RM for AppXtender. For more information, refer to the Retention Manager for ApplicationXtender Integration Guide.

2. From the documents in AppXtender Search Result Set view, right-click on the document you want to classify and transfer. The shortcut menu appears.

3. On the shortcut menu, select Classify and Transfer.

   If this is the first time in any AppXtender session that you have selected to access the Records Management system, the Records Management login dialog box appears.

   Note: You only need to log into the Records Management system once from AppXtender. From then on, when you select to classify and transfer an AppXtender document, the RM for AppXtender login dialog box is bypassed. This applies not only to the current AppXtender session but to future sessions as well.

4. Enter your RM for AppXtender user name and password.

   Note: If you have questions about your RM for AppXtender password, consult your system administrator.

5. Click Login. The Select File Plan dialog box appears.
6. Find the filing system file plan to which the document should be transferred by clicking the plus signs (+) to the left of the filing system and file plan names until the destination file plan appears.

7. Select the destination file plan folder. This enables the OK button in the lower part of the dialog box.
8. Click OK to transfer the AppXtender documents to the selected file plan. The Select File Plan dialog box closes, and the transferred document is removed from the list of documents in Search Result Set view.

9. If other documents in Search Result Set view need to be transferred to RM for AppXtender for record management, repeat steps 2 through 6 for each document.

**Filing AppXtender Documents for Retention Administration**

You use the File for Retention function to file AppXtender documents with the RM for AppXtender system for retention administration. You file documents for retention from the AppXtender desktop using the File for Retention function. Once documents are filed for retention, RM for AppXtender manages document deletion.

**Note:** For information on document access and management through the Records Management node, refer to the *Retention Manager for ApplicationXtender Integration Guide*.

**To file an AppXtender document for retention administration by the RM for AppXtender system:**

1. From the AppXtender application configured with records administration, search for the AppXtender documents to be filed for retention. For information on using AppXtender queries to retrieve documents, refer to *Entering Index Values as Search Criteria*, page 245.

   **Note:** Before you search for documents in RM for AppXtender, make sure the RM for AppXtender Indexer has been run to index any new documents added to RM for AppXtender.
For more information, refer to the Retention Manager for ApplicationXtender Integration Guide Integration Guide.

2. From the documents in AppXtender Search Result Set view, select the document you want to file for retention and right-click. The shortcut menu appears.

3. On the shortcut menu, select File for Retention.
   
   If this is the first time in any AppXtender session that you have selected to access the Records Management system, the Records Management login dialog box appears.
   
   Note: You only need to log into the Records Management system once from AppXtender. From then on, when you select to file an AppXtender document for retention, the RM for AppXtender login dialog box is bypassed. This applies not only to the current AppXtender session but to future sessions as well.

4. Enter your RM for AppXtender user name and password.
   
   Note: If you have questions about your RM for AppXtender password, consult your system administrator.

5. Click Login. The Select File Plan dialog box appears.

   Figure 293. Select File Plan Dialog Box

6. Find the filing system file plan to which the document should be filed by clicking the plus signs (+) to the left of the filing system and file plan names until the destination file plan appears.

7. Click on the destination file plan folder. This enables the OK button in the lower part of the dialog box.
8. Click OK to file the AppXtender document to the selected file plan. The Select File Plan dialog window closes. When the file for retention process finishes successfully, a clock icon appears on the far right in the AppXtender status bar.

Figure 295. Retention Administration Clock Icon in AppXtender Status Bar

Once an AppXtender document is filed for retention in RM for AppXtender, if you need to modify the document, you must check it out of the repository. When you finish working with the document, you must check it back in. As long as you have a document checked out, other users can access that document only in read-only mode.

For information on document checkout and check-in, as well as cancelling document checkout, refer to the following topics:
- Chapter 1, Getting Started
- Selecting a Document Display Mode, page 271
- Checking in and Canceling Changes, page 397
- Checking a New Document into AppXtender, page 418
- Choosing a Viewing Mode for an AppXtender Document, page 425
- Working with Checked Out AppXtender Documents, page 431
Working With AppXtender Documents That Are Filed for Retention

When you need to view or modify an AppXtender document that is filed for retention in RM for AppXtender, you query the corresponding AppXtender application for the document using the same query methods that you normally use to retrieve AppXtender documents. These methods include index value, wildcard, expression range, and list of values queries, searching by ODMA attributes, and using compound queries. For information on setting up AppXtender queries, refer to Chapter 5, Retrieving Documents.

Note: When you query for retained documents from RM for AppXtender, the query results may include non-AppXtender documents such as documents added directly via the RM for AppXtender client. The icons for these documents in AppXtender Search Result view differ from the RM for AppXtender icons. You cannot view non-AppXtender documents in AppXtender.

After viewing the retrieved document, if you need to modify it, before you can start, you must create a copy or the document and then check the document out of RM for AppXtender so that you can access it in edit mode. When you finish modifying the document, you check the altered version back into RM for AppXtender.

Note: You can copy a document that is in a retention status, thereby creating a new document that is not under retention. You cannot modify or delete the version under retention. The original document remains in an unmodified, read-only state.

Note: If you check a document out of RM for AppXtender and then find you do not need to work with it, you can cancel the checkout.

The procedures to check retained documents out, check them back in, and to cancel checkout when working with RM for AppXtender are the same as those normally used in AppXtender. For information, refer to the following topics:

- Ways of Using AppXtender, page 47
- Selecting a Document Display Mode, page 271
- Checking in and Canceling Changes, page 397
- Checking a New Document into AppXtender, page 418
- Choosing a Viewing Mode for an AppXtender Document, page 425
- Working with Checked Out AppXtender Documents, page 431
This glossary contains terms and definitions found in this guide.

**annotation**
An annotation is a note or a shape added to a document or batch page, typically to focus attention on a particular part of the page. Users can use annotations to comment on the contents of a page, block areas of the page from view, or highlight important information. When a user creates an annotation, it is associated with the AppXtender document page on which her or she created it. Annotations are edited and stored separately from the image, but they are displayed along with the image in AppXtender. The types of annotations available include text, highlighting, lines, arrows, shapes, and rubber stamps.

**annotation group**
AppXtender administrators use annotation groups to create associations between users, groups, and specific annotations. The administrator can specify which users and groups can view or modify specific annotations and which users and groups can hide or modify specific redactions.

**append**
Attach one or more pages to the end of a document.

**application**
An AppXtender application is an index-driven data storage structure where documents can be stored and retrieved. An AppXtender application is based on an index that is composed of one or many fields. AppXtender applications are created in AppXtender Application Generator (AppXtender AppGen).

**application security profile**
Application security profiles allow an AppXtender administrator to grant a particular set of privileges to a user or group of users. Each application can be set up with its own set of privileges.

**audit trail**
The Audit Trails feature allows AppXtender administrators to track user activity within the AppXtender system. System-wide activities, such as the creation, modification, and deletion of applications, users, and groups can be tracked. Administrators can also track user activity in applications by tracking items such as the creation and deletion of documents, the addition of pages, and the modification of index information for documents.

**authentication**
Authentication requires all users to enter a valid user name and password to access software modules. Authentication ensures that each user is who he or she claims to be.
authorization
Authorization is the granting of specific access privileges according to the user name. Security profiles contain information pertaining to a user’s specific privileges within the AppXtender system.

auto index import
The AppXtender Auto Index Import function allows users to automatically populate indexes using data imported from records in the AppXtender Auto Index Import table. Once data has been exported from the record to populate index fields, the record is deleted from the AppXtender Auto Index Import table. AppXtender Auto Index Import is ideal for the import of index records that are applicable to only one document.

batch
A group of electronic files for one or more documents, each of which has one or more pages.

check in/check out mode
When AppXtender is in check in/check out mode, use of revision control with AppXtender documents is mandatory. Users must check out a document in order to modify it. If they do not check the document out, it is opened in read-only mode and cannot be modified.

COLD
COLD (computer output to laser disk) data is report data generated for existing applications. COLD data can be added to AppXtender as documents through the use of AppXtender Reports Management™ (AppXtender Reports Mgmt).

data source
A data source is the means by which AppXtender accesses data from a database. When a data source is defined, an OLE DB data provider is configured to access the database. All of these characteristics in combination – where the data is stored, the format of the stored data, and the data provider used to access the data – comprise the data source.

database
A database is a collection of data tables of a particular database format (such as Oracle or Microsoft SQL Server). AppXtender uses databases to store application information. When an application is created, details such as the field definitions and security information are stored in database tables. Once documents are added to an application, index information is stored in a table, as are the pointers to the location of the documents.

digital signature
The Digital Signature features allows authorized users to electronically sign pages in AppXtender documents from Document Display view. If the document is modified later, the existing digital signature is invalidated and a new digital signature must be applied.

document
A document is a page or group of pages stored in an application and identified by index information. Each page of a document is comprised of a single object such as a scanned image file or a word processing document. To create a new document, users add an object to an application and attach index information to it. Subsequent objects can be added as additional pages of the same document.
Document Level Security

Document Level Security (DLS) pinpoints user access within an AppXtender application. With DLS, the administrator can deny a group of users access to any classified or sensitive documents without restricting access to other documents in the application. DLS can also be configured to grant a group of users access to only a specific set of documents in an application.

dual data entry

A validation measure used when indexing documents to ensure that each document is indexed correctly. Users must enter each index value twice when adding or modifying index field data. The first index value is accepted only when AppXtender verifies a match with the second entry.

ERM

ERM (enterprise report management) data is report data generated for existing applications. ERM data can be added to AppXtender as documents through the use of AppXtender Reports Management™ (AppXtender Reports Mgmt).

expression operators query

A query using expression operators to focus the document search. Users can use operators to combine index words or text strings into a single expression.

full-text

Users can index documents for full-text searching by submitting them to the AppXtender Index Server. With a full-text search, users can find documents even if they do not know any of the index values. Users can also use full-text searching to refine an index value search.

global security profile

Global security profiles can be established to automatically assign a uniform set of access privileges for a user or group of users every time a new application is created. When a global profile exists for a user or group of users, the privileges assigned in that profile are automatically assigned when an application is created. If a user or group of users does not have a global profile, an application-specific profile must be created for that user or group before they can access an application.

index

An AppXtender index contains a group of fields where descriptive information pertaining to documents can be stored. This group of field definitions is used by AppXtender when storing index information within an application.

Index Server

The AppXtender Index Server is an optional module that adds full-text indexing and OCR functionality to AppXtender systems.

installed components

Third-party components that users can download to use while working with AppXtender. This includes software for a scanning component required for interactive control, viewing and printing components for PDF files, and a KeyView component required for rendering foreign files.
"just-in-time" compilation
The first time a user accesses a page, AppXtender compiles the page into its native code. The page is then cached and downloaded. With this method, although the page takes longer to load initially, it should load quickly the next time it is accessed.

Key Reference
The AppXtender Key Reference function allows users to automatically populate indexes using data imported from records in the AppXtender Key Reference table. The record from which data has been exported to populate index fields remains in the AppXtender Key Reference table—it is not deleted. For this reason, AppXtender Key Reference indexing is useful in populating index information that will be used to describe multiple documents and that may need to be changed frequently. Any change made to a record in the AppXtender Key Reference table is reflected in the indexes of all documents described by that record.

Last Index
The Last Index function allows users to populate the index fields for one record with the index values used for the previous record.

list of values query
A query in which multiple index values can be specified for each search criteria index field. This allows users to retrieve documents matching multiple index values in a single search.

OCR
Users can process both bi-tonal and color images using optical character recognition (OCR). This process converts an image of text into text. After a user processes an image using OCR, it can then be submitted to the AppXtender Index Server for full-text searching.

OLE DB
OLE DB is a programming interface for accessing data and is a fundamental building block for storing and retrieving data using Microsoft’s Data Access Components (MDAC). OLE DB provides flexible data architecture that offers applications like AppXtender efficient access to databases. Data is accessed through OLE DB data providers.

page
The word "page" typically implies a single entity. Since AppXtender supports multiple object types, the term "page" is redefined within AppXtender to mean a single object. A very long word processing file is considered a page to AppXtender. A page could also be, for example, a single scanned image, a 30-minute video clip, or an audio recording. Each page of a document has the same index record attached.

privileges
Privileges govern the ability of a user or group of users to access functions in AppXtender.

range query
A query in which users can search for documents with index values that match one or more values in a specified range of values. This allows users to narrow a search within a single index field to get more concise and accurate results.
**reason audit mode**
When the AppXtender administrator selects the Reason Code option for AppXtender, all document creation, printing, e-mail, and export actions are audited. With Reason Code selected, when printing, e-mailing, and exporting documents, users are required to enter a comment explaining the reason for the action and to indicate which function they intend to use.

**redactions**
A redaction is a filled and opaque annotation shape, which can be used to secure or hide portions of image and text document pages. Users can apply redaction to all available shapes: lines, freehand lines, arrows, rectangles, rounded rectangles, and ovals. When applied, the area of the page behind the redaction is not visible.

**security**
Security is the combination of authentication and authorization.

**security provider**
Security providers implement authentication, which requires all users to enter a valid user name and password to access most modules. AppXtender offers two pre-packaged security providers (CM and Windows) to ensure that each user is who he or she claims to be.

**configuration option settings**
Settings available from the Settings dialog box that allow authorized users to configure AppXtender functionality based on their specific work requirements. Configuration option settings are saved on the AppXtender server as part of the user profiles.

**wildcard query**
A query in which a single asterisk (*) is used as a wildcard in search criteria to match one or more characters. This allows users to control the number of documents returned in a result set by narrowing search results.

**write paths**
Write paths are used to instruct AppXtender where to store documents, annotations, OCR output, and the ProIndex full-text database for a particular AppXtender application.
4/8-bit color images
  e-mail format, 126
  export format, 130
  storage format, 140

A
  acceleration printer options, 122
  Acrobat Reader
    view PDF files, 107
  activating
    application, 66
    data source, 66
  ActiveX embeddable objects, inserting, 343
  actual scale. See actual size, 333
  actual size, 310
    display image, 333
  actual size display, as default, 106
  add
    focus, 497
    new document, 182
    ODMA document summary
      attributes, 416
    page, 340
    rubber stamp, 465 to 466
  adding
    file type, 133
    page numbers to printed
      documents, 123
    toolbar buttons, 90
  advanced registration, 494
    horizontal/vertical, 496 to 497
  advanced sub image, 522
    bottom edge, 525
    left edge, 525
    right edge, 526
    top edge, 525
  allowing
    docking, 96
    full text on an AppXtender
      workstation, 144
  map of unknown data sources to
    existing, 107
  OCR on an AppXtender
    workstation, 145
  paste, 119
  remember password option, 136
  zoom for text, 119
  annotation group
    assigning to annotation, 468
    hiding, 470
    setting default, 468
    toolbar button, 78
  annotation selection toolbar button, 78, 476 to 477
  annotation toolbar, 77
  annotation toolbar buttons, 77
    annotation group, 78
    annotation selection, 78, 476 to 477
    arrow, 78, 451
    bring to front, 78
    cancel changes, 79
    color, 79
    delete annotations, 79
    eraser, 78, 485
    fill, 78
    freehand line, 78, 451
    hide annotations, 79
    highlight, 78
    line width, 79
    oval, 78, 452
    polygon, 78
    polyline, 78
    rectangle, 78, 452
    redaction, 78
    rounded rectangle, 78, 452
    save annotations, 79
    select all, 78, 477
    send to back, 79, 467 to 468
    straight line, 78, 451
    text annotation, 78
  Annotation toolbar buttons
Rubber Stamp, 79
Annotation toolbar, enabling display, 88
annotations, 31
arrows, 450
assigning annotation group, 468
basic lines, 450
basic shapes, 452
configuring, 446
creating, 449
default color, 447, 480
deleting, 486
e-mail document, 472
erasing, 485
export document, 474
filled or hollow, 448
freehand lines, 450
hiding annotation group, 470
highlight, 453
lines, 450
modifying, 476, 478, 482
move, 467 to 468
ovals, 452
overlapping, 467
polygons, 453
polyline, 451
print document, 471
printing text annotation, 484
properties, changing, 476
rectangles, 452
redactions, 448
resizing, 478
rounded rectangles, 452
rubber stamp, 465
saving, 445
selecting, 476
setting default annotation group, 468
shape, 452
straight lines, 450
text, 454, 465
types, 445
application
activating, 66
definition, 32
hide, 66
ODMA compliant, 441
open to search, 420
querying, 243
show, 66
views, 63
AppXtender, 48
configuring, 85, 103
desktop, customizing, 95
ODMA support, 406
on your network, 41
SDK, 81
starting, 56
AppXtender Auto Index Import Wizard, 38
AppXtender Index Image Import Wizard, 38
AppXtender Index Server, 37
AppXtender Migration Wizard, description, 39
AppXtender Reports Mgmt
definition, 32
AppXtender Reports Mgmt reports
open, 282
query, 279
view, 281
AppXtender software retention, 529
AppXtender views
Applications, 63
customize, 95
display as dialog box, 96
display as subwindow, 97
docking, 95
Document Display, 69
hiding on use, 98
Index, 71
Query, 66
AppXtender Web KeyView Comp
view foreign files, 325
AppXtender Workflow
submit documents, 393
archived format
e-mailing, 128
exporting, 131
arrow annotations, 450
arrow toolbar button, 78, 451
ascending order, as default, 111
assigning annotation group, 468
attach
all toolbar button, 81
feature, 209 to 210
page toolbar button, 81
author, search by, 138, 251
auto enhance toolbar button, 83
auto feed toolbar button, 83
auto logout, 138
auto-index
table, 38
with dual data entry, 207
automatic features
  appending to existing document, 84, 206
cropping, 526
deskewed characters, protecting, 494, 502
dots, removing, 498
enhancing images during scan, 83
full text, 145
full-text indexing new documents, 219
hiding a view on use, 98
indexing, 38, 84, 206 to 210, 350
KeyView Viewer, 107
lines, removing, 506
noise, removing, 498
OCR, 219, 387
OCR, using during full-text indexing, 144
registering an image, 494
rotating pages during scan, 83, 230
saving desktop layout on exit, 108
scanning all pages in feeder, 83, 226
setting tab size, 335
shading, removing, 498
skew, removing, 490
view settings, applying to page types, 93, 304
automatically logging in, 59
AX views
  Thumbnail, 73

B
back page, rotation during scan, 83, 230
band width, color bar, 120, 323
basic annotations
  lines, 450
  shapes, 452
batch
  create by fax-in, 202
deleting, 403
index, 213
index from a list, 215
resetting status, 218
single index, 213
batch import
  creating a file, 195
creation, 200
log, 199
performing, 198
utility, 194, 200
batch index toolbar, 81
batch index toolbar buttons, 81
  attach all, 81
  attach page, 81
delete page, 81
  new document, 81
  next page, 82
  previous page, 82
bi-tonal image enhancement, 487
default settings, 488
BIN files
  from multi-page TIFF or DCX, 141
bitonal images, 125
black and white images
e-mail format, 125
export format, 130
storage format, 139
blank pages
  removing while scanning, 232, 234
bring to front toolbar button, 78
building full-text search expressions, 257
buttons, toolbar
  adding, 90
  annotation group, 78
  annotation selection, 78, 476 to 477
  applications view, 76
  arrow, 78, 451
  attach all, 81
  attach page, 81
  auto enhance, 83
  auto feed, 83
  back rotation, 83
  bring to front, 78
  cancel changes, 79
cascade, 77
color, 79
  configuration, 77
  copy, 76
customizing, 90
cut, 76
delete annotations, 79
delete page, 81
eraser, 78, 485
fill, 78
fit height, 80
fit to window, 79
fit width, 80
form overlay, 80
freehand line, 78, 451
front rotation, 83
full screen, 77
hide annotations, 79
highlight, 78
Index view, 80
Index View, 72
line width, 79
magnifier, 80
manual feed, 83
new CAQ query, 76
new document, 76, 81
new query, 76
next page, 80
next subpage, 80
next version, 80
OCR page, 80
oval, 78, 452
pan mode, 70, 80
paste, 76
polygon, 78
polyline, 78
previous page, 80, 82
previous subpage, 80
previous version, 80
print, 76, 359, 361
query view, 76
rectangle, 78, 452
redaction, 78
removing, 90
rescan, 82
rotate left, 80
rotate right, 80
rounded rectangle, 78, 452
Rubber Stamp, 79
Run Query, 76
save annotations, 79
scan, 82
scan document, 77
scanner setup, 83
select all, 78, 477
select scanner, 77
selection mode, 70
send to back, 79, 467 to 468
show text, 80
single feed, 83
sticky view, 79
straight line, 78, 451
text annotation, 78
text search, 77
thumbnail view, 76
tile horizontally, 77
tile vertically, 77
zoom in, 80
zoom out, 80

cache forms, 119
cancel
    check out, 399, 440
cancel changes toolbar button, 79
cascade
document windows, 77, 302
toolbar button, 77
cell height
    change, 67, 72
    restore, 68, 73
Centera retention, 529
central focus, 497
change cells
    Query view, 67, 72
change password
    AppXtender, 86
change toolbar button size, 89
changing
    font of rubber stamp, 460
character
    protection, 502
check in
    definition, 49
doctorment, 398, 434, 437 to 438
    new document, 418
    new page version, 438
    open document, 427
    replacement page version, 439
check in, definition of the term, 272
check out
    cancel, 399, 440
definition, 49, 426
definition of the term, 272
document, 273
    open document, 427
prompt for when open, 137
check out mode, open document, 276
checked out documents
    close, 433
    save, 432
working with, 431

clear
  all regions, 317
  one region, 317

clipboard
  paste special, new document, 175
  paste special, new page, 342

clockwise, rotating an image, 311
close
  checked out documents, 433

COLD
  display as image only, 319
  documents, configuring, 321
  documents, definition, 32
  files, 43

COLD data
  configuring, 118
  configuring form overlay, 119

collapse columns, 103

color bar
  color, setting, 120, 323
  enabling for text, 120, 321
  width in lines, setting, 120, 323

color images
  e-mail format, 125 to 126
  export format, 130
  storage format, 139 to 140

color of annotations
  configuring, 447, 480
  modifying, 476

color toolbar button, 79

column
  hide in result set, 101
  insert into search, 253
  order in result set, 102
  save in result set, 102
  show in result set, 101
  widths in result set, 102

combining pages for
  e-mail, 127
  export, 131

comment, search by, 138, 251

compound queries, 253

compressing
  e-mailed true color images, 126
  exported true color images, 131
  stored true color images, 140 to 141

compression, viewing type for a page, 337

corporate concepts, 29

corporation configuration
  load, 160
  toolbar button, 77

configuring
  annotation colors, 447, 480
  annotation line width, 446
  annotation rubber stamps, 458
  annotations, 446
  AppXtender, 85
  AppXtender Image Capture workstation, 103
  AppXtender password, 86
  AX workstation, 103
  cache forms, 119
  COLD/ERM settings, 118, 321
  data settings, 134
  data sources, 40
  display settings, 109
  document display, 91
  e-mail package, 129
  e-mail settings, 124
  export settings, 129
  fax in settings, 147
  file types, 132
  fonts, 112
  full-text settings, 143
  image enhancement settings, 488
  index options, 134
  local forms cache, 119
  multiple data sources, 55
  OCR settings, 145
  ODMA support in AppXtender, 407
  paths, 141
  print original size, 121
  print settings, 121
  printer fonts for COLD/ERM documents, 361
  printer fonts for CX/ERMX documents, 114
  Quick Print feature, 123
  scaling, 104
  scanner properties, 225
  scanner selection, 224
  scanning, 115
  status bar, 92
  Talaris feature, 123
  thumbnails, 147, 298
  title bar, 91
  toolbars, 88
  view settings, 104
  viewer for foreign files, 324
workstation, 85
XipPrint II feature, 123
zoom, 104
connection to database, maintaining, 135
content management, 339
copy
displayed document pages, 381
existing index information to a new
document, 209
index values, 210, 246
regions to clipboard, 316
toolbar button, 76
counter clockwise, rotating an image, 311
create
document, 163 to 164
creating
annotations, 449
creating document toolbar button, 76
creator, search by, 138, 251
crop
intelligent, 526
manual, 516
ScanFix advanced settings tab, 518,
521, 524, 527
cross app query, 259
create new, 259
modify, 266
perform, 263
run, 264
Ctrl key, 401
customize
AppXtender views, 95
customizing
toolbar buttons, 90
cut toolbar button, 76
cutting a page, 402
CX documents
configuring, 118
configuring form overlay, 119
D
data
settings, configuring, 134
data field
definition, 208
modifying for existing document, 350
data source
unknown, 107
data sources, 50
activating, 66
configuration module, 40
default, 54
locating, 51
multiple, 55
multiple, login, 60
specify default, 54
data types
supported in AppXtender, 41
database
maintaining connection, 135
date
index values, Y2K compliance, 138
DCX files
importing multi-page files, 141
de-skew
ScanFix advanced settings tab, 490
text, 490
de-speck, 503
horizontal, 505
isolated, 506
vertical, 505
default
actual size, 106
ascending order, 111
data sources, specify, 54
descending order, 112
fit left to right, 106
fit to window, 106
fit top to bottom, 106
storage format for 4/8-bit color
images, 140
storage format for bi-tonal images, 139
storage format for images, 139
storage format for true color
images, 140
default annotation group, 468
definition, 29
annotation, 31
application, 32
AppXtender Reports Mgmt, 32
check in, 49
check out, 49, 426
COLD, 32
data field, 208
document, 33
document revisions, 435
full-text, 33
index, 34
key field, 208
normal mode, 49
ODMA, 50
page, 35
read-only mode, 426
definition of terms
check in, 272
check out, 272
grab bar, 95
normal document display mode, 273
normal mode, 272
query, 242
read-only mode, 273
delete
annotations, 486
annotations toolbar button, 79
batch, 403
document, 402
from the document menu, 403
from the page menu, 401
from the query result set, 403
from thumbnail view, 401
page, 401
page toolbar button, 81
page version, 400
page, by cutting, 402
query, 294
revision, 396
deleting
file type, 133
descending order, as default, 112
dialog boxes, display views as, 96
direction
text search, 287
disabling remember password option, 87
DiskXtender
as document storage server, 36
display
as icon, 328, 455
as image only, 119
document, 69, 295
duplicate document, 303
next page, 296
palette, 332
previous page, 297
scale, 306
scrollbars, 331
setting defaults for page types, 93, 304
status bar, 92
thumbnails, 298
toolbars, 89
display settings, configuring, 109
dithering, 122
document
add, 182
check in, 398, 434
configure display, 91
copying from display, 381
create, 299, 409
create new, 164
definition, 33
deleting, 402
deleting from query result set, 403
display, 91, 267, 269, 295
displayed, 41, 69
duplicate, 303
e-mail, 362
e-mailing with annotations, 472
e-mailing without annotations, 472
exporting, 370, 474
fax-in queue, 189
faxing, 355
faxing from display, 357
faxing from the result set, 355
import, 182
index, 205
index view, 351
mailing, 365
moving from display, 381
new, 418
ODMA attributes, 416
open, 274, 276
open from the result set, 423
open with ODMA, 410
printing, 355, 357, 471
properties, 329, 415 to 417
read-only, 274
retrieval, 241
retrieve through ODMA, 419
revision history, 395
revisions, definition, 435
save new ODMA documents to
AppXtender, 411
search, 421
stored, 41
submit, 386, 393
text searches, 286 to 287
to index, 417
view, 284 to 285, 295, 318
view properties, 268, 394
Index

working with checked out, 431
document properties
  general tab, 329
  image tab, 331
  OCR tab, 335
  revision history, 395
  text tab, 334
DPI resolution setting
  scan, 228
DPI, screen, 110
drag-and-drop methods
  foreign file document, 185, 187
  foreign file page, 347
  import file document, 185, 187
  importing file page, 347
drawing a region, 314
driver
  select for scanner, 231
dropping database connection, 135
dual data entry, 134, 212
  with auto-index, 207
duplicate document, 303

e-mail, 124
  combining pages for, 127
  configuring, 124
  documents, 362
  documents with annotations, 472
  documents without annotations, 472
  format, 125
  page, 370
  pages, 362
  text format, 131
e-mail format, 4/8-bit color images, 126
  e-mail format, black and white images, 125
  e-mail format, PDF, 125
e-mail format, text, 127
e-mail format, true color images, 126
  e-mail format, XPS, 125
e-mail package
  configuring, 129
e-mail tab, 124
e-mailing
  archived format, 128
  original format, 128
  edge cleaning factor, 510
  edit
    menu, in magnify window, 315
  editing
    query, 292
electronic mail, 124
  enable paste text, 119
  enhancement
    of images, 487
    options, bi-tonal images, 489
  erase annotations, 485
  eraser toolbar button, 78, 485
  ERM
    display as image only, 319
    files, 43
  ERM data
    configuring form overlay, 119
  ERM data, configuring, 118
  ERMX documents
    configuring, 118
  ERMX documents, configuring form overlay, 119
  export
    configuring settings, 129
    document, 474
    document to file, 371
    documents, 370
    images, 131
    multiple text documents to single file, 376
    page, 370, 378, 380
    page to a file, 378
    to a file, 372
    to an XPS file, 374, 377
    to OCR, 374, 380
  export format, 4/8-bit color images, 130
  export format, black and white images, 130
  export format, true color images, 130
  export tab, 129
  exporting
    archived format, 131
    combined pages, 131
    original format, 132

F
  F1 function key, 83
  F3 function key, 83
  F4 function key, 84, 206
  F5 function key, 84, 249, 251
  F7 function key, 84, 206
    using auto-index to index documents, 207
F8 function key, 84, 247, 249
F9 function key, 84, 206, 210
fax
  batch create, 202
  document, 355, 357
  from page menu, 359
  pages, 359
fax in settings, configuring, 147
fax in tab, 147
fax-in queue
  new document, 189
  new page, 347
fax-out
  documents, 355
  pages, 359
feed
  manual, 226
  single, 227
field values, list query, 250
file
  batch import format, 195
  import, 182
file menu
  in magnify window, 315
  print command, 92
file type
  adding, 133
  deleting, 133
file type, configuring, 132
file types
  COLD, 43
  ERM, 43
  foreign, 45
  hypertext markup language (HTML), 44
  portable document format (PDF), 44
  supported, 41 to 42, 167
  text, 43
fill
  modifying for an annotation, 476
  toolbar button, 78
find
  line for register, 497
  text, 287
fit
  left to right, as default, 106
  height toolbar button, 80
  to window, 309
  as default, 106
  toolbar button, 79
  fit to window height, 309
  fit to window width, 309
  fit top to bottom
    as default, 106
  float as MDI window, 97
font
  changing for rubber stamp, 460
  fonts, 361
    configuring, 112
    configuring for zoom feature with text, 307
    printer, 114
  fonts tab, 112
foreign files
  adding as page, 346 to 347
  closing, 326
  importing, 346 to 347
  KeyView Viewer, 107
  launching, 325
  saving, 328
  types, 45, 169
  updating, 327
  view, 324
  view as icons, 325
form overlay, 32
  modifying, 319
  toolbar button, 80
  view documents, 318
form overlay, settings, 119
formats
  e-mail, 125, 131
  formats for e-mail
    4/8-bit color images, 126
    black and white images, 125
    PDF, 125
    text, 127
    true color images, 126
    XPS, 125
formats for export
  4/8-bit color images, 130
  black and white images, 130
  true color images, 130
formats for storage
  4/8-bit color images, 140
  black and white images, 139
  true color images, 140
_FORMS application
  create documents, 192
  index fields, 193
forms, caching, 119
freehand line annotations, 450
toolbar button, 78, 451
front page, rotation during scan, 230
full screen, 99
toolbar button, 77
full text
allow on an AppXtender workstation, 144
full text tab, 143
full-text, 145
AppXtender Index Server, 37
building search expressions, 257
definition, 33
query, 255
search functionality, 37
search results, view, 283
full-text queue
prompt user to select, 145
full-text settings
configuring, 143
function keys
F1, 83
F3, 83
F4, 84, 206
F5, 84, 249, 251
F7, 84, 206
F8, 84, 247, 249
F9, 84, 206, 210
fuzzy
logic, 287 to 288
search, 288
G
general tab, 415
GIF animation files, 196
go to page, 296
in a displayed document, 297
grab bar, defined, 95
greyscale, display as, 107
green bar
enabling for text, 120, 321
H
heading
creating non-scrollable in text page, 320
height
change Query view cells, 67, 72
minimum, 501
hide
annotation groups, 470
annotations, 469
application, 66
index toolbar button, 72
Index View toolbar button, 72
result set columns, 101
status bar, 92
Hide Annotations toolbar button, 79
hide on use, 98
highlight annotations, 453
Highlight toolbar button, 78
horizontal
despeck, 505
margin alignment, 496
HTML file, 44
I
ignore
case, 287, 289
holes, 497
image
bi-tonal enhancement, 487
compression for e-mailed, 126
compression for exported, 131
compression for stored, 141
e-mail format, 4/8-bit color, 126
e-mail format, black and white, 125
e-mail format, PDF, 125
e-mail format, true color, 126
e-mail format, XPS, 125
enhancement, 487 to 489
export format, 4/8-bit color, 130
export format, black and white, 130
export format, true color, 130
referencing in batch import file, 195
rotating, 310 to 311
size options, 105
storage format, 4/8-bit color, 140
storage format, black and white, 139
storage format, true color, 140
sub, advanced, 522, 525 to 526
view, 80
image toolbar, 79
image toolbar buttons, 79
fit height, 80
fit to window, 79
fit width, 80
form overlay, 80
hide index, 72
magnifier, 80
next page, 80
next subpage, 80
next version, 80
OCR page, 80
pan mode, 70, 80
previous page, 80
previous subpage, 80
previous version, 80
rotate left, 80
rotate right, 80
selection mode, 70
show text, 80
sticky view, 79
zoom in, 80
zoom out, 80
Image toolbar buttons
  Index view, 80
  Index View, 72
Image toolbar, enabling display, 88
import
  AppXtender Auto Index, 38
  as input method for turnkey apps, 182
  batch, 194
  file, 182
  file format, 195
  foreign file format, 346 to 347
  index image, 38
  multiple files, 198
  used to add a new page, 346
import file
  as input method for turnkey apps, 462
importing multi-page image files, 141
index
  appending pages, 209
  auto-index table, 207
  batch from a list, 215
  batches, 213
  check for matching, 136
  copy values, 210
  definition, 34
  dual data entry, 134, 212
  entering and saving, 233
  hide index toolbar button, 72
  Index View toolbar button, 72
  key reference table, 208
  modifying, 350
  new documents, 205
  parsing MICRE codes into, 206
  paste values, 210
  query, 246
  saving, 185
  single batch, 213
  using last index saved, 210
  validation, 211
index field
  _FORMS application, 193
  _RSTAMP application, 192
index import types
  auto-index, 38
  key reference, 38
index options
  configuring, 134
index saving information, 463
index server
  submit from document menu, 220, 389
  submitting from the result set, 388
index tab, 417
Index view, 71, 351
  toolbar button, 80
Information Rights Management. See IRM
insert
  column into search, 253
  object, 177
introduction, 29
inverse text
  ScanFix advanced settings tab, 510
IRM
  applying protection to
    ApplicationXtender content, 353
  e-mailing protected document
    page(s), 364
  e-mailing protected page(s), 366, 369
  exporting protected page(s), 379
  specifying IRM options, 354

J
job
  OCR, 146
JPEG compression, 140
JPEG quality factor, 126, 130

K
key field
  definition, 208
modifying for existing document, 350
key reference, 206
able, 38
import wizard, 38
modifying existing index data, 350
using to index documents, 208
keyboard keys
  Ctrl, 401
  F1, 83
  F3, 83
  F4, 84, 206
  F5, 84, 249, 251
  F7, 84, 206
  F8, 84, 247, 249
  F9, 84, 206, 210
  Page Down, 110
  Page Up, 110
  Shift, 58, 401
  Tab, 206
KeyView Viewer
  view foreign files, 107
keyword, search by, 138, 251

L
layout, restore previous, 108
left, rotating an image, 311
length, detect minimum, 493
line
  annotations, 450
  gap, 498
  removal, 506
  report, text search, 289
  width, 79, 323, 446, 476
line width, color bar, 120
list of values, 249
load
  workstation settings, 160
locating
  data sources, 51
log, batch import, 199
logging in automatically, 59
login
  AppXtender, cannot, 160
dialog box, 59
  multiple data sources, 60
  new, 59
logout
  auto, 138
M
magnifier toolbar button, 80
magnifying a region, 314
  edit menu, 315
  file menu, 315
mail, 124
document, 365
page, 370
main toolbar, 75
main toolbar buttons, 75
  applications view, 76
  cascade, 77
  configuration, 77
  copy, 76
  cut, 76
  full screen, 77
  new CAQ query, 76
  new document, 76
  new query, 76
  paste, 76
  print, 76, 359, 361
  query view, 76
  scan document, 77
  select scanner, 77
text search, 77
thumbnail view, 76
tile horizontally, 77
tile vertically, 77
Main toolbar buttons
  Run Query, 76
Main toolbar, enabling display, 88
major revision, 436
  checking in a new document, 437
make
  private query, 293
  public query, 293
managing
  Result Set, 99
manual
  crop, 516
  feed, 83, 226
manual feed
  scanner timeout, 118
map
  unknown data sources, 107
max future years, 138
maximum
  acceptable skew, 493
  line gap, 510
line thickness, 509
maximum number of results, 110
MICRE codes, parsing, 206
minimum length of a line
line removal, 509
minor revision, 436
  checking in a new document, 438
mode
  check in, 49
  check out, 49
  choose, 425
display, select, 271
normal, 49, 272
normal document display, 273
pan mode toolbar button, 70
read-only, 273
scanning, 228
selection mode toolbar button, 70
modifying
  shape annotations, 478
text annotations, 482
move displayed document pages, 381
move to front toolbar button, 467
multi-page TIFF or DCX, 141
multiple
data sources, 55
data sources, login, 60
documents, displaying simultaneously, 302
file import, 198

O
object
  create new, 343
  insert from file, 344
  inserting in documents, 177
  OLE, 46
OCR
  allow on an AppXtender workstation, 145
displaying text, 318
document submit to queue, 386
document, 335
eengine, 145
exporting to, 374, 380
full text, 144
job, 146
submitting to index server, 219, 387
tab, 145
toolbar button, 80
OCR queue
  prompt user to select, 146
OCR Result Format setting
document, 335
workstation, 144
OCR settings
  configuring, 145
ODMA
  AppXtender support, 406
  attributes, search by, 251
  compliant application, 441
  configuring support, 407

N
network, 41
new
cross app query, 259
login, 59
object, 343
new CAQ query
toolbar button, 76
new document
  check in, 418
copying existing index information, 209
creating, 164
  from fax-in queue, 189
  from imported file, 182
index, 205
toolbar button, 76, 81
new page
  from fax-in queue, 347
  from imported foreign file, 346 to 347
new page version
  add, 350
  view, 301
new query, 243
toolbar button, 76
next page, 296
toolbar button, 80, 82
next search result, 284
next subpage
toolbar button, 80
next version toolbar button, 80
noise removal
  ScanFix advanced settings tab, 498, 503
normal mode, 49
definition, 272 to 273
open document, 274

577
create document, 409
definition, 50
file support, 172
open non-AppXtender documents, 410
retrieve document, 419
save new ODMA documents to AppXtender, 411
support, 136
view properties, 425
ODMA attributes, search by, 138
OLE objects, 46
close, 329
edit, 329
return to, 329
view, 328
opacity
modifying for an annotation, 476
open
AppXtender Reports Mgmt reports, 282
document, 274, 276, 427 to 428
non-AppXtender documents, 410
opening
AppXtender configuration, 103
origin, 288
original format
e-mailing, 128
exporting, 132
original size, configuring, 121
oval annotations, 452
oval toolbar button, 78, 452
owner, search by, 138, 251

P
page
adding a new, 340
adding an Active X object as a, 343
adding an import file as a, 346
adding from the scanner, 234
appending by scanning, 235
combining for e-mail, 127
combining for export, 131
cutting, 402
definition, 35
displaying from the thumbnail view, 299
exporting, 370, 378
faxing, 359
go to in a displayed document, 297
importing a foreign file as a, 346 to 347
inserting by scanning, 235
print command, 359
reordering, 350
selecting, 295 to 296
sending by e-mail, 362, 369
Page Down key, 110
page numbers
adding to printed documents, 123
page numbers, adding, 359
page size
scan, 229
Page Up key, 110
page version
adding, 350
deleting, 400
purging, 400
viewing, 300
palette, display, 332
pan mode toolbar button, 70, 80
parsing MICRE codes, 206
password
allowing remember password, 136
change, 86
configuration, 86
disabling, 87
remember option, 59, 61
paste
enabling, 119
index values, 210, 246
special, 119
toolbar button, 76
paths
configuring, 141
local, 142
personal search, 142
PDF files, 44
Acrobat Reader, 107
as e-mail attachments, 125
print document, 357
print page, 359
personal search path, 142
pick a data source, 284
pixels, viewing number of for a page, 337
plain text
OCR format, 146
pointer mode
pan mode toolbar button, 70
selection mode toolbar button, 70
polygon
annotations, 453
  toolbar button, 78
polyline
  annotations, 451
  toolbar button, 78
Portable Document Format file. See PDF files, 44
previous
  page, 296
  search result, 284
previous page toolbar button, 80, 82
previous subpage toolbar button, 80
previous version toolbar button, 80
print
  configure fonts for COLD/ERM and ASCII documents, 361
dithering, 122
document, 355, 357, 471
document revision history, 395
  entering, 414
  view document, 268, 329
  document property, 268
  document properties, 329
  properties, 414
  view document, 268, 329
protected ApplicationXtender content using IRM, 353
protecting
  character, 502
  horizontal, 505 to 506
purgings page versions, 400
quality of JPEG images, 140
query
  AppXtender Reports Mgmt report, 279
  by index, 246
  combination, 258
  compound, 253
  create new, 243
cross app, 259, 263 to 264, 266
definition, 242
delete, 294
disable window, 135
dirty, 292
document, 355, 357, 471
definition, 242
  expression range, 247
full text, 255
list of values, 249
make private, 293
make public, 293
new query toolbar button, 76
new query toolbar button, 76
new query toolbar button, 76
new query toolbar button, 76
rename, 293
result set tab, 266
results, 110
run, 292
save, 291
wildcard, 246
query result set
  collapsing the columns, 103
deleting from, 403
e-mailing documents from, 362
exporting COLD/ERM documents from, 376
faxing documents from, 355
  hiding columns, 101
  printing documents from, 355
  reordering the columns, 102
  resizing the columns, 102
  saving the columns, 102
  showing columns, 102
  sorting, 101
Query view, 66
  change cell height, 67, 72
  restore cell height, 68, 73
  toolbar button, 76
queue
  full-text jobs, 144
  OCR jobs, 146
Quick Print feature
  configuring, 123

579
QuickScan Pro
configuring export profiles, 238 to 239
creating export profiles, 236
integrating with AppXtender, 236

R
range of values, searching by, 247
read-only mode
definition, 273, 426
open document, 274, 428 to 430
reconstruction width/height, 510
rectangle annotations, 452
toolbar button, 78, 452
redaction, 448
modifying for an annotation, 476
toolbar button, 78
reference file fields
key reference feature, 38
regions, 313
clear all, 317
clear one, 317
copy to clipboard, 316
drawing, 314
magnify, 314
print, 361
registration
ScanFix advanced settings tab, 494
skip, 498
remember password, 59, 61
remember password, allowing, 136
remove
blank pages while scanning, 232, 234
skew, 490
speck, 503
Remove Blank Pages, 117
removing
toolbar buttons, 90
rename query, 293
reorder columns, 102
reorder page, 350
replace page, 349
rescan, 233
toolbar button, 82
reset
result set columns, 102
status of a batch, 218
resize
annotations, 478
columns, 102
resolution
setting for scanning, 228
restore cell height
Query view, 68, 73
restore last layout at startup, 108
result set, 266
auto-index, 207
changing document list, 99
collapsing columns, 103
faxing documents from, 355
hiding columns, 101
managing, 99
matching index records, 209 to 210
opening a document from, 423
reordering columns, 102
resetting columns, 102
resizing columns, 102
saving as a text file, 396
saving columns, 102
shortcut menu, 394, 396
showing columns, 101
sort automatically, 111
sorting, 101
tab, 244
text search, 288
view, 66
resultant left, 497
Retention
AppXtender software, 529
Centera, 529
identifying applications, 530
retrieving documents, 241
revision
delete, 396
history, 395
major, 436
minor, 436
right, rotating an image, 311
right-click context menu, 330
Rights Management protection. See IRM
rotate
image to the left, 310
image to the right, 311
toolbar button, back, 83
toolbar button, front, 83
toolbar button, left, 80
toolbar button, right, 80
using, 310
rounded rectangle annotation, 452
toolbar button, 78, 452
_RSTAMP application
  create documents, 192
  index fields, 192
rubber stamp
  change font, 460
  configuring annotations, 458
  creating, 458, 462
  customize, 459
  default settings, 460
  format, 459
  reset, 460
rubber stamp annotations, 465
  add, 465 to 466
Rubber Stamp toolbar button, 79
rubber stamps
  creating, 192
run query, 292
Run Query
  toolbar button, 76

S
save
  annotations, 79
  changes to a document and keep it checked out, 439
  checked out documents, 432
  columns, 102
  new ODMA documents to
    AppXtender, 411
  query, 291
  result set as a text file, 396
  settings, 150
  sticky view settings, 94
  workstation settings, 151
saved query
  deleting, 294
  editing, 292
  make private, 293
  make public, 293
scale to gray, 107, 312
scaling, 306
scaling, configuring, 104
scan
  synchronized, 118
Scan toolbar, 82
Scan toolbar, enabling display, 88
scanner
  list of those supported, 224
  properties, configuring, 225
  settings, 231
scanner timeout
  manual feed, 118
scanning
  adding a new page, 234
  configuration, 115
  enabling image processing, 116
  manual feed, 226
  mode, 228
  page size, 229
  removing blank pages, 232, 234
  rescanning, 233
  resolution, 228
  rotation, 230
  select scanner, 224
  single feed, 227
  source, 229
  supported scanners, 224
  synchronized, 226, 232, 234
  toolbar buttons, 77, 82 to 83
scanning locally, local write path, 142
scope, text search, 287
screen, 120
  DPI, 110
  resolution, 333
script toolbar, 81
  buttons, 81
scrolling, 80, 330
SDK, 81
search
  by ODMA attributes, 251
  deleting, 294
  document text, 286
  editing, 292
  expression, 247
  for documents, 241, 421
  for text from Document Display view, 287
  for text from query result set, 288
  list of values, 249
  make private, 293
  make public, 293
  opening an application, 420
  run query, 292
  saving, 291
  string, 288
  tab, 66, 243
  text search toolbar button, 77
  using a wildcard, 246
  wildcards in text searches, 289
with list, 250
search by ODMA attributes, 138
search drives, 143
security, 56
   login dialog box, 59
select
   annotations, 330, 476 to 477
   display mode, 271
   image, 330
   pages, 295 to 296
   region, 80
   scanner, 77, 224
   view mode, 313
select all
   toolbar button, 78
selection mode toolbar button, 70
send to back toolbar button, 79, 468
sending by e-mail
   combined pages, 127
separating multi-page image files, 141
server, index, 37
setting default annotation group, 468
settings
   annotations, 446
      load when AppXtender cannot log in, 160
      vertical adjustment, 497
   workstation, load, 160
   workstation, save, 150 to 151
shape annotations, 452
Shift key, 58, 401
shortcuts
   create, 299
show
   all hits on this page, 284
   annotations, 469
   application, 66
   columns, 101
   Index View toolbar button, 72
   status bar, 92
   thumbnails, 298
show text toolbar button, 80
single batch indexing, 213
single feed, 227
   toolbar button, 83
size
   adjust, horizontal, 502
   adjust, vertical, 502
   change for toolbar buttons, 89
   maximum for dots, 502
skew, maximum acceptable for images, 493
smooth characters in an image, 513
sort
   ascending order, 111
   descending order, 112
   order of document id, 111
   result set, 101
   result set automatically, 111
source
   scanning, 229
speck
   removal, 503
   removal, horizontal, 505
   removal, vertical, 505
split view, 303
status bar
   configuring, 92
   enabling display of, 92
   hiding, 92
   showing, 92
sticky view, 304
   save settings, 94
   switching settings, 305
   toolbar button, 79
storage
   device for AppXtender documents, 36
storage format
   AX images, 139
   storage format, 4/8-bit color images, 140
   storage format, black and white images, 139
   storage format, true color images, 140
straight line annotation, 450
   toolbar button, 78, 451
sub image, advanced, 522
   bottom edge, 525
   left edge, 525
   right edge, 526
   top edge, 525
subject, search by, 138, 251
submit full-text index job, 388
subwindow, display views as, 97
summary tab, 416
support
   ODMA, 136
   supported file types, 167, 346 to 347
      KeyView file support, 168
      ODMA, 172
   supported scanners, 224
synchronized scan, 118, 226, 232, 234
T

Tab key, 206
Talaris feature
  configuring, 123
text
  color bar, 120, 321
  display OCR text, 318
  e-mail format, 127
  export format, 131
  exporting multiple documents to a single file, 375
  file for batch import, 194
  files, 43
  paste, 119
  string in searches, 255
  view pages, 318
  viewing, 80
text annotations, 454
  printing, 484
  spell-checking, 455, 457
  toolbar button, 78
text searches
  document, 286
  from document display view, 287
  from result set, 288
  toolbar button, 77
  wildcard characters, 289
third-party software programs, 47
Threshold slider, 117
thumbnail tab, 147
thumbnail view, 76
  toolbar button, 76
thumbnails
  always displaying, 298
  configuring, 147, 298
  display, 298
  display page, 299
  view, 297
TIFF, multi-page, 141
tile
  document windows, 303
  toolbar button, horizontally, 77
  toolbar button, vertically, 77
timeout
  scanner manual feed, 118
title bar
  configuring, 91
title, search by, 138, 251
toolbar buttons
annotation group, 78
annotation selection, 78, 476 to 477
applications view, 76
arrow, 78, 451
attach all, 81
attach page, 81
auto enhance, 83
auto feed, 83
back rotation, 83
bring to front, 78
cancel changes, 79
cascade, 77
change size, 89
color, 79
configuration, 77
copy, 76
cut, 76
delete annotations, 79
delete page, 81
eraser, 78, 485
fill, 78
fit height, 80
fit to window, 79
fit width, 80
form overlay, 80
freehand line, 78, 451
front rotation, 83
full screen, 77
hide annotations, 79
hide index, 72
highlight, 78
Index view, 80
Index View, 72
line width, 79
magnifier, 80
manual feed, 83
new CAQ query, 76
new document, 76, 81
new query, 76
next page, 80, 82
next subpage, 80
next version, 80
OCR page, 80
oval, 78, 452
pan mode, 70, 80
paste, 76
polygon, 78
polyline, 78
previous page, 80, 82
previous subpage, 80
previous version, 80
print, 76, 359, 361
query view, 76
rectangle, 78, 452
redaction, 78
rescan, 82
rotate left, 80
rotate right, 80
rounded rectangle, 78, 452
Rubber Stamp, 79
Run Query, 76
save annotations, 79
scan, 82
scan document, 77
scanner setup, 83
select all, 78, 477
select scanner, 77
selection mode, 70
send to back, 79, 467 to 468
show text, 80
single feed, 83
sticky view, 79
straight line, 78, 451
text annotation, 78
text search, 77
thumbnail view, 76
tile horizontally, 77
tile vertically, 77
zoom in, 80
zoom out, 80
toolbars
adding buttons, 90
annotation, 77
batch index, 81
configuring, 88
customizing, 90
display, 89
enabling display, 88
image, 79
main, 75
removing buttons, 90
scan, 82
script, 81
top margin, 497
troubleshooting, indexing, 221
ture color images
e-mail format, 126
export format, 130
storage format, 140
ture type font, using with zoom feature, 307

U
unknown data source, 107
use multi-page files option, 374
user
enter password, 56
login, 59
V
validation, index, 211
vendor, 129
versions
adding new page version, 350
check in, 438 to 439
deleting, 400
new page, 437
newest, 301
next, 301
oldest, 301
previous, 300
replace page, 437
viewing page, 300
vertical adjustment
margin alignment, 497 to 498
settings, 497
vertical de-speck, 505
vertical tiling
tile horizontally toolbar button, 77
tile vertically toolbar button, 77
view
AppXtender Reports Mgmt
reports, 281
document properties, 268, 394
documents, 284 to 285, 295
duplicate document, 303
foreign files, 324 to 325
full-text search results, 283
index, 71
next page, 296
OLE objects, 328
options, full screen, 99
previous page, 297
properties from the ODMA result
set, 425
sticky, 304
text pages, 318
thumbnails, 297 to 298
view settings, configuring, 104
view tab, 104
views
Applications, 63
display as dialog box, 96
display as subwindow, 97
docking, 95
Document Display, 69
hiding on use, 98
Index, 71
Query, 66
Thumbnail, 73
volume label
search drives, 143
volume label, using in batch import file, 197

W
width
color bar lines, 323
minimum area, 501
width in lines, color bar, 120
wildcard, 246
in batch import text file, 198
in text searches, 289
searchable data types, 247
windows clipboard
paste special, new document, 175
paste special, new page, 342
wizards
AppXtender Auto Index Import, 38
AppXtender Index Image Import, 38
AppXtender Key Reference Import, 38
workflow
submit documents, 393
workstation
load settings, 160
save settings, 151
workstation, configuring, 85
write path
local, 142
local scanning, 142

X
XipPrint II feature
configuring, 123
XPS files
e-mail format, 125

Y
Y2K compliance
date index values, 138
year 2000
date index values, 138

Z
zoom, 306
allowing for text, 119
configuring, 104
in, 307
out, 308
percent, 308
ratio, 331
settings as pixels, 106
to percent, 308
zoom in toolbar button, 80
zoom out toolbar button, 80
zoom percent, 106